For my mom, my BBG, and all my friends and family.
Contents

Acknowledgments ................................................. xv

Chapter 1  
Welcome to Macintosh ............................................. 1
Switching: A Big Step! ............................................ 1
About This Book ................................................ 2
What You Need to Know ........................................ 4
Welcome Unix/Linux/BSD Users! ............................... 5
Cast of Characters .............................................. 5
An Important Note about Errors ............................... 7
About Me ....................................................... 7

Chapter 2  
History of Apple, the Macintosh, and Mac OS X ............. 9
The Beginnings .................................................. 10
  The Apple I Is Born .......................................... 11
  The Apple II Launches the Company .......................... 13
Failure #1: Apple III ............................................ 14
Apple Enters the Education Market ........................... 15
  Apple IIe ..................................................... 16
The Birth of the Macintosh ...................................... 17
Failure #2: Lisa ................................................ 17
Changes Are Brewing .......................................... 18
The Macintosh Ships ............................................ 20
Goodbye Jobs, Hello New Macs ............................... 22
  Fat Mac ..................................................... 22
  Mac Plus .................................................... 23
Apple Suffers, Then Bounces Back ............................ 23
  The Mac II .................................................. 24
Failure #3: Mac TV ............................................. 26
Sweet Success and Painful Failure ............................ 27
Failure #4: Licensing Mac OS ................................. 28
Evolution of Mac OS X .......................................... 29
NeXT Is Born .................................................. 29
NeXTStep Comes Together .................................... 32
The NeXT Computers Ship, But with Problems ............. 33
Contents

Jobs Comes Home .................................................. 35
iMac ................................................................. 36
Mac OS X Rears Its Head ......................................... 36
Summary .............................................................. 37

Chapter 3  

Ten Macintosh Myths Debunked ............................... 39
Software Support Is Minimal at Best ......................... 40
The Macintosh Is Incompatible with PCs ................. 41
Macs Are Not Upgradeable ................................... 42
The Macintosh Is Proprietary ................................ 43
Macs Are Too Expensive ....................................... 43
Macs Are Only for Graphic Artists and Schools ....... 44
Mac OS X Is a Closed System ............................... 45
Mac OS X Development Is Inefficient and Difficult ...... 46
Mac OS X Is Not Secure ......................................... 47
Macs Can’t Play Games ......................................... 48
Summary .............................................................. 50

Chapter 4  

Get to Know Your Macintosh ................................. 51
Macintosh Hardware Is Different ......................... 52
Keyboard ............................................................ 52
Command Key ..................................................... 53
Control Key ......................................................... 54
Option Key .......................................................... 54
Delete and Return ................................................. 55
Mouse ................................................................. 55
Power Button ......................................................... 57
Disks ................................................................. 57
The Mac OS X User Interface ................................. 58
Window Controls .................................................. 58
Mac OS X Uses a Desktop Metaphor ..................... 60
The Finder .......................................................... 61
The Menu Bar ....................................................... 64
The Apple Menu .................................................... 64
The Application Menu ............................................ 68
Menu Extras ......................................................... 69
The Dock ............................................................. 71
What Else Is the Dock For? .................................... 71
Dock Icons Have Contextual Menus ..................... 73
Make the Dock Your Own ....................................... 74
Set Preferences for Your Dock .............................. 76
Let’s Review ......................................................... 76
Mac OS X Has Some Major Differences .......................... 77
Scroll Bars ......................................................... 77
Important File Locations. ......................................... 79
  User Files ....................................................... 79
  System Files .................................................... 80
Subtle Differences .................................................. 80
  Sizing and Moving Windows .................................. 80
  Hiding Instead of Minimizing ................................. 81
  Mouse Pointer .................................................. 82
  Rounded Corners ............................................... 83
Summary ..................................................................... 83

Chapter 5  
Mastering Mac OS X Panther ....................................... 85

Make Finder Work for You .......................................... 86
  View Options ....................................................... 87
  Sidebar .............................................................. 88
Folder Contents ..................................................... 89
  Selecting Items ..................................................... 89
  Spring-loaded Folders .......................................... 90
  Copying ............................................................. 90
  Moving .............................................................. 90
  Deleting ............................................................ 90
  Creating an Alias ................................................ 91
  Renaming .......................................................... 91
Toolbar ............................................................... 91
  Arrow Buttons .................................................... 91
  View Buttons ...................................................... 92
  Action Button ..................................................... 94
Search Box ................................................................ 95
Customizing the Toolbar ............................................ 97
Dialog Boxes ........................................................ 98
  Open ................................................................. 99
  Save ................................................................. 100
  Print ................................................................. 102
Get Info. ............................................................... 102
Using Your Applications ............................................ 103
Installing and Launching .......................................... 103
  Application Installers .......................................... 104
  Add/Remove Programs .......................................... 105
  Launching and Quitting. ....................................... 105
Listening to Music .................................................. 106
  Importing Songs .................................................. 106
  Playing Music ..................................................... 108
Contents

Watching Movies .................................................. 109
  Watching DVDs .................................................. 109
  Watching Movie Files .......................................... 111
Managing Your Schedule ....................................... 114
Address Book ...................................................... 115
Running Classic Applications ................................ 116
Switching Applications ......................................... 117
  Command-Tab .................................................... 117
  Exposé ............................................................ 118
Capturing Screen Shots ....................................... 122
  Capturing via Grab ............................................. 122
  Capturing via Keyboard Shortcuts ......................... 123
Customizing and Configuring ................................ 124
System Preferences .............................................. 124
Dock Preferences ................................................ 126
  Size, Magnification, and Position ......................... 127
  Minimize Effects .............................................. 128
  Animation and Hiding ....................................... 128
Mac OS X Appearance .......................................... 129
  Appearance and Color ....................................... 130
  Scroll Bar and Window Behavior ......................... 130
Recent Items .................................................... 131
Font Smoothing .................................................. 132
Changing your Desktop Background ......................... 133
  Setting a Picture as Your Background .................. 134
  Automatically Changing Desktop Images ............... 136
Screen Savers .................................................... 137
  Setting up a Screen Saver ................................ 137
  Set the Timer ................................................ 138
  Hot Corners .................................................. 139
Energy Saver ...................................................... 140
  Sleep .......................................................... 140
  Schedule ...................................................... 141
  Options ....................................................... 142
Have a Conversation with Your Macintosh ................. 143
  Apple Speakable Items .................................... 144
  Voices ......................................................... 145
Setting Sounds .................................................. 146
Setting the Date and Time .................................. 147
Universal Access ................................................. 149
Changing Icons .................................................. 150
Getting Online .................................................. 152
  Network System Preference ............................... 152
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Browsers</td>
<td>153</td>
</tr>
<tr>
<td>Safari</td>
<td>153</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 5.2</td>
<td>155</td>
</tr>
<tr>
<td>Mail</td>
<td>157</td>
</tr>
<tr>
<td>iChat</td>
<td>158</td>
</tr>
<tr>
<td>Summary</td>
<td>159</td>
</tr>
</tbody>
</table>

## Chapter 6 Move Your Stuff to Your Macintosh

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare for Your Move</td>
<td>161</td>
</tr>
<tr>
<td>Preparing Your Favorites/Bookmarks</td>
<td>162</td>
</tr>
<tr>
<td>Exporting Favorites from Microsoft Internet Explorer</td>
<td>163</td>
</tr>
<tr>
<td>Exporting Bookmarks from Netscape 7 and Mozilla</td>
<td>164</td>
</tr>
<tr>
<td>Preparing Your Outlook Express Contacts</td>
<td>165</td>
</tr>
<tr>
<td>Copy Your Files with Detto Move2Mac</td>
<td>166</td>
</tr>
<tr>
<td>Copy Your Files Over a Network</td>
<td>167</td>
</tr>
<tr>
<td>Moving Your Files with FTP</td>
<td>168</td>
</tr>
<tr>
<td>Moving Your Files with Windows Sharing</td>
<td>169</td>
</tr>
<tr>
<td>Copy Your Files with a Disk</td>
<td>170</td>
</tr>
<tr>
<td>Copy Your Files Over the Internet</td>
<td>171</td>
</tr>
<tr>
<td>Preparing Your Files</td>
<td>172</td>
</tr>
<tr>
<td>Compressing Your Files</td>
<td>173</td>
</tr>
<tr>
<td>Uploading the Files</td>
<td>174</td>
</tr>
<tr>
<td>Uploading with FTP</td>
<td>175</td>
</tr>
<tr>
<td>Uploading with iDisk</td>
<td>176</td>
</tr>
<tr>
<td>What Next?</td>
<td>177</td>
</tr>
<tr>
<td>Downloading the Files</td>
<td>178</td>
</tr>
<tr>
<td>Downloading with FTP</td>
<td>179</td>
</tr>
<tr>
<td>Downloading with iDisk</td>
<td>180</td>
</tr>
<tr>
<td>Prepare the Files to Be Put Where They Belong</td>
<td>181</td>
</tr>
<tr>
<td>Where Should I Put My Files?</td>
<td>182</td>
</tr>
<tr>
<td>Documents</td>
<td>183</td>
</tr>
<tr>
<td>Favorites</td>
<td>184</td>
</tr>
<tr>
<td>Importing Your Bookmarks into Microsoft Internet Explorer for Macintosh</td>
<td>185</td>
</tr>
<tr>
<td>Importing Your Bookmarks into Safari</td>
<td>186</td>
</tr>
<tr>
<td>Music</td>
<td>187</td>
</tr>
<tr>
<td>Movies and Videos</td>
<td>188</td>
</tr>
<tr>
<td>Pictures</td>
<td>189</td>
</tr>
<tr>
<td>Desktop Pictures (Wallpaper)</td>
<td>190</td>
</tr>
<tr>
<td>Icons</td>
<td>191</td>
</tr>
<tr>
<td>Contacts</td>
<td>192</td>
</tr>
<tr>
<td>Summary</td>
<td>193</td>
</tr>
</tbody>
</table>
Chapter 7 Connect and Use Your Hardware ........................................... 193
  Input Devices ................................................................. 194
    Mice, Trackballs, and Tablets ........................................ 194
    Keyboards ........................................................................ 194
  Specialty Devices ............................................................ 195
    Ink Preferences .............................................................. 196
    Keyboard and Mouse Preferences ..................................... 199
  Digital Music, Photography, and Moviemaking ...................... 201
    iPod .............................................................................. 201
      Using an iPod with iTunes ............................................ 203
      Using an iPod as a Personal Digital Assistant ................ 205
      Disconnecting Your iPod .............................................. 206
    Digital Cameras ............................................................. 207
      Still Cameras ................................................................ 207
      Movie Cameras ........................................................... 211
  Printing, Faxing, and Scanning ............................................ 212
    Printers ........................................................................... 212
      Connecting Your Printer .............................................. 212
      Setting Up Your Printer in Mac OS X ............................. 213
      Printer Preferences ....................................................... 215
      Printing Documents ..................................................... 216
    Using Your Macintosh as a Fax Machine ............................ 219
    Scanners .......................................................................... 220
  Disks ................................................................................. 221
    Working with Disks .......................................................... 221
      Ejecting Disks ................................................................ 222
      Repairing, Erasing, and Copying Disks ......................... 223
    Removable Media ............................................................ 228
    External Hard Drives ....................................................... 228
  CDs and DVDs ..................................................................... 229
    Accessing Data on a CD or DVD ...................................... 230
    Burning Data CDs ............................................................ 231
    Burning Music CDs .......................................................... 234
    Burning DVDs ................................................................ 236
  Setting CD and DVD Preferences ......................................... 237
  Display Devices ................................................................. 238
    Display Preferences .......................................................... 239
  Personal Digital Assistants .................................................... 240
    Connect Your PDA to Your Macintosh ............................... 240
    Synchronize Your PDA and Macintosh ............................... 240
    Synchronizing with Palm Desktop for Macintosh ............... 240
    Synchronizing with iSync ................................................ 241
Synchronizing with Entourage
Summary

Chapter 8  Switch to Microsoft Office:mac
What's Missing in Office:mac
Microsoft Access
Microsoft FrontPage
Microsoft Publisher
Microsoft Project
Microsoft Visio
Office:mac and Office XP
Startup
Documents
Menus
File
Edit
Tools
Window
Help
Formatting
Toolbars
Office Assistant
Macros
Preferences
Word:mac
Word Documents
Menus
File
Edit
View
Insert
Format
Font
Tools
Table
Work
Excel:mac
Excel Workbooks and Worksheets
Menus
File
Edit
View
Insert
Contents

Format ........................................ 278
Tools ........................................ 278
Data .......................................... 279
PowerPoint:mac ................................ 280
PowerPoint Presentations ...................... 281
Menus ........................................ 281
File ........................................... 281
Edit ........................................... 282
View .......................................... 282
Insert ........................................ 283
Format ........................................ 284
Tools .......................................... 285
Slide Show .................................... 285
Entourage:mac ................................ 286
Entourage:mac Is Not Really an Exchange Client ... 286
Entourage:mac Is a Personal Information Manager ... 287
Mail .......................................... 288
Address Book .................................. 290
Calendar ...................................... 290
Notes ......................................... 291
Tasks .......................................... 292
Summary ...................................... 293

Chapter 9  Manage Your Macintosh ................. 295
Security ........................................ 295
How Safe Is My Macintosh? ...................... 296
Owning root ................................... 297
How Can I Control Access to My Macintosh? ... 297
System Security ................................ 298
Creating Accounts ............................. 299
Account Privileges ............................. 300
Fast User Switching ........................... 303
How Can I Protect My Macintosh from Myself? 304
How Do I Log into My Macintosh from Another Computer? 305
What are Those Other Services in the Sharing Preference? 306
How Can I Protect My Macintosh from Hackers? 306
How Can I Secure My Files? .................... 308
How Do I Change My Password? ................. 309
Keychain Passwords ........................... 311
How Do I Protect My Macintosh from Viruses? 313
Preventative Maintenance ...................... 314
How Do I Back Up My Macintosh Files? ........ 314
Synchronizing Folders ........................ 316
How Can I Ensure Optimal Performance? .................................. 317
  Increase Your Memory .................................................. 317
  Monitor System Activity ............................................. 317
  Increase Drive Space ................................................. 318
How Do I Keep My Macintosh Up to Date? ............................. 319
Finding and Fixing Problems ........................................... 320
  How Do I Handle Misbehaving Applications? .................... 320
  How Do I Handle Permissions Problems? .......................... 321
  How Can I Repair My Hard Disk? ................................. 323
    Startup Disk Preference .......................................... 324
Summary ............................................................................. 325

Chapter 10
Darwin Demystified ............................................................. 327
  What Is Darwin? ............................................................ 328
    Looking Under the Covers ........................................... 329
  From MS-DOS to Darwin .............................................. 331
    How the Command Line Works ..................................... 332
      tcsh ................................................................. 332
      bash ................................................................. 333
  Using Mac OS X Commands ........................................... 333
  Changing Your Shell .................................................... 336
  Working with Files and Directories ................................ 337
    pwd ................................................................. 338
    ls ................................................................. 338
    man ............................................................... 340
    mkdir ............................................................. 340
    cd ................................................................. 341
    pico ............................................................. 341
    more .............................................................. 343
    cp ................................................................. 344
    mv ................................................................. 345
    chmod ............................................................. 346
    rm ................................................................. 347
    rmdir ............................................................. 348
  Using Networking Commands .......................................... 349
    nslookup ........................................................... 349
    ping ............................................................... 350
    traceroute ......................................................... 351
  Using the Convenience Commands ................................... 352
    clear .............................................................. 353
    history ............................................................ 353
    uptime ............................................................ 354
    who ............................................................... 354
Contents

Summary ........................................... 356

Appendix A  Mac OS X Keyboard Shortcuts ........ 357
Startup .......................................... 357
Finder .......................................... 358
Application Shortcuts ......................... 360
Universal Access ................................. 361
Drag and Drop .................................. 362

Appendix B  Essential Macintosh Web Sites .... 363
News .............................................. 363
  apple.slashdot.org ................................. 364
  MacNN.com .................................... 365
Games ............................................ 366
  InsideMacGames.com ......................... 366
Technical ....................................... 367
  MacFixIt.com .................................. 367
  MacOSXHints.com ............................... 368
Shopping ........................................ 369
  MacPrices.com ................................ 369
  DealMac.com ................................... 370
Humorous ....................................... 371
  CrazyAppleRumors.com ....................... 371
Hardware and Software ....................... 372
  VersionTracker.com ............................ 372
  PowerBookCentral.com ....................... 373
Summary ........................................ 373

Index ............................................. 375
Foreword

I've been an Apple fan since 1980 when I first laid eyes on the Apple II+. Programming that little computer consumed me for the next 10 years of my life, and I've always been a huge believer in Steve Jobs and the Apple philosophy that computing should be fun and easy for everyone. Throughout the years, Apple has continued to make steady improvements in the quality of experience that users get from the Macintosh computer and I still believe in the Apple dream.

I followed Steve Jobs through his second act at NeXT Computer and developed several games on that platform including DOOM, DOOM II, and Quake. Even though these games were released for the PC, they were developed solely on NeXT computers because Steve knows how Things Should Be Done. This was very evident in the solid foundation of the Mac OS and ease of use of the AppKit on NeXTStep. I loved it.

When Steve went back to Apple and reinvented the Mac, I, of course, got back into it with a couple of iMacs and a G4. OS X has been an amazing rebirth of the Mac OS. Just seeing the little NeXTStep wait cursor showed me that everything that I loved about NeXTStep was at the foundation of the new OS and that the cold interface of NeXTStep had been replaced with a happy Mac vibe and sensibility. It's just perfect now.

You won't regret leaving Windows behind when you make the switch. The Mac will put a smile on your face.

John Romero
Project Lead,
Midway Home Entertainment
Acknowledgments

Putting together a book is a lot of hard work, and I couldn’t have done it without the help of several people.

I owe a huge thanks to Wes Beckwith, Beth Kohler, and everyone else at Wordware. Their patience and attention to detail are astonishing. I also owe a big thank you to Alan Graham for his fine job of tech editing. Special thanks goes to Jim Hill and John Romero for helping me get this book off the ground.

A big thanks goes to everyone in the cast of characters who took time to answer my questions and participate in informal surveys. Special props go to Joby and Daniel for helping with screen shots and technical information.

I would also like to acknowledge others who helped make this book possible: Tim Green, Jerry Kountz, Stuart Pace, Randy Walden, Jon Brown, Richard Wehman, Jan Stalder, Jeanne Acton, Thomas Park, Wil Wheaton, John Carmack, Jaime Guzman, Chris Griffith, and JL Chapman (thanks for the NeXTStation).

A very special thank you goes to Tom Brott. He introduced me to the Macintosh and gave me many opportunities to tinker.

I also owe a tremendous thanks to the owners of the sites in Appendix B for generously allowing me to include screen shots of their intellectual property.

Thanks to Mike Shebanek and the folks at Apple Computer for giving me access to Panther during the beta test period.

This book wouldn’t be possible without my wife, Amanda, for being my personal copy editor. She helped me with editing and put in a lot of time and effort to help me get this book done. She was patient during all those late nights and long weekends when I was sequestered in my home office, working on this book. I don’t know what I would do without her.

Finally, I would like to thank you, my reader, for switching to the Macintosh.
Welcome to Macintosh

Maybe you saw the Switcher advertisements on television or the web. Maybe you were drawn into an Apple Store by the beautiful machine in the display. Maybe you've always thought a little differently, or wanted something a little different for a change.

Whatever the reason for your switch to Macintosh, here you are. And here I am to help you.

Switching: A Big Step!

Welcome to Macintosh. From 1984 to 2002, these three words greeted Macintosh users when they turned on their Macintosh computers. Many people were upset by the demise of this tradition in 2002. “Welcome to Macintosh” was a familiar greeting, a way for the computer to tell the Macintosh user, “Hey, I’m glad you’re here. Thanks for using me!” People liked the greeting because it added a friendly touch to what was already a pleasant computing experience. Using a Macintosh is fun.

Now is the perfect time to switch to the Macintosh. The Macintosh computer is better than ever, with awesome built-in features like DVD burning, Ethernet networking, and high-speed ports for connecting devices like digital cameras and external hard drives.
On top of those great hardware features, Apple has spent considerable time and resources perfecting the Macintosh operating system, Mac OS X. Currently at version 10.3 (known as Panther), Mac OS X has single-handedly been the number one reason for many peoples' decisions to switch to the Macintosh. It's beautiful, of course, and a pleasure to use. It works in a way that really appeals to people too. The fact that it is super stable and super secure is icing on the cake.

The Macintosh will undoubtedly meet, and probably exceed, your needs, but there are some things you will need to learn about it first. Switching from PC to Macintosh is not an effortless transition. That is, after all, why you're reading this book. I will help you as you make your way from brand-new Macintosh owner to hard-core Macintosh user.

It's not always easy to uproot yourself from something you are familiar with and replant yourself into something new, even if the something new is better (metric system, for example). Microsoft Windows is ubiquitous. There are thousands of available software titles for Microsoft Windows, and it's huge in the corporate world. If you're coming from the Linux world, you're probably used to being able to recompile the kernel to add a new feature, or having 100 percent control over every aspect of your operating environment, whether it's KDE, GNOME, or plain old twm.

Well, Mac OS X is different. If it weren't, you wouldn't be here.

About This Book

I decided to write this book after much deliberation and many conversations with my friends who are Macintosh users. Rather than just translating basic Microsoft Windows skills into Macintosh skills, I wanted to approach the switch to Macintosh from the perspective of a user who wants to really get the most from his or her Macintosh computer. Macintosh has a fervent
following and influences its owners to truly “think different.” I wanted to write a book that really helps a PC user fully make the switch to the Macintosh, both physically and mentally.

Marketing aside, the Macintosh is a wonderful machine that will truly change the way you use a computer. Whether you want to go whole-hog and become a Mac addict, or you just want to get some work done without worrying about viruses and hackers, the Macintosh will work for you if you know how to work with it. To that end, this book lies before you.

Chapter 2 gives you a look at the history of Apple, the Macintosh, and Mac OS X. I come from an educational background that promotes historical context. I find it valuable and important to know where things came from in order to fully understand them. If you’re not interested in the history lesson, you can skip Chapter 2, but you’ll be missing out on some really interesting stuff.

Chapter 3 jumps into debunking some Macintosh myths. As a PC user, you may have heard, or possibly even embraced, some of these myths. As a Macintosh user, you will probably, at some point in time, have one or more of them thrown at you from non-Macintosh users who are trying to convince you that the Macintosh is worthless for whatever reason. Chapter 3 will arm you with accurate information so that you can let go of any preconceptions you may have and defend yourself and your new machine. You don’t have to start a holy war; just know the facts.

Chapter 4 gets into the meat and potatoes by helping you understand how your Macintosh is different from your PC, both in terms of hardware and the operating system, Mac OS X. Things like how to use the one-button mouse are covered in Chapter 4 and it is your first primer for using your Macintosh and Mac OS X.

Chapter 5 picks up from Chapter 4 and plunges you headlong into using Mac OS X. You’ll learn how to set up your system’s wallpaper and screen saver, how to launch and use applications, how to listen to CDs and watch DVDs, and how to get connected to the Internet, among other things.
Chapter 6 will guide you in the process of moving your files, music, and other stuff from your PC to your Macintosh. It talks about where to put your files, how to transfer them over, and how to get your email on your Macintosh computer.

Chapter 7 is all about using your new (and existing) hardware with your Macintosh. It covers printers, scanners, the iPod, digital cameras, and much more. There are lots of screen shots included to help you along.

Chapter 8 is a unique chapter. It is less about the Macintosh and more about a very important piece of software, Microsoft Office. Chapter 8 is all about switching from Microsoft Office XP to Microsoft Office for Mac OS X. If you’re a Microsoft Office user, this chapter should be considered essential reading.

Chapter 9 is all about managing your Macintosh, from setting up security to adding new user accounts. You will learn how to deal with any problems that may arise, as well as how to keep your Macintosh in good shape.

Chapter 10 is a technical chapter that covers using the command-line interface in Mac OS X. The command-line interface is sort of like a DOS prompt in Microsoft Windows: It allows you to enter text commands that give you significant control of your Macintosh. Chapter 10 also covers Darwin, the open-source part of Mac OS X that provides all of the Unix goodness.

Finally, there are two appendices. Appendix A is a list of keyboard shortcuts, and Appendix B is a list of essential Macintosh web sites.

What You Need to Know

This book assumes you are familiar with using a computer with Microsoft Windows. I use a few conventions in this book to help guide you through the process of using your Macintosh.

I am also assuming that, if you have purchased a Macintosh, you’ve unwrapped it and set it up using the instructions included with the computer, and that you’ve turned it on and made it
through the Macintosh's startup process. Ultimately, I'm assuming that you are looking at a screen with icons, a bar at the bottom with icons on it, and a menu bar at the top. The instruction book that comes with your Macintosh should at least get you this far.

When I talk about using menus, I use the and then syntax. Imagine this were a Microsoft Windows book. Using the and then syntax, I would tell you how to use the Start bar by writing, "Click the Start button, and then click Programs, and then click Microsoft Word." Click, of course, means to press and release the mouse button on the appropriate icon or menu item.

**Welcome Unix/Linux/BSD Users!**

If you are a Unix or Linux user, I welcome you. Mac OS X is an awesome operating system that offers a wonderful user interface with the familiar Unix stability and security. This book isn't necessarily tailored to Unix users, mainly because Unix and Unix-like operating systems don't have a standard user interface, but I try to include you as part of the audience whenever I can. You probably already know how to move your files over from your Unix machine to your Macintosh, so you can probably just skim over, or even skip, that part in Chapter 6. Chapter 10 covers Darwin, the BSD underpinnings of Mac OS X, so you may find that chapter particularly interesting and useful.

**Cast of Characters**

This book has a cast of characters, real people I interact with on a regular basis. Their experiences first made me consider writing this book. Some of them are Macintosh users, some are Macintosh haters, and one is a new convert.

**Brian**—I've known Brian for 10 years. I met him at a video store when I was in college. He used to be a big PC user (he had a
Tandy 286 when I met him), and it seemed like he was always having trouble with his computer. After I switched to the Macintosh in 2000, I sang its praises to him constantly. He switched in early 2001 to a used blue and white G3 from a friend, and then later upgraded to a Power Mac G4 tower. He’s fortunate enough to use a Macintosh full-time at his job, where he does creative stuff.

Joby—Joby is a talented illustrator, painter, chess player, and musician. Joby switched to the Macintosh in 1999 when he bought a blue and white G3 (he later sold it to Brian). I remember when Joby worked at an ad agency on a decrepit PC that crashed all the time. (I once wrote and sent him a program that opened and closed his CD-ROM drive at three-second intervals. I enjoy torturing him.) He kept saying he was going to get a Mac, he was going to get a Mac, and he finally did. After he sold his G3 to Brian, Joby upgraded to a Power Mac G4, which he recently replaced with a Power Mac G5 that has dual monitors and a MIDI keyboard to produce music.

Daniel—Daniel is an activist, a filmmaker, and a staunch supporter of the Macintosh. I don’t think Daniel has or would ever use a PC or Microsoft Windows, unless he absolutely had no other choice. He taught me a lot about the Macintosh when I switched, and he’s still my go-to guy for tips on the latest-and-greatest Mac OS X software. He used to have an old system from Power Computing, which was one of the “Mac clone makers” that existed in the mid-1990s. Daniel uses an iMac now.

Elley—I met Elley at the opening of Star Wars Episode I. She’s a staunch PC user and likes to talk smack about my Macintosh, even though she uses it without a second thought every time she comes over to my house. She doesn’t know anything about Macintoshes or Mac OS X.

Fred—Fred doesn’t really care about computers; he regards them as tools for getting jobs done. He does care about aesthetics, which is what got him interested in a Macintosh. Fred is a
freelance writer, so he doesn’t work in an environment that pushes one computer over another.

Steve—I have never known anyone as passionate about Microsoft Windows and the Intel processors as Steve. He is a hardware engineer by day, PC hacker by night. He knows everything about the latest graphics chipsets, memory architectures, and grid computing. He is an old-school PC user, having bought his first PC, a Compaq, in 1989. Steve has a strong distaste for the Macintosh and regards it as a toy.

Rick—Rick is a Linux user. He builds his own machines (he has several) and uses the Gentoo distribution on all of them. Rick was the first person I ever knew who ran a web server out of his apartment (Linux, of course). He regularly contributes to open-source software projects. Rick doesn’t know much about the Macintosh, mainly because the Macintosh wasn’t much of a server platform until Mac OS X came out.

An Important Note about Errors

I worked really hard to ensure this book is error free, but occasionally errors slip through the cracks. You can thus find errata on my web site, www.standefer.com/switcher. If you discover an error, you can contact me through my web site and I will immediately post a correction.

About Me

I switched to the Macintosh in 2000. I didn’t make a clean break though; in fact, I still use Microsoft Windows a lot. I’m a software architect by trade, and I use Microsoft Windows at work. At home, I exclusively use a Macintosh unless I need to connect to my office computer (my employer doesn’t offer a VPN client for Macintosh).
I first used a Macintosh in high school, around 1990, when I worked as a student library aide. I then studied journalism and used Macintosh computers extensively. In college, I always opted to use the Macintosh Quadras in the computer lab, except to play a game of Doom now and then. When I left college and entered the corporate world, I was cut off from Macintosh computers until I finally bought one of my own in 2000. Since then, I've bought two more, an iBook and a new iMac.

This book is an extension of my experiences switching to the Macintosh. I hope your journey is as pleasant as mine was.

Welcome to Macintosh.
Fred and I headed to the Apple Store at lunch one day to ogle the Power Mac G5. Fred’s not a Mac user, but he holds no allegiance to any platform. He’s just a computer user, someone who regards it as a tool that performs a job. He was sick of getting viruses all the time, so he was curious about the Macintosh. I wanted to live vicariously through him, so I was trying to convince him to buy a G5.

“I have a question for you, unrelated to the hardware,” he said. “Why do Mac people love Steve Jobs so much? I mean, what’s the big deal about the company? It seems like people buy a Macintosh because of some cult-like love of Apple.”

I delighted in his question, and I spent the next half hour explaining as much of Apple’s history as I could. That question and answer session inspired me to write this chapter in the hopes that you, the current or soon-to-be Apple Macintosh user, will be introduced to the roller coaster history of our beloved computer and the company that produces it.

This chapter covers part of the history of Apple, the Macintosh, and Mac OS X. It’s the first stage of your indoctrination as a Mac user. This story is like a three-act play. The first part is about the beginning of Apple and the events leading to the
Macintosh; the second part tells of the evolution of the Macintosh; and the third part covers the development of Mac OS X.

The Beginnings

The story of Apple starts in the 1970s with two guys, both named Steve. Their meeting and subsequent friendship would eventually cause a fundamental change in the computing world and usher in a new era of personal computing.

In the early 1970s, the idea of a personal computer was far-fetched, to say the least. Computers at the time were very large and often required their own rooms and cooling systems. Access to these computers was limited to corporate types, researchers, and people who could find a computer to timeshare and the money to pay for it.

At the time, computers fit one of three forms. A mainframe, such as the IBM System 360, was a massive computer with banks of storage units and terminals attached to it via proprietary communications channels. Think WOPR in the movie WarGames. Mainframes typically supported 100 to 400 users and required their own air-conditioned rooms, as well as a staff of technicians to maintain them and ensure their smooth operation. Mainframes typically performed computing tasks in batch. An operator would submit a job to the mainframe through a system called a teletype. At certain intervals, the mainframe computer would perform processing on all of the batched operation requests and output the results.

Minicomputers, such as the PDP-11, VAX, and IBM AS/400, weren’t as powerful or as expensive as mainframes. They were often used for organizations that didn’t need the power of a mainframe or didn’t want to outsource their computing needs. Minicomputers, with their smaller sizes and lower costs, were often used to meet one computing need, such as managing a payroll system or controlling a piece of industrial equipment. Minicomputers performed tasks interactively via a terminal.
Technically speaking, minicomputers had far less memory and physical storage space than a mainframe, but they offered many of the features found in a mainframe.

The third type is the microcomputer. A microcomputer uses a microprocessor and is designed for interactive use. Microcomputers don’t require their own rooms, and the physical device usually sits in the same place as the user and the peripherals connected to it (such as a monitor and keyboard). This idea of a computer designed around the microprocessor, which emits far less heat than the processors found in mainframes and minicomputers, was intriguing to innovators in the 1970s. Some people, including Steve Jobs and Steve Wozniak, thought microcomputers were the wave of the future.

The Apple I Is Born

Steve Wozniak, affectionately known as Woz, was fascinated by hardware and liked to create different hardware devices, including a telephone attachment for making free long-distance phone calls. The device, called a blue box, was quite popular among college students. Steve Jobs, who had known Woz for a while, offered to help Woz sell the illegal device to customers. This was the beginning of the relationship between the brilliant engineer (Woz) and the brilliant marketer (Jobs).

Woz’s interest in electronics led to the Homebrew Computer Club, a group of California electronics aficionados with a keen interest in computers. Steve Jobs began attending meetings of the Homebrew Computer Club in 1974, but while Woz enjoyed tinkering with computers and electronics, Jobs was more interested in their marketability.

Woz had already been working on his idea of a personal computer for a few years by the time Jobs joined the Homebrew Computer Club. In the mid-1970s, personal computers were starting to emerge with advertisements in magazines such as Popular Science. The personal computers were sold in kit form and offered user feedback in the form of LEDs (light-emitting
diodes — the little lights you see on modems or digital clocks). User input was accomplished through a set of switches. The most popular personal computer kit at the time was the Altair 8080, made by a small company in New Mexico called MITS.

**Note:**

Microsoft Corp., which was the bane of Apple’s existence in the 1980s and part of the 1990s, actually got its start by making a BASIC compiler for the Altair 8080.

Woz thought the Altair was interesting, but he envisioned something more. His personal computer was just a printed circuit board with an MOS 6502 processor (other kits used the Intel 8080). It didn’t even have a case. When Jobs saw Woz’s personal computer, he insisted that it could be sold. Woz and Jobs’ new personal computer was christened Apple I. *Apple* came from their new company’s name (the origin of the company name came from Jobs’ days in apple orchards during his youth, so the story goes), and the *I* designation indicated that it was the first Apple computer. You had to build your own case of course, but Woz pieced together a wooden case for his prototype Apple I and Jobs took it to a local electronics equipment retailer, who ordered 25.

By today’s standards, the Apple I is nothing to get excited about, but at its introduction in 1976, it was quite revolutionary. While other computer kits at the time used switches and LEDs, the Apple I had a video-out capability, advertised as “complete video terminal electronics.” This video terminal allowed owners of the Apple I to hook up their computers to external display devices. Owners could even hook it up to a television via an RF modulator. There was no need for a clunky teletype.

The Apple I featured 8K of RAM. That’s 8 kilobytes. The maximum RAM was 32K. The MOS 6502 operated at a blistering 1 megahertz with an 8-bit data path. The Apple I stored its built-in operations in an onboard ROM (read-only memory) chip.
It had 1K of video RAM, which was a big deal because that meant programmers could maximize the 8K of physical RAM. There were no serial ports, no floppy, no hard drive, no mouse, no sound, and definitely no CD-ROM. The display featured 24 rows of 40 characters, which would be good enough for entering programs and typing text documents. The storage option was a sold-separately cassette board connector, which allowed owners to hook up cassette data peripherals. Data throughput for the cassette interface was 1500 bits per second (1500 bps), which meant the Apple I could read or write 4K in 20 seconds. To put that in perspective, consider that DSL and cable modems routinely reach 1.5 Mbps. That's 1.5 million bits per second, and we use that to download email and surf the web. FireWire, which is built into every new Macintosh, operates at 400 Mbps or 800 Mbps, depending on the model of Macintosh.

In 1977, the Apple I went on sale for $666.66. Jobs had left his position at Atari, and Woz quit his job at Hewlett-Packard to work for Apple full-time. Apple earned $774,000 from sales of the Apple I. It was enough to convince them that they could get started on their next personal computer, the Apple II.

**The Apple II Launches the Company**

In order for the Apple II to be a success, Apple needed more than a few guys in a garage and the proceeds from selling the Apple I. They needed a management team with the ability to see products to fruition (no pun intended) and meet growth goals. Apple hired some marketing folks including Nolan Bushnell, who founded Atari. Mike Markkula, who had cut his teeth in the technology business as Intel's marketing manager, invested $250,000 and became the chairman of the company. Apple hired a president and secured a line of credit from a major bank. They were ready for business.

The Apple II was almost functionally equivalent to the Apple I. The Apple II only had 4K of RAM, but it was expandable to 64K. It also had a 12K ROM that housed the BASIC
programming language and the information necessary to boot the machine. The Apple II offered a few more expansion options and a built-in speaker, but the main technical difference between the Apple I and Apple II was the Apple II's support of a color display. It featured six colors at 280x192 and 4-bit color at 40x48. Today it is taken for granted, but color support in a personal computer was quite a lot to get excited about in those days. Probably the most obvious difference between the Apple I and Apple II was the presence of the Apple II's plastic case—no more kit computers for Apple Computers Incorporated. All of this plus game paddles and a demonstration cassette could be yours for $1,298 in 1977. Two years after the Apple II debuted, Apple released the Apple II+. It featured a few improvements, including 48K of RAM and a version of BASIC developed by a New Mexico startup called Microsoft. The II+ sold for about $100 more than the Apple II, and it was available from 1979 to 1983, when it was replaced by one of the most popular computers of all time.

Failure #1: Apple III

Before we get to that, we have to look at Apple’s first big failure. In 1980, Apple decided to crack into the business market with the Apple III. The business market needed more power than what the Apple II offered, so Apple put 128K of RAM in the Apple III and put in a 2 megahertz Synertek 6502A processor. A new high-resolution graphics chip was built into the motherboard. To meet the demanding storage needs of a modern business in 1980, Apple included a 5.25” floppy disk drive (a first for Apple). The Apple III featured a new operating system designed for higher-performance computing, but Apple II software wasn’t left out in the cold, as the Apple III had an emulator that ran Apple II programs.

With all this impressive power and technology, the Apple III was priced between $4,300 and $7,800. This pricing structure was one of the main contributors to the Apple III’s dismal failure; Apple’s troubles were further exacerbated by the many technical
problems that plagued the Apple III at launch. Apple tried to save the Apple III in 1981 by releasing a “fixed” version that had its RAM boosted to 256K and its starting price deflated by $1,000. Apple made a 5 MB external hard disk available in a last-ditch attempt to boost sales of the Apple III. Apple canned the Apple III in 1983. They made one last attempt to save face by releasing the Apple III+ with a price reduction to $3,000. Apple finally killed the Apple III line in 1985.

By the time the Apple III debuted in 1980, Apple had grown from just Steve Jobs and Steve Wozniak to several thousand employees. Revenues were in the millions of dollars, and Apple began to sell computers in international markets. In four short years, Apple grew from a garage operation into a multimillion-dollar international force in the personal computing industry.

Despite the failure of the Apple III, Apple’s financial success opened the door to release a computer that was so popular, it was in production for ten years. IBM released their PC XT, which ran Microsoft MS-DOS as the operating system and took the business computing market by storm. Apple chose to focus on a lower-priced personal computer, one that would appeal to educators and consumers. Realizing that the Apple III was too expensive, they went back to the successful Apple II, changed the case, made some technical enhancements, and improved the user experience. The end product was the Apple IIe.

**Apple Enters the Education Market**

Anyone who went to elementary school in the 1980s will instantly recognize the Apple IIe. The Apple IIe’s debut in 1983 was the beginning of Apple’s domination of the education market. Its low price of $1,398 made it a better choice for schools than the much pricier IBM XT. Schools also loved the Apple IIe because Apple offered them special incentives and software programs. This was in stark contrast to other computer vendors at the time, like Commodore and Wang.
Apple IIe

From a technical standpoint, the Apple IIe wasn’t much different from its predecessors. It featured a Synertek 6502 processor running at 1 megahertz. Out of the box, it had 64K RAM, expandable to 128K. It had an 8-bit bus and a 16K ROM that stored the built-in BASIC interpreter for running programs. The operating system was the familiar AppleDOS, but it also allowed users to run ProDOS, the operating system on the Apple III.

Display capabilities improved with the Apple IIe. It featured the standard 40-column text display, but it also supported five other display modes. Applications could run at 140x192 resolution with 6-bit color, 40x48 resolution with 4-bit color, 140x192 resolution with 4-bit color, 560x192 at 1-bit monochrome, and 240x192 resolution at 1-bit monochrome. All this graphics mumbo-jumbo meant one major thing for consumers who bought an Apple IIe: It could play graphical games. This was a huge deal in the blocky days of the Atari 2600. If you think about it, the ability to play games has been a major selling point of computers since they became ubiquitous in the early 1980s. Even today, gamers routinely spend thousands of dollars on top-of-the-line computer hardware to play the latest-and-greatest games at their absolute best. When you consider the IIe’s success in the education market, parents were inclined to buy them for their kids to use at home. I knew quite a few kids who convinced their parents they wanted a IIe for doing homework, when in fact their intent was to play games. With all that the Apple IIe offered — graphics capabilities, computing power, and low price — there was one other major factor that contributed to its success: expandability. An Apple IIe owner could easily add a floppy drive (or two). With eight expansion slots and architecture that allowed third-party vendors to build all kinds of add-in cards, people who bought the Apple IIe didn’t have to worry about replacing it in the days when the fledgling personal computing industry was changing so quickly. In the 1980s, $1,400 was a tidy sum for something as superfluous as a computer. Apple IIe owners maximized their investment by expanding their computers.
when they wanted to. This was even more important in the edu-
cation market, where the budgets didn't allow replacing
computers every couple of years.

As the Apple II and Apple IIe enjoyed success in the early
1980s, Apple itself was undergoing some changes. Apple brought
in John Sculley, a former Pepsi executive, to take over the job of
president and CEO. He was hired to help Apple become a per-
sonal computer superpower in the 1980s. Meanwhile, the IBM
PC XT was a huge success in the business sector, and Jobs was
still interested in breaking into that lucrative market. His next
attempt would be a huge failure, but it would also serve as the
stepping-stone to the computer that made Apple what it is today.

The Birth of the Macintosh

While Apple was busy selling the Apple II and trying to sell the
Apple III, Steve Jobs was looking to the future. In 1979, he vis-
ited the Xerox Palo Alto Research Center (PARC) in Palo Alto,
California. While there, he saw the Alto, a prototype computer
that was unlike others at the time. Rather than a command-line
interface, where the user types in commands, the Alto had a
graphical user interface (GUI). Application elements were in
overlapping windows, all controlled with a pointing device. Jobs
loved this idea and decided that the next great Apple computer
should be operated via a graphical user interface. In 1983, Jobs’
vision of a personal computer with a GUI was born in Apple’s
next big failure, the Apple Lisa.

Failure #2: Lisa

The Lisa was revolutionary. It was the first personal computer
with a graphical user interface. Along with its GUI and mouse, it
had a built-in 12" monochrome monitor with a 720x360 resolu-
tion. It also had 1 MB RAM, two 5.25" floppy drives, and an
external 5 MB hard drive. The processor was a Motorola 68000
running at 5 megahertz. The Lisa also featured two serial ports, a parallel port, and a 16-bit bus. The whole thing was all one unit, and it weighed in at almost 50 pounds.

Apple targeted the Lisa at large businesses, but unfortunately, all of that technology wasn’t cheap. Pricing was set at $10,000 per unit, and potential buyers stayed away in droves. Jobs was very disappointed with the sales of the Lisa on both a business and personal level. Convinced that the GUI was the wave of the future, Jobs set out on the creation of a new personal computer. It was, of course, the Macintosh.

**Changes Are Brewing**

Present-day computers mainly differ in the type of operating system that they run. There are two major choices in personal computers: Unix and Windows. The Unix choices include Linux and Mac OS X. Computer architecture is either Intel or PowerPC. There aren’t many different options, and while that seems limiting, it’s actually a good thing because it helps standards move along and it makes business decisions regarding information technology a little easier. Today, you can choose a PC running either Windows or a Unix variant (or Unix-like OS, such as Linux), or you can choose a Macintosh.

In 1984, when the Macintosh debuted, there were many choices in the personal computer market. While today’s computer owners will talk about their Linux machines or Macs or Windows boxes, in 1984 people had Apples and IBMs, not to mention all kinds of other computers that no longer exist, like Commodore. In 1984, you could go to Computerworld or any other boutique computer store and buy a Commodore VIC-20, a Commodore 64, a Radio Shack TRS-80, an Atari ST, a Zenith Z-100, an IBM PC XT, or any of the computers running the CP/M OS on a Zilog Z-80, Motorola 68000, Intel 8088, or Synertek 6502. There were also machines running MS-DOS, of course, or any of the proprietary disk operating systems such as TRS-DOS. My brother had a 6502-based Commodore 64, which
had 64K of RAM. It was great for playing games, like most of the other computers available at the time. It even accepted the Atari controllers intended for the Atari 2600 video computer system. These computers had all kinds of disk interfaces. Some had hard disks in the 5 MB to 10 MB size range, but most had no hard disk at all, and the hard disk drives cost $1,500. Almost all of the computers had a 5.25" floppy drive, with the floppy disks storing up to 320K of data. Available RAM varied from 16K to 128K. The computers varied in prices from under $200 to well over $5,000. You could hook some computers, like the Commodores, to a TV set, or you could get a computer that had a dedicated monitor, such as the Radio Shack TRS-80.

Note:
In the early 1980s, many computers were really video game consoles with computer features. The perfect example of this is the Atari 800. Most kids had a Commodore 64 or Atari computer for the sole purpose of playing games. I didn’t know any kids who used spreadsheets or database management systems on their personal computers.

The Macintosh had to be different from all the computers available at the time, including its cousin, the Apple IIe. Jobs knew that the only way he could compete with IBM, which was hands-down the major player in personal computers, was to create something that was less expensive but a whole lot better. It wouldn’t necessarily have more memory or more power, but it would be more user-friendly and flexible and more than just a device that processed data. The Macintosh would compete with the IBM computers in the business market space by being more than an overblown calculator. It would be a computer for the creativity in all of us, a computer that tapped into our natural desires to do more than the minimum necessary to get the work done. This philosophy has been part of the Macintosh for its entire history, from 1984 to today. That’s part of what makes being a Mac user so much fun.
With lessons learned on the Lisa, Jobs took a whole new approach to creating this new computer. He was concerned about the corporate fat cats interfering with the innovations he envisioned in the Macintosh. He wanted to cultivate the eccentricities of software developers and nerdy types, who were the people buying the more expensive personal computers. Jobs tapped into the "garage days" spirit of the company and led a team of engineers to create the Macintosh over a five-year period, starting with his visit to Xerox PARC in 1979.

While the Macintosh was an Apple product, it was really Steve Jobs' baby (Woz left Apple in 1982 to pursue other interests). The development of the Macintosh couldn't have been more different from the development of the Apple II. Jobs was out to change the world with the Macintosh. He cultivated a design and development team of individuals who were as altruistic and fervent as he was. IBM computers were associated with skinny black ties and short-sleeved white shirts with starched collars. The Macintosh was blue jeans, a T-shirt, and sandals. It was created by people who wanted to change the world, for people who wanted to change the world. Revolutionaries. Cavaliers. People who could, and would, "think different." The Macintosh would tap into the counterculture. This was the vision Jobs sold to his developers and, ultimately, the buying public. It stuck.

The Macintosh Ships

The Macintosh team worked almost nonstop on the product for four years. The end product was a technological marvel. It had 128K of RAM, which was double what its competitors offered, and it was expandable to 192K. It also had a 400K 3.5" floppy drive (1.44 MB versions of the 3.5" floppy drive are still included with PCs today but not in Macintoshes). It had a 32-bit Motorola 68000 processor running at 8 megahertz; the Intel 8088 in the IBM PC XT, Macintosh's chief competitor, was only 16-bit running at 4.77 megahertz.
While it shipped with 128K of RAM, it had a 64K ROM that stored a large portion of code. It included functions that developers could hook into for their own applications, simplifying development of new software for the Macintosh. The functions provided capability for sound, displaying graphics, drawing text, and interacting with GUI elements, among other things. This meant that the developers wouldn't have to write all their own routines to provide this functionality. It was built-in, and it didn't use up valuable (and expensive) RAM.

The Macintosh came in a small case with a built-in 5" monitor that could display 512x342 resolution, and the whole thing weighed only 16.5 pounds. The IBM's, with their metal cases and heavy monitors, weighed considerably more. The Macintosh had two high-speed serial ports for connecting to printers and third-party devices, and it was cute, with a smooth faceplate interrupted only by the 3.5" floppy drive slot and the screen itself, rather than the IBM's clunky black floppy drive. Best of all, when you turned on the Macintosh, you were greeted with a smiley face and then a graphical user interface. It ran an all-new operating system, Mac OS, and the system included a mouse for you to move the pointer around to select windows and click buttons. Instead of typing in an eight-character command, applications were launched by double-clicking an icon. Navigating folders on a desktop browsed the file system, and you could have more than one view of the file system available at a time. This was in stark contrast to the command-line navigation of the file system on DOS-based computers. Amazingly, this was available for $2,495.

**Note:**

At the same time the Macintosh debuted, Apple released the Lisa 2. It was less expensive than the Lisa, included 512K of RAM and the same floppy drive as the Macintosh, and had an available 10 MB hard drive. Later, the Lisa 2 was renamed Macintosh XL and featured an emulator that allowed you to run Mac OS. It was discontinued in 1985, and the Lisa was officially dead.
All of the Macintosh engineers' hard work was realized with the debut of the Macintosh during the Super Bowl in January 1984. The very famous Super Bowl commercial was directed by Ridley Scott (who directed *Blade Runner* and would go on to direct the Oscar-winning film *Gladiator*) and featured an Orwellian future where a Big Brother figure instructs mindless drones from a huge video screen. A young woman athlete, pursued by gloomy soldiers, races past the drones and hurls a sledgehammer into the video screen, causing the reign of Big Brother to come to an end. The blast fades the commercial to white, and a calm speaker tells the viewer that 1984 will not be like 1984. This commercial is credited with starting the trend of big-budget, interesting commercials that air during the Super Bowl.

**Goodbye Jobs, Hello New Macs**

While the Macintosh was a brisk seller, it wasn't enough for Apple. Steve Jobs had begun to battle with John Sculley over business and the direction of Apple. In late 1985, the Apple board of directors took a vote and ousted Steve Jobs. He was fired from the very company he had started in his garage nine years earlier, and Sculley became the head of Apple.

**Fat Mac**

People rushed out to buy the Macintosh. By the end of 1984, however, Macintosh owners were starting to get tired of the performance of their Macintosh computers. While the Macintosh had more RAM than its competitors, the GUI demanded more of the memory than the simple command-line interfaces of the DOS-based machines.

Apple tried to meet this demand with the release of the Macintosh 512K, also known as Fat Mac, which was the same as the original Macintosh but with 512K of RAM instead of only 128K.
Mac Plus

The Fat Mac was a noble attempt at meeting demand for performance in the Macintosh, but the PC industry was changing so fast that consumers wanted more out of their Macs. Apple released the Mac Plus in 1986 to combat claims that the Mac was not expandable and was underpowered. The Mac Plus ended up being the defining computer in the Macintosh line for a lot of people, myself included (a Mac Plus was the very first Macintosh that I ever used). It increased the RAM to a full megabyte, expandable to 4 MB. The ROM was doubled to 128K. The Mac Plus was also the first Macintosh to include an industry-standard SCSI (Small Computer System Interface) port, which allowed the connection of all kinds of different peripherals. The Mac Plus was the first Macintosh to get away from the boring beige color, sporting instead a light gray that was found on all Macintosh computers (except for a few small exceptions) until the iMac debuted in 1997.

The Mac Plus was a venerable offering in the Macintosh line. It was available from January 1986 to late 1990. Like the Apple IIe, the Mac Plus was a huge hit in the education market, even though its price tag hovered around $2,600. Schools replaced their aging Apple IIe computers with the Mac Plus, completely overlooking the very last offering in the Apple II line, the Apple IIGS, which also debuted in 1986. Schools liked the Mac Plus because it supported all of the available Macintosh software, plus new software that came out for the Mac OS. True to the spirit of upgradeability and support of the education market, the Mac Plus supported every version of Mac OS from System 1.1 to System 7.5.5.

Apple Suffers, Then Bounces Back

Despite the success of the Macintosh and Apple IIe lines, Apple was experiencing difficulties. Apple wasn’t doing well financially in the months following Jobs’ firing and John Sculley’s rise to the
leadership position in the company. Apple posted its first quarterly loss and a reduction in workforce of 20 percent. Just over 1,200 employees lost their jobs.

To add to Apple’s pain, it was locked in a legal battle with Microsoft over the Macintosh GUI. Apple claimed that Microsoft stole the Mac OS GUI and put it in Windows 1.0. Microsoft countered that both Apple and Microsoft got the idea from Xerox PARC, so it was fair game. Eventually, Microsoft agreed to not use any Macintosh technology in Windows 1.0 (which is one reason why Windows 1.0 didn’t have overlapping windows).

Unfortunately for Apple, it didn’t have the wherewithal to make sure Microsoft didn’t use any Macintosh technology in subsequent versions of Windows.

It was the late 1980s, and Apple was in trouble. They hadn’t introduced anything revolutionary since the original Macintosh, and the PC market had opened up with the advent of clone makers, starting with Compaq. Apple didn’t just have IBM to worry about anymore; they had to worry about the hundreds of clone makers selling cheaper versions of the IBM PC and helping to ensure the proliferation of DOS and, later, Windows.

Apple pulled a rabbit out of their hat and saved themselves with the birth of desktop publishing. Even today, desktop publishing is a computing niche that Apple still lays claim to. In 1986, Apple released the LaserWriter, a somewhat affordable laser printer that could produce professional-quality documents. At the same time, Aldus Inc. released its PageMaker desktop publishing software for the Macintosh platform. These two products revitalized the Macintosh platform and ushered in a third revolution for Apple. It set the stage for the 1987 release of their next major computer, the Mac II.

**The Mac II**

Compared to its ancestors, the Mac II was a radical departure for the Macintosh line. First, it was not an all-in-one design. It followed the typical PC form of a desktop unit and a monitor that sat on top of it. It was amazingly fast. It featured the new
Motorola 68020 processor running at 16 megahertz, as well as a math coprocessor (also called a floating-point unit, or FPU). The maximum RAM was a staggering 20 MB, and the machine had 256K of ROM. Gone were the days of the 8-bit and 16-bit bus; the Mac II had a 32-bit bus running at 16 megahertz. Buyers could get one or two 800K 3.5" floppy drives, upgradeable to the 1.44 MB SuperDrive. Optional 40 MB and 80 MB hard drives were also available.

**Note:**

"SuperDrive" is a brand name that Apple used to describe their top-end input/output drives. It originally meant the 1.44 MB 3.5" floppy, and it came to be the DVD-R/DVD-ROM/CD/CD-R/CD-RW drive available in current Macintosh computers.

The most exciting feature of the new Mac II, and its biggest selling point, was its support of color monitors. By adding a graphics card to the Mac II via its NuBus expansion slots, you could get 640x480 resolution with up to 16 million colors. This was a huge deal for the fledgling desktop publishing industry because it allowed users to design with color and output color.

Over the years of the Mac II's life, it was available in several versions, including the IIx, IICx, IICi, IIFx, IIIsi, IIvx (the first Macintosh with a case designed to hold a CD-ROM drive), and IIvi. The IIFx and IIIsi were very powerful and sold for as much as $10,000. Apple was selling 50,000 Mac II computers each month. Apple also released several other lines of Macintosh computers in the late 1980s and early 1990s, including the powerful Mac SE/30, the Mac LC line (which was popular in schools), the Mac Quadra line (which replaced the Mac II line), various "Classic" computers that revived the all-in-one design, the Centris, and the supremely popular PowerBook in all its incarnations.

During the late 1980s, the PC began to emerge as the dominant force in the personal computer realm. It really came down to two choices — a Macintosh or a PC clone running a Microsoft
operating system (the workstation market was still populated by megabuck systems from the likes of Sun and SGI running proprietary Unix operating systems). The Commodore-Amiga, Atari ST, and all the others had pretty much bitten the dust or languished in obscurity. In 1990, Microsoft released Windows 3.0, which brought the GUI to the non-Macintosh masses. Windows ran on top of DOS, which was on just about every PC out there. Users could buy Windows 3.0 and run GUI applications just like a Macintosh user could run a GUI application, but at a much cheaper price. Apple needed to find an edge to keep their customer base.

**Failure #3: Mac TV**

In late 1993, Apple had another experience with total failure when it released the Mac TV. It was black, which was quite different at the time, and it came in the same case as one of the LC computers. It had a cable TV tuner card and a CD-ROM drive. It was Apple’s attempt to enter the emerging “multimedia” market, but it sold very poorly. Only 10,000 units shipped before it was terminated in early 1994.

Apple considered licensing the Mac OS to other computer makers and even thought about moving to Intel architecture, but these plans were nixed. Instead, Apple trudged forward and released the PowerBook line of notebook computers, which sold very well. It was enough to give Apple the money to perform research and development on their personal digital assistant, the Newton. In 1993, Apple released the ground-breaking Newton PDA, but it didn’t sell very well because of its abysmal handwriting recognition. The handwriting recognition was so terrible that the Newton was lampooned in an episode of *The Simpsons* where a character’s input of “Beat up Martin” is translated by the Newton to “Eat up Martha.” But despite the problems, Apple wasn’t ready to call the Newton a failure yet because the PDA market was still so new.
Apple faced yet another leadership change in 1993 when Sculley stepped down from the position of CEO and Michael Spindler took the hot seat. Spindler’s placement as CEO was important to Apple’s future; he brought Apple out of the doldrums with the release of the first Power Macs in 1994. At the same time, he made a decision that, depending on who you ask, ranks as one of Apple’s worst.

**Sweet Success and Painful Failure**

Apple, Motorola, and IBM had joined forces to develop a new processor to power next-generation computer systems. The new alliance was called the PowerPC consortium, and the processor was called the PowerPC. The goal was to infuse workstation-class performance into personal computers. Apple had been using the Motorola 680x0 line of processors, which are based on the CISC (Complex Instruction Set Computer) architecture. The PowerPC processor was based on a RISC (Reduced Instruction Set Computer) architecture, which meant that a RISC processor had to do less work per cycle than a CISC processor, making it more powerful.

Apple was the primary PowerPC customer. It bet the farm on the PowerPC processor, and the Power Mac family of Macintosh computers was born. The very first offering in the new line of Power Mac computers was the Power Mac 6100. It used the first PowerPC processor, the PowerPC 601 running at 60 or 66 megahertz. Its other specifications were similar to Windows-based PCs of the days, including PCI slots, 16-bit stereo output, a 2X CD-ROM, 8 MB RAM, and a 500 MB hard drive. The Power Mac 6100 was also available with an add-in “DOS card,” a card with an Intel 486DX2/66 processor for running DOS and Windows applications. Apple went whole-hog with the PowerPC processor and released no fewer than 20 different Power Macs between 1994 and 1997. The PowerPC processor is still used in all Macintosh computers to this day.
Failure #4: Licensing Mac OS

Riding the wave of euphoria from the release of the Power Mac line, Apple decided to try to increase their profits by taking a drastic step — licensing the Mac OS to third-party computer manufacturers. The biggest licensee was Power Computing, which started selling lower-cost Macintosh clones. This struck a fear in Apple, as it appeared that Power Computing was eating into Apple's sales.

But sales were the least of Apple's problems. They couldn't produce computers fast enough to meet the demand. At one point, Apple had close to $1 billion in backorders. Apple also lost touch with their customers and pushed low-end Performa computers instead of the more powerful machines. Power Computing picked up Apple's slack and met the demand for power-hungry users, but Power Computing also had its own problems.

The pot boiled over when Apple posted a $70 million loss for the fourth quarter of 1995. The following month, January 1996, Apple showed Michael Spindler the door and Gil Amelio, former president of National Semiconductor, took the reins. In the end, Spindler's tenure at Apple had only one up and a plethora of downs.

Gil Amelio had a tough time at Apple. In the first quarter of 1996, Apple posted a loss of $740 million. Amelio tried to get Apple back in the black by changing the structure of the company, and unfortunately, some people lost their jobs because of it. On the product front, Apple announced more additions to the Power Mac line, as well as a few servers and a new PowerBook, but nothing truly new or groundbreaking. The second quarter showed a loss of $33 million, but by the end of the third quarter, Apple had managed to gain a profit of $29 million. The Newton, which was still trudging along despite the crushing competition from Palm, was spun off into a separate company.

In July 1997, Gil Amelio was released from his position. While his short tenure at Apple is marked with lackluster financial performance and uninteresting product releases, he was part
of something that changed Apple forever and put the company where it is today.

Evolution of Mac OS X

After Steve Jobs was ousted from Apple, he spent some time clearing his head. He had been working nonstop for almost ten years to get Apple where it was. What was the next step for him? Even though he was still technically chairman of Apple, he no longer made any contributions to the company; he was a figurehead at best and a has-been at worst.

Jobs had always felt that his best contributions at Apple had been in developing new products, such as the Macintosh. He liked changing the world, and he had definitely done that working for Apple. Jobs searched within himself for inspiration and innovation. He looked toward the area where he had the most expertise with selling computers: education.

NeXT Is Born

In early September of 1985, Jobs traveled to Stanford University and had lunch with a noted biochemist. During their conversation, the biochemist told Jobs of the scientific difficulty of extracting DNA in experiments. This gave Jobs an idea. What if scientists could use computers to simulate the experiments? Even better, what if a computer was produced and sold to the higher education market, like universities and teaching hospitals? This wasn’t the Macintosh’s intended market; this market was completely untapped.

About a week after the meeting with the Stanford biochemist, Steve Jobs approached the Apple board of directors and informed them of his decision to start a new company that would produce hardware and software for the higher education market. He would thus be resigning from the position of Apple Computer’s chairman and dedicating himself to his new company. He
told the Apple board that the new company wouldn’t compete with Apple, and as a condition of his departure, he would take a handful of employees with him.

The Apple board agreed with Jobs, and a couple of days later, Jobs dropped a bombshell. The Apple employees he was taking with him were five of the top people in the company, including engineers who worked on the Macintosh and personnel from marketing and sales. Among them, they knew almost everything there was to know about Apple’s business practices and plans for the future. The board freaked out, to say the least, but they couldn’t stop Jobs, and in the long run, they felt they were better off without him.

Note:

Somewhere between the time Jobs left Apple in 1985 and started NeXT in 1987, he found the time to create another company that wasn’t in the software business. It was called Pixar, and you may have seen a couple of their products lately, like the films Toy Story, A Bug’s Life, and Monsters Inc.

Jobs and his new employees took off from Apple HQ in Cupertino and started a company called NeXT Inc. Jobs’ idea was that NeXT would create a computer that would offer superb performance and sophisticated capabilities but be inexpensive enough for universities and scientists to be able to afford it. At the time, researchers were still predominantly using expensive timesharing systems. A good workstation could easily cost over $20,000. Jobs hoped NeXT could tap into this market by producing a computer that was capable of doing what the science-type guys wanted it to without the enormous expense and lack of control in a distributed timeshare system. It also, of course, had to be easier to use.

The NeXT computer would run the Unix operating system, mainly because that’s what the scientists were currently using and it was a stable, reliable, and powerful platform. Unix is a multitasking operating system designed to handle several
applications at once. For example, a graduate student working on his doctorate in physics could run a particle simulator application, a graphing application, and an application to output the results to a plotter all at the same time. This kind of power was not available on Mac OS, MS-DOS, or Windows.

Unix, though, has been a command-line system since its inception in 1970. Workstation and server vendors whose equipment ran Unix all had their own version of the operating system. AT&T owned Unix and licensed it to these vendors, and they would add their own features and drivers to make their Unix “flavor” work on their systems. Some AT&T Unix flavors include SGI Irix and Digital Equipment Corporation Ultrix.

Note:
In an interesting twist, Apple also had a flavor of Unix. It was called A/UX.

Jobs knew Unix was just one part of the NeXT success equation. The NeXT computer would need an intuitive, attractive GUI on top of its Unix core. This operating system, called NeXTStep, was based on a distribution of Unix that wasn’t owned by AT&T called Berkeley Standard Distribution (BSD) version 4.3. The NeXTStep operating system consisted of three layers. The bottom layer was the Mach kernel, which was the heart of the operating system. The BSD core sat on top of the Mach kernel, and the NeXTStep GUI, called Workspace Manager, sat on top of BSD.

Mach was developed at Carnegie Mellon University to act as a small, lightweight operating system layer. At only 1 MB in size, the Mach layer contained the low-level capabilities of the NeXTStep operating system, such as memory allocation, multitasking, multithreading, and BSD compatibility.

In 1976, AT&T shipped version 6 of Unix, and the University of California at Berkeley purchased a license for the Unix source. Computer science students at Berkeley began to pore over the
source and made several enhancements to it. Eventually, BSD became its own version of Unix and split away from AT&T; the source to BSD was released to the public domain. Major Unix vendors such as Sun and Hewlett-Packard released their own flavors of Unix based on BSD (SunOS and HP/UX, respectively). The BSD layer provided the operating system services to applications and user interaction.

**NeXTStep Comes Together**

The top layer of the NeXTStep operating system was, of course, Workspace Manager. At the time, other Unix flavors ran the X Window System for GUI functionality. X Window worked, but Motif, the main window manager (the program that draws stuff like the window borders, scroll bars, and so on), wasn’t very attractive, extensible, or easy to develop for. Jobs decided to create an all-new window manager for NeXT, and Workspace Manager was born. The NeXTStep GUI used a technology called Display PostScript (DPS). DPS let the computer use the same system for drawing on the screen as printers used for drawing on paper. This let designers and desktop publishers get a 100 percent accurate representation of their work on the monitor. It also made everything more attractive.

The second part of the NeXT equation was the development environment. Jobs bought into the object-oriented concepts that software should be constructed from reusable parts. Programming for Macintosh and Windows required complicated functions. Changing the text on a command button, for example, was quite a chore. The NeXTStep overcame this problem by including an object-oriented framework for building applications and an all-new language for programming the NeXTStep, called Objective-C. The NeXTStep framework was made up of objects, which could be pieced together to build powerful software in much less time than on Windows or Macintosh (or even other Unix flavors). Developers could use drag-and-drop technology to design applications, rather than writing all the code by hand. This
drastically reduced development time and costs, and we still use that technology today.

The third part of the NeXT equation was the hardware itself. The very first NeXT machine was the NeXT Cube. It was a beautiful, black magnesium cube that was very heavy and very expensive to produce. It featured a Motorola 68030 running at 33 megahertz, which was one of the fastest processors that you could get in a personal computer at the time. It was faster than the fastest Macintosh and Windows machines of that year. The Cube also had an optical drive (kind of a precursor to CD-ROM and DVD-ROM) that was then quite futuristic. To show off the technology, every Cube included a copy of the complete works of Shakespeare on optical disc.

The NeXT Computers Ship, But with Problems

With the NeXT Cube running the NeXTStep operating system, Jobs planned for a 1987 release. The problems started almost immediately after its introduction. First, NeXT shipped the Cube a year late, in 1988. (Jobs' response to criticism over the delay: "Late? This computer's five years ahead of its time.") Second, it cost $6,000, which was roughly twice the cost of a Macintosh. Third, while it had an awesome operating system and development environment, there was no software available. The reports are that Jobs alienated third-party developers with his bravado.

The problems with the NeXT systems became more and more apparent. The optical drive, which stored up to 256 MB of data on each disc, was noisy, slow, and unreliable. NeXT had designed the systems to use all proprietary hardware; it was impossible to use any peripheral that didn't come from NeXT, including mouse, monitor, keyboard, and, shockingly, printer.

Regardless of these limitations, Jobs pushed forward with his new company. NeXT was able to sell many of its workstations, including the Cube and Slab, a new desktop with a monochrome display. Customers loved the NeXTStep operating system and the very fast development time. Big businesses were buying the
NeXT machines to help them roll out their new internal software. Rumor has it that the CIA bought a lot of NeXT machines and still uses them.

Customers indeed loved the NeXTStep operating system, but they loathed the hardware because it was expensive to maintain, proprietary, and unreliable. Jobs had built a facility capable of outputting 150,000 NeXT machines per year; NeXT only sold 50,000 total. By all accounts, NeXT was a failure.

There are, however, a couple of interesting success stories that are part of the NeXT saga. Around 1989, a man named Tim Berners-Lee was working on an academic project that would bring a technology called “hypertext” to the Internet. The idea was for academics to be able to link their documents to each other on a system that spread throughout academia via the worldwide network. He decided to use a NeXT computer to build this system because the NeXTStep offered an intuitive environment for building software, and other systems at the time didn’t have what he felt he needed to get his project done. Eventually, he finished development of this project on his NeXT machine, and the World Wide Web was born.

On the other side of the world, a company called Sybase was creating a relational database system. Sybase chose the NeXT platform for the same reasons as Tim Berners-Lee and countless other developers: It was easier. In a strange twist of fate, the Sybase product, called SQL Server, would eventually be shared with Microsoft and become Microsoft’s enterprise database system for Windows.

Despite these successes, NeXT was losing cash. They decided to abandon hardware and changed their name to NeXT Software Inc., with the sole intent of selling the NeXTStep operating system for other platforms. NeXT changed the name of NeXTStep to OpenStep and had success with porting OpenStep to Intel x86, Sun, and Hewlett-Packard. Ultimately, though, NeXT Software couldn’t stay afloat and folded in 1993. Jobs’ company was a failure.

While NeXT was trying to do its thing, Apple was in trouble. Mac OS was getting long in the tooth, and Apple needed a new
operating system for their Power Mac hardware. Windows NT was out for the PC, and Apple couldn’t compete with it. Like Unix, Windows NT was multitasking and multithreaded, meaning it could run several applications at once and they wouldn’t interfere with each other.

Apple, IBM, and Novell joined forces to create a company called Taligent, with the idea of creating a new operating system. It failed. Apple spent $1 billion on a new version of Mac OS called Copland, and they never got it to work. By 1996, Apple was desperate, and Gil Amelio shopped around for a Mac OS replacement. Apple looked at Be, whose BeOS product was a technological and aesthetic marvel, but Apple and Be couldn’t come to an agreement.

**Jobs Comes Home**

In a move that shocked the world, Apple acquired NeXT in December 1996. It was the best thing Gil Amelio did for Apple. The price tag for NeXT was $400 million, which was an incredible amount of money for a software company that wasn’t selling any software. The most shocking thing of all, however, was that Amelio got Steve Jobs as part of the deal. He would come on as a consultant, helping Apple create an operating system from the NeXTStep code.

When Amelio was ousted shortly after the NeXT acquisition, Jobs stepped in as interim CEO. He was back in control of the company he had founded 20 years prior. In January 1997, he announced that Apple was working on the next generation of Mac OS, called Rhapsody. It would be based on OpenStep, available in 1999, and would work on all Mac computers produced from 1997 on. When Jobs took over Apple, he instituted sweeping changes. He killed off the Newton entirely. He eliminated support of Apple’s legacy computers. He introduced System 8, which he promised would be the interim solution between the old Mac OS and Rhapsody. He also revoked Mac OS licensing and bought out Power Computing. One of the biggest shockers
was Jobs' announcement that Microsoft would invest $150 million in Apple and bring Office to the Macintosh by 1998. Apple’s stock price soared.

**iMac**

It did not stop there. In 1998, Jobs introduced the iMac, which became one of the best-selling computers of all time. Jobs also introduced a new line of PowerPC G3-based computers, which blew away PC competition in performance. Unfortunately, Jobs' return didn’t prevent the company from releasing a few failures. In 1997, Apple released the Twentieth Anniversary Macintosh, which was an awesome-looking machine and a good performer. Its downfall was its price: $10,000. Then, in 2000, Jobs introduced the G4 Cube. It was another beautiful design, but it had problems: a clear plastic case that cracked easily and a lack of upgradeability at the $1,700 price point. Apple took a bath on the G4 Cube but bounced back as they always have (and hopefully, always will).

Back on the Rhapsody front, things weren’t progressing as quickly as Apple and Jobs would have liked. Apple engineers had no problems getting OpenStep to run on a Macintosh, but getting it to work on Apple’s entire product line was impossible. Rhapsody was delayed again and again, and Mac users got irritated. Finally, Jobs announced a change in Apple’s plans. Mac OS 8 and Rhapsody would be merged into one operating system, called Mac OS X (by the time it actually happened, OS 9 had already been released).

**Mac OS X Rears Its Head**

In 2000, the first Mac OS X preview was made available to the general public. By 2001, the final version of Mac OS X, version 10.0, was shipped. Jobs' promise of an operating system that would take the Macintosh into the future while maintaining compatibility with older Mac OS software was realized. Mac OS X
had a rocky start, but Apple worked diligently on stabilizing the operating system and released regular patches. With the release of Mac OS X 10.2 “Jaguar” in August 2001, Apple had accomplished its goal of a stable, reliable operating system that would serve as a good replacement for the venerable Mac OS.

Now, Mac OS X ships by default on all new Macintosh machines. You probably have it on yours, unless you bought an older machine. Mac OS X retains a lot of the features of OpenStep, such as the rich programming environment and free development tools. Mac OS X is based on the Mach kernel and the BSD Unix, with a display system on top that uses a new technology called Quartz instead of Display PostScript.

Mac OS X is the operating system that Mac users had been waiting for. Gone are the days of memory problems, freezes, consistent crashing, single tasking, insecurity, and all the other gripes about Mac OS.

**Summary**

I’ve always loved history; I’ve found that I understand the hows when I better understand the whys. The goal of this chapter was to educate you on the history of the Macintosh and the company that made it. I think that it will make you appreciate your Macintosh a little bit more, and it will also help you understand it a little better when things go wrong. Before long, you’ll be subscribing to *MacAddict* and hanging out at your local Apple Store talking about Apple’s latest news.

My friend Fred bought a PowerBook that day. We don’t talk on the phone anymore; he demands we communicate via iChat.
Rick and I met up at Fry's Electronics one Saturday afternoon. I was shopping for an 802.11b access point for the Internet appliance in my kitchen, and Rick was looking for a Bluetooth adapter to go along with his new cell phone. I casually mentioned to Rick that Mac OS X had Bluetooth support (I'm always the evangelist), and the new Macs all had Bluetooth hardware built in as an option. He was surprised.

"What do you do if you don't have a new Macintosh and you want to use Bluetooth?" he asked. "Do you need some kind of proprietary connector?" No, I said, because the Macintosh has USB support as well as all kinds of other industry-standard peripheral connectors. In fact, Apple sells the D-Link DBT-120 Bluetooth adapter at the Apple Store, which is the same Bluetooth adapter that Rick bought that day.

This conversation got me thinking. What other Macintosh misconceptions were out there that people who didn't use the platform perpetuate? I decided to do further research and I asked my friend Steve, who is a hard-core PC user and hardware engineer, what he disliked about the Macintosh. He was always teasing me about my "Crapple" and "Macintoy." I figured his embracing of antiquated euphemisms was evidence enough that he would embrace the Macintosh myths, and his vigorous attacks on the Macintosh platform would ensure I got the most out of him.
I invited Steve to his favorite watering hole in downtown Dallas to discuss the Macintosh myths. Here are my favorites, presented for your consideration.

**Software Support Is Minimal at Best**

Steve: Macs don’t have nearly as much software as Windows.

The facts: People perpetuate this myth because if they don’t see Macintosh software in stores, it doesn’t exist. Windows users perpetuate this myth much more than Linux users (in fact, this myth applies to Linux as well). The truth is, there is a Macintosh equivalent for just about every PC software program out there. Microsoft makes Internet Explorer and Office for both the Macintosh and PC. Adobe makes Photoshop and a myriad of other applications for both platforms. There’s also America Online, MSN, and Quicken.

There is usually a Macintosh alternative for software that exists on PC but not on the Macintosh (for example, Microsoft Access for Windows; Macintosh users would use FileMaker or MySQL). Sometimes it’s free (like MySQL). A search at VersionTracker should turn up what you need. For example, when I switched to the Macintosh, I needed a UML software modeling application similar to Microsoft Visio. I found it in OmniGroup’s OmniGraffle, which is included with Power Macintosh tower systems.

To be fair, there is an exception that I should mention. Many “vertical market” applications are Windows-exclusive. These applications are written for specific market segments, like managing flight logs, tracking real estate data, or controlling industrial equipment. But if you need to use a Windows-specific application on your Mac, you can usually run it with VirtualPC.
Ten Macintosh Myths Debunked

The Macintosh Is Incompatible with PCs

Steve: Macs don’t work with PCs. They can’t read PC disks and CD-ROMs. Everything about the Macintosh file system is proprietary and inhospitable to PC files, unless it’s a text document.

The facts: This is kind of a broad myth that can be argued for hours. It depends on what you mean by compatible. If you mean that Macs can’t run Windows software natively, then yes, they’re not compatible, just like a diesel engine isn’t compatible with gasoline. There’s no arguing about that. What this myth pertains to is the assertion that Macs and PCs can’t communicate with each other and, further, can’t share files. This is ridiculous.

The truth is, Mac OS X was designed with Windows compatibility in mind. This means that files created and saved in Windows will work in Mac OS X, and vice versa.

Note:

This is application-specific of course because some vendors may decide that the Macintosh version of a piece of software can’t read the Windows version file format, but it’s not because Mac OS X doesn’t support it. I personally haven’t encountered this, but I can’t say that it doesn’t exist.

In the old days of Mac OS, you couldn’t share disks between Macs and PCs without special software. This isn’t the case anymore, especially with CD-ROMs being the prevalent medium (and Macs don’t have floppy drives). If you copy files to a CD on a Macintosh, that CD will work on Windows. It works the other way also. External hard drives can usually be shared. In fact, I kept the manuscript for this book on my USB keychain hard drive so I could get to my files on my Mac and PC.

As far as communication, Macs use TCP/IP on Ethernet, same as Windows. Macs don’t just use AppleTalk like they used to in the stone age of computing. Mac OS X TCP/IP is based on the venerable BSD TCP/IP stack, which is the granddaddy of
TCP/IP support. You can very easily attach a Macintosh running Mac OS X to a Windows network. The Macintosh can see Windows machines, and vice versa.

**Macs Are Not Upgradeable**

**Steve:** You can't upgrade a Macintosh with more RAM or a bigger hard drive (at least not without sending it to Apple). You also can't add any expansion cards, and what expansion cards may exist are proprietary to Apple.

**The facts:** People believe that the Macintosh is not upgradeable because back in the old days, the all-in-one Macs didn't take "normal" RAM; they required a special kind of RAM from Apple. You also couldn't open the case and change the components inside like you could with PCs.

Now, the iMac and the eMac have the same basic all-in-one design, so you can't upgrade the monitor or the video card. You can, however, upgrade the hard drive and RAM. This all-in-one design is the selling point of the iMac and eMac; it's for people who don't tinker with their computers. The all-in-ones have never been known for their simple upgradeability, but Apple hasn't exclusively been making iMacs all these years. The Power Mac tower is fully upgradeable. It offers many PCI slots for expansion. Want USB 2.0? Add a USB 2.0 PCI card. Want a new 3D video card? Slide it in. It's simple to open the case. Just unlatch it and hinge the side of the case down. The hard drive is upgradeable too (it's IDE), as is the RAM, and even the processor can be switched out with a new, faster one (depending on your model). The Power Mac also has expansion bays for adding new devices like an extra CD-ROM drive or a SuperDrive.
The Macintosh Is Proprietary

Steve: The Macintosh is a proprietary platform. It only accepts Apple components, and it doesn’t use PC parts. Networking is only done through AppleTalk; it doesn’t use Ethernet or TCP/IP.

The facts: Until the late 1990s, nearly every Macintosh had an industry-standard Small Computer System Interface (SCSI) port for expansion. They’ve had SCSI since way back near the Macintosh’s inception (the Mac Plus was the first Macintosh with SCSI). Back then, most PCs didn’t have SCSI, and the ones that did were very expensive. Macintosh computers have always had networking jacks built in also, but the early Macintoshes did use the proprietary LocalTalk and AppleTalk protocols. That is probably where this myth started, but that’s not the way it is now.

Macintosh computers use industry standard technology like 802.11 for wireless networking, Bluetooth for wireless connection to devices such as cell phones, USB 2.0 and FireWire for connecting devices like printers and iPods, CD-ROM and DVD-ROM, Ethernet for connecting to networks, VGA and DVI video standards, PCI-X for adding high-speed expansion such as a faster video card, and a whole lot of other acronyms that are important to people who care about having a nonproprietary computer.

Macs Are Too Expensive

Steve: A Macintosh can easily cost three times as much as a comparable PC that I can build. Macs are overpriced because Apple has a monopoly on them.

The facts: This myth is a matter of perspective, and it has been argued to death all over the Internet. If you build your own PC, it will most likely cost less than a Macintosh. However, if you buy a similarly equipped Dell or Hewlett-Packard, its price will be
more in line with a Macintosh. You will be hard-pressed to build a
machine in the class of the Power Mac G5 for less than $2,000.

More importantly, the Macintosh includes tons of useful soft­
ware that you don’t have to go out and buy. You get Safari for web
browsing, iChat AV for instant messaging with audio and video,
iMovie for editing digital movies, iPhoto for managing your digi­
tal photographs, and iTunes for playing digital music and making
audio CDs. Depending on what model you buy, you get lots of
other free software. Consumer Macintosh systems like the iMac
come with games (including Tony Hawk’s Pro Skater 4),
Quicken, Sound Studio (an audio editor), and AppleWorks. Pro­
fessional machines, like the Power Mac G5, include OmniGraffle
(a modeling tool), OmniOutliner (for managing projects), Graphic
Converter (for working with image files), QuickBooks, and Art
Director’s Toolkit.

You have to look at the whole picture to find your value.
Apple offers machines chock-full of goodies, like SuperDrives
and widescreen monitors. They don’t offer commodity machines;
their target consumer is someone who wants more than just a
computer. The iBook is a stellar deal for a small portable, and
Apple also offers a sub-$1,000 desktop, the eMac.

Macs Are Only for Graphic Artists and Schools

Steve: The Macintosh is a niche computer for a niche market.
Only graphics types and students use it. This is because it’s not
powerful enough for real computing.

The facts: This one goes way back. Apple sold a large number
of Macintosh computers to schools, and that became a big part of
their market. They also sold many machines to graphic artists
and desktop publishers, so since the 1980s, people have thought
the Macintosh was a niche machine for students and artists and
nobody else could benefit from the platform.

The funny thing is that this myth has shades of truth. Apple
still targets graphic artists and schools; who wouldn’t market to
their most loyal customers? The Macintosh will never shed its appeal to graphic artists because it is a platform for creativity. Artists, animators, illustrators, designers, writers, and all kinds of other creative types love the Macintosh, and Apple embraces them. Of course, the Macintosh’s legendary ease of use is very attractive to schools.

A Macintosh is useful for all kinds of other computing tasks, from managing a business to writing books and developing biomedical technology. The Macintosh is very popular with scientists and academic researchers who love its Unix stability and Aqua user interface (they love the Macintosh for many of the same reasons they loved NeXT computers). The Macintosh is also popular in the law profession, which is a bit of a surprise since that segment is so resistant to change. Don’t forget that the Macintosh is also available as a server.

Mac OS X Is a Closed System

Steve: Mac OS X is a closed operating system. You can’t look at the source and modify it, and it doesn’t offer support for open-source applications.

The facts: Mac OS X is based on Darwin, which is an open-source operating system. Aqua and Quartz aren’t open-source, but that doesn’t make the whole operating system closed. Mac OS X is not as open as Linux, but it’s a heck of a lot more open than Windows.

Mac OS X lets you run an X server (like XFree86) on top of Darwin, so you could run GNOME or KDE and bypass almost all of the proprietary parts of Mac OS X (like Aqua and Quartz). You could run all kinds of Linux software that has been ported to Mac OS X. I’d say that’s pretty open. Panther includes an X11 implementation so you can run your X Window System applications alongside your Mac OS X applications.
Mac OS X Development Is Inefficient and Difficult

Steve: I heard that software development on a Macintosh is really difficult, and the way the operating system is designed makes for inefficient and slow code. That’s probably why there’s not very much software available for the Macintosh.

The facts: I don’t know about older Mac OS versions, but development on Mac OS X is a breeze. The Cocoa framework gives developers plenty of shortcuts into the innards of Mac OS X, allowing them to focus on their core business logic instead of figuring out how to draw windows. It’s not that much different than the .NET Framework for Windows or the Java Software Development Kit.

Inefficient development is caused by limitations of the operating system and the programming language being used. Because the Cocoa framework shields Mac OS X developers from having to write code to do basic things like accept rich text and scroll windows, developers can focus on writing the code that matters. I’m not saying this is unique to Mac OS X; it’s not. Most modern graphical operating systems offer some kind of framework for building applications. Windows, for example, has the Win32 API and the .NET Framework. There are also other frameworks for building graphical applications, such as Microsoft Foundation Classes (MFC) for Windows applications and Qt and GTK+ for Linux applications. These are just a few examples.

Apple also gives away professional developer tools with every copy of Mac OS X. Panther includes Xcode, the new integrated development environment for building Mac OS X applications.

Mac OS X fully supports Java, and its JVM is very fast. James Gosling, the father of Java, uses a Macintosh running Mac OS X for his Java development work. You have to figure that if the guy who invented Java uses a Mac for Java work, the Mac is a viable platform for Java development.
Ten Macintosh Myths Debunked

Mac OS X Is Not Secure

Steve: Mac OS X is not a secure operating system.

The facts: Mac OS 9 wasn't the bastion of security; it wasn't even multi-user. But Mac OS X is another story. It's based on the tried-and-true BSD. BSD is based on Unix, and Unix is about the most secure operating system you can get on consumer-level hardware.

First of all, Mac OS X ships with all the dangerous stuff, like Telnet, turned off. You have to explicitly activate the services that could pose a security risk; this is to ensure that the system is as secure as possible out of the box. You have to turn on file sharing, web sharing, PHP, and remote login (via ssh) before you can use them. The Sharing preference window is where you control these services (except PHP, which must be activated via a configuration file).

Secondly, Mac OS X is not as susceptible to viruses. In fact, at the time of publication, there have been no virus outbreaks on Mac OS X, while Windows has endured countless virus epidemics. Remember ILOVEYOU and Melissa? My wife lost every photograph she had saved on our PC thanks to the ILOVEYOU virus. One of the reasons viruses like these don't work on the Macintosh is because the Macintosh scripting engine, AppleScript, is much more secure than the Windows Script Host on Windows platforms. Windows viruses have shut down entire companies for several weeks at a time, costing millions — and sometimes billions — of dollars in lost productivity. Meanwhile, Macintosh shops chug along unaffected, just like their Unix and Linux brethren.

Thirdly, Mac OS X users don't have administrator access by default. If you want to install something on your Macintosh, you have to have permissions and a password. So if you stay logged in all the time at home, only you (and whoever knows your password) can install new software applications. It works the same way at the command line; you have to use the sudo command to
get the privileges to do potentially damaging things to your system.

Lastly, AirPort, the wireless networking piece of Mac OS X, features 128-bit encryption. You won’t have to worry about someone with a wireless LAN card intercepting your network transmissions or piggybacking on your Internet connection.

**Macs Can’t Play Games**

Steve: Macintosh hardware can’t play games. The Macintosh video system isn’t capable of supporting today’s 3D games, and what games do exist for the Macintosh are just ports of old games that nobody plays anymore.

The facts: Let’s look at these one at a time. First, the Macintosh hardware is very capable of supporting today’s 3D games and 3D games that come out in the future. All Macintosh computers support OpenGL, the most popular 3D application programming interface (API). At the time of publication, the top-of-the-line Power Mac G5 supports AGP 8X and is available with a choice of three video cards (be forewarned: This information is pretty technical):

- **ATI Radeon 9800 Pro** — This is currently the fastest and most visually advanced video card available. The Radeon 9800 features a 256-bit memory interface and 128 MB of video SDRAM. It features a 128 MB frame buffer for supporting large textures. It can render 350 million triangles per second. This monster has a 21 Gbps memory bandwidth. That’s fast.

- **ATI Radeon 9600 Pro** — This card has the same basic architecture as the more powerful Radeon 9800 Pro, but offers a 128-bit memory interface and 64 MB of video SDRAM. It has 64 MB frame buffer memory for textures and it can render 185 million triangles per second. Its memory bandwidth is 9.6 Gbps.
• NVIDIA GeForce FX 5200 Ultra — The GeForce line of video cards has been popular with gamers for quite a while, and this entry is no slouch. It features a 128-bit memory interface, like the Radeon cards, and 64 MB of video SDRAM. The 64 MB frame buffer memory and 8.8 Gbps memory bandwidth enable this card to render 75 million triangles per second.

Suffice it to say that a single processor 1.6 GHz Power Mac G5 with the ATI Radeon 9800 Pro is a powerhouse for playing the latest 3D games. As I write this chapter, Doom 3 isn’t out yet (and it may still not be out by the time you read this), but all three available video cards should be able to run Doom 3 at a high resolution and detail set to high. Then again, Doom 3 may not come out for Macintosh at all, which leads me to the second part of my answer.

The Macintosh is not as much of a gaming platform as the PC. That’s not to say it’s not a gaming platform at all; it’s just that the Macintosh currently offers about 125 of the current top 200 games. As Mac OS X gains market share among Mac OS 9 users and new Macintosh owners, this will change. The Macintosh gaming market has already seen the releases of Warcraft III, Medal of Honor: Allied Assault, EverQuest, Unreal Tournament 2003, and The Sims.

One criticism of Macintosh gaming that I can’t argue with is that the Macintosh is often a “porting platform” for game developers. They release the PC version first, and the Macintosh version comes out later (case in point: Tony Hawk 3). This isn’t true for every developer (Blizzard, for example, works on Macintosh and PC versions of their games at the same time). There is one notable exception, though; Quake was released for Mac OS first.

People generally don’t buy Macintoshes because they want to play games. You can play a lot of great games on your Macintosh (and it’s really subjective; I found there are more and better puzzle games for Mac OS X than Windows XP). If you have a Power Mac G4, you can upgrade the video card as new
games demand, and you can push your total RAM pretty high (the Power Mac G5 supports up to 8 GB of RAM). If you have an iMac, eMac, PowerBook, or iBook, your gaming options are a little more limited. The iMac comes with the NVIDIA GeForce4 MX with 64 MB DDR SDRAM, so it will handle most games with aplomb. The eMac features the ATI Radeon 7500 card with 32 MB DDR SDRAM, so it can handle most games. Portable computers, whether Macintosh or PC, have never been good at playing games. But you probably already knew that.

Summary

“Well, I guess I didn’t know as much about the Macintosh as I thought,” Steve conceded. “Mac OS X sounds kind of cool, but I can’t give up my Windows software and games.” I told him that it was fine. Not everyone has to switch to the Macintosh. Life is about choices, and making the choices that are right for you is part of the joy of living.
Elley is a PC user who has no desire to switch to Macintosh; she even has a disdain for Mac OS X. She’s referred to both the Macintosh and Mac OS X in a few unprintable ways. Of course, none of that stops her from using my iMac to check her email or keep tabs on the results of her eBay auctions when she’s at my house. It’s always fun to see her scramble around on my iMac. The keyboard confuses her, and the window buttons are on the “wrong side.”

Her complaining made me wonder one day; what is a new Macintosh user going to think when she gets everything out of the box, hooked up, and turned on? The Macintosh is very different from a PC in many ways. The single-button mouse is a shock on its own! This chapter will help you conquer your new machine so you can get down to business.

Mac OS X is similar to Microsoft Windows in that they both have a graphical user interface (also called a GUI). A graphical user interface is what you see when you start Microsoft Windows and Mac OS X. It’s the buttons and windows and icons that make the operating system usable to you. Mac OS X, of course, uses a windows metaphor (notice the lowercase w), like just about every other graphical user interface operating system out there. But while Mac OS X shares characteristics with Microsoft Windows (and KDE, GNOME, and most of the Linux window managers), it does things its own way also.
Note:

It's pointless to compare the Mac OS X GUI to a Linux GUI; Linux doesn't have a standard user interface. KDE and GNOME allow a Linux user to choose a specific window manager with different behaviors, so there's no way to fairly compare the Mac OS X user interface to Linux.

The good thing about Mac OS X is that, while it is different from Microsoft Windows, it is intuitive enough for you to not need to throw away all of your Microsoft Windows skills in order to use Mac OS X. Most of your Microsoft Windows skills aren't specific to Microsoft Windows; they're skills that you've acquired while working with a GUI. The concepts of point-and-click and drag-and-drop are not unique to Microsoft Windows. These concepts exist in Mac OS X, and they work the same way.

Macintosh Hardware Is Different

Macintosh computers don't consist entirely of PC components that you can buy off the shelf; a Macintosh will have lots of industry-standard stuff in its guts, but it uses a few things that are unique to the Macintosh, both inside and out.

Keyboard

Elley called me into my office because she couldn't cut and paste on my Mac. Instead of pressing Command-X, she had pressed Control-X. In the Microsoft Windows world (as well as the Linux world, for the most part), the PC keyboard's Control key, when pressed in tandem with the X key, cuts something. It doesn't work that way on the Macintosh; you have to hold down the Command key (the one with that little squiggly thing, next to the Spacebar) and press X. So Elley lost her text and couldn't get it back via Control-Z or Command-Z, which was pretty frustrating.
Command Key

There's a special key on the Apple keyboard called the *Command key*. It's the key with the little squiggly design, kind of like a clover leaf:

![Figure 4-1: The Command key on a Macintosh keyboard](image)

This key unlocks the power of keyboard shortcuts in Mac OS X and Macintosh applications. This key is the equivalent of Control on a PC keyboard in terms of its functionality.

The Command key is used as the base key in keyboard shortcuts. For example, Command-Q quits an application; the equivalent in Microsoft Windows is Alt-F4. Command-C copies something, while Command-X cuts it. In Microsoft Windows, these shortcuts are Control-C and Control-X, respectively.

Appendix A offers a substantial list of Mac OS X keyboard shortcuts, along with their Microsoft Windows equivalents. Be sure to take a look at it, as you will find your Mac OS X experience greatly enhanced if you know the keyboard shortcuts.

**Note:**

The Command key hasn't always had that little squiggly thing. On older Apple keyboards, such as those from the 1980s, the Command key had the Apple logo on it; it was thus known as the Apple key. Some Macintosh users still refer to the Command key as the Apple key. Current Apple keyboards have both the "clover" and the Apple on the Command key, so what you call it is just a matter of personal preference.
Control Key

The Control key on a Macintosh keyboard is mainly used for “Control-clicking” (that is, holding down Control and clicking the mouse button). This brings up contextual menus, based on whatever you Control-click. If you have a two-button mouse, you’ll never need to Control-click anything.

The Control key is used a lot in Terminal, which is explained in Chapter 10. Appendix A offers more information about the Control key.

Option Key

The Option key is principally a modifier for other keys; it’s the equivalent of the PC keyboard’s Alt key. In fact, on some Macintosh keyboards, the text “Alt” appears above Option on the key itself. If you hold down the Option key while dragging an item in the Finder, a little plus sign appears over the icon. This means that Mac OS X will copy the file you’re dragging. Holding down the Option key and the Command key while dragging an item will create an alias, the equivalent of a Microsoft Windows shortcut.

While the Option key is most often used to modify other keys, it is also used to type special characters. Hold down Option and press another key and a special character will appear. Holding Option and pressing P inserts the character δ.

The Option key isn’t really a direct equivalent to the Alt key in Microsoft Windows. Many people use the Alt key to access menus in Microsoft Windows, but the Option key in Mac OS X doesn’t do this. It’s designed more for accessing special characters and functions.

More uses for the Option key can be found in Appendix A.
Delete and Return

On a Macintosh keyboard, the Delete key performs the same operation as the Backspace key on the PC keyboard. The Return key is the same as the PC's Enter key, but Macintosh keyboards also have an Enter key, located on the number pad. Most of the time, Return and Enter do the same thing. In some keyboard shortcuts, however, Enter can't be substituted for Return and vice versa.

Note:

Some people like to use third-party keyboards, such as an ergonomic model, and most of them don't have a Return key; instead, they have the standard Enter key. Throughout this book, when I instruct you to press the Enter key, you can press either the Return key or the Enter key on your Apple Macintosh keyboard.

Mouse

Yes, the Macintosh has a one-button mouse. It has had a one-button mouse since the very first Macintosh, which happened to be the very first computer on the market to have a mouse. Of course, technically speaking, the mouse included with new Macintoshes has no button at all. Instead, you press the entire mouse down, so the mouse itself acts as the button. Apple likes to use those kinds of interesting industrial designs, typically in the name of increased usability.
When Douglas Engelbart invented the computer mouse in 1964, he couldn’t have envisioned the ubiquity of his invention 40 years later. It’s hard to imagine what computing would be like without a mouse in this age of hyperlinks and drag-and-drop. When Apple created the Macintosh, it was decided that a single-button mouse would be included. Designers insisted that the single-button paradigm was in line with Apple’s ease-of-use philosophy. Jef Raskin, the father of Macintosh, had used a three-button mouse at Xerox and found it unwieldy. He felt a single-button mouse was faster and more efficient, and easier to remember how to use. He noticed at Xerox that he and other mouse users were continually clicking the wrong buttons on three-button mice.

When Microsoft Windows 95 was released in August 1995, the concept of “right-clicking” was introduced to the masses (Unix folk had already been using three-button mice for years), and the two-button mouse became a staple of popular computing. Yet, the Macintosh still shipped with a one-button mouse, and Mac OS didn’t even support a second mouse button.

Fast-forward eight years. Microsoft Windows XP and Microsoft Windows 2000 make heavy use of the right mouse button to perform important tasks; sometimes, it seems impossible to use Microsoft Windows without the right mouse button. Yet, the Macintosh still ships with a one-button mouse, even though Mac OS X supports a two-button mouse.

Apple still stands by their original design philosophy: A single mouse button makes a user’s computing experience simpler and more intuitive. Apple has conceded a little along the way with Control-clicking and supporting two-button mice starting with Mac OS X.

Just because Apple doesn’t include a multi-button mouse doesn’t mean you can’t plug one into your Macintosh if you want to. I use a USB Microsoft IntelliMouse Explorer Optical, which
Get to Know Your Macintosh

has five buttons. My wife uses a Wacom tablet and stylus, and her stylus has two buttons, plus an eraser.

Power Button

The power button on a Macintosh is special. If you press it while your Macintosh is on, it will put your Macintosh to sleep. If you press it and hold it down, it will turn off your Macintosh. If you press it when your Macintosh is off, it will turn your Macintosh on.

Most Macintosh users I know never turn their machines off; they put their Macintoshes in Sleep mode. Sleep mode is like the Microsoft Windows Standby mode; it consumes less power but keeps the computer more readily accessible. Macintosh computers typically wake from Sleep mode very quickly.

Disks

Mac OS X doesn’t treat disks the same way Microsoft Windows does. When you insert a disk (such as a DVD or CD) into your Macintosh or connect an external disk of some sort, Mac OS X “locks” the disk. This is called mounting a disk. This means that an image of a disk is mounted in the file system in a special folder called Volumes, located on the root of your Macintosh’s file system (in other words, /Volumes).

When a disk is mounted, it appears on your desktop. When you want to remove a disk from your Macintosh, whether it’s a DVD, CD-ROM, USB hard drive, FireWire hard drive, or whatever, it must be unmounted. This is accomplished by ejecting the disk through one of several ways. (I talk about ejecting disks in detail in Chapter 7.)
The Mac OS X User Interface

While Mac OS X appears to be very similar to Microsoft Windows, with icons on the desktop and a background image, Mac OS X is actually quite a bit different in how applications behave and what those desktop icons represent. Mac OS X also has a different look and feel that may be a little confusing for you at first; for example, instead of a Start menu, it has a Dock (that strip at the bottom of the screen with the icons on it, which I discuss a little later in this chapter). These challenges are not insurmountable. Let's take a look at features of the Mac OS X user interface and how they compare to and contrast with Microsoft Windows.

Window Controls

If you double-click the icon that looks like a disk drive in the upper-right corner of your screen, a window appears showing the contents of your hard drive. Okay, so close the window. Wait a second...the Close button isn't on the right side; that blob-like button on the right side just changes the way the window looks! There are three colored buttons on the left. What do I do?

Relax. It's easy to get used to the window controls in Mac OS X. The first thing you need to do is familiarize yourself with the location of the controls. They're on the left side of the title bar, not the right. Now, notice that the first button is red, the second button is yellow, and the third button is green. This is just like stoplights in the United States. This color scheme is supposed to make the buttons feel familiar; after all, if you drive anywhere, you see this color scheme every day.

The red button has an X inside it; it closes a window. The yellow button has a minus sign (−); it minimizes a window. The green button has a plus sign (+), so it maximizes, right? Well, not exactly. There really isn't a "maximize" in Mac OS X. Instead, the green button changes the window size between its default setting and the user setting. It behaves a little differently
depending on what application you are using (iTunes is a great example of this). You should play around with the green button a bit to get a feel for how it works.

See Figure 4-2 for a comparison between the Mac OS X window controls and the Microsoft Windows XP window controls.

Figure 4-2: The Mac OS X window controls compared to the Windows XP window controls. They’re remarkably different, yet similar.

You can turn off the colors in the Mac OS X window controls by setting the color scheme to Graphite. We go over that in Chapter 5.

**Note:**

Some windows, like the Finder windows, iTunes, and the Mail window, have an extra button on the far right of the title bar, as you can see in Figure 4-2. This button does something different in each application, but generally speaking, it “rolls up” a window. This means it will sometimes hide the toolbar (as in Mail), condense the window (as in iTunes), or hide all extraneous information (as in Finder).

The Close button behaves a little differently based on the application you are using. Unlike Microsoft Windows, where clicking the X quits the application, most Mac OS X applications don’t quit when you click the red X. Instead, the current window closes and the application remains open. Some applications behave just like Microsoft Windows, where closing the main window quits the application.
Mac OS X Uses a Desktop Metaphor

In Mac OS X, the base of the user experience is the desktop. The desktop displays your mounted disks, aliases (shortcuts to files, folders, or applications), files, and folders. The desktop is a visual representation of a folder on your Macintosh’s hard drive, as it is in Microsoft Windows, but it’s also more than that. It’s the starting point for all of your activities in Mac OS X. Everything you want to do is accessed from the desktop.

Figure 4-3 is a picture of the default desktop that is created for all users on your Macintosh.

The Macintosh default desktop has a basic background, some icons, and a few things that may seem a little different to you. There are a few differences, like the presence of my USB keychain hard drive, the Microsoft Word icon in the Dock at the bottom of the screen, and my user name in the upper-right
corner. But other than those three things, the desktop in Figure 4-3 should be just like yours.

The Finder

The Finder is the essential piece of Mac OS X that makes everything available to you. The Finder enables you to access your disks and files, launch applications, and generally interact with Mac OS X.

The very first icon on the Dock is the Finder; it’s the blue smiley face. If you click it, it will do one of two things — show you a Finder window you already have open or open your home folder.

Figure 4-4: Clicking the Finder icon in the Dock brings up this window, showing the contents of my home folder.
Note:
I tell you all about how to change Finder preferences, such as what window to show when you click the Finder icon, in Chapter 5.

In a Finder window, the name of your computer is the topmost icon. Clicking that icon will show you the mapped drives on your machine, as pictured in Figure 4-5.

![Figure 4-5: Clicking the name of your computer (in my case, Tyger) will show you your mounted drives. This is the information stored in /Volumes, as I mentioned earlier in this chapter.](image)

This is essentially the same behavior that the My Computer icon in Microsoft Windows provides, except Finder shows only your mounted disks while My Computer shows all of your drives, whether they have disks in them or not. Finder will not show an icon for your CD or DVD drive if there is no disc in it.
Figure 4-6: Double-clicking the My Computer icon on my Microsoft Windows XP machine shows this window, which shows all of your drives, network connections, and other storage devices connected to your computer (such as Pocket PC).

When you look at your Microsoft Windows desktop, you probably see the My Computer icon. You might also see Network Neighborhood, if you have network connections and you elected to show that icon. The My Computer and Network Neighborhood icons represent shortcuts to information about your machine; My Computer shows your disk drives, and Network Neighborhood shows your network connections. In Mac OS X, the Finder provides all this information.

Finder is the equivalent of Windows Explorer in Microsoft Windows. Its most important job is providing a way for you to interact with Mac OS X. It provides the file access and management for Mac OS X. Finder is the application that abstracts all the technical stuff that makes Mac OS X work. It’s the interface through which you use your system. Without Finder, you would have to do everything through a command-line prompt.
**The Menu Bar**

Notice the menu bar at the top of the screen. That menu bar never goes away. Microsoft Windows XP applications all have their own menu bars, attached to the windows in the application (same for most Linux applications, also). But Mac OS X applications all use the same menu bar, which is at the top of the screen, and it changes based on what application you are using. Each application has its own menu bar, with its name as the first item, called the application menu.

Figure 4-7 shows the menu bar when I'm working in Finder.

![Finder Menu Bar](image)

Figure 4-7: The menu bar when I'm in Finder on my Panther machine

Figure 4-8 shows the menu bar when I'm working in Safari.

![Safari Menu Bar](image)

Figure 4-8: The menu bar when I'm using Safari

Notice that the two menu bars are very different. They display their own application names and offer different choices. This is similar to how Microsoft Windows applications and Linux applications all have their own menu bars. The difference is that the Microsoft Windows and Linux applications own their menu bars, while the Mac OS X applications use the stationary menu bar at the top of the screen.

Let's take a closer look at the parts of the menu bar.

**The Apple Menu**

The menu bar always includes the Apple on the left, called the Apple menu. The Apple menu does not change; it's essentially a system-wide menu. The Macintosh operating system has had this menu since the very first version of Mac OS.
Microsoft Windows has an equivalent, called the Start bar, which is the key starting point in Microsoft Windows (in other words, most of your activities in Microsoft Windows are kicked off from the Start bar). In Mac OS X, the Apple menu isn’t the starting point, but rather a shortcut to important system capabilities. (The Apple menu in versions of Mac OS prior to Mac OS X let you launch applications.)

Look at my Apple menu in Figure 4-9. It should be almost exactly like yours.

Figure 4-9: The contents of my Apple menu in Panther. Notice that my logged-in name, Rob Standefer, is next to Log Out. This will be different on your machine, unless you use the name Rob Standefer to log into your Macintosh. If you do, we need to talk!

That’s all well and good, but what do each of those menu items actually do?

**About This Mac**

This menu item simply pops up a window that tells you about your Macintosh, including the version number of Mac OS X, the amount of memory in your machine, and the processor. You can click the button labeled More Info... for more technical information about your machine.
Software Update... (Panther Only)

This menu item launches the Software Update utility, which downloads patches and updates from Apple's servers. This item only exists in the Panther menu, but you can still launch Software Update in a couple of different ways. I talk about that in Chapter 9.

Get Mac OS X Software...

This item launches your default browser and navigates to a web page containing downloadable Mac OS X software.

System Preferences...

Clicking this menu item will launch the System Preferences application, which I discuss in detail in Chapter 5.

Dock

This menu item lets you configure your Dock, the strip of icons at the bottom of your screen. I talk about the Dock a little later in this chapter.

Location

Location lets you specify which network connection you are using. For example, if you use AirPort at home and a modem when you're traveling, these connections would appear in the Location menu so you could easily select one or the other, depending on how you want to connect.
Recent Items

Recent Items is just that — a list of your recently opened items, including applications and documents. You can clear this list when it gets too long for your liking.

Force Quit (Application)

Force Quit launches a window that allows you to force an application to quit when it is malfunctioning. Use this when an application misbehaves and you have to kill it (but only when all other attempts to quit the application have failed).

Sleep

This one is obvious; it puts your Macintosh to sleep. You won’t be prompted to confirm; your system will go to sleep immediately if you click this menu item.

Restart...

Yes, it’s just what you think. It restarts your Macintosh. You will be prompted for confirmation if you click this.

Shut Down...

This menu item turns off your Macintosh completely. Again, your Mac will prompt you for confirmation to shut down.

Log Out (User)

This menu item logs the specified user out of your Macintosh. To log out means to quit the current Mac OS X session and return to a login screen. Mac OS X uses login sessions, like Microsoft Windows and Linux, to provide user-level security. Each user should have a unique password.
The Application Menu

Directly to the right of the Apple menu is the application menu item; it always contains the name of the application that is currently in use. The application menu lets you know where you are when you’re using Mac OS X. In other words, it lets you know what application is currently active. This is important in those applications that have windows that can be closed without the application quitting, like Safari.

The application menu also gives you access to the application’s preferences and a way to quit the application. Each application has its own set of menu items in its application menu. Take a look at two different application menus on my Macintosh in Figures 4-10 and 4-11.

<table>
<thead>
<tr>
<th>iTunes</th>
<th>File</th>
<th>Edit</th>
<th>Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>About iTunes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferences...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop for iTunes Products</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Provide iTunes Feedback</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Register iTunes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide iTunes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Others</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quit iTunes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mail</th>
<th>File</th>
<th>Edit</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Mail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferences...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Mail</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Others</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quit Mail</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-10: The iTunes application menu contents

Figure 4-11: The Mail application menu contents

Notice that the application menu for iTunes has lots of stuff in it, while the Mail application menu is pretty sparse. The Mail application menu has only the basic items that all application menus are supposed to have, like About, Hide, and Quit (per Apple’s user interface design guidelines). Regardless of the extra stuff in there, you can always count on the application menu to have the same basic functions.
Menu Extras

Menu extras are those little icons on the far right side of the menu bar. Most Macintosh users will have just a clock and volume indicator, but you can have many more than that. Some applications, like iChat, load their own menu extras. I loaded a bunch on my machine because I find them handy for shortcuts. Check them out in Figure 4-12.

Figure 4-12: I loaded several menu extras, which may be unfamiliar to you.

When you first start up your Macintosh, you'll see far fewer menu extras loaded, perhaps something more like Figure 4-13.

Figure 4-13: Maybe you can relate to these menu extras a little better.

A menu extra is essentially the equivalent of the little notification icons in the system tray in Microsoft Windows. They relay information such as remaining battery life, status of applications, and so on.

How Do Menu Extras Work?

A menu extra is a small program that, when executed, adds an icon to the menu bar. When you click a menu extra, a menu appears (surprise!) with the options for that particular menu extra. For example, if you have iChat, and you've told iChat to display your status in the menu bar (this can be activated in iChat’s preferences), you can click its menu extra (the thought bubble) and a menu appears with options to make yourself available, away, or offline, or to view your buddy list.

One menu extra that is loaded by default is the volume menu extra. This is a great example of how the menu extras compare.
to the Microsoft Windows system tray. In Microsoft Windows, you can click the little volume indicator in the system tray and a menu appears. See Figure 4-14 for what I’m talking about.

![Figure 4-14: The Microsoft Windows XP volume indicator. The image on the left shows the menu when you left-click the volume indicator. The image on the right shows the menu when you right-click it.](image)

Now, if you click the volume menu extra in Mac OS X, a menu appears with a slider that lets you adjust the volume of your system. The volume you set here is system-wide. That means that all applications will emit sounds at that volume unless they have an overriding volume control, like iTunes. The volume menu extra can be seen in action in Figure 4-15.

![Figure 4-15: I’m setting the volume of my Macintosh using this volume menu extra.](image)

The volume menu extra ignores Control-clicks and right-clicks. It has one basic function — setting your volume. Mac OS X as a whole doesn’t worry about things like balance and microphone volume; it leaves those decisions up to the individual applications that need those settings. That’s one way that Mac OS X makes your user experience more pleasant by simplifying common functions.
The Dock

The Dock is the most remarkably different thing about the Mac OS X user interface. The Dock is like your command center. The standard Dock that appears when you first start up your Macintosh is shown in Figure 4-16.

Figure 4-16: The default Dock for a new machine

You may ask, what exactly is the Dock? Well, it contains aliases to your applications (remember, aliases are like shortcuts) and shows what applications you have open and what windows you have minimized. The Dock is a lot like the Microsoft Windows Start menu and taskbar.

The Dock shows your available applications (like the Programs submenu in the Start menu in Windows). It shows your opened applications, your minimized windows, and whatever folders you want. If you point your mouse at an icon on the Dock, the name of the item will appear above the icon. See Figure 4-17.

Figure 4-17: When I hover over the icon that looks like a blue Q, I see that it's the icon for the QuickTime application.

What Else Is the Dock For?

When an application is open, the Dock adds a little triangle beneath the icon. Look at the first icon on the Dock, the happy face. See that little triangle pointing at the happy face? That's there to let you know that Finder is open. (Finder has to be open in order for your Macintosh to work, as you learned earlier in the chapter.)
Trash Can = Microsoft Windows Recycle Bin

The Dock also holds your Trash, where you drag files and folders to delete them. Trash is the equivalent of the Recycle Bin in Microsoft Windows. Trash also doubles as an eject button; when you are dragging a disk, the Trash icon turns into an Eject icon and you can drop your disk there to eject it. Remember that from what I said before about disks? Check out Figure 4-18 to see this in action.

Figure 4-18: Notice the text above the Eject button says “Eject.”

When you drag a network drive to the Trash, the Eject button appears but the text “Disconnect” appears instead of “Eject.”

Managing Your Applications (Sort Of)

The vertical bar on the right side of the Dock is a divider. Everything to the left of the vertical bar is an application alias (like a shortcut in Microsoft Windows), and everything to the right of the bar is like a workspace. Consider the Microsoft Windows Start menu: Your applications are launched from Programs, and your windows are described in the taskbar.

Keeping Track of Minimized Windows

In Mac OS X, the Dock works kind of like the Start menu in Microsoft Windows. Your applications are launched from the Dock, of course, but the Dock also displays your minimized applications and windows as well.

While the Microsoft Windows taskbar will show an icon with the name of the application below the icon, Mac OS X goes a bit further. When you minimize an application to the Dock, the icon that appears in the Dock is a representation of your application. For example, if you minimize a Safari window, a miniature
version of the Safari window will appear in the Dock. See Figure 4-19 for an example.

Figure 4-19: The minimized web page icon is an exact copy of the Safari page, only really small. Some applications, like QuickTime, have live updating icons for minimized windows. If you play a QuickTime movie and minimize it to the Dock, the icon in the Dock will continue playing your movie. Give it a try. It’s quite interesting.

Dock Icons Have Contextual Menus

You can Control-click (or right-click) an item in the Dock and see a contextual menu for the item, just like items in the Microsoft Windows taskbar. For example, if you Control-click Safari, a menu appears that gives you a couple of menu options, depending on whether Safari is open or not. Figure 4-20 illustrates what I’m talking about.

Figure 4-20: I Control-clicked the Safari icon in my Dock while Safari was open (notice the triangle). The menu shows the name of each Safari window I have open.

Other applications have more sophisticated context menus. iTunes, for example, has a feature-packed context menu. Check out Figure 4-21 to see what I mean.

Figure 4-21: iTunes has an awesome context menu, making it really easy to control your playlist without actually going into the iTunes window.
Two more things: Every open application will have Force Quit in the context menu (this lets you force misbehaving applications to quit), and every item in the Dock will have a Show in Finder menu option, which opens a window to the folder containing the application. Play around with it a bit, and see what happens when you Control-click (or right-click) the different items in the Dock.

**Make the Dock Your Own**

By default, the Dock comes with a few icons on it and some settings set to their defaults. Now take a look at Figure 4-22. This is a picture of my heavily customized Dock in Panther.

![Figure 4-22: My heavily customized Panther Dock. You can add applications, folders, files, AppleScripts, and anything else for which an alias can be created.](image)

You add things to your Dock by dragging the icon to the Dock to the specific location you want the icon to go. Remember that applications go in the Dock to the left of the vertical bar; files, folders, and other items go to the right of that vertical bar.

**Add an Application to Your Dock**

Let’s step through the process of adding an application to your Dock, since launching applications is what you’ll use the Dock for the most. First, open your hard drive by double-clicking it on your desktop, and then double-click the Applications folder. All of your applications are in there (unless you installed something custom and it put the application elsewhere, of course). Just click and hold the application icon, drag it to the Dock where you want it to go, release, and voila! It’s on your Dock. Notice as you are dragging the application icon to the Dock that the other icons courteously move out of the way to make room.
Note:

Another cool way to add an application to the Dock is by starting the application and then dragging the application’s icon to where you want it on the Dock. That will tell the Dock that you want the application icon to stay there even when the application is closed.

Add Other Items to the Dock

You can use the Dock for much more than a launchpad for your applications. You can drag things like folders, mapped drives, files, and AppleScripts to the area to the right of the vertical line in the Dock. Try it out. Drag your Applications folder to the Dock. Now click on Applications in the Dock and hold down the mouse button. After a few seconds, a menu will pop up showing you the contents of Applications. Check out Figure 4-23 for what to expect.

Figure 4-23: Holding down the mouse button on my Applications folder alias on my Dock shows the long list of applications on my machine. Control-clicking the folder (or right-clicking it if you have a two-button mouse) will achieve the same effect.

If you add a file to the Dock in the same way, it will make the file easily accessible; simply clicking it once will open it up. This is useful if you open one particular file more often than others.

I mentioned that you could add mapped drives and disks to the Dock too. This works the same way as the folder; if you click and hold, Control-click, or right-click the disk, a menu of the contents of the disk will appear.
Removing Items from the Dock

When you want to remove something from the Dock, just drag it out of the Dock and release it onto the desktop. It will disappear into a cloud of virtual smoke.

Figure 4-24: I dragged an icon off my Dock and dropped it on the Finder desktop. This removes the icon from the Dock; it doesn’t move it from the Dock to another location because all the icons on the Dock are aliases. Your original file, folder, or application is left alone.

Set Preferences for Your Dock

Now, remember the Apple menu and that it has menu options for setting preferences for your Dock? You can choose how your Dock behaves by enabling or disabling those menu options. I like to turn on magnification and turn off hiding, but those are just my preferences. You can even click the Dock Preferences... option to load a window that lets you set up your Dock a little more, but don’t do that yet; we’ll get to that soon!

You can customize the Dock to your heart’s content, you can hide it and never use it, or you can leave it just the way it is. It’s your Dock to do with as you please.

Let’s Review

That’s a lot of information in one sitting. Let’s review the Dock before we move on to the rest of the chapter.

- The Dock is essentially the equivalent of the Start menu and taskbar in Microsoft Windows.
- You can add applications, files, folders, and aliases to the Dock by dragging them to and dropping them on the Dock.
• The Dock has an icon for Trash, the equivalent of the Recycle Bin in Microsoft Windows.
• Trash turns into Eject when you drag a disk over it.
• You can Control-click or right-click items in the Dock to get a contextual menu.
• You can set preferences for your Dock in the Apple menu, including magnification, Dock position, and hiding.

I think that’s it for the Dock for now. We cover setting the finer details of the Dock in Chapter 5.

Mac OS X Has Some Major Differences

You’ve learned the basics of Mac OS X and how it’s different from and similar to Microsoft Windows. By now you should be able to double-click icons to open them (applications, files, or folders) and click the menus to make them work. That stuff is the same as Microsoft Windows.

Now let’s take a look at what’s really different. When you make it through this part of the chapter, you’ll have mastered the basics of using Mac OS X and you’ll be ready to start making Mac OS X work for you.

Scroll Bars

If you’ve looked at your Mac OS X scroll bars lately, you might have noticed that they’re markedly different from the Microsoft Windows scroll bars. Take a look at Figures 4-25 and 4-26 to see what I mean.
Figure 4-25: This is Windows Explorer in Microsoft Windows XP. Take a look at the scroll bars.

Figure 4-26: This is a Finder window in Mac OS X. Notice the scroll bars. What’s different?

Yep, in Mac OS X, the scroll bar arrows are together rather than at opposite ends of the scroll bar. This is to make it easier for you to scroll your windows with your mouse. Why move the mouse up and down the screen to get to a page of text when you can move it only a fraction of an inch?

If you don’t like the scroll bar arrows so close together, there’s a way to change it so they’re at opposite ends of the scroll bar, just like in Microsoft Windows. I explain how in Chapter 5.
Important File Locations

Just about everything we've covered in this chapter has been visual in nature. Clicking the Finder icon has exposed you to the file system a little bit. If you dig a little deeper, you'll see that the file locations — where Mac OS X stores applications and files — are significantly different from Microsoft Windows and, in many ways, much simpler to understand.

User Files

First, Mac OS X calls directories *folders*. Second, Mac OS X considers the center of your Mac OS X universe to be your home folder. This folder is located at /Users/<your logged in name>, where / is the root of your hard drive.

**Note:**

Have you noticed that slashes are in a different direction? In Microsoft DOS and Microsoft Windows, the slashes are backslashes (\). In Mac OS X, the slashes are forward slashes (/). This is because Mac OS X comes from the world of Unix, where slashes are all forward slashes. Look at a URL, for example: All the slashes are forward slashes because back when the web first came into existence, it was solely on Unix machines. In fact, the web was “invented” on a NeXT machine, which had an operating system based on BSD. BSD, of course, came from Unix. Thus, the forward slashes. Whew.

When you add a user to Mac OS X (I’ll show you how in Chapter 9), the operating system creates a hierarchy of folders for that user under /Users/<user name>. These folders are specific to the user, which means that whatever the user does to configure his or her system (such as customizing the Dock) stays specific to that user. This is just like the user directories in the
Documents & Settings directory in Microsoft Windows 2000 and later versions.

Double-click your hard drive and look at the Users folder. The icon is a folder with a silhouette of two people. Open that folder by double-clicking it. You'll see all of the home folders for the users on your system.

**System Files**

Microsoft Windows puts all of its operating system files into \Windows or \Winnt (or any other directory you specify at installation). Mac OS X puts its system files in /System and /Library. Generally speaking, you never need to go into either of these folders. Mac OS X gives all users their own specific Library folder, where important data is stored (like desktop pictures). This is different from Microsoft Windows, where all desktop pictures (for example) are stored in the same directory and accessible to all users.

**Subtle Differences**

There are a few other subtle, yet significant differences in Mac OS X. Love 'em or hate 'em, these differences are part of what gives Mac OS X its identity.

**Sizing and Moving Windows**

Mac OS X windows can be sized only by clicking and dragging the window resize handle, which is located at the bottom-right corner of every Mac OS X window.

Figure 4-27: This resize handle can be found on every Mac OS X window. This screen shot shows the resize handle on a brushed metal window (left) and a standard window (right).
Moving windows in Mac OS X differs based on what kind of window you are dragging. If you want to move a brushed metal window, click and drag anywhere on the brushed metal “surface.” If you drag a standard window, you have to click and drag on the title bar (that strip of the window at the top with the window name on it).

**Hiding Instead of Minimizing**

Before Mac OS X, the Macintosh operating system didn’t have anything that represented the *application state* of the operating system. In other words, there was no launchpad, or Dock, or taskbar. When you had applications open, they were all open, and you could pick the foreground application (the one you wanted to use) by choosing it in a Finder menu.

- **Note:**
  
  Mac OS X doesn’t have that Finder menu; it has the Dock instead. You can, however, download a menu extra that gives you that drop-down Finder menu from previous versions of Mac OS.

Since the Macintosh operating system didn’t have a concept of minimizing, the operating system had a special mechanism called *hiding*. A user could hide an application by pressing Command-H and then bring it out again by selecting it in the Finder menu. Hiding is included in Mac OS X, and it’s actually the preferable way to deal with “desktop clutter” for many people.

To hide a window or application, simply press Command-H. This will hide the current application. You can also use the Application menu to hide the current application or all others. See Figure 4-28 for an example of how to hide an application.
Note:
Panther offers an additional way to deal with desktop clutter. It’s called Exposé. We’ll talk about Exposé in Chapter 5.

Figure 4-28: Clicking an application’s menu will show you the hide options for that application.

Mouse Pointer

Take a look at the default mouse pointer in Microsoft Windows in Figure 4-29.

Figure 4-29: The default Microsoft Windows mouse pointer

Now, compare it to Figure 4-30, the default mouse pointer in Mac OS X.

Figure 4-30: The default Mac OS X mouse pointer

It should be pretty obvious that the Microsoft Windows mouse pointer is white, while the Mac OS X mouse pointer is black. This is just one of the small differences that most people don’t even really notice. I actually set my Microsoft Windows mouse pointer to black on my PC because I’m so used to it that way in Mac OS X.
Rounded Corners

Daniel has a great eye for design, especially subtlety. He pointed out a while back that the menu in Mac OS X has rounded corners. The screen doesn’t go to a squared-off edge like in Microsoft Windows or Linux. The rounded corners don’t really add much to the Mac OS X experience, save for making everything a little cleaner to the eye. It’s just one of those things that’s cool and kind of unique (although technically speaking, Macintosh operating systems from System 1 to Mac OS X have always had those round corners).

Figure 4-31: The luxurious rounded corners of the Macintosh menu

Summary

The Macintosh has some major differences from PCs, both in the hardware and the operating system. Using Mac OS X shouldn’t be a foreign concept to you; your Microsoft Windows skills will translate over to Mac OS X for the most part, and learning the new stuff can be a lot of fun. The greatest thing is that, while Mac OS X and Microsoft Windows XP (and the Linux window managers) are very different in terms of look and feel, the concepts behind the user interfaces of the two operating environments are the same. In other words, if you go from Microsoft Windows XP to Mac OS X and then to KDE on Linux and then back to Mac OS X, it won’t be like moving to a different planet; what you do in one will have an equivalent in another, with a few differences that you will become accustomed to.
On a warm August night in 2002, Joby and I stood together in the longest line I've ever seen anywhere other than a theme park. It was at the Apple Store in Plano, Texas, with hundreds of other Macintosh users (and some future Macintosh users as well). We were all there for the same thing: the unveiling of Mac OS X 10.2, otherwise known as Jaguar. Well, that, and the free T-shirt that came with it.

We had all eagerly awaited Jaguar enough to stand in this unimaginably long line because even though Mac OS X had been a cool operating system up to that point, it was lacking a lot of features that we missed from Mac OS 9, such as color labels and spring-loaded folders. Jaguar promised to be the version of Mac OS X we had been waiting for, and for the most part, it was.

Fast-forward a year to October 24, 2003, when Apple unveiled Mac OS X 10.3, known as Panther. This new version of Mac OS X showed us what our Macintosh computers were truly capable of, introduced some innovative new features, such as Exposé, and reincorporated some of the things we missed from older versions of Mac OS.

In this chapter I teach you how make Panther work for you, with a focus on translating some of your Microsoft Windows skills to Panther. I cover the basics, like how to install applications and change your desktop background, as well as the cool
things like using Exposé, the awesome new window management tool built into Panther.
So let's go!

Make Finder Work for You

Finder is the Mac OS X equivalent of My Computer, Windows Explorer, and much more. Copying, deleting, moving, and duplicating files are just a few of the things Finder allows you to do.

Open a Finder window by clicking the smiley face in the Dock. Finder will pop open a window very similar to Figure 5-1.

Figure 5-1: This is a standard Finder window. Don't worry about the specific contents being different on your machine.

A Finder window consists of seven main parts, listed from top to bottom, left to right: the standard window controls and title bar, a toolbar, a search box, the sidebar, the currently selected folder contents, the currently selected folder size information at the bottom, and a standard resizing handle on the lower right.
You can do all kinds of things from this Finder window, including navigating your file system, manipulating files, launching applications, ejecting disks, burning CDs and DVDs, and much more.

**View Options**

Before we begin our foray into Finder, let’s take a look at the View options first. You can access View options by clicking the View menu in Finder, and then clicking Show View Options. You will see a window like Figure 5-2.

![Figure 5-2: (Left) View options for the desktop. (Right) View options for a Finder window.](image)

When View options is open and the word “Desktop” appears at the top of the window, you can set the options for your desktop. In this window, you can change the size of your icons, set the desktop’s text size, set the label position, and turn on several options. You can also set view options for Finder windows. We’ll get to that soon.
The sidebar, a new feature with Mac OS X Panther, has proven to be very popular. It’s a shortcut to files, folders, applications, drives, and just about whatever else you want to put in it.

Figure 5-3: The default sidebar contains aliases to your computer, your mounted disks, your home folder, and some common folders like Documents and Applications. Compare it to a Microsoft Windows Explorer window, with the common tasks pane on the left side.

To add something to your sidebar, just drag the item to the sidebar and drop it where you want it to go. Then you can access the item by clicking it. If you want to remove something, just drag it off the sidebar and release the mouse button (you don’t have to drag it all the way to the Trash). The item will disappear in a puff of smoke.
Folder Contents

The folder contents make up the big mass of space to the right of the sidebar. The folder contents are Finder’s *raison d'être*: They let you access your folders and files. You can act on items in folder contents by Control-clicking (or double-clicking) them or by using the toolbar. If you like a simpler window for manipulating your files, click the rounded rectangle button on the right of the title bar. You will see something like Figure 5-4.

![Figure 5-4: Clicking the rounded rectangle button changes the look of the Finder into just the title bar, window controls, and folder contents.](image)

However you like your Finder window to look, once it’s open you can manipulate your files and folders as you please by renaming them, moving them, creating aliases, and so on.

Selecting Items

Selecting an item in Mac OS X works the same way as it does in Microsoft Windows. You can click a single item, or you can drag a box around multiple items. If you hold down Command, you can select multiple items in the same way as holding down Control and clicking in Microsoft Windows.
Spring-loaded Folders

As you drag an item over a disk or folder and wait a second (don’t release the mouse button), the disk or folder will open automatically under your mouse pointer. This is a feature of Mac OS X called spring-loaded folders. If you drag an item over the icon of any folder or disk without releasing the mouse button, the folder or disk will pop open. When you release the mouse button and the dragged file or folder is copied, all the folders or disks that have popped open will automatically close.

Copying

Copying files in Mac OS X is very similar to copying files in Microsoft Windows. Control-click (or double-click) the file (or folder or application), click Copy in the context menu, then Control-click the destination and click Paste Item.

A second method is to hold down the Option key, then drag and drop the item you wish to copy to its destination folder. As you drag the item (while holding down the Option key), a green bubble with a plus sign should appear on the icon. This means it will be copied. If the green bubble with the plus sign doesn’t appear, the item will be moved to the new folder instead of copied.

Moving

Moving a file in Mac OS X works the same way it does in Microsoft Windows: Drag it from the source folder and drop it in the destination folder. Spring-loaded folders work with moving files and folders.

Deleting

To delete an item, drag it to the Trash. You can also Control-click the item and click Move to Trash.
Creating an Alias

To create an alias (like a shortcut in Microsoft Windows), drag the item while holding the Command and Option keys and drop it in its destination. As you are dragging it, an arrow will appear on the icon, just like in Microsoft Windows. As in Windows, when you drop the item, its icon will have an arrow on it to indicate that it is an alias. You can move the alias anywhere on your hard drive and no matter where it ends up it will always know where the original item is, even if you move the original item.

You can also Control-click an item to create an alias. This is discussed later in this chapter.

Renaming

To rename an item, click its name, found just below the icon. The name will change to highlighted text, like in a word processing program. Type in your new name and press Enter.

Toolbar

The toolbar in the Finder window serves two important purposes: navigating and viewing your file system, and performing actions on your Mac OS X files and folders. Clicking one of the icons in the toolbar performs a specific function, such as taking you to the previous folder or changing the view of the folder contents.

Arrow Buttons

The first set of buttons consists of two buttons with arrows on them. They work the same way as the back and forward buttons in a web browser (and the arrow buttons in Windows Explorer). As you open folders by double-clicking them, Finder keeps track of the path you took to get through the folders. If you click the left arrow (back), Finder will move you back one folder. If you
click the right arrow (forward), Finder will move you forward one folder. If either arrow is gray, that means there is nowhere to go in that direction.

**View Buttons**

The second set of buttons in the Finder toolbar contains the view buttons. Clicking these buttons will change your Finder view (the way it looks and navigates). This is similar to Windows Explorer’s View menu, where you can view files as icons, or in a list, and so on. Finder’s views are a little different from Explorer’s views, though.

**Icon View**

The first button selects the icon view, which is the default view. It shows all of your files and folders as icons with the file or folder name beneath the icon. This is the same as the icon view in Windows Explorer. Double-clicking an icon will launch an application, open a file, or show the contents of a folder, depending on what the icon represents.

**List View**

The second button selects the list view. The list view in Finder is very similar to the list view in Microsoft Windows. It displays the contents of a folder in a multicolumn list. You can expand and contract folders by clicking the dark triangle next to the folder’s icon. Each column displays a particular piece of information about the file, folder, or application. You can show and hide individual columns by choosing View Options while you’re in a folder in list view.
Column View

The third view button selects a very cool feature that just has to be experienced: column view. Column view is similar to list view, except that it displays the contents of folders in expanding columns, and it shows the contents of only one path at a time. Open a Finder window, set it to column view, and then navigate through folders. You'll be able to easily keep track of your path by looking at the columns.
Figure 5-6: Column view is very handy when you’re moving around in a lot of folders. It’s really easy to keep track of where you are. If you click a file or application in column view, details about that file or application will appear in the last column.

**Action Button**

The Action button looks like a gear. When clicked, it displays a contextual menu that changes based on what is active when you click the Action button. If you click on an item in the sidebar or somewhere on a Finder window (in other words, anything but a file, application, or folder icon), the action menu has three standard choices: New Folder (creates a new folder), Get Info (I talk about that a little later), and Show View Options.

If you click the Action button after clicking a file, folder, or application, the Action menu has quite a few more choices in addition to the standard ones.
- **Color Label.** This lets you assign a color to an item's icon. When you select a color label, the background of the item's label will change to that color. Try it out. It's a nice way to personalize your computer.

- **Move to Trash.** This does exactly what you think it does: It moves the item to the Trash.

- **Duplicate.** This creates a copy of the item. This is equivalent to copying an item and pasting it in the same window.

- **Make Alias.** This creates an alias of an item, which is the same as a Microsoft Windows shortcut. It's a new icon that points to an item.

- **Create Archive.** This creates a compressed file containing the selected files and/or folders. The compressed archive is in the widely used Zip format.

- **Copy.** This copies your item. If you have chosen this, you will be able to paste the item through the action menu.

You don’t have to click the Action button every time you want to use one of these actions. They are also available by Control-clicking an item.

### Search Box

Typing a word in the search box will automatically cause Finder to search for files and folders that match your search term. If you click the magnifying glass icon in the box, you can choose where Finder should search.
Figure 5-7: A search of the word “fiction” returned a couple of results. One is an MP3 file and the other is a folder.

You can bring up a more powerful search window by pressing Command-F in Finder. From this window you can fine-tune your search. Click the + icon to add a new search criterion, and click the – button to remove a search criterion.

Figure 5-8: Now I can fine-tune my search for “fiction” and limit it to files and folders named “fiction” rather than finding all files and folders with “fiction” in the name.
Customizing the Toolbar

The toolbar is easily customized to better suit your needs. You can add items to the toolbar that perform different functions or you can use the default set of icons. The toolbar can be set to show the icon and text, just the icon, or just the text, and you can set the text to a different size.

To customize your toolbar, open a Finder window, click View in the Finder menu, and then click Customize Toolbar... (You can also Control-click the Finder window and click Customize Toolbar... in the menu that appears.) You will see the Customize Toolbar pane with a bunch of icons on it, each with a label beneath it to tell you what it does. You can drag the icons you want to add to the toolbar to the rectangular area that has been outlined on your Finder window. With this pane open, you can also remove buttons from the toolbar by dragging them off the toolbar and releasing them anywhere. They will disappear into the familiar puff of animated smoke.

Note:

You don’t have to open the Customize Toolbar pane to remove an item from your toolbar; you can Control-click a toolbar button and pick Remove Item.

If you decide you want to revert to the default buttons, drag the default set to the toolbar and it will reset everything. When you are finished customizing your toolbar, click the Done button.
Figure 5-9: This is the Customize Toolbar pane. You have several options for customization, including adding an Eject button and a Burn button (for burning CDs and DVDs, covered in Chapter 7).

**Dialog Boxes**

A dialog box is the window that pops up when you click Open, Save, or Print in an application. Technically speaking, a dialog box is any window that expects you to enter information or perform an action. For this discussion, we’ll take a look at the standard dialog boxes that all Mac OS X applications are supposed to use.

You may have noticed that in most Microsoft Windows applications, when you click Open, Save, or Print, you see a dialog box that is consistent between applications (there are exceptions, of course). In other words, the Open, Save, and Print dialog boxes in Microsoft Word for Windows are the same as in Adobe Acrobat Reader for Windows. Mac OS X is the same:
Applications use standard dialog boxes for opening, saving, and printing. The result is a consistent user experience.

**Open**

When you open something (usually a file) in a Mac OS X application, the application will pop up the Open window, which looks a lot like a Finder window. It has the same sidebar as Finder, a version of the Finder toolbar (navigation arrows, a List View button, and a Column View button), and folder contents.

The unique parts of the Open dialog are a Cancel button, an Open button, and a drop-down menu. The drop-down menu gives you a quick way to move through a hierarchy of folders, as well as listing the files or folders you’ve used recently. Any files that can’t be opened in that application will be grayed out.

![Open dialog](image)

Figure 5-10a: This is the standard Microsoft Windows XP Open dialog.
Figure 5-10b: This is a standard Mac OS X Open dialog. The main difference is that a Mac OS X Open dialog doesn't let you type in a filename. It also doesn't have a Files of type option.

The Open dialog's folder contents work the same way as in Finder. Once you locate the file you want to open, just click the Open button (or double-click the filename) and you're set. If you decide you don't want to open a file after all, click the Cancel button.

**Note:**

Some applications, like Microsoft Word for the Macintosh, have a customized version of the Mac OS X Open dialog. It works the same way, with some added features.

**Save**

When you are working in an application such as TextEdit and you make changes to an existing file, a dot appears in the red button in the title bar (the Close button). This means your file has been changed since the last time it was saved and needs to be saved again if you want to keep those changes. Mac OS X saving works the same way it does in Microsoft Windows. When you click the
Save button or select Save in the File menu, your file will be altered to reflect the changes that have been made and saved that way.

**Note:**
Adding the dot to the Close button to indicate that a file has been changed and needs to be saved is a very handy standard in Macintosh applications. Microsoft Windows applications that offer this sort of feature usually put an asterisk next to the name of the application in the title bar or show the Save button dimmed until a change is made to the file, but in fact, there is no standard way to show a file has changed in Microsoft Windows.

When you click Save on a new file that hasn’t been saved before, the Save dialog will appear. You’ll also see the Save dialog when you click Save As... in the File menu, just like in Microsoft Windows. And also like Microsoft Windows, the Save dialog in Mac OS X is a lot like the Mac OS X Open dialog, with a few changes.

![Image of Save dialog](image)

**Figure 5-11: The Mac OS X Save dialog is very similar to the Mac OS X Open dialog. Note that you can type a filename.**

In the Mac OS X Save dialog, you enter the name you want to give your file in the Save As box. There’s a drop-down menu below the Save As box that lets you choose where to save the file. But what if you don’t want to save in any of the places listed in that drop-down menu? No problem. There’s an arrow next to the Save As box that will help you out. Click that and the Save
dialog expands to allow you to navigate through the folder contents to choose where your file will be saved. There's also a button named New Folder that creates a new folder when you click it. And of course there's the requisite Cancel button for canceling the save and a Save button to commit to everything you did to the file after you opened it.

**Print**

The Print dialog is covered in Chapter 7.

**Get Info**

If you ever have a need to get more information about an item in Mac OS X, such as a file, folder, application, or disk, you can use Get Info. To open Get Info, click the object you want information about and then click File, and then Get Info (you can also press Command-I, or Control-click the object, or choose Get Info from the Finder Action toolbar button if you're in a Finder window).

Figure 5-12: Get Info in Mac OS X is the equivalent of Properties in Microsoft Windows.
Get Info gives you all kinds of information about the item, and the information is contextual to the item you selected. For example, if you open Get Info for a hard disk, the Get Info window will tell you how much free space is on the hard disk. Get Info also gives you information about permissions, which I talk about in Chapter 9.

Using Your Applications

Mac OS X applications are entirely unlike Microsoft Windows applications. For example, when you install a Microsoft Windows application, it will often place files all over your machine — in the Windows directory, in its own directory, on the desktop, in the Start menu, and in various other places (not all Microsoft Windows applications do this, of course).

Mac OS X applications don't put files all over your machine when you install them. In fact, a Mac OS X application is actually a folder with the file extension .app. The folder contains the program and all of the files that the program will need to launch. This consolidation significantly simplifies working with Mac OS X applications, especially when it comes to installing them.

Installing and Launching

Not all Mac OS X applications are the same, but most can be installed by simply dragging the application's icon from the source media (CD, DVD, downloaded file, and so on) to your /Applications folder. Most Mac OS X applications that I've installed have worked this way. Occasionally, the applications will put preference files in /Library/Preferences when you use them for the first time.
Application Installers

There are a few applications that have their own installers. These you install the same way you do most Microsoft Windows applications: Double-click the installer's icon and then just follow the onscreen instructions. Some application installers are packages (they end in the .pkg extension).

Figure 5-13: When I double-clicked the XEphem package icon, its installer started. This is the most common installer for Mac OS X applications.

Other applications may come in a Unix file format called a tarball. It ends in the .tar extension, and it's essentially a balled-up collection of files; kind of like a Zip archive in Microsoft Windows. A tarball may contain a package file, some kind of installer, or the application itself. Other applications might be in disk images, which end in the extension .dmg. All you have to do to install them is drag the application from the disk image to your /Applications folder. (Disk images are covered in Chapter 7.)
Occasionally you’ll get a file in the Stuffit format (it ends in the .sit extension). This is a compressed archive of other files. Mac OS X usually unstuffs these files automatically; you can unstuff any Stuffit archive by double-clicking it.

**Add/Remove Programs**

There is no concept of Add/Remove Programs in Mac OS X, mostly because Mac OS X doesn’t really need to keep track of all of your applications (the applications do a good job of keeping track of themselves) and there’s no standard installation mechanism for applications. (Some applications, as I mentioned, don’t have to be installed at all; you just drag them from the source to your /Applications folder.) Some Mac OS X applications will include an uninstall option, but most don’t. When you want to remove an application from your computer (uninstall it), you just drag its icon to the Trash. You can then remove the application-specific files and folders from /Library and the Library folder under your home folder by dragging them to the Trash.

**Launching and Quitting**

Launching a Mac OS X application works the same way as launching a Windows application in Microsoft Windows. Depending on where the alias to the application resides, you click or double-click its icon (for example, an application in the Dock requires a single click, while an application in a Finder window requires a double-click). When the application launches, its icon appears in the Dock (if an alias to the application isn’t already there) with a black triangle under it. The icon will bounce up and down on the Dock until the application is fully launched.

When you are finished using an application, you can quit it by pressing Command-Q on your keyboard or by choosing Quit from the application’s menu. You can also quit an application by
Control-clicking (or double-clicking) its icon in the Dock. Simply closing the windows of an application doesn’t always quit the application, as it does in Windows, so you should make a habit of quitting Macintosh applications in one of these ways.

**Note:**
There’s another way to quit applications: force quit. This should only be used for misbehaving applications. I talk about it in Chapter 9.

### Listening to Music

Now that you know how to install, launch, and quit applications, let’s use one: iTunes, found in your /Applications folder. iTunes is the music library and player application included, for free, with every Macintosh computer. (There’s also a free version of iTunes for Microsoft Windows.) You can use iTunes to copy music files from your music CDs to your computer (*importing*, also called *ripping*) and recording songs onto new CDs (called *burning*).

**Note:**
CD burning is covered in Chapter 7.

### Importing Songs

Importing songs using iTunes is a cinch. Open iTunes from /Applications, insert a CD into your Macintosh, and click the Import button. iTunes will import all of the music on the CD to your iTunes library on your Macintosh’s hard disk in one of four formats: MP3, AAC, AIFF, or WAV. (See Figure 5-15.)

Which format you use is up to you. I like to use the AAC format because it’s CD-quality sound and the file sizes are smaller. Joby loves MP3 and AIFF because he can use the imported files in his music-making software. You can choose the format in the
iTunes preferences. Click the iTunes application menu, and then Preferences... (or press Command-, (comma)). Then click Importing in the toolbar.

Figure 5-15: If you don't want to import some music tracks, uncheck them. iTunes won't import songs that don't have a checkmark.

Figure 5-16: When you choose your format, be sure you decide what bit rate you want (from the Setting drop-down). The higher the bit rate, the better the quality, but at the cost of increased file sizes.
If you get MP3s from somewhere, or you copy them over from your PC, you can import them into iTunes in two ways. You can either select the files in Finder and drag them into iTunes, or you can click File and then Add to Library... (or press Command-O) and select the folder that contains your music.

**Playing Music**

At its most basic, iTunes is a music player, whether your music is a track on a CD, a stream from a music server, or an audio file on your Macintosh hard disk. iTunes is an excellent music player at a superb price (free), and it's really easy to use.

![Image of iTunes](image)

Figure 5-17: My iTunes library has thousands of songs in it. I use column sorting to organize my music and find what I want to listen to.

If your iTunes library has music in it (you've imported songs or you've added them to the iTunes library by clicking File and then Add to Library...), all you have to do to play a file is double-click it. (If you can't find the song you want to play, you can type its name into the Search box and iTunes will find it for you.) iTunes has controls like a CD player, so you can play, rewind, fast-forward, skip tracks, and so on.
If you want to listen to a music stream, click Radio in the Source box and select the Internet radio station you want to listen to, or click the Advanced menu and then Open Stream... and enter the URL of the music stream.

**Note:**
A complete discussion of iTunes could easily fill an entire book, so I suggest you hit your local bookstore and pick up one of the iTunes books to learn more about this great application. I talk a little more about iTunes in Chapter 7.

### Watching Movies

In the mid-1990s, the idea of multimedia burst onto the scene. It seemed like everyone was jumping into the video-on-CD phenomenon. People got so excited about being able to watch video on a computer, even if it was small and grainy.

Now, in the 21st century, watching video (or even television) on your computer is commonplace. With the advent of DVD and high-quality video formats, as well as powerful video cards, you will have no problem enjoying quality movies on your Macintosh.

### Watching DVDs

I love movies. In fact, while I took breaks from writing this book, I would watch parts of *Good Will Hunting* on DVD. If your Macintosh has a SuperDrive, you can watch video DVDs on it using an application called DVD Player, which is found in /Applications. Unlike Microsoft Windows, there’s no need to install
anything extra. All you have to do to watch a video DVD is insert it into your Macintosh’s SuperDrive; DVD Player should start automatically. (If it doesn’t, just launch it from /Applications.)

![DVD Player controller](image)

Figure 5-19: When you watch a DVD with DVD Player, you get this cool controller that has all of the controls of a standard DVD player. Press Command-Option-C on your keyboard to toggle the controller between horizontal and vertical.

If your DVD starts playing in a window and you want it in full screen, press Command-O on your keyboard or open the Video menu and choose Enter Full Screen. Your movie will fill your entire screen, the menu will disappear, and the controller will disappear after ten seconds. To retrieve the controller (to pause, rewind, etc.), move the mouse. If you need to use the menu, move your mouse pointer to the top of the screen and the menu will reappear.

Region coding is a method DVD manufacturers use to ensure that DVDs are only playable in certain regions of the world. DVDs released in the U.S. and Canada are region 1 encoded, those in Japan and Europe are region 2, and so on. The reasoning behind this is that sometimes movies in the United States are released on DVD before they’re even released in theaters in other countries. Your Macintosh is set up to play discs from any region five times (meaning it is possible to watch five DVDs from any region on your Macintosh) before it decides on and locks in a region. Be mindful of this if you have any foreign release DVDs before you play them in your Macintosh. If you play more Region 2 DVDs than Region 1, the DVD Player application will lock into Region 2, making your Macintosh unable to play Region 1 (United States and Canada) DVD movies.
Watching Movie Files

Of course, the ability to watch DVDs on your computer is a nice convenience, but in my opinion, there’s a downright need for the ability to watch movie files, such as movie trailers at apple.com/trailers, or the strange commercials my friends send me all the time. Mac OS X can play most of these files through either QuickTime Player (included with Mac OS X) or Windows Media Player (downloadable from microsoft.com/mac).

QuickTime Player

QuickTime Player is the versatile video player included with every Macintosh. It’s found, not surprisingly, in /Applications. It can play QuickTime movies, AVI files, MPEG movies, and many more movie and audio files. It even supports automatic updates for adding support of other video formats.

You can play a QuickTime video by double-clicking the video’s icon or starting QuickTime Player from /Applications. Open a movie in QuickTime by opening the File menu and clicking one of these options:

- New Player will open a new QuickTime Player window.
- Open Movie in New Player... will open a movie file located on a disk, such as your hard drive or a CD.
- Open URL in New Player... will open a movie file at a specified URL.
- Open Recent will show a menu displaying your recently played movies.
Figure 5-20: The QuickTime Player controls are similar to those on a VCR or DVD player. To jump to a specific point in the video, drag the down arrow slider to the point in the video you want to watch.

You can configure QuickTime Player from System Preferences. Click the apple on the toolbar, click System Preferences, and then choose QuickTime under Internet and Networking. From here you can set QuickTime to play movies automatically, set your Internet connection speed, and update QuickTime with the latest updates from Apple.

Figure 5-21: In the Update tab of the QuickTime preferences window, you can elect to install third-party QuickTime software.
Turn on Install new 3rd-party QuickTime software and click the Update Now... button. A window will appear with a Custom button on it. Click that button and the QuickTime Component Install window will appear with a list of third-party components you can install, such as Axel and Streambox.

Tip:
Those who watch DivX movie files on PCs will be happy to know that they can be watched on Macs, too. You just need to download a DivX codec from VersionTracker.com to enable DivX support in QuickTime Player.

Windows Media Player

To watch video files that are in the Windows Media Video (WMV) format, you will need the Windows Media Player. You can download it from Microsoft’s Macintosh site at microsoft.com/mac. Once downloaded and installed, you will be able to play both video and Windows Media Audio (WMA) files.

Figure 5-22: Windows Media Player works similarly to QuickTime Player. It has buttons that mimic the ones on your VCR.
Windows Media Player for the Macintosh works a lot like Windows Media Player for Microsoft Windows, but it lacks some of the features found in the Microsoft Windows version. It does a fine job of playing WMV and WMA files, but lacks features like the Media Guide. Most Macintosh users prefer iTunes and QuickTime Player for music and movie files anyway.

**Managing Your Schedule**

Mac OS X has an awesome application for managing your schedule and calendar events. It’s called iCal, and it can be found in your /Applications folder. iCal lets you define multiple color-coded calendars, so you could have one calendar for your home events, like dentist appointments and music recitals, and one calendar for your work events, such as project meetings and product releases. You could even have a calendar for friends’ and family members’ birthdays.

![iCal calendar](image)

Figure 5-23: You can show and hide calendars by clicking the check box next to the calendar.
iCal also lets you subscribe to other calendars. There are hundreds of calendars to choose from. Sports team schedules, television listings, meteor showers, lunar eclipses, and concert dates are a few of the calendars you can subscribe to. (You can find calendars at icalshare.com and apple.com/ical/library.)

**Tip:**
You can change your iCal view (day, week, month) by clicking the corresponding button at the bottom of the iCal window. You can also navigate through months by clicking the arrow buttons.

**Address Book**

Mac OS X includes a full-featured contact management tool called Address Book, located in /Applications. Address Book is available to all Mac OS X applications (although not all of them use it). The contacts in your Address Book are accessible to Mail (discussed later in this chapter) and iChat (also discussed later). You can import and export contacts, and even sync your contacts with a mobile phone, personal digital assistant, and iPod using iSync (discussed in Chapter 7).

![Address Book](image)

Figure 5-24: Address Book displays all of your contacts in a list and displays a card for the contact when you click the contact’s name. You can even associate a picture with the contact.
If you have a large number of contacts, you can search for a specific contact by typing data in the Search box. It will return results very quickly.

**Running Classic Applications**

Occasionally, you might need to run a Mac OS 9 application for some reason. (I have an old astronomy program that is a Mac OS 9 application.) Mac OS X can launch these applications using a special program called Classic. Generally, you can just double-click the application's icon. If the Classic environment hasn’t already started, it will start automatically, and then your Mac OS 9 application will launch.

![Classic Applications Window](image)

Figure 5-25: This is what you’ll see when the Classic environment is starting up. Mac OS X is actually running a copy of Mac OS 9 to support your Mac OS 9 application.
You may never use Classic, but there are still Mac OS 9 applications out there that some people can't live without. It's nice to have the ability to use them if you find the need.

**Switching Applications**

I always have several applications in use at once. My email program, my web browser, and one or more chatting programs are perpetually open. I also use Microsoft Word a lot, iTunes for listening to music, Terminal (which I talk about in Chapter 10), and there are usually some development tools running too. Needless to say, my desktop can get quite crowded.

**Command-Tab**

Let's say I'm in the process of using Microsoft Word to write some documents for publishing on the web. I also have a couple of chat windows, a Finder window, iTunes, and Terminal open. In the middle of my typing, I realize that a song I don't want to hear is playing and I want to skip the track. To skip it, I could move my right hand from the keyboard to the mouse, click the iTunes application icon in the Dock, click the fast-forward arrow in iTunes, click the Microsoft Word application icon in the Dock, and then click the document I'm working on and resume my typing. Executing this series of steps is commonplace, but why bother going through all of those motions when it's possible to get the same results with just a few keystrokes?

You might already know that Microsoft Windows has an application switcher that is accessible by pressing Alt-Tab on your PC keyboard. Well, Mac OS X has pretty much the same thing. Pressing Command-Tab on your keyboard in Mac OS X pops up an attractively rendered application switcher that contains the icons of all of your currently open applications. As you hold down Command, press the Tab button to toggle through your active application icons. Release the keys when the
application you want to switch to is highlighted, and that application will become active.

![Figure 5-26: The application switcher in Mac OS X works exactly the same way as the application switcher in Microsoft Windows.](image)

Switching to iTunes to change tracks is as simple as pressing Command-Tab until iTunes is selected, releasing to open iTunes, and then pressing the right arrow key to make iTunes skip to the next song. You then use Command-Tab to get back to the application you were working in.

**Exposé**

Consider my Microsoft Word scenario. With all of those applications open, I have many windows to deal with. One application can have several windows of its own, and when you combine all the individual application windows together, you have what is called *screen real estate clutter*. Hiding an unused application with Command-H is an acceptable way to reduce this clutter, but it doesn’t really solve your clutter problem when you need to access all of your open applications frequently. For example, if you’re typing in Microsoft Word and you need to check your research in Safari, it would be very troublesome to hide Safari in an effort to reduce screen real estate clutter, only to have to show it again every time you want to look at a web page. Screen real estate clutter is annoying, but Mac OS X comes with an awesome tool to help you deal with it. It’s called Exposé.

Exposé offers three ways for you to deal with screen real estate clutter, and best of all, each is available with a single keystroke (you can also assign Exposé functions to other keys and even to buttons on your mouse; more on that later).
Show All Windows

The first Exposé function is Show All Windows. You can execute it by pressing the F9 key on your keyboard. This function effectively shows you every window that you currently have open by shrinking them down and spreading them out on your desktop so that they no longer overlap each other. As you move your mouse pointer over each window, the title of that window appears to help you find the one you’re looking for. When you locate the window you want to activate, click it and it will be brought to the foreground.

Figure 5-27: Exposé’s Show All Windows gives me a nice view of every open window. I can select a window by clicking it.

Note:

Exposé will not show the windows of any applications that are hidden or minimized. It only shows the windows of applications that are currently open and in view. This is by design: Exposé is intended to help you manage your screen real estate clutter. If the window isn’t in view (it’s hidden or minimized), it’s not contributing to the clutter.
Show Application Windows

The second Exposé function is Show Application Windows, which is executed by pressing F10 on your keyboard. When you execute Show Application Windows, Exposé will show you only the windows that are part of the currently active application, and darken everything else. For example, if I have three Microsoft Word documents open and piled on top of each other, I can execute Show Application Windows and Exposé will tile my Microsoft Word document windows over the other application windows, which will be darkened and left unaltered in the background. Then I can choose which Word document I want to work with.

Figure 5-28: Using Show Application Windows is extremely helpful when using an application that has lots of child windows, such as a development tool or a web browser. Here I am using Exposé to show all of my open Microsoft Word documents so I can easily find the one I want to work on.
Show Desktop

Occasionally, whatever you may be doing on your computer, you will find that you have a pressing need to do something on the desktop. This is especially the case when you have tons of icons on your desktop (Brian must have 30 or 40 icons on his Mac OS X desktop). You could always hide every application or minimize all of those windows, but you don’t need to. You could use Exposé’s third function, Show Desktop, by just pressing F11 on your keyboard.

Show Desktop moves all of your open windows out of the way (the edges of the windows will be visible on the perimeter of the screen) and gives you a full, clear view of your desktop. If you press F11 and immediately let it go, the windows will move and stay out of the way until you either click one of the windows or you press F11 again. If you press and hold down F11, the windows will move out of the way temporarily, and then spring back into place when you let go of the key.

Figure 5-29: Using Show Desktop, I was able to move everything out of the way and open a Finder window. Notice the window borders on the edges of my desktop.
Capturing Screen Shots

From time to time, you may find it necessary to snap a screen shot. In Microsoft Windows, you would press Alt-PrintScr (or just PrintScr) and paste the screen shot into an image editor like Microsoft Paint. Mac OS X offers two choices for snapping screen shots: You can use the included Grab application, or you can use a keystroke. Which one you should use depends on your specific needs.

Capturing via Grab

Grab can be found in/Applications/Utilities. When you launch it, its icon appears in the Dock, but you will not see an application window pop up. Grab is just a menu from which you can capture a screen shot. Click the Capture menu, and then choose the type of capture you want to use:

- **Selection.** This method of capture lets you drag a selection box around a specific area of your desktop that you want to capture, allowing you to take a screen shot of only a portion of the screen.

- **Window.** If you choose this method, Grab prompts you to select a window to capture. Click the window you want a screen shot of and Grab captures it.

- **Screen.** Choose this method to have Grab take a picture of the entire screen and all of its contents.

- **Timed Screen.** Use this method of capture when you want Grab to snap a shot of your screen after 10 seconds. This is useful when you need a screen shot of something in action.

When you execute your capture, Grab opens a window showing the results of your capture. If the screen shot is as you wanted it, you can then save it as a TIFF file.
Tip:
While Grab is a nice screen shot tool, you can alternatively use a third-party application to handle your screen shot tasks. Snapz Pro X is my favorite, and there are others available at VersionTracker.com.

Capturing via Keyboard Shortcuts

There are four keyboard shortcuts that will snap screen shots for you so you don’t have to bother with Grab. Depending on which shortcut you use, your screen shot will either go to a file or to the clipboard.

- Capture screen to file. If you want to capture the entire screen to a file, press Command-Shift-3. This will take a screen shot of your entire screen and save it as a PDF file on your desktop.

- Capture screen to clipboard. If you want to capture your entire screen to the clipboard, press Command-Control-Shift-3. This will put a capture of your entire screen in the clipboard, which you can then paste into your favorite image editing program.

- Capture selection to file. If you want to capture a selection and save it to a PDF file on your desktop, press Command-Shift-4. Your mouse pointer will change into a plus sign and you can drag a box around what you want to capture. The screen shot is automatically captured when you complete the selection.

- Capture selection to clipboard. You can capture a selection to the clipboard by pressing Command-Control-Shift-4. Drag and drop a box around what you want to capture and it will be saved in the clipboard.

These keyboard shortcuts can be changed in the Keyboard & Mouse Preferences window, which I discuss in Chapter 7.
Customizing and Configuring

Making your computing experience work for you is very important. Luckily, Mac OS X gives you quite a bit of control over how your system works. You can change icons, set up a screen saver, define a background picture, change the way the scroll bar works, and much more.

System Preferences

Most of your Mac OS X configuration is handled by System Preferences, which is a window consisting of little preference panes that allow you to configure your network settings, Dock, printers, and Mac OS X’s appearance, among other things. System Preferences is the Mac OS X equivalent of the Microsoft Windows Control Panel.

Figure 5-30: System Preferences varies from Macintosh to Macintosh, as some of the preferences are hardware-specific. Ink, for example, will only appear if you have a tablet connected to your Macintosh.
You can open System Preferences by clicking the Apple menu, and then System Preferences... or you can double-click the System Preferences icon in /Applications. (You may even have the System Preferences icon on your Dock; the icon looks like a light switch with the Apple logo on it.)

When you open System Preferences, the preferences icons are grouped together by function. This is a good configuration if you’re not familiar with all of the preference options and what they do. If you would rather access the preferences alphabetically, you can click the View menu and then choose Organize Alphabetically. This might make it easier to find the specific preference you want to work with rather than skimming through them in their groups. Use what works best for you.

Note:
This chapter doesn’t cover all of the preferences. Instead, I talk about the preferences in relevant chapters. Most of the preferences are covered in Chapter 9.

The System Preferences window has a toolbar, which contains a default list of preferences. You can customize this toolbar for your own needs by dragging the preference icons you refer to most and dropping them onto it. Remove preferences by dragging them off the toolbar and releasing them anywhere; they disappear into a cute puff of animated smoke. Clicking the rounded rectangle icon in the title bar hides the toolbar.

Figure 5-31: The System Preferences toolbar is very customizable. The top image is the default System Preferences toolbar, and the bottom image is my System Preferences toolbar, which I have customized to suit my needs.
When you click a system preference, the controls for that system preference take over the System Preferences window (these are called *preference panes*). When you are finished with that particular preference, you can click Show All on the toolbar to get back to the main System Preferences window. The changes you made are automatically saved.

**Note:**
Some preferences will be locked and can only be changed by an administrator. If you’re not the administrator of your Macintosh, you’ll need to ask the appropriate person to allow you to make changes. There’s a lock icon in the lower-left corner. Click it to change the access to the particular preference. Security is covered in Chapter 9.

**Dock Preferences**

In Chapter 4, you were introduced to the Dock. You may have added icons to it, removed icons from it, and maybe even changed its size. Now you can customize it a little more using the Dock preferences in System Preferences.

**Tip:**
You can access Dock preferences a few different ways. You can open System Preferences and click the Dock icon, you can click the Apple menu and select Dock Preferences... under the Dock menu item, or you can Control-click (or double-click) the Dock and pick Dock Preferences....

The Dock preferences pane offers the same options as the Dock menu found under the Apple menu or by Control-clicking the Dock, with one extra setting: Animate opening applications.
Size, Magnification, and Position

You can adjust the Dock’s size by dragging the slider back and forth between Small and Large. (You can also change the Dock’s size by clicking the dividing line in the Dock and dragging it up and down.)

Magnification is handy for Docks that have a large number of icons. It’s also a fun effect. When magnification is turned on, icons on the Dock grow bigger as you move the mouse over them. Use the Magnification slider to decide just how big you want them to get.

You can set the position of the Dock on your desktop by choosing one of the options: Left, Bottom, and Right. Bottom is the default, and a good choice for smaller monitors. If you have a wide-screen monitor, you might want to put your dock on the left or right to maximize your vertical screen space.
Minimize Effects

The Dock has two minimizing effects, which occur when you minimize an application to the Dock. The Genie Effect causes a minimized window to shrink down in a wave onto the Dock, as if it were a genie going back into its bottle. The Scale Effect causes the minimized window to simply scale down from full size to a small icon as it moves down into the Dock.

Figure 5-33: The Genie Effect is my personal favorite. If you hold down Shift when you click the minimize button, the window will slowly minimize to the Dock.

Animation and Hiding

You have two more options: animating opening applications and automatic hiding/showing of the Dock. The first option makes an application icon bounce in the Dock when you open it until the application’s startup sequence has completed. This is not just a cute effect; if you are doing something else while waiting for an application to open, you will know your application is ready to use when the icon stops bouncing.

The second option, when turned on, hides the Dock until you move your mouse into the area where the Dock is positioned.
The Dock will disappear again when you move the mouse away from it. (This behavior is the same as “Auto-hide the taskbar” in Microsoft Windows.) This is a nice option to have if you have a smaller monitor and want to maximize your screen real estate.

**Note:**

If you have both of these options turned on, you will not be able to see the icon animation unless you have your mouse placed near the Dock so that it is visible.

### Mac OS X Appearance

Microsoft Windows allows you to set the default colors and fonts via the Appearance tab in Display Properties, which is accessed through Display on the Control Panel or by right-clicking the desktop and choosing Properties. The Mac OS X equivalent is the Appearance preference, in the Personal section of System Preferences.

![Appearance preference](image)

Figure 5-34: The Appearance preference lets you choose colors and the behavior of scroll bars, among other things.
Mac OS X isn’t quite as configurable as Microsoft Windows in this area. For example, Mac OS X doesn’t support themes, and you can’t change the color of window borders or menus. This is by design; it ensures a consistent and familiar user experience.

Tip:
There are third-party programs you can install that will allow you to customize the appearance of Mac OS X. You can find a few at VersionTracker.com and Unsanity.com.

**Appearance and Color**

The first group on the Appearance preference pane allows you to choose between two colors for Mac OS X buttons, menus, and windows: Blue and Graphite. Blue is the default appearance. If you look at the other controls on the Appearance preference pane when Blue is selected you will see that the radio buttons and drop-downs are all blue. Choosing Graphite will color your buttons, menus, and windows gray. This setting is appealing to people who find the Blue appearance distracting.

You can also choose the highlight color for selected text and lists. You have a wider range of choices here. If you click Other..., you can choose a specific color. You’ll see this color when you click icons, select text, use list view or column view in Finder, and several other places.

**Scroll Bar and Window Behavior**

The second group of items in the Appearance preference pane allows you to configure your scroll bars. The default behavior for scroll bars in Mac OS X is for the scroll buttons to be grouped together. If you are used to having the buttons at the top and bottom of the scroll bar, as in Microsoft Windows, you can choose to have them placed this way instead. Figure 5-35 shows the two scroll bar styles.
In this area, you can also decide whether you want the scroll bar to page through documents when you click it or to scroll directly to the place where you have clicked.

The other two options in this group allow you to configure scrolling and minimizing. Smooth scrolling does just that; it smoothes the effects of scrolling windows, eliminating choppiness. Turning this option off will improve scrolling performance but you won't get the cool scrolling effect.

“Minimize when double clicking a window title bar” is pretty self-explanatory. When you turn this option on, Mac OS X will minimize a window to the Dock when you double-click its title bar. This feature is a carryover from the Mac OS days.

**Recent Items**

If you remember from Chapter 4, the Apple menu has a Recent Items submenu that shows the most recent applications you’ve launched and the most recent documents you’ve opened. The third group in the Appearance preference pane allows you to set the number of recent applications and recent documents that will show up in the Recent Items submenu. Choosing None will cause the Recent Items submenu to disappear from the Apple menu altogether.
Font Smoothing

Mac OS X features built-in antialiased fonts. Antialiased fonts are much smoother and easier to read on your Macintosh, whether you're looking at a web page or an application document. Antialiasing is a graphics trick that smoothes the jagged edges on text. In the font section of the Appearance preference pane, you can set Font smoothing style to one of four choices:

- **Standard** - best for CRT. Use this setting if you have a CRT monitor, the classic tube-based monitor that looks like a television (the eMac and old iMacs have CRT monitors). This setting does not apply antialiasing to fonts.

- **Light.** This setting will add slight antialiasing to your fonts. This setting is best for people who like the sharp edges of fonts but don't want them too sharp.

- **Medium** - best for Flat Panel. This is the setting you should be using if you have a flat panel iMac or if you're using an LCD display with your Macintosh. It will apply just the right amount of antialiasing to make your fonts look great. This setting is very similar to the ClearType setting in Microsoft Windows.

- **Strong.** If you don't want your fonts to have any edges at all, turn on Strong. Your fonts will be very smooth. This is especially attractive to people who use large fonts in Mac OS X.

You may notice that some smaller fonts are difficult to read with font smoothing turned on. You can use the Turn off text smoothing option to choose what point size should be left alone (not smoothed). For example, if you choose 12, then font smoothing will be turned off for text that is 12 point or smaller.
Changing your Desktop Background

Possibly the most popular way to customize a Macintosh is to change the background image. Some people like to have pictures of their families on their desktops; others like to have pictures of cars or perhaps a funny image. Whatever your preference, as long as you have it in an image file format (.jpg, .gif, .bmp, etc.), Mac OS X can use it as your background image.

In Microsoft Windows, background images are configured in the Desktop tab of the Display Properties dialog. In Mac OS X, you can change your background image through a similar set of steps. You can open System Preferences and click the Desktop & Screen Saver preference, or you can Control-click (or right-click) the desktop and choose Change Desktop Background.... Either choice takes you to the same window.

Figure 5-36: Changing the desktop background on Microsoft Windows involves navigating a list of images or clicking the Browse... button to load a specific image. The Desktop & Screen Saver preference in Mac OS X System Preferences is a little more organized and it offers something special: automatic desktop picture changing.
In the Desktop & Screen Saver preference in Mac OS X, you can choose from several different sources for a background image:

- Apple Background... contains images that are muted with soft designs.
- Nature images feature a nature theme, like a leopard print and a ladybug on a leaf.
- Abstract contains images with wild colors and swirled designs.
- Solid Colors are just that: solid colors with no images.
- Pictures Folder is linked to the Pictures folder under your home folder. Any images located there will be available with this option.
- Images is a folder located under /Library. It contains all of the Mac OS X-included images (found in Apple Background..., Nature, and Abstract). You can place your picture files here if you want, but it's not necessary.
- Choose Folder... allows you to specify a folder containing images from which you can select to use as your desktop background.

**Setting a Picture as Your Background**

To set one of the included backgrounds as your desktop, click one of the built-in pictures from any of the first three folders (the same goes if you want to use one of the preselected solid colors in the fourth folder). If you want to use your own folder, click Choose Folder... and select the folder containing the pictures you want to use for your background. Click the folder in the list and then click the picture you want to be your desktop background.
There is one last way to make a picture from your files your desktop image: Open a Finder window and navigate to the image you want to place as your desktop, then drag and drop the image file from the Finder window onto the box in the Desktop & Screen Saver preference that shows your current desktop image. The only problem with this method is that it will not work with every picture. The computer will automatically make whatever picture you choose fill the whole screen, which could cut off parts of the picture, especially if it is taller than it is wide. Pictures that are close to the dimensions of your monitor work best with this method.
Figure 5-38: You can drag just about any image file to the desktop area in the Desktop & Screen Saver preference and the image will immediately become your background.

**Automatically Changing Desktop Images**

One of the neat features of Mac OS X is the ability to have your desktop background change itself automatically at a specified interval. First, choose a folder containing the desktop images you want to use. You can choose any one of the background folders from the Desktop & Screen Saver preference, such as the Nature folder or the folder that was chosen the last time you used the Choose Folder... option. If you have pictures in iPhoto that you’d like to cycle through as backgrounds, you can even choose Photo Library. (iPhoto is covered in Chapter 7.)
Next, turn on Change picture at the bottom of the pane, and set the time interval to how often you want the background pictures to switch. There are several time lapses to choose from, ranging from every five seconds to once per day. Next to that menu, there is an option for Random order. If you turn this on, the desktop image will be selected at random from the folder that you chose. If you leave it off, the pictures in your chosen folder will cycle in order.

If you decide you don’t like this option after all, simply turn off Change picture and your desktop will be restored to whatever it was previously, even if the original background isn’t in the folder you chose for Change picture.

**Screen Savers**

In the past, screen savers were intended to prolong the life of a monitor. Older CRTs suffered from burn-in; if an image was left on the screen for too long it would be permanently burned into the monitor (you would be able to see a ghost of it, even if the original image was no longer there). You may have noticed this problem on older ATMs or stand-up arcade games.

So the screen saver was originally developed to combat burn-in, and then somewhere along the way, the screen saver turned into screen entertainment. They aren’t really necessary anymore (especially on LCD flat panel monitors, which cannot burn in), but several screen savers are included with Mac OS X nonetheless. If you’re concerned about burn-in, or if you enjoy a little variety when you’re not using your computer, a screen saver is right up your alley.

**Setting up a Screen Saver**

Your screen savers can be accessed via the Desktop & Screen Saver preference. Click the Screen Saver tab and choose one of the built-in screen savers.
You can also opt to use a slide show of images from one of your own folders as your screen saver. Click either the Pictures folder (if there are images in it) or Choose folder... to select any folder containing images. If you have pictures in iPhoto, you can also pick Photo Library. Another option is to turn on Use random screen saver, which will randomly choose one of the screen savers whenever it is supposed to start up. You can click the Options button to set screen saver-specific options.

**Set the Timer**

The Start screen saver bar lets you choose how many minutes your Macintosh sits unused before the screen saver kicks in. Just drag the slider to the number of minutes you want it to wait before turning on the screen saver. If you set the slider between two of the numbers on the bar, the screen saver will come on.
after a corresponding number of minutes (there's really no way to tell exactly how long).

**Hot Corners**

If you click the Hot Corners... button, the Active Screen Corners pane pops up. You can use this function to assign certain tasks to the corners of your screen. Whatever task you assign will be carried out when you move your mouse pointer into that corner of the desktop.

The Active Screen Corners pane has a representation of a Mac OS X desktop with a drop-down menu in each corner. Each of the four drop-down menus has the same options. The first two options pertain to the screen saver. If you pick Start Screen Saver in one of the drop-down menus, then anytime you move the mouse pointer into that corner, the screen saver will immediately start up.

If you select Disable Screen Saver in one of the drop-down menus, the screen saver will be temporarily turned off when your mouse moves into that corner. The hot corner actions only hold while your mouse pointer is in that corner. For example, if you have the lower-right corner set to Disable Screen Saver, the screen saver will only be disabled while your mouse pointer is sitting in the lower-right corner. As soon as you move the mouse out of that corner, the hot corner is no longer active.

The other selections in the drop-down menu set the hot corners for Exposé. These options work the same way as F9, F10, and F11 (as described previously in the Exposé section of this chapter), except that moving the mouse pointer into the designated corner of the screen will activate the chosen function, in addition to its corresponding function key. In other words, if you set the upper-right corner of your screen to All Windows, and then move your mouse pointer into that corner, you will get the same result as pressing F9 on your keyboard.
Energy Saver

The Energy Saver preference is equivalent to the Power Options settings in Microsoft Windows. It is found under the Hardware group in System Preferences. Energy Saver is important for conserving energy and prolonging the life of your display. It is especially important if you have a flat panel monitor; turning off your flat panel monitor when it's not in use will significantly increase the life of the monitor.

Sleep

In the Sleep section of Energy Saver, you can tell Mac OS X to put your entire computer to sleep after a specified period of inactivity (in other words, after a chosen amount of time where your Macintosh isn’t being used by someone or doing anything on its own, like downloading files). As the name suggests, putting your computer to sleep when you are not using it saves energy, quite a bit of it in fact. Most people set this to a higher setting, like one hour, so that the computer doesn’t put itself to sleep when they’re only going to be away for a few minutes.

In this section there is also a separate sleep timer for your display (monitor); you should set the time on this to a relatively low setting, like 10 or 15 minutes, to best preserve the life of your display. The monitor takes less time to wake up than the computer does.

If you have a screen saver turned on and you set your display’s sleep timer to a time shorter than your screen saver’s activation time, Mac OS X will tell you that your display will go to sleep before the screen saver activates. It’s just a friendly warning; it’s not an error.
Figure 5-40: I set my display sleep to one minute and Mac OS X let me know that my screen saver won’t activate with this setting.

When turned on, the final selection in this window puts your hard disk to sleep when it is not in use. This is a simple on/off option that will spin down your hard disk when it’s not doing anything, preserving the life of your hard disk and consuming less power. If you have more than one hard disk, turning this option on will apply to all of them.

**Schedule**

You can use the Schedule tab of the Energy Saver preference pane to schedule a startup time and shutdown or sleep time for your Macintosh. This is a great way to conserve energy, since the only time your computer isn’t drawing energy is when it’s turned off. To set a time, turn on the option by putting a check mark in the box, and then choose the day and time.
Figure 5-41: I choose to start up my Macintosh every day at 8:00 A.M., and shut it down every day at 1:00 A.M. If you don't want to do a hard shutdown, choose the Sleep option instead.

**Options**

The Options tab allows you to specify how your Macintosh should wake up and what to do after a power failure. You can choose Wake when the modem detects a ring if you plan to have people dial into your computer (like if you use it as a fax machine). Choosing Wake for Ethernet network administrator access will wake up the computer when administrators access your Macintosh over a network. The Allow power button to sleep the computer option will allow you to press the power button to put the Macintosh to sleep (this is the default behavior).
### Energy Saver

<table>
<thead>
<tr>
<th>Show All</th>
<th>Displays</th>
<th>Sound</th>
<th>Network</th>
<th>Startup Disk</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Energy Saver</strong></td>
<td><strong>Show All</strong></td>
<td><strong>Displays</strong></td>
<td><strong>Sound</strong></td>
<td><strong>Network</strong></td>
</tr>
</tbody>
</table>

#### Sleep | Schedule | Options

**Wake Options**
- [ ] Wake when the modem detects a ring
- [x] Wake for Ethernet network administrator access
- [ ] Allow power button to sleep the computer

**Other Options**
- [ ] Restart automatically after a power failure

---

**Click the lock to prevent further changes.**

---

**Figure 5-42:** The Options tab lets you define some behaviors for your Macintosh pertaining to when it wakes up and when a power failure occurs.

The last option, Restart automatically after a power failure, does just that — it restarts your Macintosh immediately after a power failure. I leave this turned off because I don’t want my Macintosh to keep restarting if power is fluctuating, such as during a mild storm.

---

### Have a Conversation with Your Macintosh

Two of the coolest features of Mac OS X are its built-in speech recognition and a set of computer-generated voices that will speak to you. You can access the speech recognition and voices through the Speech preference in System Preferences (it’s in the System group). The Speech preference in Mac OS X is the equivalent of the Speech option add-on in Microsoft Windows.
Apple Speakable Items

The Mac OS X speech command system is called Apple Speakable Items. Speech recognition in Mac OS X isn’t true speech recognition. It doesn’t type out what you say. Rather, it’s a system that allows you to speak commands to your Macintosh, such as “Get my mail,” and Mac OS X will follow your instruction (in this case, it will open your mail application).

Note:

You will need a microphone in order to use Apple Speakable Items. The flat panel iMac has a microphone built in.

The Speech Recognition tab has three tabs of its own. The On/Off tab is, predictably, where you can turn Apple Speakable Items on and off. When the recognition system is turned on, a small microphone appears on your desktop. The word in the microphone — the default is Esc — is the listen key, the key that you press to activate speech recognition. In the On/Off tab you can also opt to have the Speakable Items turn on when you log in.

The Listening tab lets you configure Speakable Items to listen for a command when a certain key is pressed. Click the Listening tab to choose the microphone and tell Speech how you want listening to be activated.

Click the Commands tab to turn on and configure the speakable commands. For example, you can turn on the Address Book command set so that you can speak the names in your address book to send mail.

Figure 5-43: This is the microphone that appears on your desktop when Speakable Items is turned on. The word on the microphone shows what key will activate speech recognition. Click the arrow button to open or close the command list.
You can have a lot of fun playing with the speech recognition. Here’s something to try. Turn on speech recognition; the microphone will appear on your desktop. Now hold down the listen key and say, “Show me what to say.” The Speech Commands window will appear with a list of commands. Hold down the listen key and say, “Tell me a joke.” Your Macintosh will tell you a knock-knock joke, and the acceptable commands will appear in the Speech Commands window. Of course, the obvious answer is, “Who’s there?” You may have to practice with it a while before your Macintosh gets used to your voice. Be sure you ask, “What time is it?”

**Voices**

You can talk to your Macintosh via Apple Speakable Items, and your Macintosh can talk to you via its built-in voices. There are 22 voices you can choose from, spoken in all kinds of ways (there’s even one that speaks in a dirge; it’s called Bad News).

![Speech Recognition](image)

**Figure 5-44:** You can turn on Talking Alerts by putting checks next to Speak the phrase and Speak the alert text. Click the Demonstrate Settings button to test it out.
You can have your Macintosh read alerts aloud (like when an application is telling you something), you can have it read text that you move your mouse pointer over, and you can have it read selected text when a key is pressed.

This last option is the most powerful and useful. Imagine you've written a short story and you want to have it read back to you. In the Spoken User Interface tab of the Speech preference, turn on Selected text when the key is pressed. A window will appear asking you to enter a keyboard shortcut. You can choose any keys for your shortcut; just press them and click OK (mine is Command-Shift-S).

Now, in your word processing program containing your short story, select all of the text (Command-A will do it in most applications) and hit the keystroke you defined for speaking. Your Macintosh will read back what you wrote in the default voice.

**Setting Sounds**

Unlike Microsoft Windows, Mac OS X doesn’t allow you to assign sounds to operating system events. Mac OS X only makes one sound, an alert. There are no sounds for clicking menus, minimizing windows, or shutting down.

You can change your alert sound using the Sound preference under Hardware in System Preferences. There are many alert sounds to choose from. You can also use the Sound preference pane to choose your output device (such as external speakers) and your input device (such as the internal microphone in an iMac).

Some Mac OS X applications have their own built-in sound schemes. Microsoft Entourage, for example, has its own set of sounds that are associated with different events, such as new mail, sending mail, and deleting mail.
Figure 5-45: The Sound preference pane has sliders for controlling the alert volume and the system volume. I recommend keeping Show volume in menu bar checked unless your speakers have their own volume knob. That way you’ll have easy access to a volume control.

Setting the Date and Time

When you turn on your Macintosh for the first time, the initial setup process will set your date and time. If you need to adjust the date or time, or configure the date and time settings (such as time zone), use the appropriately named Date & Time preference in System Preferences.

The first tab in the Date & Time preference is where your main changes are made. First, it has an option for setting the date and time automatically via the Internet. Obviously, this only works if you have an Internet connection. When turned on, this option sets your Macintosh’s date and time by getting the information from a time server. If you want to manually change your date and/or time, you must first turn the auto set off. Then you will be free to enter the new date and time by clicking on the calendar or digital clock. Your Macintosh will automatically update
itself for daylight saving time if you select a time zone that observes it.

The second tab in the Date & Time preference is where you specify what time zone you want your computer to observe. Click your location on the map or your closest major city in the drop-down menu to select your time zone.

The final tab, Clock, lets you tell Mac OS X how you want your clock to be displayed (digital or analog), along with some other options.

![Date & Time Preference](image)

Figure 5-46: If you turn on the Window option next to View in, you get a cool floating clock that you can place anywhere on your desktop.

You can also turn on Announce the time to have a voice tell you what time it is at an interval you specify (such as on the hour). Click Customize Voice to choose the voice in which the computer will tell the time, and the rate and volume at which it will speak.
Note:

You can change the format of the date and time from the United States standard to the standard of another country, such as the United Kingdom. To do this, from System Preferences click International, then click the Formats tab and change the region to the one that suits you. Be sure to turn on “Show all regions” if your country doesn’t show up in the drop-down menu at first. You can also use the International preference to format numbers, select keyboard layouts, and add other language support.

Universal Access

Mac OS X supports users with disabilities by providing visual cues for events, text zooming, white-on-black text, and so on. These options are configurable in the Universal Access preference in System Preferences (it’s in the System group). This preference corresponds to the Accessibility Options in the Microsoft Windows Control Panel.

Figure 5-47: Universal Access has several options for accessibility for the impaired.
The two options at the bottom of the screen let you turn on access for assistive devices (such as Braille keyboards and screen readers) and text-to-speech for the Universal Access preference (the computer will read the options in the Universal Access window for you as you hover over them).

Universal Access supports options for users who have difficulty seeing, hearing, using a keyboard, or using a mouse. Click the Seeing tab to set visual options, such as zooming and contrast. Click the Hearing tab to set volume and visual cues (Mac OS X can make the screen flash when an alert occurs, such as a new mail chime). Click the Keyboard tab to enable one-handed keyboarding support and key delays. Finally, click the Mouse tab to activate Mouse Keys (lets you control the mouse pointer with the keyboard) and mouse pointer movement.

**Changing Icons**

Microsoft Windows requires you to jump through hoops to change an icon. You have to right-click the file/folder/application, choose Properties, and then click the Change Icon... button. You can only choose icons that are in icon libraries or that exist as .ico files.

Mac OS X is light-years ahead of Microsoft Windows in this area. It gives you a quick and easy way to change any object's icon for which you have write permissions. (Permissions are covered in Chapter 9.)

To change an icon, click the object in Finder whose icon you want to change, and open Get Info for that object (File, Get Info). Now find the icon that you want to use. It can be an icon file or it can be any other object in Finder. Open Get Info for that object, so that you have two Get Info windows open, one for the folder where you want the icon and one for the picture you want as your new icon. See Figure 5-48 for an example.
Here's how you change the icon:

1. Click the source icon in the Get Info window. It should have a blue outline to show it's selected.

2. Click the Edit menu and then Copy.

3. Click the target icon in the Get Info window you want to change so that it has a blue outline.

4. Click the Edit menu and then Paste.

Voilà! Your icon is changed.
Getting Online

Getting online with a Macintosh is wonderfully easy. The first step is, of course, physically connecting your Macintosh to your network. If you are using dial-up, plug a phone cable from your Macintosh's modem into an available telephone jack (usually in your wall). If you're using broadband, connect an Ethernet cable from your Macintosh's Ethernet port into your DSL modem, cable modem, broadband router, or whatever device you use to connect your broadband. If you're using AirPort or another wireless networking device, make sure the device is installed and the wireless router (and other pertinent equipment) is turned on.

Network System Preference

Once your physical connection is in place, you're ready to get connected. If you already hooked up all of your Internet hardware when you set up your Macintosh, and told it to connect to the Internet when you turned it on for the first time, you might be able to skip this step and go straight to the discussion of web browsers.

Open the Network preference in System Preferences. Unfortunately, everyone's Internet connection is different, so it's not possible for me to guide you through every step of setting up yours. My recommended process for establishing your Internet connection consists of two steps:

1. Find your existing network settings for your dial-up or broadband connections. On your Microsoft Windows machine, open the Network Connections option on the Control Panel (if you have Microsoft Windows XP), the Network and Dial-up Connections option on the Control Panel (if you have Microsoft Windows 2000), or the Network option on the Control Panel (if you have Microsoft Windows 98 or Microsoft Windows ME). This will show you your current settings.
2. On your Macintosh, in the Network preference, select Network Status from the Show drop-down. Now click the Assist Me... button at the bottom of the Network preference window. This will start a Network Setup Assistant, which will ask you questions about how you want to connect to the Internet. You choose your connection type, such as dial-up or AirPort. As you go through the setup, check your Microsoft Windows network settings for the answers to Network Setup Assistant’s questions.

If you have trouble, you should contact your Internet service provider. They will be able to guide you through the process of setting up your Internet connection.

Web Browsers

Mac OS X includes two web browsers, Safari and Microsoft Internet Explorer 5.2 for Macintosh. Which one you choose to use depends a lot on how you like to browse the web, as the two have very different features.

Safari

Safari is Apple’s first contribution to the Macintosh browser market; you can find it in /Applications. It’s fast, free, powerful, and it does a pretty good job of displaying complicated web sites. It supports Macromedia Flash, Macromedia Shockwave, Java, JavaScript, and most of the other web technologies you’ll encounter in your web travels.

Note:

If your Macintosh doesn’t already have Safari installed, you can download it from apple.com/safari.
Safari works just like most other web browsers. Type your web site into the URL box (the box with an icon that looks like a planet) and press Enter on the keyboard to load the site. You can bookmark sites, add sites to the bookmark bar, and manage your saved bookmarks using the Bookmarks menu. As a great convenience, there is a built-in search box in the upper-right corner of the browser window, which searches the highly popular Google search engine for whatever information you type in the box.

Safari also blocks pop-up ads. You can turn this feature on by clicking the Safari application menu, and then clicking Block Pop-Up Windows. If the check mark is next to this menu item when you open it, it's already activated.

Yet another really cool feature of Safari is tabbed browsing. Instead of opening a web page in a new window, you can elect to open it in a tab in the current window. See Figure 5-49 for an example.

![Figure 5-49: Two related web sites (they both have Macintosh prices) in two tabs, both in one browser window.](image-url)
Tabs are designed to help reduce desktop clutter while browsing multiple web pages, and they work wonderfully to this end once you get used to using them. I use tabs a lot, but my wife does not; she has trouble remembering that all of the sites she’s looking at are in the same window, and when she’s finished looking at a web page, she often accidentally closes the whole browser window instead of closing only the individual tab she was using. Exposé is better for her in this case, and might be a better solution for you if you find you have a similar problem.

Tip:
If you want to use keyboard shortcuts, type this into Safari’s URL box: file:///Applications/Safari.app/Contents/Resources/Shortcuts.html.

Microsoft Internet Explorer 5.2

Mac OS X also includes Microsoft Internet Explorer 5.2, a browser that still holds its own against newer web browsers like Safari and Mozilla Firebird. Internet Explorer is fast, reliable, and feature-packed.

To use Internet Explorer, open it from /Applications. It works the same way as Internet Explorer for Microsoft Windows, so it should be familiar to you. Internet Explorer for Macintosh doesn’t have quite the same layout as its Microsoft Windows cousin, but in a lot of ways, it’s actually better.

Internet Explorer has five tabs on the left side of the window. These aren’t tabs like in Safari, but rather tabs that contain specific information for your browsing experience. The Favorites tab shows all of your bookmarks. History shows a list of all the web sites you’ve visited using Internet Explorer. Search brings up a search box, similar to the Google search in Safari but not attached to the Google search engine. Scrapbook is a handy feature that allows you to drag images from web pages into the Scrapbook window, creating an Internet scrapbook of images you like as you surf the web. Finally, the Page Holder tab allows you
to browse any page through just a list of links. To use it, click the Page Holder tab, click Add, and then click the Links button.

In my opinion, the coolest feature in Internet Explorer for Macintosh is the Auction Manager. Auction Manager can monitor eBay auctions that you are bidding on and alert you if you’re outbid. You can also use Auction Manager to keep track of auctions you’re interested in, without bidding on them. I generally use it to keep track of a list of eBay auctions I’m considering bidding on before they end.

To use Auction Manager, open Internet Explorer, browse to eBay, and find an auction. Any auction will do; you don’t have to bid on the auction to keep track of it with Auction Manager. Now click the Tools menu and then click Track Auction. Enter your eBay user ID (don’t worry, it won’t bid for you), and click Track. Internet Explorer will now track the auction for you.

If you’re bidding on the item, you can have Auction Manager email you when you are outbid and when the auction ends. There are a few other notification options as well.

![Info for 1972 BLYTHE W/ORIGINAL BOX MINTY BRUN...](image)

The controls below may be used to customize the description of the auction you have chosen to track. These settings are also used by Internet Explorer to determine when the auction’s status has changed.

- **Name:** 1972 BLYTHE W/ORIGINAL BOX MINTY BRUN
- **URL:** http://cgi.ebay.com/ws/i?item=11972
- **Status:** Auction is Open
- **User ID:**

**Auction Close**
- **Date & Time:** Sunday, December 7, 2003 2:00 AM
- **Closes in:** 0 Days, 8 Hours, 13 Minutes.

Figure 5-50: If you click Customize instead of Track in the Track Auction window, you can customize your tracking settings and the auction’s description in Auction Manager.
Unfortunately, Microsoft has decided to no longer update Internet Explorer for Macintosh, citing competition from Apple’s Safari. That means Internet Explorer's future does not include tabbed browsing or pop-up blockers, at least not on the Macintosh.

Mail

Microsoft Windows includes a free email program, Outlook Express, which does a decent job of sending, receiving, and managing email. Mac OS X includes its own free email program, Mail, which does an excellent job of sending, receiving, and managing email.

Mail is a very useful, full-featured email application for Mac OS X, on par with the better (and sometimes costly) email programs for Microsoft Windows. And incidentally, Mail blows Outlook Express out of the water. It includes message grouping (you can have messages automatically grouped together by subject) and an exceptional junk mail filter. It supports four account types: IMAP, POP3, .Mac, and Exchange (through Outlook Web Access).

Figure 5-51: I love Mail for one main reason: its incredible junk mail filtering options.
iChat

Instant messaging (IM) is a cultural phenomenon. It’s a fun and easy way to stay in touch with friends, loved ones, and colleagues, and a great way to make new friends. I have a couple of friends who met on a discussion forum, fell in love via instant messaging, and now, three years later, they’re happily married with a beautiful baby girl.

Mac OS X has an awesome IM application called iChat, found in /Applications. I can’t guarantee iChat will find you true love, but if you want to converse with people using text, audio, and/or video, iChat is the program for you.

![Image of iChat conversation]

Figure 5-52: I’m chatting with Daniel about how great iChat is.

iChat uses the AOL Instant Messenger (AIM) network, so if you’re already an AIM user on your PC, using iChat is as simple as logging into your AIM account. Unfortunately, you can’t access your AOL buddy list from iChat; you’ll have to add all of your buddies to Address Book before you can add them to iChat.
Tip:
If you’re not an AIM user, you can choose from one of the several other IM clients for Mac OS X, including Yahoo Messenger, MSN Messenger, Jabber, and ICQ. If you used Trillian on your PC to connect to multiple services, take a look at Fire for Mac OS X, found at VersionTracker.com.

Summary

This chapter provided you with information to help you learn how to get the most out of your Macintosh computer. I hope that you are now fully comfortable with moving around in Mac OS X. The skills you acquired in this chapter will be with you throughout your Macintosh experience. The most important thing is that you come away from this chapter with the ability to sit down at your Macintosh and do what you want to do with it. I also hope you spend some time customizing your Macintosh and making it suit your personality. In the next chapter, I’m going to help you move your files from your PC to your Macintosh. Then you can start getting some real work done!
Most people who switch from Microsoft Windows or Linux to the Macintosh want to keep the files from their old machines; very few people make a clean start with a Macintosh and just trash all their old files and emails. If you are one of those few, however, feel free to skip this chapter.

Fortunately, Mac OS X makes moving your files from your PC to your Macintosh very easy. This chapter will show you several ways to move your files, folders, contacts, and other PC items to your Macintosh. Each method has a difficulty rating (how hard it is to set up and execute the transfer), a speed rating (a rough measurement of how long it will take to set up the connection or hardware and transfer your files), and a cost (how much you are going to have to spend). The ratings will help you find a balance between effort, patience, and expense.

Note:

There may be other methods in addition to what I present here; I’ve tried to cover the most common methods for moving files from a PC to a Macintosh.
Prepare for Your Move

Before you move anything over to your Macintosh, you need to prepare the files on your PC for the trip. If you take the time to organize your files into manageable folders on your PC, putting those files in their proper places on your Macintosh will be a much simpler affair once they are moved over.

**Note:**
If you are going to use Detto’s $50 Move2Mac software to make your move, you can skip this section. Move2Mac automatically knows what to do with your files based on their types.

I suggest you create several folders on your PC, with each folder containing a certain type of file (one folder for music files, one for documents, and so on). That way, you’ll know right where your files are located once you get them on your Macintosh, and you won’t have to spend a lot of time navigating through folders to find the right document.

On your PC, create these folders and copy the corresponding files that you wish to move over into the folders:

- **Documents.** This folder should contain your Microsoft Office documents, your Quicken data files, your text files, and any other documents on your PC.

- **Pictures.** Put your wallpapers, photographs, icons, and other pictures in this folder.

- **Movies.** If you have any movies (such as MPEGs and AVIs) on your PC, put them in this folder. This includes movies you’ve made and those you’ve downloaded.

- **Music.** This is where you put your MP3s, WAV files, WMA files, and any other music on your PC.
• **Favorites.** Export your favorites and put the file(s) in this folder. Detailed instructions for this folder are below.

• **Contacts.** This is a little more involved. I talk about this folder right after the Favorites folder.

---

**Preventing Your Favorites/Bookmarks**

To transfer your favorites/bookmarks over to your Macintosh, you first need to export them from whatever web browser you use in Microsoft Windows. Each web browser is different; I’ll tell you how to export your favorites/bookmarks from a few of the most popular web browsers for Microsoft Windows.

---

**Note:**

“Favorites” and “bookmarks” are the same things. Microsoft Internet Explorer calls them favorites, while Mozilla and Netscape Navigator call them bookmarks. Macintosh calls them bookmarks as well.
Exporting Favorites from Microsoft Internet Explorer

Launch Microsoft Internet Explorer on your PC. Click the File menu, then Import and Export. This will start the Import/Export wizard. Click Next, select Export Favorites, and click Next. Click the Favorites source folder you want to export and click Next.

Note:
When you choose which bookmarks to export, you need to select all of the bookmarks and bookmark folders you want to export.

Figure 6-2: Make sure you click Export Favorites on this screen.

Now you should be on the Export Favorites Destination screen. Choose where you want the exported favorites to be placed by clicking the Browse... button or typing the path if you know it. Click Next. Click Finish and you're all done!
Exporting Bookmarks from Netscape 7 and Mozilla

Netscape 7 and Mozilla use the same code for the browser core, so the two browsers are exactly alike in a number of ways, including exporting of bookmarks. There's no wizard like in Microsoft Internet Explorer, and the process is a little more labor-intensive, but it is still not that hard.

Start out by launching Netscape 7 or Mozilla (whichever one you use). Click the Bookmarks menu, and then click Manage Bookmarks... Click the bookmarks folder and/or bookmarks files you want to export. Click File and then Export... and you will see a dialog box prompting you for the location in which to save your bookmarks file (it's called bookmarks.html). See Figure 6-3 for a little more detail.

Figure 6-3: In this screen shot of Mozilla, I’ve selected multiple bookmarks and bookmark folders by holding down the Control key and clicking the items I wanted to export.
Preparation of Your Outlook Express Contacts

Moving your contacts (i.e., your address book) from your PC to your Macintosh is really easy if you were using Microsoft Outlook Express on your PC. Here are the three simple steps for exporting your contacts from Microsoft Outlook Express into the Contacts folder you’ve created on your PC.

1. Launch Microsoft Outlook Express on your PC. Click the Tools menu and then click Address Book.

2. Click the Edit menu and then click Select All to highlight all of your contacts. If you don’t want to export all of the contacts, instead of clicking Select All, hold down the Control key and click each contact that you want to keep individually.

3. Drag the selected contacts to the Contacts folder.

Figure 6-4: Microsoft Outlook Express will automatically create VCF files for your contacts. Most Mac OS X contact managers, including Address Book, Microsoft Entourage, and Palm Desktop, can understand the VCF format.
So how do you move your email? If you’re using America Online (AOL) or web-based email (like Yahoo! Mail or Hotmail), you don’t have to transfer anything; your email is stored on a server. For everyone else, I’m sorry to say that there’s no single easy way. Some people suggest re-emailing yourself all of your email and then retrieving it on your Macintosh. Others suggest using Netscape Mail as a mediator. I took the easy way out and used a Palm IIIc to move over my email, contacts, and calendar to Mac OS X; using a Palm has the added benefit of getting all of your Microsoft Outlook items. I synchronized it with my PC, and then took it over to my Macintosh and synchronized it again. My Macintosh retrieved all of my emails, contacts, and calendar events from my Palm and put them in Mail, Address Book, and iCal, respectively. One drawback to this method is that a Palm doesn’t have a lot of memory, so if you have tons and tons of emails, this method may not work for you. The thing is, there is no silver bullet, and with every PC email client being different, there is no way for me to help everyone transfer their email to their Macintosh computers. Apple has come up with a tidy way to transfer all of your email, via their $100 .Mac subscription. You can read all about it at www.apple.com/switch/howto/mailbox.html.

The last step in preparing to move your old files over to your new computer is to set up your Macintosh to receive the files from your PC. You’ll need to create a “staging area” on your Mac, a place to put your files while they’re in transition. Create a new folder in your home folder and name it PC Files. When you move your stuff over from your PC using one of the methods in this chapter, put the files in the PC Files folder. After your move is complete, you can put the files into their new homes on your Macintosh; where to put the different kinds of files is covered at the end of this chapter.

Now that your PC files are ready for the trip and your Macintosh is ready to receive them, let’s get rolling!
Copy Your Files with Detto Move2Mac

Difficulty: Easy
Speed: Fast
Cost: $50 to $60, depending on the version you buy

Detto Move2Mac is your best choice for moving your stuff from your Microsoft Windows machine to your Macintosh. It’s quick, painless, inexpensive, and requires the least amount of work. The package includes a cable for connecting your PC to your Macintosh, and the Move2Mac program, which you install on both your Microsoft Windows PC and your Macintosh.

Move2Mac transfers music, movies, photos, folders, icons, and just about any other file from your PC to your Macintosh. It also transfers settings, including your bookmarks (favorites) and desktop pictures. When you use Move2Mac to transfer your stuff from your PC to your Macintosh, it preserves the folder structure. If you move over your My Documents folder, the folder structure of all of the folders under My Documents will be preserved. Move2Mac will do its best to put your files in the appropriate places (for example, My Documents files go into Documents, My Pictures files go into Pictures, and so on).

Move2Mac will also move your Microsoft Outlook Express address book to your Mac OS X Address Book, and it will move your email settings to the Mac OS X Mail application, but unfortunately it doesn’t move over your actual emails.

Setting up Move2Mac is easy. You just install the software on both computers, connect the cable, choose the files you want to copy, and click Next. Move2Mac can transfer 500 megabytes in 15 minutes using the USB cable (included with the $50 version), and 500 megabytes in about 1.5 hours using a parallel-to-USB cable (included with the $60 version). The parallel-to-USB version of Move2Mac is more expensive ostensibly because the cable is more expensive to make; it’s intended for PCs that do not have a USB port.
Copy Your Files Over a Network

**Difficulty:** Medium (setup), Easy (transferring)

**Speed:** Fast

**Cost:** $0 if you already have a network. You can get a crossover cable (a cable that connects your Macintosh to your PC via their Ethernet ports) for $7.

I think the network method is the best overall if your PC and Macintosh are already networked (perhaps through an Ethernet router or hub, or a crossover cable) and you don't want to use Move2Mac.

There are two routes you can take with the network method. You can use FTP to connect to your Macintosh from your PC; FTP is very easy to set up and use.

The other method involves turning on Windows Sharing so your PC can see your Macintosh. This method is more interactive than FTP. With Windows Sharing, you can connect to your Macintosh and work with your Macintosh files and folders the same way as any other disk in Windows Explorer. It requires slightly more work to set up, but it uses a more familiar interface.

**Moving Your Files with FTP**

FTP stands for *file transfer protocol*. It's been in use for many years because it's relatively fast, stable, and easy to use. To use FTP, you need an FTP server and an FTP client. Mac OS X should be the FTP server in this case. Microsoft Windows 2000 and Microsoft Windows XP both have an FTP client built-in, accessible from a DOS prompt. If you don't have Microsoft Windows 2000 or Microsoft Windows XP, you can download an FTP client from VersionTracker.com. I recommend WS_FTP Pro, available at Ipswitch.com. It's easy to use and very powerful. (You can use any FTP client you want, of course.)
The first step is to turn on the FTP server in Mac OS X. This is done in the Sharing preference in System Preferences. Open the Sharing preference and click the Services tab. You'll see a list of services in a box. The service's state (on or off) is indicated in the first column, and the service's name is in the second column. Turn on FTP Access by putting a check mark in the On box (you will need administrator privileges to turn on FTP Access).

![Sharing Preference](image)

Figure 6-5: The Sharing preference tells you how to connect to your Macintosh via FTP. The stuff after ftp:// is what you will need to connect from your PC. (Note that your FTP address will most likely be different from mine.)

Now that your FTP server is turned on, you can connect to your Macintosh from your PC. Fire up your FTP program and enter the address for your Macintosh (remember, you can get it from the Sharing preference by clicking the FTP Access service; make sure the service is turned on). Enter your username and
password and connect to your Macintosh. This process varies by FTP application.

Once your FTP application has connected to your Macintosh, you will see the contents of your home folder. In WS_FTP Pro, change your local directory (that is, the directory on your PC) to the folder containing the files you want to move to your Macintosh. Now drag the files from your PC to your Macintosh. You can drag the entire folder over to your Macintosh, and all the files will be transferred together.

![File Transfer Screen](image)

Figure 6-6: Every FTP application is different, so your mileage may vary. WS_FTP Pro is pretty straightforward — PC files are in the left view and remote files (my Macintosh) are in the right view view.

When you’re finished transferring your files, close the FTP client on your PC and turn off FTP Access on your Macintosh if you don’t plan to use it again. When you transferred the files over, they should have automatically been put in their correct, corresponding places. Now you’re ready to import contacts and bookmarks and complete your move.
You're a brave soul if you want to use the FTP application included in Microsoft Windows NT, Microsoft Windows 2000, and Microsoft Windows XP. Open a command prompt from the Start menu. Type "ftp" (without the quotes) and press Enter. Type "open" followed by your server's name or IP address (e.g., "open 192.168.1.100"). FTP will attempt to connect; if it's successful, enter your username and password. Now, enter "bi" to set the mode to binary, and then navigate to the folder containing your Zip files using the "lcd" command (e.g., "lcd c:\switch"). Once you're in the correct folder on your hard drive, you can set the remote disk to where you want to put the files by using the "cd" command followed by the folder name; you can make a folder using the "mkdir" command (e.g., "mkdir switchfiles"). When you're ready to upload, use the "put" command followed by the name of the file (e.g., "put filename"). When you're finished uploading files, issue the "bye" command. If all of this sounds like too much work, download WS_FTP Pro from ipswitch.com and use it with the methods described in this section. It has a free evaluation and it's only 4.25 megabytes to download.

Moving Your Files with Windows Sharing

One of the best new features in Mac OS X is its keen support of Microsoft Windows networks. Mac OS X can see Microsoft Windows machines and Microsoft Windows machines can see Mac OS X, all without having to purchase and install special software. The key is an open-source technology called Samba, which provides the bridge between your Macintosh and your PC.

For our purposes, we only need to see the Macintosh from the PC, since all we're doing is copying files and folders over; we're going to push files from the PC to the Macintosh.
Note:
If you wanted to go the other route (connect to the PC from the Macintosh and pull files), you’d need to do a little more work, namely turning on file sharing in Microsoft Windows and sharing a folder. After you share a folder on your PC, use Connect to Server on your Macintosh and click the Browse button. Find the PC share and click Connect. More info is at apple.com/switch/questions/sharing/windows-share.html.

The first step is turning on Windows Sharing on your Macintosh. Open System Preferences, and then click the Sharing preference. Click the Services tab, and then turn on Windows Sharing. Your Macintosh is now visible to PCs on your network, easy as that!

![Sharing window](image)

Figure 6-7: Like FTP Access, Sharing displays the address for your Macintosh that you will need to connect to from your PC.
The next step is sitting down at your PC and connecting to your Macintosh. Depending on what version of Microsoft Windows you are using, this step can vary in degree of difficulty. I would take the easiest route and connect to the Macintosh via its address, which you can find in the Sharing preference (it's in the format \somenumbers\username). Make a note of this address, then head over to your PC and follow these steps:

1. Open My Computer.
2. Click the Tools menu and then click Map Network Drive.
3. Choose a drive letter (I used M: for Macintosh).
4. Enter the path to your Macintosh in the Folder box. It should start with \ and end with your username. For example, mine is \192.168.1.100\rob.
5. Click Finish. You will be prompted for your username and password. Enter your Mac OS X username and password and click OK.

When you complete these steps, Microsoft Windows will open a Windows Explorer window containing the contents of your home folder on your Macintosh. You can start copying over your PC files and putting them exactly where you want them to go. When you finish transferring your files, sit down at your Macintosh and set it up (add your contacts to Address Book, import music into iTunes, and so on).
Move Your Stuff to Your Macintosh

Figure 6-8: If you want to reconnect to your Macintosh the next time you log into Microsoft Windows, turn on Reconnect at logon.

Copy Your Files with a Disk

**Difficulty**: Easy  
**Speed**: Very slow to very fast, depending on what kind of disk you use and how much data you have  
**Cost**: $0 if you have media (or you’re sharing a disk). CD media is currently around $20 for 100 discs.

There are all kinds of disks out there: hard disks, CDs, DVDs, floppy disks, Zip disks, Jaz disks, and so on. Which kind of disk you use ultimately doesn’t figure into this discussion, as I’ll assume you know how to use the particular type of disk you’ve chosen (for example, if you’re going to use a CD, I assume you know how to burn one on your PC).

This method is so simple that all it requires is dragging files, saving them to the disk, and then physically carrying it from your PC to your Macintosh. On your PC, drag the folders containing your migrating files to the disk you’re using for transport. (I hope you are using something with a lot of free space, like a
FireWire hard drive, CD-R, DVD-R, or even a USB keychain drive.) When the folders are copied to the disk, burn the disk (if it’s a CD or DVD) or unplug the disk (if it’s a hard drive) and insert it into your Macintosh or plug it in.

When the disk is mounted on your Macintosh, drag the files from the folders on the disk to the corresponding folders on your Macintosh, and start setting up your Macintosh (import your music into iTunes, movies into iMovie, and so on). It’s as simple as that. If you made a CD or DVD containing your PC files, you now have a backup of those files in case you ever need it.

**Copy Your Files Over the Internet**

**Difficulty:** Easy

**Speed:** Depends on your Internet connection and how much data you have

**Cost:** Depends on your Internet service provider (ISP) and whether or not you already have access to a server

If you don’t have a huge amount of data to move from your PC to your Macintosh, and you’re on a broadband connection, copying your files from your PC to your Macintosh using the Internet can be a quick and painless alternative to the other methods discussed in this chapter.

So how much data is a huge amount? It’s all relative. If you don’t mind waiting to upload one gigabyte of data to an Internet server and then waiting for that one gigabyte of data to download to your Macintosh, then go for it. For most people, especially those using 56K modems, uploading and downloading more than a few megabytes can be a time-consuming pain.

This method is really intended for the people who don’t have a lot of data, don’t have a CD burner, can connect only one computer (PC or Macintosh) to the Internet at a time, don’t have a home network, and don’t want to invest any more money than what they already spend on an ISP.
To use this method, you will need to have access to a server (usually either a web server or a dedicated FTP server) where you can place the files you want to move and then download them to your Macintosh. If you don’t already have access to a server, then you have a few choices. First, check with your ISP to see if they offer storage. Many ISPs give you an allotment of storage space free (or at a discounted rate) with your Internet service plan. If yours does not, you can sign up for disk storage at one of the many disk storage sites on the Internet, like xdrive.com. Otherwise, you will need to use one of the other methods described in this book.

Preparing Your Files

Preparing your files for the transition involves two main steps. The first step is getting your files organized into new folders and ready for the move (as discussed in “Prepare for Your Move,” earlier in this chapter). The second step, which is optional but highly recommended, involves compressing your files to shrink their sizes. Compressing the files gives the added benefit of reducing the number of files to copy over; a single compressed archive can contain many files. Compressing your files into an archive can significantly reduce upload and download time.

If you’ve ever used WinZip to make a Zip file or used Microsoft Windows XP’s Send to Compressed Folder feature, you’ve used file compression. The Zip format (not to be confused with Iomega’s Zip disks) has been in use for many years, and it’s the most popular file format for compression and archiving. Both Microsoft Windows XP and Mac OS X support the Zip format, and if you have one of the other versions of Microsoft Windows, you can use WinZip (available at winzip.com).

If you have lots of files, you can create several Zip files instead of six core archives, but however many files you need to upload and download, both the FTP method and the iDisk method will do the job.
Compressing Your Files

After you have copied the files you want to move into the transition folders, it's time to compress them. If you're using Microsoft Windows XP, right-click each folder, click the Send To menu item, and then click Compressed (zipped) Folder. This will create a new file with the name of the folder and the .zip extension for each of the folders.

If you are using WinZip, right-click each folder, click the WinZip menu item, and then click Add to <foldername>.zip (where <foldername> is the folder you clicked on; e.g., Documents.zip, Pictures.zip, and so on). If WinZip isn't a menu item in the right-click menu, then open the WinZip application, drag the folder into the WinZip application, and save. Do this for each of the folders.

Figure 6-9: If you use WinZip, make sure you click the second menu item, as seen here.
Whichever method you use, you should have six files: Documents.zip, Pictures.zip, Movies.zip, Music.zip, Favorites.zip, and Contacts.zip. These are the files you’re going to upload to the Internet and then download to your Macintosh.

**Uploading the Files**

On your PC, go ahead and connect to the Internet if you haven’t already. Then, establish the connection between your PC and the server on which you are going to put your files. Next, you will begin your upload.

There are several different methods for uploading files to the Internet. Some web hosts offer browser-based applications for uploading files. Others offer WebDAV, which lets you map drives as if the web server were a network share (this is how iDisk works). For our discussion, we’ll look at two popular file upload mechanisms.

**Uploading with FTP**

I discussed FTP earlier in this chapter; you can use FTP to directly transfer files from your PC to your Macintosh, as long as they are both on a network. In this section, I’m assuming that only one computer is able to connect to the Internet at a time. I’m also assuming that you don’t have your PC and Macintosh networked; if you do, you should be using the network method instead of this one.

Armed with a username, password, and the URL or IP address of the server you’re going to use with FTP, launch your FTP client. Enter your server address, username, and password, and connect to the server. Your FTP program will give you feedback on the success of your connection. Most FTP programs will display two views of files: one view is of the files on your local disk, and the other view is of the files on your remote disk (the FTP server).
In the local disk view, navigate to the folder containing the Zip files you created earlier. In the remote disk view, navigate to the folder where you plan to put the Zip files (you may be able to create a folder; if not, use one of the existing folders, but for security purposes, try to use one that isn’t accessible via the web). See Figure 6-10 for my setup in WS_FTP Pro.

![Figure 6-10: I can see the location of my zip files on my hard disk and the folder on my FTP server where I plan to put the files when I upload them.](image)

WS_FTP Pro will let you just drag and drop files from your PC to your FTP server. All you have to do is drag the file from the view of your local disk (the PC view) to the folder on your server (the remote view). Other FTP applications have different mechanisms for uploading a file, but the ultimate goal is the same: uploading the files from your PC to your FTP server.
Move Your Stuff to Your Macintosh

Uploading with iDisk

If you have a .Mac subscription, you have an iDisk, which is space on Apple's servers where you can store files. The major disadvantage of using iDisk for moving your files is that it has a 100 MB ceiling. You can, of course, pay extra to increase your space, but the size limit is fine if you don't have more than 100 MB of data to move over, or if you don't mind moving over your data in 100 MB chunks.

Unfortunately, you can't create new folders in your iDisk. This means that you'll have to work with the folders that already exist. That's fine though; you only have six Zip files to upload, so you can just put them in your iDisk's Documents folder.

Your iDisk is storage space on a web server hosted by Apple and located at a URL. To connect to your iDisk from Microsoft Windows, you'll need to create a shortcut to that URL, called a network place. Your URL is http://idisk.mac.com/username, where "username" is your .Mac account name (mine is rstandefer1, for example). Microsoft Windows will use this URL to access your iDisk.

The process of connecting to your iDisk differs depending on what version of Microsoft Windows you are running. In Microsoft Windows XP and Microsoft Windows 2000, open Windows Explorer and click Tools, and then Map Network Drive. In Microsoft Windows 98, double-click My Computer, then double-click the Web Folders icon, and then double-click Add Web Folder. When the box appears, enter the URL to your iDisk. Check out Figure 6-11 for an example.

When you click Finish, Microsoft Windows will prompt you for your .Mac username and password. Enter this info, and then iDisk will be accessible in My Computer, just like any other hard disk.
Windows can help you connect to a shared network folder and assign a drive letter to the connection so that you can access the folder using My Computer.

Specify the drive letter for the connection and the folder that you want to connect to:

- **Drive:** I:
- **Folder:** http://idisk.mac.com/rstan

Example: \server\share
- **Reconnect at logon**
- **Connect using a different user name**
- **Sign up for online storage or connect to a network server.**

The next step is copying your files to the iDisk. Simply double-click your iDisk in My Computer to open it, and then drag the Zip files to the Documents folder (or whichever of the other folders you wish; just don’t put the files in Public or Sites).

Figure 6-12: My iDisk shows up in My Computer as “rstandefer1 on idisk.mac.com.” I can work with it just like any other hard disk, within the confines of iDisk’s permissions.
Move Your Stuff to Your Macintosh

What Next?

When you’re finished uploading your files, disconnect from your FTP server (if you used FTP) and disconnect your PC from the Internet (do this only if you have to, like if you’re on dial-up or you only have one network cable for connecting a computer to your DSL or cable modem). You’re now ready to move over to your Macintosh and download the files.

Downloading the Files

Downloading the files to your Macintosh is a very simple and painless process, whether you used FTP or iDisk. In fact, the process is pretty much the same for both. Your FTP server and iDisk are both accessible via the Go menu in Finder. For consistency’s sake, we’ll look at them individually. If you haven’t done so already, you should connect to the Internet on your Macintosh now.

Downloading with FTP

With your files safely stored on an FTP server, you’re ready to get them onto your Macintosh. This process is so incredibly simple that it’s almost awe-inspiring. Here’s what you do:

1. Go to Finder by clicking your desktop, by using Exposé, or by clicking the Finder icon in the Dock.

2. Click the Go menu and then click Connect to Server... (or press Command-K). A window will appear; it wants information about your server.

3. Enter ftp:// and then your server’s name or IP in the Server Address box. For example, if your server were ftp.example.com, you would enter ftp://ftp.example.com.

4. Click the Connect button and you will be prompted for your username and password. Enter this info and click OK.
Mac OS X will do some processing, and then a Finder window will pop open with the contents of your FTP server. Your FTP server will be mounted on your desktop, just like any other network share. Navigate to the folder containing your Zip files and drag them from your server to your desktop. That’s it! The files are downloaded and ready to be organized on your Macintosh.

![Connect To Server](image)

Figure 6-13: Don’t forget the ftp:// before the name or IP of your FTP server. If you want to add the FTP server to your Favorite Servers, click the + button.

### Downloading with iDisk

Working with iDisk in Mac OS X is even easier than FTP, if you can imagine. Make sure .Mac is set up on your Macintosh in the .Mac preference in System Preferences (all you have to do is enter your .Mac username and password).

1. Go to Finder via Expose, by clicking the desktop, or by clicking the Finder icon.

2. Click the Go menu, and then the iDisk menu, and then My iDisk... (or press Shift-Command-I).

A Finder window will open with the contents of your iDisk. (An icon will also appear on your desktop with your .Mac username as its name.) Navigate to the folder containing your Zip files and drag them all to your desktop. You’re all done moving your files!
Prepare the Files to Be Put Where They Belong

With the files safely downloaded, you’re ready to decompress them and place them where they belong. Double-click each Zip file to decompress it. A folder will appear; it will have the same name as your Zip file (without the .zip extension of course) and it will contain the files you zipped up in that archive. Now you’re ready to move on to organizing your old files on your new Macintosh.

Where Should I Put My Files?

Mac OS X doesn’t have the same folder layout as Microsoft Windows, so you have to map the Microsoft Windows folders to their closest equivalents in Mac OS X. But Mac OS X doesn’t just throw you into the fire. Like Microsoft Windows, your home folder holds special folders where you can place your different types of files.

Note:

If you’re a Linux user, you can just create a folder layout that matches your Linux folder layout, or copy your Linux home folder to your Macintosh.

Keeping all of your files in your home folder is a wise idea. Besides the benefit of being able to easily manage your files, putting all of your files in your home folder adds a significant level of security. Other users won’t be able to access the files in your home folder, and you can use special Mac OS X security features to lock down your home folder even further (I talk about these features in Chapter 9).
Documents

You can store anything you want in the Documents folder in your Mac OS X home folder. You might want to consider putting all of the files from your Microsoft Windows My Documents folder in the Documents folder in Mac OS X. You can devise your own scheme of document management in Mac OS X, and if you keep everything in the Documents folder in your home folder, it will be a lot simpler for you to create backups.

Favorites

Exporting your bookmarks from your PC browser was pretty easy, and now you'll want to import them into your Macintosh browser. Getting your bookmarks into Microsoft Internet Explorer for Macintosh will be a cinch; getting your bookmarks into Safari is going to require a little more work, but it's really not that hard.

Importing Your Bookmarks into Microsoft Internet Explorer for Macintosh

On your Macintosh, navigate to the folder in which you put your exported bookmarks and find the bookmarks file. Rename it to Favorites.html. Now open up a separate Finder window, go to your home folder, and navigate to the Library/Preferences/Explorer folder. Drag and drop Favorites.html into this folder.
Move Your Stuff to Your Macintosh

At this point, a confirmation to replace an existing Favorites.html might appear. If you click Replace, any existing favorites you’ve defined in Microsoft Internet Explorer for Macintosh will be deleted. If you have already added bookmarks to Internet Explorer on your Macintosh, and you don’t want to lose them, you can add your PC bookmarks to them with one catch: Internet Explorer can only add the whole bookmarks file, not the bookmarks themselves, so the entire bookmarks file from your PC will be shown as a single bookmark. Clicking it will load a web page with all of your PC bookmarks available individually as links.

The next time you start Microsoft Internet Explorer for Macintosh, the bookmarks you imported from your PC will be available.

**Importing Your Bookmarks into Safari**

The best way to import bookmarks into Safari is to use a program called Safari Enhancer. You can download it for free at VersionTracker.com. Safari Enhancer is a great application for customizing Safari, and its bookmark importer is really handy. It
imports bookmarks from several different web browsers, including Microsoft Internet Explorer and Netscape Navigator.

To import bookmarks using Safari Enhancer, launch the Safari Enhancer application and click the Bookmark Importing tab at the top. Click the drop-down menu to select the source of your bookmarks and choose Any HTML File. Click the Import Bookmarks button, navigate to the file you brought over from your PC, and double-click it. Safari Enhancer will import your bookmarks into Safari.

When you import bookmarks using Safari Enhancer, the bookmarks you import are placed in the Imported IE Favorites folder. It doesn't matter what kind of bookmarks you import; Safari Enhancer always puts imported bookmarks in that folder. If this is just too annoying for you, you can always navigate to each link and then add it by itself as a new bookmark in Safari. There is a trick you can pull, however, that will simplify things.

First, follow the above instructions for importing your bookmarks into Microsoft Internet Explorer for Macintosh. Then, use Safari Enhancer to import your bookmarks from Internet Explorer (choose Internet Explorer in the Import bookmarks from drop-down menu). Click Import Bookmarks and Safari Enhancer will import the bookmarks from Microsoft Internet Explorer for Macintosh to Safari. This slightly convoluted process results in your bookmarks being imported into Safari in true bookmark form, instead of one bookmark that leads to a bunch of links.

Music

Microsoft Windows has a special folder called My Music to store all of your music files, whether they’re in MP3, WMA, AIFF, or some other format. Mac OS X has an equivalent folder, called Music, in your home folder. When you transfer your files to your Macintosh, put your music files here. After you’re finished moving the files, you can launch iTunes and tell it to import the
music you transferred over into its library so you can listen to it. Chapter 5 covers how to do this in greater detail.

If you bring over Windows Media Audio (WMA) files, you’ll need to download Microsoft Windows Media Player for Mac OS X from macintosh.com/mac. This is the only player available for Mac OS X that can play WMA files.

**Movies and Videos**

Microsoft Windows has a special folder for movies and videos called My Videos. Mac OS X has a similar folder called Movies under your home folder; your movies and videos should go there. You can edit your movies in iMovie, or watch them in the appropriate player (you can usually just double-click the movie file to watch it).

**Pictures**

Like documents, music, and videos, Microsoft Windows has a special folder for pictures called My Pictures. On your Macintosh, you have a Pictures folder under your home folder. This is where your pictures go. After you transfer your pictures to your Macintosh, you can put them under iPhoto’s control by importing them into iPhoto. In the iPhoto application, click the File menu, and then click Import.... Choose the Pictures folder under your home folder, and iPhoto will add all of the picture files in Pictures to the iPhoto library. (Using iPhoto is discussed in Chapter 7.)

**Desktop Pictures (Wallpaper)**

Microsoft Windows desktop pictures, also known as wallpapers, are typically bitmaps (ending in the .bmp file extension) or JPEGs (ending in the .jpg extension). Some of the desktop pictures included with Microsoft Windows (or Linux for that
matter) are pretty cool, so it makes sense to move some or all of them over to your Macintosh to use as the Mac OS X background.

Microsoft Windows XP stores desktop pictures in a folder called Wallpaper. This folder is inside a folder called Web, which is inside the Microsoft Windows installation folder (usually C:\Windows or C:\Winnt). So, to get to your desktop pictures, open Windows Explorer and navigate to your Windows installation folder\web\wallpaper (e.g., c:\windows\web\wallpaper). Your bitmaps and JPEGs will be there, ready for you to copy over to your Macintosh.

Note:
When you access your Microsoft Windows system folder, it may give you a message saying the files are hidden. Just click Show the contents of this folder and you’ll be able to see your files.

Icons

Mac OS X icons have some special features that make them look really nice, but if you’re attached to icons in Microsoft Windows, you can move them over to your Macintosh and use the icon changing technique outlined in Chapter 5. Just copy the files on your PC ending in .ico to your Pictures folder in Mac OS X. I hope you’ll resist the urge to use Microsoft Windows icons, though; Mac OS X icons are of much better quality, and you can find some really cool ones at xicons.com.

Contacts

Once you have completed the process of moving everything over to your Macintosh, you can add the contacts to Address Book by starting the Address Book application from /Applications,
Selecting all of the contacts in the Addresses folder, and then dragging them into Address Book.

Summary

This chapter's singular goal was to help you move your files from your PC to your Macintosh. I don't deny that it can be tricky, especially if you have lots of files to move over or a very complex hierarchy of folders. Realize that it's not an all-or-nothing proposition; you can move over some of your files now and some of them later.

The next chapter will guide you in connecting your hardware to your Macintosh.
It seems like you can plug just about anything into your computer. Calculators, mice, tablets, printers, wireless adapters, voice recorders, digital cameras, personal digital assistants, and network access points are just a sample of the things you can hook up to your computer. In my house, even my CD changer and the remote control for my home theater connect to my computer.

This chapter covers the specifics of connecting and using some of the more popular Macintosh-compatible devices. I have a Rule of Probable Connectivity that states, “If the device has a connector that will plug into your Macintosh, it will probably work.” Many PC devices will work with your Macintosh. Of those that will, some might need a little help first; for example, the older UMAX scanners don’t have Mac OS X drivers, so you would need a third-party tool to hook it up. Other devices may require special physical adapters, such as a serial- or parallel-to-USB converter. Unfortunately, some of your devices may not work at all. Consult the manufacturer of your device to determine if it will work with Mac OS X.
Input Devices

There are all kinds of input devices that meet all kinds of different needs. There are special devices for editing video, creating digital music, manipulating digital instruments, enabling accessibility for the disabled, and just about every other task imaginable. Covering every single one of these individual devices would require thousands of pages, so I’ll focus on a few common ones. These concepts apply to most other devices as well. Remember the Rule of Probable Connectivity.

Mice, Trackballs, and Tablets

Mac OS X offers built-in support for most mice and trackballs, such as those produced by Logitech, Microsoft, MacAlly, and so on. Generally speaking, if the mouse or trackball has a USB connector (or supports Bluetooth), it will work on your Macintosh.

Tablets, however, require you to load a driver. They need special software to enable features like the built-in eraser on the stylus (as on the Wacom brand). Just remember the Rule of Probable Connectivity, and if your mouse, trackball, or tablet still doesn’t work, be sure to check the manufacturer’s web site for updated drivers before abandoning it.

Keyboards

Just about any USB keyboard will work with a Macintosh. PS/2 and AT-style keyboards won’t work; there’s no PS/2 or AT connector on a Macintosh. Likewise, old Macintosh keyboards that use the ADB connector won’t work either; you’ll need an adapter. It seems like adapters are made for just about everything these days, so try doing an Internet search in Google to see if an adapter exists for your situation.

Some specialty keyboards, such as certain ergonomic models, use special software in conjunction with the keyboard.
Usually, the keyboard basics will work fine if it has a USB connector, but sometimes the manufacturer doesn’t release Mac OS X versions of the special software required to make the most of the keyboard.

**Specialty Devices**

I consider specialty devices to be input devices that not everyone uses, or can even identify, such as the device that allows visually impaired people to use a computer. Of course, the Rule of Probable Connectivity applies. Sometimes, just plugging something in to see if it works is good enough. I don’t like to spend money on something unless I know it will work, but if I already have the device lying around or someone gives it to me, I plug it in and see what happens. I’m adventurous like that.

**Note:**

While I am crazy enough to just plug something in, you should consider that there might be a device out there that will damage your Macintosh if you just plug it in willy-nilly. I’ve never heard of that happening, but you never know.

You’ll have to check with the manufacturer of your specialty device if you don’t know whether or not it works with Mac OS X. Specialty devices such as biometric security scanners, film negative scanners, CAD digitizers, barcode readers, and PCM readers simply don’t work with Mac OS X, and the manufacturers have no intention of developing drivers for the Mac. Occasionally, an open-source driver exists; in this case, a Google search is your best bet. If you’re really adventurous and have the skills, you could even write your own driver. Otherwise, you can either keep your PC around for those devices, or replace them with something that works with Mac OS X.
Ink Preferences

Mac OS X has built-in handwriting recognition software called Ink, which activates when you connect a tablet to your Macintosh. You can control Ink's preferences in the Ink preference in System Preferences. There are several options you can set, such as your handwriting style, the language, and the font.

Figure 7-1: If you click the Gestures tab in the Ink preference pane, you can define gestures that can make your tablet perform operations like Undo and Return. The Word List tab lets you add special words that you use that may not be in Ink's vocabulary.

To turn Ink on, click the On option next to Handwriting recognition is; the Ink floating window will appear. This floating window lets you turn Ink on and off, activate modifier keys (Command, Shift, Option, and Control), switch to a special application for writing and drawing, and access help and preferences.
Writing with Ink

When Ink is turned on, you can write anywhere on your desktop and Ink will interpret your handwriting (it works best when you have an application open that accepts text, like TextEdit or Mail). When you write, a translucent sheet of yellow paper appears on your screen. As you write, Ink shows your pen strokes. When
you stop, Ink recognizes your writing and inserts it in the receiving application at the insertion point.

**The Ink Notepad**

The Ink floating window has an icon that looks like a pad of paper. If you click it, a special application will appear that allows you to write as much as you want and then send what you wrote to an application such as Microsoft Word or TextEdit.

![Image of Ink Notepad](image_url)

**Figure 7-4**: After you finish writing in the Ink notepad, click the Send button to send your text to an application. If you want to clear what you wrote, click the Clear button.

The Ink notepad also lets you draw freeform. If you click the icon that looks like a star, the Ink notepad will load a canvas on which you can draw pictures. When you finish drawing your
masterpiece, click the Send button to paste your image into an application. If you want to start over, click the Clear button.

Figure 7-5: The Picture tool in the Ink notepad is very handy if you want to quickly create small drawings to include in documents.

**Keyboard and Mouse Preferences**

Microsoft Windows has two separate Control Panel options for setting keyboard and mouse preferences. Mac OS X rolls them into one, Keyboard & Mouse in System Preferences. In the Keyboard & Mouse preference pane, you can set your keyboard's key repeat rate and delay until repeat settings. You can also set your mouse's tracking and double-click speeds.
The Keyboard & Mouse preference pane also lets you define keyboard shortcuts. You can change existing keyboard shortcuts and add new ones.

![Keyboard & Mouse preference pane](image)

Figure 7-6: The Keyboard & Mouse preference pane has an option under the Keyboard Shortcuts tab that allows you to turn on full keyboard access. If you are used to navigating Microsoft Windows using your keyboard, turning this option on will let you navigate Mac OS X the same way.
Digital Music, Photography, and Moviemaking

In most cases, at least one of these three things — digital music, photography, or moviemaking — are part of the reason people switch to the Macintosh, if not the sole reason. The Macintosh is an excellent machine with excellent software that will help you achieve digital convergence nirvana.

iPod

The iPod has been touted as the greatest innovation in personal music enjoyment since the development of the Sony Walkman. While there are other digital music players out there, and a lot of them are very good, the iPod still reigns as the most popular and widely used digital music player for Macintosh users.

Using an iPod with your Macintosh is an exercise in simplicity. It is delightfully easy. The iPod connects to your Macintosh via a FireWire port, either at the top of the iPod (for the first-generation iPods) or on the iPod dock (for the new iPods). All you have to do is connect the FireWire cable from your iPod (or iPod dock) to one of the FireWire ports on your Macintosh. The FireWire connector has a special shape, sort of a rectangle with a rounded edge. When your iPod is properly connected to your Macintosh, Mac OS X will mount the iPod on your desktop; it will also show up in Finder. The iPod has its own special icon and a label that you can rename to whatever you want.

Note:

If you have a flat-panel iMac, you have one FireWire port. If you have a PowerMac tower, you could have two FireWire ports — one for FireWire 400 and one for FireWire 800. Plug your iPod into the port that accepts your iPod cable's connector. It will only fit in the FireWire 400 port.
Figure 7-7 shows an iPod mounted on my desktop.

![Image of iPod on desktop](image)

Figure 7-7: When the iPod is mounted on my Panther desktop, its icon looks just like an iPod.

Mac OS X treats your iPod like any other external disk. It mounts it, places an icon for it on your desktop, and makes it available via Finder. When I double-click on the iPod icon on my desktop, the Finder window shown in Figure 7-8 appears.

![Finder window with iPod contents](image)

Figure 7-8: The Finder window showing the contents of my iPod. The music files on the iPod are hidden; you can't access them from Finder.
You can copy files to the iPod in Finder and then share them with other Macintosh computers. To do this, drag the files you want to copy from their location to your iPod. You can create folders on your iPod, just like on your Macintosh, and you can even use labels. It works just like any other hard disk in Mac OS X.

**Using an iPod with iTunes**

Once your iPod is connected to your Macintosh via its FireWire cable, you can then manage the digital music files on your iPod using the iTunes application. iTunes will show your iPod in its list of sources on the left side of the iTunes window.

![iTunes](image)

Figure 7-9: iTunes launched after I connected an iPod. The iPod showed up in the Source box on the left.

If you look closely at Figure 7-9, you will notice that the iTunes Eject button's icon changed to show that an iPod is connected. It only appears when you select the iPod in the iTunes Source box.
Also, an extra button with an iPod icon was added next to the equalizer button; it only appears when you click your iPod in the iTunes Source box. Clicking this extra button will allow you to set the preferences for your iPod in iTunes.

Figure 7-10: When I clicked the new iPod button in iTunes, the iPod Preferences window appeared.

You can fine-tune the behavior of your iPod and iTunes by setting the options in the iPod Preferences window. You can elect to have iTunes launch automatically when an iPod is connected, and you can decide how iTunes will sync your music library with your iPod.

**Playlists**

iTunes treats your iPod playlists the same way it treats the playlists stored on your Macintosh. If you want to copy music from your Macintosh to your iPod, simply drag the files from your iTunes Library to the iPod. You can drag the music to the iPod itself or to one of its playlists.
Connect and Use Your Hardware

Figure 7-11: Joby brought over his iPod, which is named Jabwai. Since he owns the album, he copied the music files from my iTunes library to the Hip-Hop playlist on his iPod.

As you are dragging files to your iPod, be aware of the free space meter at the bottom of the iTunes window. It updates in real time as you add files to or delete files from your iPod.

One last thing. It’s a one-way street from iTunes to your iPod. You can’t copy music files from your iPod to iTunes.

Using an iPod as a Personal Digital Assistant

While the iPod excels as a digital music player, it also has some nice personal digital assistant (PDA) features that you can take advantage of by using the iSync application.

The iPod features two typical PDA components: a contact database and a schedule. The contact database is synchronized with your Address Book. The schedule is synchronized with iCal.
With your iPod plugged in via its FireWire cable, launch the iSync application (it's in /Applications). You will see something very similar to Figure 7-12.

![iSync application](image)

**Figure 7-12:** The iSync application shows my iPod as a device that supports synchronization.

Clicking the Sync Now button synchronizes your Macintosh and your iPod. If you have new contacts in your Address Book and/or new items in iCal, they will all be copied to your iPod.

**Note:**

iSync is a one-way synchronization — it updates from your Macintosh. If you delete a contact or schedule item from your Macintosh, it will be deleted from your iPod as well.

The synchronization process will complete and you can use your iPod as a PDA. This has some definite advantages if you carry your iPod with you all the time, or if you have one and don't want or need a full-blown PDA.

**Disconnecting Your iPod**

Never, ever disconnect your iPod from your Macintosh without ejecting it first. Eject your iPod by clicking the Eject iPod button in iTunes, or by dragging it to the Eject button on the Dock, as seen in Figure 7-13.
When your iPod is connected, it displays a message on its screen letting you know that you should not disconnect it. When you eject it from your Macintosh, the iPod’s display will show a check mark. As long as you remember to never unplug the iPod’s FireWire cable without that check mark appearing on the iPod display, you should be fine. Disconnecting your iPod without ejecting it could cause your iPod to lose all of its data, or even permanently damage the iPod. Unfortunately, I speak from personal experience.

**Digital Cameras**

The advent of the digital camera has enabled amateur photographers to do things with photos that were previously only available to professionals. With a digital camera, you can take pictures that are easily manipulated on a computer. You can even print out digital photos on photograph-quality paper, bypassing the local photo developing lab entirely.

**Still Cameras**

Most digital still cameras include an interface for connecting to your Macintosh, usually USB or FireWire. Some don’t have built-in connectors and instead use a card reader.

When you connect your digital camera to your Macintosh, Mac OS X mounts the camera on the desktop, just like any other disk or storage medium. There are two applications included with Mac OS X that make retrieving images from your digital camera simple: iPhoto and Image Capture.
iPhoto

In Chapter 5 I mentioned that every new Macintosh includes iPhoto. You can find it in /Applications on your hard drive. iPhoto is a full-featured application for managing your digital photographs. It allows you to import pictures from your digital camera, and then organize, edit, and share them.

Figure 7-14: iPhoto shows that I have 169 photographs, and that my Sony DSC camera is connected and ready for importing.

To import images from your digital camera, click the Import button. It will download all the pictures from your digital camera, and then give you the option to keep or delete the originals on the camera (if you don’t have the Erase camera contents after transfer box checked).

Once your images are imported, you can organize them in several different ways. The choices that iPhoto gives you include printing the images, creating a slideshow of the images, emailing them, making a web page, creating .Mac slides (if you have a
iPhoto also offers a facility for editing your photographs. Its features are limited compared to a full-blown image-editing program like Adobe Photoshop, but they are useful nonetheless. Features for cropping, eliminating red-eye, retouching, converting the image to black and white, and adjusting the brightness/contrast are all available. You can also click Enhance to let iPhoto decide how your picture can be improved for you automatically.

Figure 7-16: Editing a picture of my cat in iPhoto. I clicked the Enhance feature, which brightened the picture and deepened the blacks.
Full coverage of all of iPhoto's features would easily fill up an entire book. There are several good books on iPhoto at your local bookstore.

**Image Capture**

Almost all that Image Capture does is import your images from your digital camera to your computer. Image Capture does not offer all of the bells and whistles that iPhoto does, but if you prefer to work with your photos in an image editing program like Adobe Photoshop, Image Capture would make more sense for you than iPhoto would. There's no need to launch a big application like iPhoto just to get your images if you're going to do all your image editing in Photoshop.

Like iPhoto, Image Capture allows you to build a slide show or a web page containing your photographs. You can also tell Image Capture to automatically crop your photographs.

Mac OS X doesn't support every single digital camera and card reader out there. At the time of publication, Apple's list of compatible cameras is available at apple.com/iphoto/compatibility/camera.html. You should check there to see if your camera (or the camera you want) is compatible with Mac OS X.
**Movie Cameras**

There is another type of digital camera, the digital movie camera. The two most popular digital movie camera formats are MiniDV and Digital 8. Both types of cameras will include a FireWire or USB 2.0 port for importing video onto your Macintosh. Non-digital video cameras, such as VHS-C or Hi8, will require you to purchase external hardware that will capture the video from your camera and move it to your computer.

Mac OS X includes iMovie, an excellent application for retrieving video from your digital video camera and adding movie effects like titling and fades. iMovie is a full-featured digital video editing package that will suit the needs of most users who want to make home or independent movies with their Macintosh computers.

After you connect your digital video camera to your Macintosh (usually with FireWire, but occasionally with USB), start iMovie from /Applications. From within iMovie, you can import your video, which iMovie calls *clips*. You can then add music, titles, wipes, fades, and special effects. When you're finished, you can export your movie to QuickTime and create a DVD with iDVD.

iMovie is a huge topic that deserves its own book. Head to your local bookstore or an online retailer and take a look at the dozens of iMovie books available.
Printing, Faxing, and Scanning

Mac OS X supports most modern printers and scanners. Some printers and scanners use proprietary drivers that exclude the Mac OS X user entirely, but that's mostly limited to the multifunction printers (such as the Canon MultiPass) and older scanners (especially the older UMAX scanners).

Printers

The Macintosh has always been a front-runner in the desktop publishing industry. The technology of the print shop professionals has trickled down into the hands of the average consumer, enabling almost anyone to use sophisticated and high-quality printing devices.

Then there are the rest of us, happy to spend $50 on a cheap inkjet printer at the local electronics superstore. I usually use my printer to print out interesting web pages or cheat codes for video games. I have some friends who, believe it or not, write letters on their Macintosh, print them out, and send them in envelopes via the U.S. Postal Service.

Connecting Your Printer

The first thing you have to do is figure out how your printer is going to connect to your Macintosh. Most printers on the market today have either a USB connector or an Ethernet connector. If your printer uses USB, you can just plug the USB cable into your Macintosh. If your printer uses Ethernet, you can either plug the Ethernet cable into your Macintosh directly, or you can plug your printer into a network hub or router, which will make your printer accessible as a print server (this depends on your model of printer, so I'm generalizing here).
Older printers, such as those with parallel ports, don’t plug into the Macintosh and thus won’t work directly with your Macintosh. In this case, the best thing to do is buy a network print server. This is a box that plugs into your router or hub and accepts your printer’s parallel cable. It then makes your printer available on your network. It’s not a perfect solution. Some printers just won’t work, no matter what you do.

If your printer is on your network (if you’re on a network at your office, for example), you won’t need to connect any printer hardware to your Macintosh. The process of setting up your printer may not work exactly as I describe in this section because there are so many different types of printers out there.

Tip:
If you are trying to use your existing printer, a couple of alternatives you might want to check out are Gimp-Print and CUPS. Gimp-Print has a bunch of drivers for older Macintosh printers and Microsoft Windows printers. You can find Gimp-Print at gimp-print.sourceforge.net. CUPS (Common Unix Printing System) is another way to connect to unsupported printers. You can access CUPS by opening Safari and browsing to 127.0.0.1:631.

One last, important thing: Once your printer is successfully connected to your Macintosh, make sure you turn it on.

Setting Up Your Printer in Mac OS X

Now that the hardware stuff is done, you’re ready to add your printer in Mac OS X. Go to /Applications/Utilities and launch Printer Setup Utility (it’s called Print Center in Jaguar). If you don’t have any printers set up, Printer Setup Utility will ask you if you want to add one.
Chapter 7

Figure 7-18: This message only appears if you do not have a printer set up on your Macintosh. Click the button labeled Add to continue the process of adding a printer to your Macintosh.

When you click Add, a window will appear with a list of your available printers. If you’re using a USB printer and it is properly connected to your Macintosh and turned on, it will appear in this list. If you’re not using a USB printer and you don’t see your printer automatically listed, you’ll need to choose the connection type (for example, Rendezvous if your printer supports it and it is connected to your network). Once you choose the correct connection type, your printer should appear in the list.

Figure 7-19: My Canon printer is connected to my Macintosh via USB, so it shows up as an available printer. When I click the Add button, the Canon printer will be available to Mac OS X and my applications.
When you finally see your printer listed in the Add choices, select it and click the Add button.

**Note:**

This process assumes that the driver for your particular printer is already installed. Mac OS X ships with drivers for several manufacturers, but your printer may not be supported out of the box. You’ll have to check the printer manufacturer’s web site for a Mac OS X version of your printer driver.

If all has gone well, your newly added printer will appear in the Printer List. It should look very similar to Figure 7-20 (your printer model may be different, of course).

![Printer List](image)

Figure 7-20: My Canon i450 USB printer is listed in the Printer List. It’s set up and ready to print out my documents.

**Printer Preferences**

System Preferences has a preference in the Hardware group called Print & Fax. If you open it up and click the Printing tab, you can set up new printers, set the default printer in the Print dialog, and set a default paper size. You can also turn on printer
sharing so other computers on your network can print to your printer.

![Print & Fax settings]

**Figure 7-21**: This is the Print & Fax preference pane, with the Printing tab selected. Clicking the Set Up Printers... button launches the Printer Setup Utility so you can add, edit, and delete printers in your Printer list.

**Printing Documents**

The hard part is over. Printing documents in Mac OS X is pretty much the same as printing documents in Microsoft Windows or in Linux. The main difference lies in how the Print dialog looks. Like Microsoft Windows and Linux, documents are printed from the applications that created them (or applications that support the document format). Printing in Mac OS X can be as simple as pressing Command-P, or you can fine-tune settings for your printed document using Page Setup.
Page Setup

Page Setup lets you tell Mac OS X how you want your document formatted. The Page Setup dialog is different for every printer. You can use Page Setup to set the paper size, orientation, and so on.

Print

Now you’re ready to print! There are two ways to print out a document. You can click File, then Print, or you can press Command-P. Both methods bring up the Print dialog box, which will differ from printer to printer.

![Print dialog box](image)

Figure 7-22: This is the Print dialog for my Canon i450. It has all the standard stuff you’d expect in a Print dialog, like number of copies, a Preview button, and the Print button.

You may be content with accepting the default print settings when printing out documents and might never even need to use the advanced printing capabilities of Mac OS X, but if you want more control, it’s there. The drop-down menu labeled Copies & Pages contains a host of options pages for you to work with in your individual printing scenario. Layout, media, color options, and output options are a few of the configurable settings, depending on your printer.
Before you click the Print button for your final printout, you can click the Preview button to see what that printout will look like. This will start the Preview application to give you a snapshot of what your document will look like once it’s printed. From Preview, you can go ahead and print your document by clicking the Print button, or you can cancel Preview and go back to the Print dialog.

![Preview of "Untitled".pdf (1 Page)](image)

Figure 7-23: Clicking Preview in the Print dialog in TextEdit brought up this window. This gave me a chance to realize that I didn’t want this substandard writing committed to paper, so I canceled it.

One cool thing about printing in Mac OS X is the button labeled Save As PDF.... A PDF (Portable Document Format) is an Adobe Acrobat file that you can open in Preview. When clicked, Save As PDF... will save your document as a PDF file (effectively “printing” your document to PDF). You may recognize PDF files from Microsoft Windows, which required you to install an application called Acrobat Reader to access them. PDF is a great file format for sharing documents that have rich formatting, such as marketing materials and software manuals.
Using Your Macintosh as a Fax Machine

You can set up your Macintosh to receive faxes by connecting its modem to your phone line and turning on the fax capability. (Even if you use broadband, you still have to connect your Macintosh's modem to your phone line, but you don’t need to be able to dial into the Internet.)

To turn on fax receiving, open the Print & Fax preference in System Preferences. Click the check box next to Receive faxes on this computer and put your fax number in the box labeled My Fax Number. You can use your home phone number if you don’t have a dedicated fax number. Decide what you want your Macintosh to do with the incoming faxes and you’re set.

Figure 7-24: I have my Macintosh set up to save incoming faxes to a folder and automatically print them out on my printer. I could elect to have them automatically emailed as well.
Scanners

A scanner is a powerful tool for digitizing real-world objects. Once relegated to digitizing conventional photographs, the scanner is now also frequently used for digitizing negatives, creating animation, digitizing clothing designs, and copying documents (like a copy machine).

Hooking up a scanner to a Macintosh is a piece of cake, provided that the Rule of Probable Connectivity is in your favor ("if the device has a connector that will plug into your Macintosh, it will probably work"). Unfortunately, scanning is still a little weak on Mac OS X, which is shocking when you consider how many Macintosh users are in the graphic art businesses. Still, you're not at a total loss because there exists a great $40 application that breathes new life into unsupported scanners. It's called VueScan, and you can get it at www.hamrick.com.

Connect the cable from your scanner into the accepting port on your Macintosh. (Nothing happens when you plug it in.) The hard part is over. Every scanner is different, so yours may require you to install a driver. Other scanners are automatically recognized. You can use the software included with your scanner, you can use a graphics program like Adobe Photoshop, or you can use Image Capture (if Image Capture can see your scanner).
In case you haven’t noticed, Macintosh computers don’t have floppy disk drives. Apple decided that the floppy drive was useless, so they haven’t had floppy disk drives in their computers since the iMac debuted in 1997. You are still left with a myriad of choices for disk storage, like removable media (such as Zip disks), external hard drives, CDs, or DVDs.

**Working with Disks**

Mac OS X treats disks differently from Microsoft Windows and similarly to Linux. That’s not to say that Mac OS X complicates things or makes your disks behave any differently.

To use a disk with your Macintosh, first insert it into wherever it goes. If it’s a CD or DVD, put it in the CD or DVD drive (or SuperDrive). If it’s a USB or FireWire disk, plug it in to the appropriate jack. This part is the same as Microsoft Windows and just about every other desktop operating system out there.

When you insert a disk into your Macintosh or hook one up to it, Mac OS X displays an icon for the disk on your desktop (remember, Mac OS X *mounts* the disk). Conversely, if you eject a disk, Mac OS X removes it from the desktop. Mac OS X doesn’t show the state of your drive; in other words, if there’s nothing in the drive, Mac OS X doesn’t show you the drive itself. It only shows you the disks.

**Tip:**

If you don’t want to display disks on your desktop, you can tell Finder to hide them. Click the Finder application menu and then click Preferences. Uncheck one or more of the boxes under Show these items on the Desktop and the icons will disappear.
There are some special behaviors for certain disks, too. I'll talk about these behaviors in the disk-specific sections in this chapter.

**Ejecting Disks**

I've mentioned it before, but I want to emphasize again that you should always eject a disk from your Macintosh using one of the seven supported methods:

1. Press the Eject button on your keyboard. If the disk is not a CD or DVD, you have to click the disk's icon first. If your keyboard doesn't have an Eject button, F12 will do the trick. You'll have to hold it down for a second.

2. Select the disk by clicking on it, then press Command-E.

3. Drag the disk to the Eject icon on the Dock. The Eject icon doesn't appear until you drag a disk. It's in the same place as the Trash (the Trash icon turns into the Eject button). There's a special behavior when you're dragging a CD-R or DVD-R: It burns the disk.
4. In a Finder window, click the Eject button next to the disk in the sidebar.

5. Press the Eject button on your device, if it has one (or use an eject feature of an application, such as in iTunes).

6. Control-click the disk icon, then choose Eject from the menu. Right-clicking works too, if you have a multi-button mouse.

7. Select the disk, click File, then click Eject.

You should never eject a disk by unplugging it or pulling the disk out. You could lose your data or damage the disk. This is especially important for external hard drives, including the iPod.

**Repairing, Erasing, and Copying Disks**

Mac OS X includes a special application for working with disks called Disk Utility. You can find it at /Applications/Utilities. You can manage all of your disks with Disk Utility, including unmounting disks, enabling or disabling journaling (this is a special thing that makes your disk more reliable), and ejecting disks. Disk Utility also lets you perform first aid on a disk, erase a disk (like formatting a disk in Microsoft Windows), and create disk images (a copy of your disk in a special format the Mac OS X understands). You can burn a disk image to disk (similar to an ISO file), or copy it to a hard drive/CD/DVD/whatever. A disk image is a file ending in the extension .dmg; you can copy it just about anywhere you can copy any other file.

Disk images are mounted on the desktop, and Mac OS X treats a mounted disk image just like any other disk. You even have to eject it when you're finished using it. Disk images are an excellent way to create direct copies of Mac OS X folders to CD. We'll get to that a little later.
Repairing

You can repair a disk by selecting it in the box on the left side of Disk Utility, then clicking the First Aid button. Mac OS X disk first aid repairs disk permissions (the permissions on files on your disk sometimes get messed up, locking you out of the disk or files) and it repairs the disk itself.

Repairing a disk doesn’t mean that Disk Utility will fix physical damage (such as actual scratches or blemishes on the surface of the disk) to a disk. Repairing a disk really pertains to repairing the disk’s file system. It fixes problems that occur in the file system when a disk is removed without first being unmounted, or if the disk was mounted when your Macintosh is restarted by losing power (from a storm), or by being unplugged or turned off with the button (rather than a clean restart or shutdown).

![Figure 7-26: If you select a disk in Disk Utility, the First Aid screen shows up and you can repair a disk and disk permissions.](image-url)
Repairing a disk also fixes file permissions errors caused by such things as application installations and performing a hard reset (or unplugging the power cord). You can repair permissions by pressing the Repair Disk Permissions button. If you want to, you can verify disk permissions first by pressing the Verify Disk Permissions button. Doing this will save you time if no repairs need to be made.

**Note:**
You can't repair the boot disk (the disk that has Mac OS X on it) from within Disk Utility. You'll have to boot from your Mac OS X Panther installation CD or download a free application from VersionTracker that will make a Mac OS X boot CD with special utilities for fixing problems. This is covered in more detail in Chapter 9.

**Erasing**

Disk Utility can erase hard drives (internal and external, but not your system disk), CD-RW discs, and DVD+RW discs. To erase a disk, select the disk and click the Erase button. But be careful, because Erase doesn't simply remove files from the disk and send them to the Trash. Erase formats the disk, with the same results as formatting a disk in Microsoft Windows; everything is deleted, and there's no way to get it back.

When you erase a hard disk with Disk Utility, you can choose a new volume format. The volume format is the type of disk file system. In the world of Microsoft Windows, the typical file system is FAT32 or NTFS. Mac OS X supports four file systems:

- Mac OS Extended
- Mac OS Extended (Journaled)
- Mac OS Standard
- UNIX File System
Mac OS Extended is the default file system volume format. It’s a high-performance volume format that uses loads of technical stuff, like resource forks. Mac OS Extended is also available in journaled form to help protect the system if it loses power or if a component fails. Mac OS Standard is the classic Macintosh disk format that people sometimes need to use, like when they have older Macintosh computers. The Unix File System (UFS) is carried over from the Unix world. It lacks some of the features of Mac OS Extended, like associating a type and creator with a file. For example, on a UFS disk, JPEG files would not be associated with Photoshop.
Copying

To copy a disk, you must create a disk image. As previously stated, a disk image is a perfect copy of a disk or a folder in file form, which can be burned to CD or shared in several ways. Copying a disk in Disk Utility is very simple. First, click the disk in the list on the left side of the Disk Utility application. Second, click the Images menu, then New, then Image from <your disk>.... See Figure 7-28 to see how I created a disk image of PocketDrive.

Figure 7-28: (Top) I selected New, then Image from PocketDrive.... (Bottom) Then I set the options for my new image (named it PDImage, elected to make the image read-only) and clicked Save. (Right) Disk Utility then created the disk image for me and placed the new file where I specified (in my case, my desktop).
When you create a disk image, Disk Utility creates a new file with the .dmg extension and places it wherever you specify. You can then mount it, just like a disk, or use Disk Utility to burn the image to a CD (not the image file but the actual image itself, creating a CD copy of your disk). I'll talk about that a little later.

**Removable Media**

For this discussion, I use the term “removable media” to describe disk-based media such as Zip disks, floppy disks, Jaz disks, backup tapes, and so on. Considering the Rule of Probable Connectivity, your removable media device will probably work if you can easily plug it into your Macintosh. This is definitely the case for the Zip and Jaz drives, as Mac OS X includes drivers for these devices. Other removable media devices, however, such as Bernoulli drives and tape backup systems, will probably require a visit to the manufacturer’s web site for the latest drivers.

There is no floppy drive in a Macintosh; the floppy has been absent since the introduction of the iMac in 1997. If you want to use floppy disks for whatever reason, you can buy an external USB floppy drive for your Macintosh at most computer retailers.

**External Hard Drives**

If your external hard drive supports FireWire, it will work with your Macintosh, as long as you have a post-1997 Macintosh. Pre-1997 Macs do not have FireWire support.

If your hard drive is USB (such as a keychain hard drive) and it supports USB 1.1, it will work with most Macintosh computers. If your hard drive is USB 2.0, it will work with the latest models, except the eMac. Of course, at the time of publication, Apple may have updated the eMac to support USB 2.0. You’ll need to check the user guide included with your Macintosh to make sure.
When you plug an external hard drive into your Macintosh, an icon appears on the desktop (unless you have this option turned off in Finder preferences). You can then use your hard drive just as if it were built into your Macintosh. If you’ve opted for the icon not to appear when the disk is mounted, you can access it by opening a Finder window and clicking the disk’s icon in the sidebar.

**CDs and DVDs**

Mac OS X can read any CD that adheres to the ISO-9660 or Joliet standards. Readily available music CDs (except those with weird copy protection schemes), PC CDs, Unix CDs, and Macintosh CDs should adhere to these standards, and as long as they do, your Macintosh can read them. And of course, Mac OS X can read and write CD-R and CD-RW discs too.

You can use writable CDs and DVDs to easily back up your data or store files for sharing. When you burn a data CD or data DVD, the disc isn’t playable in CD or DVD players; only computers can read it.

**Note:**

The exception is MP3 CDs and MP3 DVDs, which are discs filled with MP3s and playable in special MP3 disc players.

Mac OS X can also understand any DVD that follows the DVD standard, and can read and write DVD-R and DVD-RW. All that alphabet soup means that your Macintosh can work with nearly any current optical disk format out there.
Note:
Mac OS X can also work with DVD+R and DVD+RW media, but DVD+R and DVD+RW aren’t supported by the SuperDrive (the CD/DVD drive in your Macintosh). If you have an external DVD+R/DVD+RW drive, you can use it to back up data as Mac OS X supports it. You can burn files to the disc in Finder, but you won’t be able to use iDVD or iTunes with a DVD+R or DVD+RW.

To use one of these discs, insert the disc into your Macintosh. If you have a slot-loading Macintosh, just slide the disc in. If your Macintosh has a CD tray, depending on the model of Macintosh you have, to open it you press the Eject button on the physical drive, press the Eject key on your keyboard for about one second, or press F12 for about one second if your keyboard doesn’t have an Eject key. When you place the disc in the drive tray, gently press the tray to close it. If you are using a PowerBook or iBook, just slide the drive closed until you hear a click.

Accessing Data on a CD or DVD
If you insert a CD or DVD containing data, you can access the data on the disc the same way you access data on any other disc: through Finder. If the disc is writable, such as a CD-R, CD-RW, DVD-R, or DVD-RW, you can drag files to it, rename the disc, change its icon, and anything else you can do to another disc (including erasing it). If the disc is a CD-ROM, meaning it’s read-only, then all you can do is read, not alter, the data on the disc or copy data from it.

Note:
Playing CDs and DVDs on your Macintosh is covered in Chapter 5.
Burning Data CDs

Burning CDs in Mac OS X is very easy. It can be as simple as dragging files to a CD-R or CD-RW and ejecting the disc, or creating a playlist in iTunes and clicking the Burn Disc icon, or using Disk Utility.

To use a CD-R or CD-RW for backing up or sharing files, first insert the blank disc in your drive. Mac OS X will read the disc, figure out that it's a writable CD, and display a dialog box asking you what you want to do with the disc.

---

You inserted a blank CD. Choose what to do from the pop-up menu.

- **Action:** Open Finder
- **Name:** untitled CD
- **Make this action the default**

---

Figure 7-29: This is what you see when you put a blank, writable CD in your Macintosh for the first time, and every time you put a blank, writable CD in your Macintosh unless you choose otherwise (like clicking the Make this action the default check box).

You have two options for action: You can choose to open Finder so you can start copying files to the CD, or you can choose to open iTunes to make a music CD. You can also name the CD and elect to make the selected action show up as the default each time you insert a blank CD. If after making your selections you're ready to proceed with adding files or music to the CD, click OK to continue. If you change your mind about the disc (you've inserted a blank CD by mistake or no longer wish to use the blank CD), click Eject. If you want Mac OS X to pretend the disc is not there right now so that you can use it later when you're ready for it, click Ignore. You can still access it from iTunes. If you insert a previously used CD-R or CD-RW, you won't see this box.
Note:
If it is a CD-R, you can erase it, but you cannot use it again. If it’s a CD-RW that you no longer need to keep, you can erase it using Disk Utility and then add your new information to it.

When you choose Open Finder in the dialog box, the disc is mounted on your desktop and you can drag files to it. Again, this disc works just like any other, so you can copy files, delete files, rename files, rename the disc, change the disc’s icon, and so on.

When you have your files set up the way you want them on the CD, it’s time to burn the disc. Burning means committing the files to the disc. When you begin adding files to your blank CD, Mac OS X creates a disk image of it and your files and folders are copied there. When you burn the disc, that disk image is copied to the CD.

Note:
An update to Mac OS X Panther added multisession recording. This means you can copy files to a CD-R, burn the CD-R, and copy additional files to it later. For more information on how to use the multisession capability, see www.standefer.com/switcher.

To burn the disc, you have a few options:

- You can drag the disc to the Trash on the Dock. The Trash icon will turn into a nuclear symbol. Drop the disc on the nuclear symbol and the disc will begin burning.
- You can select the disc, click File, and then Burn Disc in Finder.
- You can Control-click (or right-click) the disc’s icon on the desktop and pick Burn Disc.
When you start the disc burning, Mac OS X will prompt you with one more dialog box, asking if you’re sure you want to burn the disc, as seen in Figure 7-30.

Figure 7-30: Mac OS X confirms your request to burn the disc. This is your chance to back out.

Leave the speed setting at Maximum unless you are using a disc that requires a slower burn speed. At this point, if you click Eject, your recording session will be cancelled (the disk image will be deleted and the files you put on the CD will no longer be associated with that CD) and your disc will stay blank, allowing you to start all over again. If you’re certain you’ve added all you wanted to the disc, click the Burn button, and the information you dragged over will be committed to the CD.

**Burning CDs Using Disk Utility**

Occasionally, you may want to burn a disk image to CD. Sometimes I download software packaged in a disk image, and then I create a CD from that image using Disk Utility so I can easily copy the software to another machine or share it with friends (the true spirit of shareware).

To burn a disk image to CD, select the disk image in Disk Utility and click the Burn icon on the toolbar. If the disk image you want to burn isn’t displayed in Disk Utility, you can drag an alias of the disk image from Finder into Disk Utility.
Figure 7-31: Burning a CD in Disk Utility gives you a few more options, such as verifying the burn and ejecting the disk after burning.

To proceed with burning the disc, click the Burn button. You can cancel the burn by clicking the Cancel button. If you realize the wrong CD-R or CD-RW is in the drive, you can click the Eject button to eject the disc so you can insert a different one.

**Burning Music CDs**

A music CD is a compact disc containing music that is playable in a standard CD player. As I mentioned earlier, you can also make an MP3 CD, which is essentially a data CD with a bunch of MP3 files on it, but this section focuses on using iTunes to make music CDs you can play in any CD player.

**Tip:**

Use a regular CD-R and not a CD-RW. CD-Rs are cheaper and more likely to play in a CD player. Many CD players can't read the CD-RW format.

The first thing you have to do is start up iTunes. It's located in /Applications, of course. With iTunes open, you need to decide which songs you want burned to your music CD. A CD can only
Connect and Use Your Hardware

Hold 74 minutes of music, which is 1.2 hours of music, so be mindful of that when choosing your songs.

I’m going to make a CD of some Nick Drake songs I like. iTunes is open, the Nick Drake songs are displayed in iTunes, so what do I do next? Create a new playlist by pressing Command-N.

Figure 7-32: I selected all of the Nick Drake songs I want to record to CD, and then I dragged them to the Source box to create a playlist. I then clicked the playlist to see how much time is used up: 1.1 hours, which means I have room to spare.

Whatever your playlist is named will become the name of the CD, so you can change your playlist’s name by clicking it, just like changing a file’s name in Finder. You can make changes to your playlist, and when you’ve made all of your decisions, you’re ready to burn a CD.

But first, you need to make a couple of decisions. Open iTunes preferences by clicking the iTunes application menu, and
then Preferences... (or press Command-,). Click the Burn icon. You should see the window shown in Figure 7-33.

Figure 7-33: Be sure you select the Audio CD disc format if you want to play your CD in a standard CD player. If you want to make a CD of MP3s, pick MP3 CD. You can also set the length of silence between songs by choosing a value for Gap Between Songs.

When you’re finally ready to burn your playlist to CD, click the playlist, make sure the songs you want to burn to CD have check marks next to them, and then click Burn Disc in the upper-right corner of iTunes. iTunes will do some calculations and then tell you the disc is ready to be burned (iTunes will eject the disc tray if you don’t have a CD-R inserted). Click the nuclear symbol and in a few minutes, you’ll have a music CD. If you decide you don’t want to burn a CD after all, click the X icon to cancel the burn. That’s it!

**Burning DVDs**

You burn a DVD the same way you burn a CD. You insert the DVD-R or DVD-RW, drag files to it, and burn it using one of the three disc burning methods. You can also use Disk Utility to burn a DVD the same way you use Disk Utility to burn a CD.
Burning DVDs in iDVD

Burning a DVD playable in a DVD player is a little different from burning a data DVD. You need to use iDVD, found in /Applications/iDVD 2, to make your DVD. In the iDVD application, you can create a project for your DVD. This is how you create the menu screen for your DVD. You can add pictures, slide shows, video, and music to your DVD menu and make it as simple or complex as you want.

Burning a DVD in iDVD is easy. After you create your iDVD project, click the Burn icon in the lower-right corner. It will turn into the nuclear symbol. (If a DVD-R or DVD-RW is not in the SuperDrive, iDVD will eject the SuperDrive tray and pop up a message asking you to insert a DVD-R or DVD-RW.) Simply click the nuclear symbol to start burning your DVD.

A full discussion of iDVD’s features would consume a whole book, so you should take a trip to your local bookstore and choose an iDVD book for the lowdown on all of iDVD’s features.

Setting CD and DVD Preferences

You can control the way Mac OS X handles certain types of CDs and DVDs via the CDs & DVDs preference in System Preferences. For example, tell Mac OS X to open iTunes when you insert a music CD and open DVD Player when you insert a DVD.

Figure 7-34: Click the drop-down menu to choose the action you want Mac OS X to take when you insert a disc.
Chapter 7

Display Devices

I remember when a display device consisted of a console television and an RF modulator. Today, displays are much more sophisticated, and they come in different sizes and configurations to suit just about any display need.

For almost any Macintosh other than a Power Mac G5, you can purchase an Apple video adapter and output your Macintosh’s video to a television via an S-video cable (sometimes erroneously referred to as SVHS) or composite video signal (the red, yellow, and white connectors). If you have a Power Mac G5, you can buy the special DVI to video adapter from Apple to achieve the same result.

If you want to connect your iMac or iBook to an external monitor, you will need to purchase the Apple VGA display adapter, which allows you to connect your Macintosh to any VGA monitor. This achieves video mirroring, which means that what you will see on your external display is the same as what you see on your iMac’s display. iMacs don’t support dual monitors.

If you have a Power Mac, a DVI to VGA adapter is included, so out of the box you can connect to a second display using VGA or ADC (the proprietary Apple connector for Apple displays). Power Mac computers have two video outputs: one ADC and one DVI. This means that you don’t even need a connector if your second monitor is DVI. Power Mac computers support video mirroring and extended desktops, which actually lets your single desktop occupy two monitors at the same time with the two monitors acting as though they were one.
Display Preferences

To set the properties of your display, use the Displays preference in System Preferences. You can define the resolution, brightness, color depth, and color profile. Most of these settings don’t require you to fiddle with them. Apple sets them to what they think are the best settings. I leave the settings as they are, with the exception of brightness. I tend to adjust my brightness throughout the day.

Figure 7-35: Changes you make in the Displays preference occur immediately; there’s no Apply button like in Microsoft Windows.
Personal Digital Assistants

Mac OS X supports personal digital assistants running the Palm operating system. The Macintosh had limited support for PDAs in the past, but the introduction of Mac OS X changed all that.

Connect Your PDA to Your Macintosh

Connecting your PDA to your Macintosh requires a USB connection between your Palm and your Macintosh. Some PDA manufacturers support serial-to-USB converters. For this discussion, I will assume that your PDA has a USB cable. If your PDA or PDA dock does not have a USB cable, you will need to either acquire a cable that converts the cable-to-USB (like the serial-to-USB converter) or purchase a supported USB cable for your PDA.

Note:

Mac OS X doesn't do anything special when you plug in a PDA. It doesn't put an icon on your desktop or launch an application automatically.

Synchronize Your PDA and Macintosh

You have a few options when it comes to synchronizing your PDA and your Macintosh. You can use the Palm Desktop application, you can synchronize your PDA with iCal and Address Book using iSync, or you can synchronize your PDA with Microsoft Entourage.

Synchronizing with Palm Desktop for Macintosh

Synchronizing your PDA with Palm Desktop for Macintosh is a no-brainer. It works exactly the same way as it does with
Microsoft Windows. After you create your To Do items, memos, contacts, events, and so on, you just click the HotSync button on your Palm device (or the Palm device’s cradle, depending on the device).

**Synchronizing with iSync**

In order to synchronize your PDA with iSync, you will need to download and install the iSync Palm Conduit from Apple’s web site. You will also need to have Palm Desktop for Macintosh installed.

---

**Note:**

Pocket PC users are not left out in the cold completely! Using a third-party tool such as Missing Sync, you can use iSync to synchronize your Pocket PC with Address Book and iCal. Check out apple.com/isync for more details.

---

Once you have Palm Desktop for Macintosh and the iSync Palm Conduit installed, you need to activate the iSync Conduit in HotSync Manager. HotSync Manager is found in the folder where you installed Palm Desktop for Macintosh (on my Macintosh, it’s in /Applications/Palm).

When you have HotSync Manager open, click the HotSync menu, and then click Conduit Settings.... The Conduit Settings window will open, and the current Palm user will be selected. If you need to change Palm users, click the combo box and select the correct user.

iSync Conduit will be listed in the column labeled Conduit Name. Click iSync Conduit, and then click the Conduit Settings button. Finally, click the check box labeled Enable iSync for this Palm Device if it’s not already checked (there should be a check mark in the box). Click the OK button, close Conduit Settings, and then quit HotSync Manager.
Figure 7-36: I clicked the Conduit Settings button and this preference pane popped up. It's a little confusing having a button labeled Conduit Settings in a window also labeled Conduit Settings. If you have trouble figuring things out, click the question mark button on the right for guided help.

Now that you have the iSync Conduit set up, you're ready to sync with iCal and Address Book. Start the iSync application. You should see your Palm device on the iSync window, with the name of the Palm user you set up. Go ahead and click it to show the synchronization options for that device.

The synchronization options allow you to fine-tune your synchronization, such as specifying which iCal calendars you want synchronized. Make your selections; iSync will set them as the default and you're ready to synchronize. Just click Sync Now and iSync will take care of the rest.
For first sync: Merge data on computer and device

- Turn on rob synchronization
- Force slow synchronization

**Contacts**

- Synchronize: All contacts

**Calendars**

- All
  - Home
  - Work

- Selected:

- Put events created on Palm into: Home

- Ignore Palm events older than: One Week

- Events Time Zone: US/Central
  - Using System Time Zone

![iSync interface with user settings](image)

**Figure 7-37:** My Palm user is named rob, so iSync labels my Palm "rob." When I click it, the synchronization details are displayed.

**Note:**

When you click the Sync Now button with a Palm device added to iSync, iSync will pop open a message alerting you that you need to press the HotSync button on your Palm device. If you don’t press this button, synchronization with your PDA will fail. If you don’t want to synchronize your Palm, click either the Cancel button or the button labeled Sync without PalmOS devices.
Synchronizing with Entourage

Microsoft Entourage is an excellent personal information management (PIM) application that is included in the Microsoft Office for the Macintosh suite. (Chapter 8 is dedicated to Microsoft Office:mac.) Some people I know have hundreds of contacts and dozens of appointments set up in Microsoft Entourage. They don’t use iCal or Address Book because they’re ingrained in Microsoft Entourage, and they like it. It works for them; if it works for you, that’s perfectly fine.

Coming from Microsoft Windows, you may be the type of user who eschewed Palm Desktop for Windows in favor of Microsoft Outlook. If that’s the case, you may naturally gravitate toward Microsoft Entourage, with its similarity to Microsoft Outlook and its awesome features. You can also synchronize Entourage, Address Book, and iCal. They’re not mutually exclusive.

Synchronizing your Palm with Microsoft Entourage requires some of the same steps as setting up synchronization through iSync. First, you’ll need to download the Handheld Sync Installer from Microsoft’s web site at microsoft.com/mac and install it on your Macintosh.

Tip:
The Handheld Sync Installer requires certain Microsoft Office updates, so ensure you have those before installing Handheld Sync for Entourage. You can download the required update by following the links on the Handheld Sync software download page.

When you install the Microsoft Handheld Synch application, it will disable Palm Desktop for Macintosh. The installer puts the Microsoft Entourage Conduit in the appropriate folder, making it accessible from the Conduit Settings preferences in HotSync Manager.
Let's set up the Microsoft Entourage Conduit. Open up HotSync Manager from the application where it was installed (on my Macintosh, it's in /Applications/Palm). Click the HotSync menu, and then click Conduit Settings... to open the Conduit Settings pane. You should see Entourage Conduit in the Conduit Name column. If you don't see it, something is wrong. You'll have to check the support pages at Microsoft's Macintosh site at microsoft.com/mac for more help.

Click Entourage Conduit, and then click the Conduit Settings button. This will bring up the settings for the Entourage Conduit, allowing you to fine-tune the synchronization of your Palm with Microsoft Entourage.

**Entourage Conduit Settings**

<table>
<thead>
<tr>
<th>Synchronization options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Entourage Identity:</td>
<td>Main Identity</td>
</tr>
<tr>
<td></td>
<td>Settings...</td>
</tr>
<tr>
<td>Address Book:</td>
<td>Synchronize</td>
</tr>
<tr>
<td></td>
<td>Settings...</td>
</tr>
<tr>
<td>Calendar:</td>
<td>Synchronize</td>
</tr>
<tr>
<td></td>
<td>Settings...</td>
</tr>
<tr>
<td>Tasks:</td>
<td>Synchronize</td>
</tr>
<tr>
<td></td>
<td>Settings...</td>
</tr>
<tr>
<td>Notes:</td>
<td>Synchronize</td>
</tr>
<tr>
<td></td>
<td>Settings...</td>
</tr>
<tr>
<td>□ Synchronize private records</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

Figure 7-38: Make sure you choose the correct identity for synchronization. I only have one, so Main Identity is the default and only choice. If you have multiple users set up in Microsoft Entourage, you will need to select the identity of the user for whom you want synchronization to occur.

Decide what you want to synchronize from the choices (Address Book, Calendar, Tasks, and Notes), and then click the OK button. You can then quit HotSync Manager.
To synchronize Microsoft Entourage with your Palm, click the HotSync button on the cradle or in the HotSync application on your Palm. That’s all there is to it!

Summary

This chapter was all about connecting hardware to your Macintosh. Hopefully, your devices work just fine with your Macintosh. As the Macintosh grows in popularity, more and more manufacturers will support the platform. As it stands, there’s pretty decent support for most hardware that’s currently on the market, but alas, ’tis not a perfect world.
Microsoft Office is a strange thing. It drives Microsoft, providing a large chunk of the company's revenue. Businesses build their entire desktop PC infrastructure around Microsoft Office and its system requirements. When a new version of Microsoft Office is announced, people rejoice.

Okay, maybe there's not that much fanfare, but everyone probably agrees that Microsoft Office is a pretty important piece of software for millions of people. So, when Microsoft and Apple joined forces in 1997 and Bill Gates promised a new version of Microsoft Office for the Macintosh, there was much legitimate excitement. The announcement led to Office 98 for the Macintosh, which was 100 percent compatible with Office 97 for Windows and released in 1998.

After Microsoft released Office 2000 for Windows, they followed up with a Macintosh version, called Office 2001. It was 100 percent compatible with the file formats of Office 2000, keeping Macintosh users happy because they could use a Macintosh in a corporate environment. It also included Entourage:mac 2001, Microsoft's new personal information manager and email application for the Macintosh.
While the first version of Microsoft Office for Macintosh, version 1.5, appeared in 1991, Word, Excel, and PowerPoint had been available for the Macintosh since the 1980s. Word 1.0 for Macintosh was released in 1984, and Excel 1.0 for Macintosh was released in 1985. PowerPoint was originally developed on a Lisa and released for the Macintosh in 1987 (this was before Microsoft bought Forethought, the original makers of PowerPoint); PowerPoint didn’t appear on Microsoft Windows until 1990. The announcement of Office for the Macintosh in 1997 was so important because it reaffirmed Microsoft’s commitment to the Macintosh platform and promised updated versions of the very important applications that make up the Microsoft Office suite. Microsoft had released an arguably awful version of Word for the Macintosh (version 6.0), and Macintosh users had been feeling slighted by the software giant.

Microsoft released Office XP for Windows in 2001 and followed that with a release of the first Mac OS X version of Office, called Office v. X for Mac. Many Office:mac users agree that the Mac OS X version of Office is superior to Office XP, all while maintaining 100 percent file compatibility with Office for Windows, right down to the Visual Basic macros.

**Tip:**
If Microsoft Office isn’t that important to you and you just want to open and edit Microsoft Office documents, you can use AppleWorks. AppleWorks is included on every eMac, iMac, and iBook. You can also purchase it from Apple for $99. It has a lot of the features of Microsoft Office at a significantly lower cost. It works fine for most of your Office documents, but it does not have 100 percent compatibility. If you already know and love Microsoft Office, AppleWorks may not be right for you.
This chapter will help you get started with Office:mac by “translating” Microsoft Office XP functionality into its corresponding Office:mac features. This chapter doesn’t cover every single detail of Microsoft Office:mac; rather, the intention is to help you identify what’s different between the two versions, and what you can expect when moving from Office XP to Office:mac.

Each Microsoft Office for Windows version, from Office 1.0 to Office System 2003, is different. This chapter focuses on Microsoft Office XP for Windows, which is currently the most popular version of Microsoft Office in use, and Microsoft Office:mac v.X, which is the current version of Microsoft Office for the Macintosh.

Note:
At the time of publication, Microsoft had announced Office 2004 for Macintosh but had not released it yet. From early reports, Office 2004’s major differences lie in its new tools (such as Project Center and Compatibility Reports). It will also feature some user interface enhancements.

What’s Missing in Office:mac

Before I get started with the comparison, I should point out that Microsoft Office:mac doesn’t have all the applications that are included in Microsoft Office XP for Windows. It’s a bit of a sore spot for some Microsoft Office:mac users, but there are alternative software applications for Mac OS X that provide the same functionality.

Microsoft Access

Microsoft Access is a database program that is very popular for small database applications. While there is no version of Microsoft Access for the Macintosh, there are good Mac OS X
alternatives out there, including the easy-to-use FileMaker, the powerful and popular MySQL (which is free), and the also-free PostgreSQL.

**Microsoft FrontPage**

I know many people who seemingly can't live without Microsoft FrontPage. They love it for its simple page editing and site management features. Microsoft has decided not to make a version of FrontPage for the Macintosh, but that's fine, because there are many other web development and management tools for the Macintosh. Take a look at Softpress Freeway, Macromedia Dreamweaver MX, and Adobe GoLive for a start. If you like to build HTML pages by hand, take a look at BBEdit. Or use TextEdit, located in /Applications.

**Microsoft Publisher**

Microsoft Publisher lets you create rich content, such as brochures and marketing materials. It's essentially a simplified desktop publishing tool. The desktop publishing industry was created on Macintosh computers, so there are tons of Mac OS X alternatives to Microsoft Publisher that are as easy to use.

QuarkXPress and Adobe InDesign CS are popular professional desktop publishing tools for the Macintosh, but they can be pretty expensive. If you don't want to spend that much, you can check out Stone Create ($149, part of the $299 Stone Studio suite of applications).
Microsoft Project

Microsoft Project was released for the Macintosh five years ago (version 4.0), but there is sadly no current version of Microsoft Project for the Macintosh. This is really hard to understand, given the prevalence of Macintosh computers in print shops and animation studios, and the existence of the old version (you can find it online, but it was only available on 3.5" floppy disks).

It looks like Microsoft doesn't have any plans to put out a Mac OS X version of Microsoft Project for Macintosh, so in the meantime, you can either run it in Virtual PC or take a look at Project Manager X, which imports MPP files from Project 2000 and above.
Microsoft Visio

Microsoft Visio is a flowcharting and modeling tool that is really popular with business professionals and software developers. It features several templates for creating flowcharts, network diagrams, UML software diagrams, entity-relationship diagrams, and all kinds of other technical stuff. There's no version of Microsoft Visio for the Macintosh, but there are some excellent alternatives, some of which are free.

The first thing you should do is see if OmniGraffle is in your /Applications folder. It's included with the Power Macintosh and PowerBook models. OmniGraffle is an awesome application that lets you create several different types of drawings, just like Microsoft Visio. You can use the OmniGraffle stencils to create circuit engineering diagrams, flowcharts, office layouts, periodic tables, GUI designs, and UML diagrams, to name a few.

If you don't have OmniGraffle and you want to create UML diagrams, you should check out Poseidon for UML.
Switch to Microsoft Office:mac Edition. It's based on the open-source ArgoUML project, and it's free. It's somewhat limited in features, however, so you may want to take a look at QuickUML from Excel Software if you need the hard-core stuff. It features UML modeling, database design, process modeling, code generation, and other powerful features like those found in Microsoft Visio.

Office:mac and Office XP

Office:mac is a suite of applications that includes Word:mac, Excel:mac, PowerPoint:mac, and Entourage:mac. In many ways, Office:mac is the same as Office XP, in terms of functionality. The Macintosh versions of Word, Excel, and PowerPoint work the same way as the Microsoft Windows versions; you create a Word document in Word:mac the same way you do in Word XP, for example.

The key differences between Office:mac and Office XP lie in user interface changes. For example, Office:mac applications don't "host" their documents, like Office XP does. The Office:mac document window isn't contained inside the specific Office:mac application; it floats around on its own and disappears entirely when Office:mac is no longer the active application. This differs from Office XP applications, which host their child documents (in other words, an Excel workbook is contained by Excel).

Tip:

When you minimize an Office:mac document, it minimizes to the Dock, just like application windows.

Office:mac can read and write documents created in Office 95, Office 97, Office 2000, Office XP, Office 98 for Macintosh, and Office 2001 for Macintosh. It can also import documents from other applications, like Lotus 1-2-3 and WordPerfect.
Chapter 8

Startup

When you launch Word:mac, Excel:mac, or PowerPoint:mac from the Microsoft Office X folder in /Applications, you’ll immediately see something specific to Office:mac. It’s the Project Gallery, which is your dashboard for creating new Office documents. You can create a new blank Office document, or you can create an Office document from a template (you can choose a template from the Category box). You can also choose to create an Office document by clicking one of the options (List Wizard creates an Excel spreadsheet, Mail Message creates an Entourage:mac email, and so on).

Figure 8-3: This is the Project Gallery. If you want to open an existing Office document or one of the documents Office:mac supports (like a Lotus 1-2-3 spreadsheet), click the Open... button.

Documents

A document in Office:mac is the same as a document in Office XP (for this discussion, I’ll use the term document to include Word documents, Excel spreadsheets, and PowerPoint presentations). You can add content to your document, create tables, make text bold, and so on. When you click Save in an Office:mac application, you get the same thing as when you click Save in an
Office XP application: a file containing your data and formatting. The file is in one of the Office application formats (for example, a .doc file for Word or an .xls for Excel). If you create a document in Office:mac, you can open and edit it in Office XP, and vice versa.

To create a new Office:mac document, click the type of project you want to create, such as Word Document or Excel Spreadsheet, in Project Gallery and then click OK. Office:mac will close the Project Gallery and present you with a fresh, blank document. This process is different from Office XP, which opens a new Office document by default when you launch the Office XP application and shows the New Document task pane.

Figure 8-4: The task pane in Office XP gives you choices for creating new documents from templates or existing documents. In Office:mac, this is handled by Project Gallery.
Menus

For the most part, the menus in Office:mac applications are the same as the menus in Office XP applications. Furthermore, the Office:mac applications (excluding Entourage) use the same base menu structure. In other words, they all have a File menu, an Edit menu, a Tools menu, a Window menu, and a Help menu; we’ll call these shared menus. Each Office:mac application has its own specific items in its shared menus, which we’ll look at in the application-specific sections of this chapter. First, let’s take a look at the shared menus and how they compare to their Office XP counterparts. Each of the menus discussed in this section are common across the Office:mac applications.

Note:
When I refer to Office:mac applications, I’m excluding Entourage:mac from the mix. While it is a part of Office:mac, it doesn’t have the same menu structure or most of the features found in the other Office:mac applications, like a Formatting Palette. Entourage:mac has its own section at the end of this chapter.

File

The File menu in Office:mac applications is very similar to the File menu in Office XP applications. Items in the Office:mac File menu with the same names in the Office XP File menu, such as Save, Close, and Properties, work the same; that is, they produce the same result (saves a document, closes a document, opens a document’s properties). The File menu in Office:mac applications has a few differences from its Office XP cousin. Let’s take a look.

Project Gallery... opens the Project Gallery that you see when you start an Office:mac application (refer to the Startup section earlier in this chapter).

The Office:mac File menu does not have the Search... item (use Finder’s Command-F instead), nor does it have the Exit item (Quit is in the application menu).

Edit

The Edit menus in Office:mac and Office XP are almost exactly the same. The difference is the absence of Office Clipboard... in the Office:mac Edit menu. Office:mac moves the Office Clipboard to the View menu. All of the other menu items in the Edit menu work exactly the same.

Figure 8-5: Notice that both the Office:mac Edit menu and the Office XP Edit menu show you the shortcuts for the menu items. The other menus in Office:mac and Office XP show the shortcuts as well.
Tools

Office:mac applications have their own specific Tools menus, but there are two items that are common to the Tools menus in Word:mac, Excel:mac, and PowerPoint:mac.

Dictionary is a new item in Office:mac. It opens a searchable dictionary, in which you can type in a word and read its definition.

![Dictionary Menu]

Figure 8-6: If you Control-click a word and click Define, the dictionary opens with the definition of the word.

Flag for Follow Up... lets you create a reminder to follow up on your document, spreadsheet, or presentation at a specified date and time. This is helpful for those situations when you have a deadline for finishing a document, or you send the document to someone and you need a response by a certain date.
Window

In each Office:mac application, the Window menu has all of the items in the corresponding Office XP application (for example, both Excel:mac and Excel XP have the Hide, Unhide, Split, and Freeze Panes items). Office:mac applications add three items to the Window menu.

**Zoom Window** doesn’t really zoom anything; it just changes the size of your Office:mac document window. This is the same as clicking the green + button in the title bar.

**Minimize Window** does just that: it minimizes the current document window.

**Bring All to Front** seems like it would bring all the document windows to the front, but honestly, I’ve never figured out how it’s supposed to work.

Help

The Office:mac Help menu is very similar to the Office XP Help menu. It only excludes the Office XP features that don’t apply to Office:mac, such as Activate Product... and Detect and Repair....

The other menus in Office:mac applications differ by application, so we’ll take a look at those menus in the application-specific sections of this chapter.

Formatting

Formatting is where Office:mac really shines. In addition to offering the same formatting toolbars as Office XP, Office:mac has a floating window called the Formatting Palette. The Formatting Palette allows you to close all of those formatting toolbars, conserving screen real estate and reducing clutter. You can activate the Formatting Palette by clicking View, and then Formatting Palette. You can also click the Formatting Palette toolbar button, seen in Figure 8-7.
Chapter 8

Figure 8-7: The button in the "clicked" state is the Formatting Palette button on the Standard toolbar in Word:mac (it looks the same in Excel:mac and PowerPoint:mac, too). If the Formatting Palette is already visible, clicking this button will hide the palette.

The Formatting Palette contains labeled sections, with options for formatting your document, spreadsheet, or presentation. The Formatting Palette contains different options for each application, so the Word:mac Formatting Palette is different from the Excel:mac Formatting Palette, but they work the same way.

Each section has an arrow; if you click the arrow, it expands and contracts the section. You can control the format of text, borders, spreadsheet cells, and so on. The Formatting Palette is essentially several toolbars rolled up into one nicely compact floating window.

Figure 8-8: The Formatting Palette in Word:mac, Excel:mac, and PowerPoint:mac. Each Formatting Palette is specific to the application.

Note:
The Formatting Palette isn't available in Entourage:mac, mostly because Entourage:mac doesn't deal with formatting documents; it's a personal information manager.
**Toolbars**

Office:mac applications have most of the toolbars in Office XP applications, and they work the same way. Click the View menu, and then click Toolbars to see the individual toolbars available to that Office:mac application. Some of the toolbars that are “missing” in Office:mac applications aren’t really missing at all; they’re part of the Formatting Palette (as in the case of Borders). If something you need is missing, check to see if it’s available elsewhere in the Office:mac application, such as in a menu.

![Customize window](image)

Figure 8-9: You can customize your toolbars in Office:mac applications the same way as in Office XP. Click View, then Toolbars, then Customize... (or Tools, and then Customize...) to open this Customize window. You can also customize your menus at the same time.

**Tip:**

You can increase and decrease the size of a toolbar by dragging the resize grip in the bottom-right corner of the toolbar.
Office Assistant

Yes, Office:mac has the Office Assistant, in the form of an anthropomorphic Macintosh. It's kind of cute, and it can be helpful. You can turn it on by clicking the Help icon in the Standard toolbar. If you're not fond of Office Assistant, you can deactivate it by turning off Use the Office Assistant in the Help menu.

Macros

Microsoft includes the Visual Basic for Applications macro engine in Office:mac, so most of your Office XP macros should work fine. You can even use the Visual Basic Editor in the Macros menu under the Tools menu to write your macros by hand. If you share an Office:mac document with an Office XP user, your Office:mac macro should work with no problems.

Figure 8-10: After you finish editing your macro, save it, and then click the Word application menu. Choose Close and return to Microsoft Word to quit the Visual Basic Editor.
Preferences

In Office XP applications, you can click Options under the Tools menu to open the Options dialog, which lets you configure your Office XP application down to its last detail. In Office:mac, things work a little differently. Click the application menu, and then click Preferences... to configure your Office:mac application.

The Preferences dialog in the Office:mac applications works the same as Options in Office XP: It lets you set options (or preferences, as they are known in Mac OS X) for the individual Office:mac applications. The application dialogs differ in some ways. The Word:mac Preferences dialog, for example, is the same as the Word XP Options dialog except for one option, Security. The Excel:mac Preferences dialog, on the other hand, is missing several options found in the Excel XP Options dialog, including Error Checking and Spelling. In most cases, the “missing” options are configurable in other preferences.

Figure 8-11: The Word:mac Preferences dialog has a better user interface than its Word XP cousin, but the Word XP Options dialog offers slightly more configuration choices.
Word:mac

Word:mac is the Office:mac application I use the most (I used it to write this book). I use Microsoft Word XP a lot at my day job and Word:mac when I get home. I have been using Word since 1991.

Word XP and Word:mac have a lot in common, and they work pretty much the same way. Word:mac moves a few things around, adds some new features, and lacks a few features found in Word XP. The other differences lie in how Word:mac looks and feels. Let's dive in.

Word Documents

The Word document window works the same way in Word:mac as it does in Word XP. It has a title bar, a scroll bar with a splitter, buttons to change the document view, a status bar, and the ability to turn on options like Track Changes and Macro Recording.

If you look at the four buttons on the left side of the status bar in Word:mac, they're the same four buttons as in Word XP, with slightly different icons. These four buttons change the view of your document. The first button is Normal View, the second button is Online Layout View (called Web Layout View in Word XP), the third button is Page Layout View (called Print Layout View in Word XP), and the fourth button is Outline View.

The status bar displays information about your document, including the current page and a running page count. This is almost exactly the same as in Word XP; there are only two differences, both in the Word:mac status bar. One is the word count, which you can click for more information, such as a character count. The other is the spelling/grammar check button, which you can click to run a spelling or grammar check for your document.
Tip:
If you click the status bar in Word:mac, you get the Find & Replace window, just like double-clicking the status bar in Word XP.

There are four buttons on the right side of the status bar. If you click one of these buttons in Word:mac (or double-click it in Word XP), it turns on a document option. REC will open the Record Macro window. TRK will turn on Track Changes. EXT will turn on selection extension, which allows you to expand a selection of text by clicking in the document rather than dragging a new selection. OVR turns on Overtype, which will insert new text over existing text. These options work the same in Word:mac and Word XP.

Figure 8-12: If you click the word count in the status bar, you get a summary similar to the Word Count summary in Word XP.

Figure 8-13: When you turn on a document option, the button turns green.
Menus

Word:mac has all of the top-level menu items (File, Edit, View, and so on) that are in Word XP, and adds three more: the application menu (like in all other Mac OS X applications), the Font menu, and the Work menu. (I’ll talk about the Font and Work menus a little later.)

The Word:mac menu items (the items in the top-level menus) are a little different from the menu items in Word XP. Some menu items are moved, while other menu items have new names. Other menu items are completely new to Word:mac and don’t exist in Word XP at all, and Word:mac omits some menu items that are in Word XP. Let’s take a look at what’s different in the Word:mac menus.

File

In addition to the standard menu items in the File menu (Save, Properties, and so on), the Word:mac File menu adds an item not found in Word XP.

Open Web Page... opens a web page from a URL. Type a complete URL, including filename, into the Open Web Page dialog, and Word:mac will open that page. (Word:mac can open a web page from a local disk through the Open dialog, the same way as in Word XP.)

Figure 8-14: Be sure you type in the complete address, including filename and extension, as shown here. If you click the arrow button, a list of previously opened web pages will drop down, and you can open a web page from that list.
Edit

The Word:mac Edit menu is nearly identical to the Word XP Edit menu, save for the single change common to Office:mac applications (Office Clipboard is moved to View).

View

The View menu in Word:mac has several differences from the View menu in Word XP. A few items have different names but work the same way. Let's take a look at what's different.

**Online Layout** is the same as Web Layout in Word XP; it just has a different name.

**Page Layout** is the same as Print Layout in Word XP.

**Master Document** is specific to the Word:mac View menu. It opens the master document, which allows you to organize and maintain a long document, such as a book manuscript, by dividing it into smaller, more manageable subdocuments.

**Formatting Palette** is specific to the Word:mac View menu. It opens the Formatting Palette, discussed earlier in this chapter.

**Office Clipboard** is in the Edit menu in Word XP, and moved to the View menu in Word:mac. It opens the Office Clipboard.

**Comments** is like the Markup menu item in the Word XP View menu. It displays comments in a window at the bottom of your document. It only works when Track Changes is active.

**Reveal Formatting** is in the Format menu in Word XP, and moved to the View menu in Word:mac. When you turn this on, you can view the formatting of any part of your document by clicking it (see Figure 8-15).

**Task Pane** is not present in the Word:mac View menu; the Word XP task pane is not part of Office:mac. The Office:mac equivalent of the task pane is the Project Gallery.
Paragraph Formatting

Paragraph Style: Indent: Left 0" Flush left
Direct:

Font Formatting

Paragraph Style: Font: Times, 12 pt, English (US)
Character Style:
Direct: Bold, Italic, Underline, Shadow

Figure 8-15: Reveal Formatting works a little differently in Word:mac. It changes your mouse pointer into a quotation box, and when you click something in your document, a floating window appears that contains formatting information about whatever you clicked.

Insert

The Insert menu is intended for inserting formatting or items such as page breaks and footnotes into your Word document. The Word:mac Insert menu has several differences from the Word XP Insert menu. Some items are simply moved, while others are new to Word:mac.

Break has a submenu with break types; this is different from Word XP, which pops up a dialog box in which you can choose a break type.

Footnote..., Caption..., Cross-reference..., and Index and Tables... are items in the Reference submenu in Word XP, and moved to the top-level Insert menu in Word:mac. They work the same way.
HTML Object allows you to add common web page objects, such as scrolling text and buttons, to your Word:mac document. The HTML objects are particularly useful if you’re making a web page with Word:mac. HTML Object is the Word:mac equivalent of Web Component... in Word XP’s Insert menu.

![Scrolling Text Options Window](image)

Figure 8-16: When you click an item in the HTML Object menu, enter information for the object in the window that pops up. This is the Scrolling Text options window.

**Movie...** lets you insert a movie in your document. If your document is a web page, you can insert a movie, select an alternate image for browsers that don’t support the movie, and add text that will display when the movie can’t load (see Figure 8-17).

**Diagram...** is not present in Word:mac. Unfortunately, Word:mac doesn’t have the Diagram Gallery from Word XP.
Figure 8-17: Movies show up directly in your document. You can control the behavior of the movie, such as looping, using the floating toolbar.

**Format**

The Format menu in Word:mac has a few differences from its Word XP counterpart. Some things are moved around, but for the most part, the Format menus are the same. **Reveal Formatting...** has been moved from the Format menu in Word XP to the View menu in Word:mac, and Frames has been removed entirely (Word:mac doesn’t support the Frames feature of Word XP).

**Font**

This menu is specific to Word:mac; it doesn’t exist in Word XP. The Font menu is essentially a shortcut to your fonts. Clicking a font name in this menu will change the font and apply it to any selected text. You can also choose a font in the Formatting Palette, of course (in Word XP, you could choose a font from the Format... dialog).
Tools

At first glance, it would seem that the Tools menu in Word:mac lacks several items found in the Tools menu in Word XP, but it doesn’t: Word:mac simply moves things around and changes the way you access certain things. For example, Language has a submenu in Word XP, but in Word:mac, Language... opens a dialog box containing a list of languages (exactly like the Set Language... item under Language in Word XP). The other menu items on the Word XP submenu have been moved to the Tools top-level menu in Word:mac, except Translate, which is not a Word:mac feature.

In addition to the Office:mac Tools menu items, the Word:mac Tools menu has these changes:
Thesaurus..., Hyphenation..., and Language... have been moved from the Language submenu in Word XP's Tools menu to the top-level Tools menu in Word:mac.

Data Merge Manager opens a floating window, similar to the Formatting window, which allows you to fine-tune your merging tasks. It's equivalent to the Mail Merge Wizard in Word XP.

Figure 8-19: Work your way through the sections of Data Merge Manager until you have your merge set up just the way you want.

Translate and Online Collaboration are not part of Word:mac, so they are absent from the Tools menu. Options was also removed, but it has an equivalent in the application preferences.

Table

The Table menu in Word:mac is exactly the same as the Table menu in Word XP.
Work

The Work menu is specific to Word:mac. You can use the Work menu to keep track of documents you’re working on. If you click the Work menu and then click Add to Work Menu, your current document will be added to the menu. Then you can quickly access the document by selecting it from the Work menu.

Tip:
To remove an item from the Work menu, press Command-Option-Minus, and then click the item in the Work menu you want to remove. This works in the Recent Documents list in the File menu as well.

Excel:mac

Microsoft Excel is the most popular spreadsheet application in the world. It’s as well suited for managing large sets of numerical data, with powerful calculation capabilities and robust data retrieval, as it is for making plain old columnar lists, like player positions on a Little League baseball team.

Excel:mac lives up to the reputation of its Office XP cousin by building on the success of the Microsoft Windows versions of Excel. Excel:mac features user interface enhancements and 100 percent compatibility with Excel XP workbooks, worksheets, and macros.

Excel Workbooks and Worksheets

Except for a few small differences, Excel:mac workbooks and worksheets look the same as their Excel XP counterparts. Worksheets have the same numbered rows and lettered columns, and workbooks have the same three default worksheets (Sheet1, Sheet2, and Sheet3). When you select a cell, it is outlined, and the position in the row and column is marked, just like
in Excel XP. If you’re an Excel XP power user, you will feel right at home in Excel:mac.

Excel:mac’s user interface still works the same as Excel XP (scrolling, navigating cells, selecting sheets, and so on, but no Task Pane; use Project Gallery instead). Excel:mac has the same look and feel as other Mac OS X applications. A new workbook contains three blank worksheets and you can select a worksheet by clicking its tab, just like in Excel XP.

Figure 8-20: If you Control-click a worksheet tab in Excel:mac, you’ll get a context menu that’s very similar to the worksheet context menu in Excel XP. Excel:mac omits Tab Color and adds Help.

The right side of the status bar adds a feature not found in Excel XP — three icons with text: SCRL, CAPS, and NUM. These icons show the status of your Scroll Lock, Caps Lock, and Num Lock. (Word:mac has similar icons in its status bar, for turning on features like Track Changes and Overtype.) In Excel:mac, you can’t turn on Scroll Lock, Caps Lock, or Num Lock by clicking the icon; you have to use the appropriate keys on your keyboard, and the icons just indicate the state of the key: off or on.

In Excel XP, you select specific cells, add formulae to your worksheets, and use functions via the function bar. Excel:mac has a slightly different function bar. It works the same way as in Excel XP (you can still select any cell by clicking the cell’s coordinate in the name box, for example), but instead of an “fx” icon, Excel:mac has an icon that looks like a calculator. This icon performs the same operation (inserting a function), but with a twist: You build your function using a calculator. This cool feature lets
Figure 8-21: Excel:mac also has a window splitting feature. Just grab the splitter on the horizontal or vertical scroll bar and drag it.

you build all kinds of functions using a familiar calculator interface. As you enter the details of your function, the result is automatically entered in the Answer box.

Figure 8-22: As you are building your formula in the calculator, you can select cells in your worksheet and the cells will be added to the calculator’s formula, which updates in real time.
You can add conditional logic to your function by clicking the If... button. If you want to get the sum of two or more cells, click the Sum... button. If you want to add a built-in Excel function, such as AVERAGE or DATE, click the More... button. You'll get a list of built-in functions very similar to the list of functions in Excel XP. In fact, the two applications have the same functions, which further ensures compatibility.

In addition to the calculator, Excel:mac’s function bar has an equal (=) button. Clicking this button lets you enter a formula by hand, bypassing the calculator altogether.

**Menus**

Excel:mac has the same top-level menu as Excel XP (Excel:mac adds the application menu, of course). The menus in Excel:mac have most of the items found in the Excel XP menus (like Word:mac, Excel:mac has more in common with its XP cousin than it has differences). Microsoft changed very little in Excel:mac. Let’s take a look at each menu and examine the changes.

**File**

The Excel:mac File menu has the same changes found in the Word:mac and PowerPoint:mac File menus (e.g., Project Gallery), but doesn’t add anything specific; it’s almost identical to the Excel XP File menu.

**Edit**

Excel:mac’s Edit menu is nearly identical to Excel XP’s Edit menu. The only difference is the moved Office Clipboard item (it’s in View).
View

The View menu in Excel:mac doesn’t differ greatly from the View menu in Excel XP. It adds two items, the Formatting Palette (it works the same way as in Word:mac) and the Office Clipboard. It removes the Task Pane menu item, as the task pane is not part of Office:mac.

Insert

A few items are changed in the Excel:mac Insert menu. Excel:mac adds one item to the Insert menu and removes a couple of others.

List... is a really cool feature in Excel:mac (it’s not available in Excel XP but is in Excel 2003). It launches a wizard that lets you build a schema for data displayed in your Excel worksheet, with built-in filtering and formatting. For example, if you were creating a list of Little League baseball players, the list would probably contain player names, numbers, and positions. You could use the List Wizard to define your columns (Player Name, Player Number, Player Position) and then apply formatting to the list. The formatting could ensure that only a numeric value is entered in the Player Number column, only nonnumeric values are entered in the Player Name column, and so on. The List Wizard is really useful when you have many columns with specific types of data (currency and dates, for example).

Excel:mac removes the Symbol... and Diagram... menu items. These features are not available in Excel:mac.

Tip:

Symbol is inexplicably removed from Excel:mac; if you need to add a symbol to a worksheet, add the symbol to a blank Word:mac document and copy the symbol from Word:mac to Excel:mac. You can also use a keyboard shortcut using the Option key.
Figure 8-23: After you define your list in List Wizard, it's added to your worksheet and a floating toolbar appears. You can use the toolbar to customize and manipulate your list.

**Format**

The Excel:mac Format menu is exactly the same as the Excel XP Format menu.

**Tools**

The Tools menu is where Excel:mac shows the most differences. It adds several items and removes a few others. Let's take a closer look.

**Calculator** opens the formula calculator, which you can use to build formulas and place the results in a cell. This is the same formula calculator as the one accessible from the worksheet function bar.

**Wizard** launches the Conditional Sum Wizard, which lets you sum values in a column. You can add a condition to the sum, and the wizard builds the formula for you. So instead of typing out a long formula, like =SUM(IF(D5:D6>3,D5:D6,0)), you can use the Conditional Sum Wizard to build the sum formula for you. This works the same way as in Excel XP.
AutoCorrect Options... is renamed to just AutoCorrect... and moved from the bottom section of Excel XP’s Tools menu to the top section of Excel:mac’s Tools menu. Compare and Merge Workbooks... is renamed to Merge Workbooks... and Formula Auditing is renamed to Auditing.

Excel:mac’s Tools menu removes Speech (Office:mac doesn’t have Office XP’s built-in speech recognition), Online Collaboration, and Options (this is moved to the Preferences under Excel:mac’s application menu).

**Data**

The Data menu in Excel:mac is almost exactly the same as the Data menu in Excel XP. The only difference is Excel:mac’s PivotTable Report... menu item, which is renamed from Excel XP’s PivotTable and PivotChart Report... menu item.
I can't imagine a corporate world without PowerPoint. Every day, in conference rooms all over the world, countless PowerPoint slides are shown, one after another. PowerPoint forms the basis of thousands of presentations on topics varying from product launches to cafeteria menus.

**Tip:**
If you happen to dislike PowerPoint, you should take a look at Apple’s Keynote product. This $99 software is a powerful presentation application that gives PowerPoint a run for its money. Many Mac OS X users insist that Keynote is the superior product, but if you’re comfortable with PowerPoint, there’s no pressing reason to switch to Keynote.

Unlike Word:mac and Excel:mac, PowerPoint:mac shows several major differences when you start it up. After you choose PowerPoint Presentation from Project Gallery and click OK, you’re presented with a blank presentation and the New Slide window. This window expects you to choose a slide theme, such as:

![New Slide window](image)

Figure 8-25: If you don’t want this window to appear when you start PowerPoint:mac, turn on Don’t show this dialog box again.
as Chart, Picture, or Bulleted List. The New Slide window is sort of like the Slide Layout task pane in PowerPoint XP.

**PowerPoint Presentations**

When you choose a slide theme and click OK, PowerPoint:mac creates the slide and you’re ready to get to work. PowerPoint:mac looks different from PowerPoint XP, but the changes aren’t drastic. There’s your blank slide, with space for adding notes, and a list of your slides on the left. You may have immediately noticed that the Drawing toolbar is not at the bottom of the slide window. Instead, it floats on the left side of the slide list. You may also have noticed that there’s no Slides tab; there’s only a list of slides with the title text. Also, PowerPoint:mac has two extra buttons in the lower-left corner. In addition to Normal, Slide Sorter View, and Slide Show, PowerPoint:mac adds Outline View and Slide View. PowerPoint:mac lacks the Formatting toolbar, as these options are moved to the Formatting Palette.

**Menus**

PowerPoint:mac has the same top-level menus (File, Edit, and so on) as PowerPoint XP. Some of the menus have different items, just like you’ve seen in Word:mac and Excel:mac. PowerPoint:mac shows the most changes of the Office:mac applications, and we’ll examine those changes here.

**File**

The PowerPoint:mac File menu isn’t substantially different from the PowerPoint XP File menu. It has the standard Office:mac differences (Project Gallery, no Search..., etc.) and one unique addition.

Make Movie... could be called an equivalent of the Pack and Go... item in the PowerPoint XP File menu, but it’s technically
different. Make Movie... allows you to create a QuickTime movie (in the .mov format) of your PowerPoint:mac presentation. It doesn't compress your slides into a package, like PowerPoint XP does. This is a cool way to share your presentation with others, but they will need to have QuickTime installed.

**Edit**

Like the File menu, PowerPoint:mac's Edit menu doesn't show a lot of changes. It has the same Office:mac changes (the Office Clipboard is moved to View), and it doesn't add anything. The PowerPoint:mac Edit menu does, however, remove one item: Links.... The concept of linking objects isn't present in Office:mac, so this item has been removed.

**View**

Under the View menu, you can change the view of your presentation and you can show (or hide) aspects of PowerPoint:mac. The View menu has a few changes from its PowerPoint XP counterpart but nothing terribly major. It also has the standard features of the Office:mac View menu (like Office Clipboard and Formatting Palette).

Slide changes the view to just the current slide. The single slide view covers the entire PowerPoint:mac presentation window.

Slide Miniature is a really cool addition to PowerPoint:mac. If you zoom your slide, say to 400 percent, you can turn on Slide Miniature, which will open a window that displays your entire slide. (Slide Miniature is unavailable until you zoom in on your slide.) This is best left to a visual example, so see Figure 8-26.
Figure 8-26: The Slide Miniature comes in handy when you zoom in on your slide. As you make changes to your slide, the Slide Miniature is updated to reflect those changes.

The PowerPoint:mac View menu has a few renamed items. Color/Grayscale in PowerPoint XP is renamed to just Grayscale in PowerPoint:mac. Grid and Guides... in PowerPoint XP is renamed to just Guides in PowerPoint:mac. These changes are minor and easy to figure out.

The PowerPoint:mac View menu also removes one item: Task Pane.

**Insert**

The Insert menu differs slightly in PowerPoint:mac. It adds one item and removes another.

**Tab** simply inserts a tab, just like clicking the Tab key on your keyboard.

Like Word:mac and Excel:mac, PowerPoint:mac removes Diagram... from the Insert menu.
Format

PowerPoint:mac doesn’t remove anything from the Format menu; it has everything found in its PowerPoint XP counterpart. The Format menu does, however, see the addition of two items. Slide Color Scheme opens the Color Scheme window, where you can choose a scheme to apply to your slide.

![Color Scheme Window](image.png)

Figure 8-27: If you click the Custom tab, you can define your own color scheme. Click the Apply button to apply the color scheme to the current slide, and click the Apply to All button to apply the color scheme to all of the slides in a presentation.

Colors and Lines... is only available when you click an object on your slide. It opens the Format AutoShape window, where you can configure the fill color and transparency, line color and weight, and so on.

**Note:**

When you don’t have an object selected, the Format menu shows a grayed-out Object item. When you click an object to select it, the Object menu item changes to an option for
that object. For example, if you click the title of a slide, the Object item changes to AutoShape, which will open the Format AutoShape window.

PowerPoint:mac changes the name of Background... to Slide Background... for consistency purposes.

**Tools**

The Tools menu in PowerPoint:mac has several changes from the Tools menu in PowerPoint XP. It has the standard changes in the Office:mac Tools menu (such as Dictionary and Flag for Follow Up...). It removes Speech (Office:mac doesn’t have built-in speech recognition; you can use Apple Speakable Items instead), Compare and Merge Presentations... (I’m not sure why this is removed), Online Collaboration (Mac OS X doesn’t support NetMeeting), and Options (use Preferences in the application menu instead). AutoCorrect Options... is renamed to AutoCorrect and moved near the top of the menu.

**Slide Show**

At first glance, PowerPoint:mac’s Slide Show menu looks like it is completely different from its PowerPoint XP cousin, but in fact, it’s not that different. Some items are moved around and others are renamed, but for the most part, the Slide Show menu in PowerPoint:mac and the Slide Show menu in PowerPoint XP are very much alike.

Animation Preview is the only item added to the Slide Show menu in PowerPoint:mac. It launches a window that shows you a preview of each slide animation you select.

Several items move around, including Rehearse Timings and Set Up Show..., while Animation Schemes... becomes a submenu (Animations). The Slide Show menu excises Online Broadcast, as this feature is not supported in Office:mac.
Entourage:mac

Entourage:mac is the closest thing to a Macintosh equivalent of Outlook XP. Entourage:mac has a number of the same features, such as email, calendars, contacts, tasks, and notes. It also works the same way, for the most part. So how do you choose whether to use Entourage:mac or Mail/iCal/Address Book? If you need Microsoft Exchange capability, Entourage:mac is the way to go. If you don’t use a Microsoft Exchange server, your decision is based more on personal preference. Entourage:mac doesn’t have the nice integration with other Mac OS X applications. For example, it doesn’t use the Mac OS X Address Book, which is available to all Mac OS X applications. Of course, it’s not hard to add your Entourage:mac contacts to Address Book and vice versa.

Now, let’s take a closer look at Entourage:mac.

Entourage:mac Is Not Really an Exchange Client

Entourage:mac’s integration with Microsoft Exchange isn’t as strong as Outlook XP’s. According to Microsoft, for Entourage:mac to work with an Exchange server, you have to install the Entourage:mac update 10.1.4 on your Macintosh (it’s available at microsoft.com/mac), and your Exchange server must meet these requirements:

• It must be Microsoft Exchange Server 2000 SP2 or later.
• Outlook Web Access must be installed and active.
• IMAP, SMTP, HTTP DAV, and LDAP must all be enabled on your Exchange server.

In other words, Entourage:mac is not a “true” Exchange client like Outlook XP. Instead, it uses different protocols to access Exchange information (IMAP for email, LDAP for the Global Address List, and WebDAV for updating free/busy data). That
doesn’t mean Entourage:mac isn’t an excellent application in its own right. If your Exchange server meets the requirements, using Entourage:mac with Exchange is a pleasant experience.

**Entourage:mac Is a Personal Information Manager**

A personal information manager (PIM) is an application designed to manage your email, contacts, calendar, notes, and tasks. Both Outlook XP and Entourage:mac are PIM applications (Outlook XP also has a journal, which is not available in Entourage:mac). If you are used to using Outlook XP, you’ll find Entourage:mac very comfortable and somewhat familiar.

Entourage:mac and Outlook XP work pretty much the same. You can choose Mail, Address Book, Calendar, Notes, or Tasks from a set of icons in Entourage:mac (see Figure 8-28). This is similar to the Outlook bar in Outlook XP.

Figure 8-28: Just select the part of the application you want to use (Mail, Address Book, Calendar, Notes, or Tasks). Custom Views allows you to create specific filters for your Entourage:mac items.
Mail

In Entourage:mac's Mail view, there's a folder list, just like in Outlook XP. Your mail is displayed in a columnar list, which you can sort by clicking the column name. In addition to the regular email functions (creating, deleting, forwarding, and so on), you can assign categories for your mail, activate automatic junk email filtering, and flag a message for follow-up.

One of the really cool features of Entourage:mac is mail linking. This feature lets you link emails together. You could use this for all kinds of things. For example, when my family was trying to coordinate getting together for the holidays, I received email from several members of my family. The emails all had different subjects and sent dates, of course. In addition to their email, I had travel confirmations and emails from my friends about taking care of my pets while I was away. I also had entries in my calendar for my traveling, notes containing reservation information and contact numbers, and several tasks I had to complete before I left. To simplify managing all of this, I created links between
the mails, calendar items, and tasks. This greatly simplified managing all of the little details of holiday get-togethers.

To create a new link, click the area in the Link column (its icon looks like a chain), and click either Link to New or Link to Existing. If you click Open, Entourage:mac will display a window containing all of the links you’ve defined for that particular item (see Figure 8-30). If a link is already defined for the item, an icon will appear in the Link column. Clicking it will pop up a menu that displays your links (organized by type, like mail, task, and so on).

![Figure 8-30: In this example, I've linked together items related to taking a programming test.](image)

When you send a message and the recipient replies, the two messages are linked automatically. This is really great if you have several related emails and you want to traverse the thread of conversation.
Address Book

The Entourage:mac Address Book doesn’t really look anything like the Outlook XP address book (called Contacts in Outlook XP). Entourage:mac contacts are organized into columns, like mail. You can sort by column; filter by name, category, and company; and assign categories to your contacts (like Friends, Family, Work, and so on).

![Address Book](image)

Figure 8-31: Address Book has several views that you can select from a list that give you quick access to contacts listed by predefined filters.

Calendar

The Entourage:mac Calendar looks and works very much like its Outlook XP relative. You can view your calendar by day, work week, standard week, and month. If you’ve used the calendar in Outlook XP, you should feel right at home in the Entourage:mac Calendar.
Figure 8-32: If your calendar event has the reminder turned on, you’ll get an Office Notification when the event is due to start.

Notes

Entourage:mac Notes use the same column-based view as Mail and Address Book, rather than the “sticky note” interface of

Figure 8-33: Entering notes is really easy via the simple Note window.
Outlook XP. You can use the same filtering and sorting techniques. Notes can be linked to other Entourage:mac items, including emails and calendar events. They can also be synchronized with your Palm device, as I described in Chapter 7.

**Tasks**

Working with tasks in Entourage:mac works just like Outlook XP. You can set a due date, mark a task as completed, set a priority, and turn on a reminder. Tasks also take advantage of the categories feature in Entourage, so you can assign “Call florist” to the Personal category and “Add cover sheet to TPS reports” to the Work category.

![Tasks](image)

Figure 8-34: When you mark a task as completed, a line is drawn through it. Unlike Outlook XP, however, Entourage:mac tasks don't have a “percent complete” feature.
Summary

This chapter exists solely to help you make the transition from Microsoft Office XP to Microsoft Office v. X for Mac. It can be a very smooth transition, even for the most hard-core Office XP user. Microsoft took great care in making sure Office:mac is compatible with Office XP, and they avoided drastic changes to Office:mac that would interrupt your productivity. If you want to dig deeper into Office:mac, take a look at any of the excellent Office:mac books at your local bookstore.

The next chapter covers managing your Macintosh. You’ll learn how to create user accounts and protect your Macintosh from hackers.
After Fred bought his new Macintosh, he looked to me as his constant companion, guiding him through every step of new ownership. I like helping people, so I was more than happy to lend Fred a hand. Most of Fred’s questions were about how to do things like move several files at once and other stuff covered in Chapters 4 and 5. His most important questions pertained to ensuring his Macintosh was secure and error-free.

When I started working on this book, I thought about Fred’s questions, and I knew I wanted to talk about how to manage your Macintosh, especially system security. This chapter is a combination of the two and it answers common questions about managing your Macintosh, specifically security, maintenance, and troubleshooting.

**Security**

In today’s world of cyberterrorism, significant financial losses due to hacker attacks, and email viruses, security should be one of your top concerns. There’s no need to panic; Mac OS X is a very secure operating system right out of the box, and there are various easy things you can do to make your Macintosh even more secure.
How Safe Is My Macintosh?

Mac OS X is built on the Unix operating system, a very secure operating system in its own right (more about Mac OS X's Unix underpinnings is covered in Chapter 10). Mac OS X includes several built-in security features:

- **Secure Shell (OpenSSH).** This is a secure application and protocol for connecting to your Macintosh from another computer. I discuss this later in this chapter.

- **Secure Sockets Layer (OpenSSL).** This is a framework for secure web transactions. If your Macintosh acts as a web server, OpenSSL will support secure connections between your users and your Macintosh. (I tell you how to make your Macintosh a web server later in this chapter.)

- **Kerberos.** Kerberos protects your Macintosh by ensuring that anyone who connects to it has proper credentials.

- **Automatic Log Out.** Your Macintosh can automatically log out users after a certain amount of inactivity. (This is activated in the Security preference, which I discuss in the next section.)

- **FileVault.** You can secure the contents of your home directory with powerful encryption. FileVault is discussed later in this chapter.

- **Virtual Private Networking (VPN).** VPN allows secure remote access to corporate networks. If you work for a corporation that allows you to work from home, you’re probably using VPN to connect to their network.

- **Wired Equivalent Privacy (WEP).** If you use wireless networking, WEP should be important to you. It provides data encryption over wireless networks; this helps protect your data as it is transmitted over your wireless network.
All that technical stuff means that your Macintosh is pretty secure, but it doesn’t stop there. Every Macintosh ships with all communication ports closed and all services (file sharing, web sharing, FTP access, and so on) turned off. You have to explicitly turn these services on.

**Owning r00t**

Mac OS X has a built-in user called “root” that has total control over the system; the root account comes from Mac OS X’s Unix background. The root account is the account that hackers try to exploit (known as “Owning r00t” in hacker speak), so every Macintosh has the root account turned off by default. You have to explicitly turn it on. If you don’t know what root is or what it’s for, then you’re probably best off not even bothering with it. (User accounts are covered next.)

**How Can I Control Access to My Macintosh?**

This is the most basic security question. The simple answer is, “Create user accounts and enforce them.” That may sound somewhat draconian, but all it really means is that you should create a user account for each person who will require access to your Macintosh. Microsoft Windows works the same way. Enforcing user accounts allows you to exercise more control over your system. You can control what applications and system preferences individual users have access to, as well as what activities they can perform (such as modifying the Dock or burning CDs and DVDs). Each account has its own home folder, with permissions on the home folder’s contents exclusively assigned to that account (with a couple of exceptions, notably the Public and Sites folders). Other accounts can’t access files in your home folder unless you allow them to.
System Security

Before you create accounts, you should open the Security preference in System Preferences and define some basic security measures for your Macintosh. You can elect to require a password when your Macintosh wakes from sleep or a screen saver; this is kind of like locking a workstation in Microsoft Windows. You can disable automatic login, which I recommend, and you can turn on automatic log out after a certain number of minutes. If you want to limit access to secure system preferences, you can turn on the option that requires a password to access them.

Note:

If you see a padlock icon and the message "Click the lock to make changes," you will need to do just that. You'll have to enter an administrator password to continue. You'll see this padlock in many different places.

Figure 9-1: Remember that the options you set here affect all users on your Macintosh.
Creating Accounts

Setting up user accounts is very easy; it’s as simple as setting up user accounts in Microsoft Windows. Open System Preferences and click the Accounts icon. The Accounts preference will open and you’re ready to create accounts — but only if you have administrator access.

Click the plus sign button at the bottom left of the Accounts pane, and enter the information about the user in the boxes on the right. All you need to enter is a name; you don’t have to enter a password, but I highly recommend that you do.

**Tip:**
If you want to remove a user account, click the account to select it and then click the minus (-) button.
Each account you create will have the privilege of logging into your Macintosh directly (sitting in front of the machine) and remotely (using another computer connected to the network). After you enter the account information, you can choose a picture for the account in the Picture tab.

If you click an account name to select it and then click Login Options, you can choose to have your Mac OS X login window displayed as a list of users or require the user to enter a name and password. This is similar to Microsoft Windows XP, where you can have a friendly login screen (the user clicks her name and enters her password) or the forced login screen (the user presses Ctrl-Alt-Delete and enters both a username and password). The advantage of the list of users is simply ease-of-use, while the advantage of forcing the user to enter an account name is the addition of another layer of security.

You can also choose to automatically log in as a certain user, hide the Sleep, Restart, and Shut Down buttons, and enable fast user switching (I talk about fast user switching later in this section).

Account Privileges

Now you're ready to set the limitations of the account; in other words, you're going to decide what privileges the user account has. Click the Limitations tab in the Accounts preference and you will see three choices: No Limits, Some Limits, and Simple Finder.

No Limits

No Limits is just that: no limits. That means that the user account isn’t limited except in administration tasks, which will require an administrator password.
Note:
If you want to give a user administrator access, select No Limits, then turn on Allow user to administer this computer in the Security tab. The other stuff in the Security tab in the Accounts preference is the same as the Security preference.

Figure 9-3: Accounts with no limits that aren't administrator accounts will show “Standard” under the account’s name in the accounts list. If the account has no limits and is granted administrator access, “Admin” will appear under the account name.

Some Limits
Choosing Some Limits allows you to choose from several limitations you can enforce. You can limit the user's ability to:

- Open all System Preferences
- Change the password
- Modify the Dock
- Burn CDs and DVDs
In addition, if you turn on This user can only use these applications you can choose exactly which applications the account is able to launch. If you want to disable launch privileges for an application, uncheck the box under the Allow column. If an application isn’t in the list, click the Locate... button to find it.

Figure 9-4: You can fine-tune individual application launch privileges by expanding the arrow and turning off the Allow check box.

If you set some limits for an account, the text under the account name will change to “Managed.” Use this setting for user accounts that you want to have a certain level of freedom but limit what they can do.

**Simple Finder**

If you enable Simple Finder, the account will use a version of Finder with a simplified Dock and launch privileges for specific applications, as in the Some Limits setting. Use this setting for user accounts that you want to tightly control. If you set an
account to use Simple Finder, the text under the account name will change to “Simplified.”

**Fast User Switching**

If you share your Macintosh with other people, you may find fast user switching very useful. Fast user switching allows you to switch users in the middle of a Mac OS X session without interrupting the applications any users have open.

For example, let’s say there are two accounts on a Macintosh, named John and Mary. John is currently logged in and working, but Mary stops by and needs to check her email. John doesn’t want to log off and lose his place. Their Macintosh has fast user switching turned on for both users, so John clicks the fast user switching menu extra, which displays the currently active account. He then clicks Mary’s name, and Mac OS X prompts for her password. She enters it and Mac OS X switches to her account in a really cool animation. Meanwhile, all of John’s applications stay open in his session but are invisible to Mary.

![Figure 9-5: Every user account that has fast user switching enabled will appear in the fast user switching menu extra.](image)

I use fast user switching when Elley comes over. I usually have a lot of applications open at once, doing different things, and Elley wants to check her auctions. I created an account for Elley on my Macintosh, and I switch to her account so she can look at her
auctions and check her email. When she’s finished, I log her out, and Mac OS X switches back to my account.

How Can I Protect My Macintosh from Myself?

This sounds like a silly question, but it’s not. If you have administrator access to your Macintosh, you can do damage without even realizing it. The best thing to do is create two user accounts for yourself. One user account should be an administrator account, and the other should be a Standard (no limits) account you use on a regular basis.

![Authenticate](image)

Figure 9-6: When you need to perform an administrator function, Mac OS X will prompt you for an administrator username and password. If you click the Details arrow button, you can get more details about the security request.

If you do things this way, you’ll always know exactly when administrator access is required; you won’t be able to perform administrator actions until you explicitly want to.
How Do I Log into My Macintosh from Another Computer?

Mac OS X includes a remote login application called Secure Shell. It's been in use in the Unix world for quite some time; it effectively replaced the insecure Telnet application. If you turn on Remote Login on your Macintosh, you can log into your Macintosh from another computer using the Secure Shell application, called SSH, in Terminal. Using SSH gives you the advantage of being able to launch applications on the remote computer. (Terminal is covered in Chapter 10.)

The easier and more common choice is using the Go menu in Finder; this gives you the advantage of accessing your remote Macintosh via Finder windows instead of the command line, but you can't launch applications on the remote computer. To connect to another Macintosh, click the Go menu in Finder, and then click Connect to Server... (or press Command-K). You'll see the Connect To Server window. Enter the address in the Server Address box (for remote login, you have to use the format user@ip; for example, switcher@127.0.0.1).

![Connect To Server Window](image)

Figure 9-7: You can add a server to the Favorite Servers by typing in its address in the Server Address box and clicking the plus (+) button. You can see a list of recent servers by clicking the button that looks like a clock.
After you enter the address and click the Connect button, you will be prompted for your username and password. Enter this information and click the Connect button. Mac OS X will prompt you to choose a volume to mount; select one, click OK, and it will be mounted on your desktop.

When you connect to your Macintosh using the Go menu, it doesn’t use the OpenSSH protocol like SSH does. You have to turn this on. When you click the Connect button in the Connect To Server window, click the Options button. Turn on Allow Secure Connections using SSH. Doing this will let you rest easy knowing it’s a secure connection.

**What are Those Other Services in the Sharing Preference?**

That’s a good question. If you used the network method to move your files over from Microsoft Windows as discussed in Chapter 6, then you turned on the Windows Sharing service, which allows Microsoft Windows computers to connect to your Macintosh. The other services are relatively self-explanatory; when you click each service, instructions are displayed below the services list. For example, click the Personal Web Sharing service and the instructions tell you how to view your Macintosh’s web site, including a URL for both your computer and your account’s personal web site.

When you turn on a service, it opens your Macintosh to the world. You’ll need to protect your Macintosh from hackers, which leads us to the next question.

**How Can I Protect My Macintosh from Hackers?**

Mac OS X has built-in firewall software that will help protect your Macintosh from hackers. The Mac OS X firewall monitors incoming network traffic and denies all inbound connections except those you permit. You can activate the firewall in the
Sharing preference in System Preferences. Click the Firewall tab
and you'll see the status of your firewall, either Firewall On or
Firewall Off. If the firewall is off, turn it on by clicking the Start
button.

Below that is the list of ports with a description, such as
Personal Web Sharing and Printer Sharing. When you start the
firewall, it automatically protects all services turned on in the
Services tab. If you want to turn on the firewall for other ports,
turn on the check box next to the item.

![Sharing Preferences](image)

**Figure 9-8:** You can add a port by clicking the New... button. I
added iChat Rendezvous and iTunes Music Sharing and turned on
the firewall for these ports.

If you have a home network and use a router, it probably has its
own built-in firewall. You should activate the firewall in your
router and the firewall in your Macintosh to help protect your
network and connected computers from hackers. The Mac OS X
firewall is very stout; it's based on ipfw, a firewall technology
that has been in use on Unix systems for many years, but it
won’t protect the other computers on your network like the
router’s built-in firewall will.

**How Can I Secure My Files?**

Each user account on a Mac OS X system has exclusive access
to the files in its home folder; this is called *permissions*. If you
access another user’s home folder, you’ll be able to see the fold­
ers and files but you won’t be able to access them.

This security is pretty stout on its own, but if you want to
truly protect your files, you can encrypt the contents of your
home folder. With encryption enabled, even if someone is able to
access your files, he won’t be able to read them. This is possible
through a Mac OS X feature called FileVault. When FileVault is
turned on, it automatically encrypts and decrypts your home
folder.

To turn on FileVault, open the Security preference and click
the Turn On FileVault... button. You will be prompted for an
administrator password, and then Mac OS X will start the poten­
tially lengthy process of encrypting the contents of your home
folder.

If you want to turn off FileVault, open the Security prefer­
ence and click the Turn Off FileVault... button. You can only turn
on FileVault for your account.

FileVault uses the Advanced Encryption Standard (AES) with
128-bit keys to encrypt your data. There are $3.4 \times 10^{38}$ pos­
sible 128-bit keys with AES encryption. AES encryption is a
United States government security standard; they use it on
their data, which is of the highest national security.
How Do I Change My Password?

You should use a password that is a made-up word consisting of letters and numbers, with some letters in capitals. This is the most secure password scheme you can use, but admittedly, it’s easier to forget “k3CD4rbNm” than “windmill.” If you’re too worried about forgetting your password, you can get by with remembering to change your password on a consistent basis. I change mine every other week.

Changing your password in Mac OS X is very easy. Open the Accounts preference in System Preferences, pick the user for whom you want to change the password, enter the new password, and enter the new password again in the Verify box. You can also enter a Password Hint if you want.
Figure 9-10: If you’re logged in as an administrator, you can change other users’ passwords. You should make sure you have a good reason to do this; otherwise, you’re going to have some very angry Macintosh users on your hands.

**Tip:**

There’s another way to change your password that requires you to use Terminal, the Unix command-line application (it’s found in /Applications/Utilities). You can use the setpwd command in Terminal to set your password. I suggest this method if you are comfortable with using command lines (like if you come from a Linux or Unix background).

When you change your Mac OS X password, it doesn’t change the passwords for your other applications. You’ll have to change your password in the application. In other words, you can’t change your MSN Messenger password by changing your Mac OS X password; you’ll have to change your password at the MSN.com website.
**Keychain Passwords**

Mac OS X has a password management system called Keychain, which can keep track of various passwords you need for different applications. For example, Keychain manages passwords for Mail, MSN Messenger, the iTunes Music Store, and network shares. Keychain doesn't let you change passwords, however; all it does is keep track of them.

Having Keychain keep track of your passwords means you don't have to type in a password every single time one is required (this is especially helpful when you connect to network shares). Your keychain is only accessible to you, and it requires your Mac OS X password to unlock.

You can manage your existing keychains and create new ones using the Keychain Access application in /Applications/Utilities (see Figure 9-12).

Keychain does more than just track passwords, however; you can also use it to store secure information such as personal identification numbers and credit card information. To add secure information to your keychain, open Keychain Access and click File, and then New Secure Note Item... or click Note in the toolbar. Enter a name for the note, such as "credit card number," and enter the text of your note. Click the Add button and the secure note will be added to your keychain (see Figure 9-13).
Figure 9-12: Keychain Access displays all of your currently managed password items. If you want to see the password, turn on Show password and enter your Mac OS X password in the Keychain prompt.

Figure 9-13: After you add your note, click it in the list and you can view information about it. If you turn on Show note and enter your password, you can view the contents of the note.
Protecting your Macintosh from viruses is surprisingly easy. The main reason is because there just aren’t many viruses that affect the Macintosh and, specifically, the Mac OS X. Sobig, Nimda, Melissa, Nachi, ILOVEYOU, and the rest of the viruses and worms in the news have affected Microsoft Windows machines. Mac OS X, like its Unix and Linux brethren, just isn’t as easy to target with viruses. Part of the reason for that is Mac OS X is inherently a secure operating system, so there are fewer security exploits for worms. The other part of the reason is something called “security through obscurity.” Since there are far more Microsoft Windows machines than Macintoshes, virus writers target Microsoft Windows.

Still, it’s better to be safe than sorry. Just because you never hear about Mac OS X viruses doesn’t mean someone isn’t working on one. To that end, you have a couple options for virus protection on Mac OS X.

First is Virex from McAfee. Virex is included with a .Mac membership, or you can purchase it for around $50. Virex has been around for a long time, and most old-timer Macintosh users trust it. If you’re a .Mac subscriber, taking advantage of Virex is a no-brainer.

The second choice in Macintosh virus protection is Norton AntiVirus. This product may be familiar to Microsoft Windows users; Norton products have been in use on Microsoft platforms for many years.

Both Virex and Norton AntiVirus are updated regularly with new virus signatures.
Preventative Maintenance

While Mac OS X is a stable and secure operating system, there’s no such thing as an infallible computer. Hardware fails, power gets cut off, applications misbehave; all or one of these things can wreak havoc on your Macintosh experience or possibly cause financial loss. Just as you protect yourself from hackers and viruses, you should protect yourself from unforeseen problems.

How Do I Back Up My Macintosh Files?

It’s important that you regularly back up the files in your home folder, even if that means you just burn them on CD or DVD. There are automated backup tools, however, that greatly simplify the process of backing up all of the data on your Macintosh. Automated backup software will also allow you to schedule backups, so you’re not required to remember to back up your files.

The easiest way to get into automated backups is to get a .Mac subscription. This $99-per-year service includes Backup, an automated backup tool that is really easy to use. Backup can back up your Macintosh data to CDs, DVDs, and drives (hard disks, Zip disks, and so on). Backup can also back up your data to your iDisk, which is on a managed server in Apple’s server farm. By backing up your files to iDisk, you don’t have to worry about keeping track of media or worrying about hard disk failures (the iDisk servers are on redundant arrays and use all kinds of other networking safeguards to protect your data).

If .Mac isn’t your cup of tea, there are dozens of other backup applications for Mac OS X. One of my favorites is Impression ($25), which is available at VersionTracker.com. Impression will back up data to DVD, CD, or hard disk, and it is very configurable. Impression is one of the best backup tools for Mac OS X if you want fine-grained control over your backups and you don’t need scheduled backup capabilities. (Impression also has a restore mechanism.)
Figure 9-14: Backup shows what items you’re going to back up, as well as how much disk space you have available on the target (where your backups will go). I have Backup scheduled to back up my items at 9:00 A.M. every day.

Figure 9-15: Impression doesn’t have the predefined backup items like Apple’s Backup. You can drag-and-drop the items you want to back up directly into Impression.
Unfortunately, Impression doesn’t back up data to iDisk, but it does support backing up files to disk images, which can be encrypted. At a cost of only $25, Impression is worth a look.

**Tip:**
There are dozens of backup applications for Mac OS X (many people like a tool called Retrospect), and you can find them at VersionTracker.com.

### Synchronizing Folders

Another way to back up your Macintosh is to use folder synchronization software. This is kind of like the Briefcase in Microsoft Windows. Folder synchronization software serves two purposes: It synchronizes data in folders (changes in Folder A are added to Folder B, and changes in Folder B are added to Folder A), and it backs up data from one folder to another.

When backing up data using folder synchronization, one folder is your source folder (the data you want to back up), and the other folder is the destination. The destination folder can be on a CD-R, a FireWire hard disk, or any other type of storage medium. This method of backing up data isn’t as full-featured as the dedicated backup software (folder synchronization works with only one source folder at a time), but it is a quick and easy way to back up your data.

My favorite folder synchronization software is Synk (not to be confused with iSync). There are several other applications that work just as well; I’ve heard Execusync is really good. You can find these applications at VersionTracker.com.
How Can I Ensure Optimal Performance?

There are several factors that affect system performance, including disk space, memory, and running applications. There's no silver bullet for ensuring optimal performance, but there are several things you can do.

Increase Your Memory

The first thing you could do is consider boosting your RAM to its maximum, or the maximum you can afford (you probably don't need to go to 8 gigabytes in a G5; 1 gigabyte will probably suffice). This upgrade will make everything you run faster. Applications launch quicker, you can do several things at once, and Mac OS X speedily moves along. Memory is also cheap, so the cost barrier is relatively low.

Monitor System Activity

The next thing to do is find out how many processes you have running and kill the processes that are unnecessary. You can do this using Activity Monitor, found in /Applications/Utilities.

Activity Monitor will show you all of your current processes — running applications and server tasks — along with how much memory they are consuming and what percentage of the processor time they require. Activity Monitor will help you realize which applications are using up your system resources, and you can decide if you need them open. For example, editing a video in Final Cut Pro requires a significant amount of system resources, so it would be wise to shut down Microsoft Word, Safari, and other applications that require a lot of processor time and memory. You can double-click any process (or click the Inspect button in the toolbar) to get more information about the process, including memory usage, statistics, and open files. If you want to quit a process, you can click the Quit Process button in the toolbar or the Quit button in the process inspector.
Activity Monitor gives a lot of information about your system and its running processes. It has a live updating monitor in the lower-left corner, with color-coded tracked items. Click the item in the toolbar for which you want to see live information.

**Increase Drive Space**

If you have demanding hard disk needs, such as an immense MP3 collection or lots of video files, consider adding an external FireWire hard drive. They get big; I recently saw a 500-gigabyte model in a magazine. You can store your data on the FireWire drive and keep your internal Macintosh hard disk relatively clean. (I like to use no more than 50 percent of my disk capacity at a time, but for no particularly good reason.)
How Do I Keep My Macintosh Up to Date?

Microsoft has a web site for updating Microsoft Windows, called Windows Update. It works pretty well, and you can set up your Microsoft Windows machine to automatically check Windows Update for new and updated Microsoft Windows software.

Mac OS X has a similar application simply called Software Update. Software Update will update your system with the latest versions of Apple software and, more importantly, the latest security fixes and operating system updates. I can't stress enough how important it is to stay on top of security fixes.

You can access Software Update via the Apple menu and the Software Update preference in System Preferences. You can set Software Update to automatically check for updates daily, weekly, or monthly. You can also make Software Update immediately check for updates by clicking the Check Now button.

![Software Update](image)

New software is available for your computer.

If you're not ready to install now, you can use the Software Update preference to check for updates later.

<table>
<thead>
<tr>
<th>Install</th>
<th>Name</th>
<th>Version</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AirPort Software</td>
<td>3.2</td>
<td>8.8 MB</td>
</tr>
<tr>
<td></td>
<td>Bluetooth Software</td>
<td>1.4.1</td>
<td>2.2 MB</td>
</tr>
<tr>
<td></td>
<td>iPod Software</td>
<td>1.3.1</td>
<td>5.6 MB</td>
</tr>
</tbody>
</table>

Figure 9-17: If there's an arrow next to the update, a restart will be required.
When Software Update finds updates for your Macintosh, it will give you a list of updates. If you turn on the check box in the Install column, and then click the Install button, the updates will be downloaded and installed.

If you’re a dial-up user, you may want to turn on Download important updates in the background. That way, your Macintosh can download the updates while you work in other applications; when they’re ready to be installed, Software Update will let you know.

**Finding and Fixing Problems**

Heaven forbid your Macintosh has some kind of problem. It’s every user’s worst nightmare to find her applications unresponsive or unable to access files. Worst of all is the dreaded hard drive crash, which strikes fear in the hearts of all computer users.

Hyperbole aside, the Macintosh is not immune to these kinds of problems, but it is possible to handle them with aplomb.

**How Do I Handle Misbehaving Applications?**

Occasionally, an application will lock up. Your mouse pointer will change into a spinning colored pinwheel and the application will be unresponsive. When this happens, you may want to quit the offending application. This is accomplished via Force Quit.

There are several ways to force quit an application. You can Control-click its icon in the Dock and click Force Quit. You can press Command-Option-Esc on your keyboard to bring up the Force Quit Applications window. You can also use Activity Monitor to quit the application process.
If an application doesn't respond for a while, select its name and click Force Quit.

When you force quit an application, it's a good idea to verify and repair disk permissions. Sometimes an application can have a file open and force quitting the application messes up the permissions on the file. We'll talk about how to fix that next.

How Do I Handle Permissions Problems?

Permissions are the set of rules defining who can access a file or folder. You can view permissions by clicking the file or folder and clicking Get Info (it's in the File menu in Finder or you can press Command-I). Click the arrow next to Ownership & Permissions to expand it, and you can see your permissions for the file or folder. If you expand Details, you can see more detailed information about permissions.

There are three main permission categories: the Owner, the Group, and Others. The owner is the originator of the file or folder, or the user account that takes ownership of the file or folder. The group is the group of users that has permissions for
the file. The Others category contains all users who don’t fall into one of the previous categories.

You set access for each category by clicking the drop-down next to Access. You can choose Read & Write, Read-Only, Write-Only, and No Access. When you select the access level, click the Apply to enclosed items... button to make your changes stick.

But what if something goes wrong? The solution is Disk Utility, found in /Applications/Utilities. In Disk Utility, click your hard disk in the drive list, and then click the First Aid tab. Click the Repair Disk Permissions button and Disk Utility will find and fix all of the permissions errors on your Macintosh.

![Disk Utility](image)

To use First Aid, select the volume and click a repair button.

- You can verify or repair any volume format supported by Mac OS X.
- First Aid cannot repair a write-protected disk, a CD-ROM, or a disk with open files. To repair or verify the startup disk, boot from the Mac OS X install CD and select Disk Utility from the Installer Menu.
- You may only repair permissions on a volume with Mac OS X installed.
- If Disk Utility cannot make repairs, try other disk repair programs or back up your data and erase the volume.

Figure 9-19: Before you click Repair Disk Permissions, you can click Verify Disk Permissions to find out if there are any problems to repair.
How Can I Repair My Hard Disk?

You can repair any disk using Disk Utility; just click the disk, click the First Aid tab, and click the Repair Disk button. There’s one exception: Disk Utility can’t repair the startup disk (that’s usually your Macintosh’s internal hard disk). You can start up from your Mac OS X installation disk and run Disk Utility from the Installer menu, or you can use one of the commercially available disk repair applications.

So the process is:

1. Start up from another disk, such as your Mac OS X installation disk.

2. When you start up using another disk, run Disk Utility and repair the disk or use a proprietary application (like Norton SystemWorks or Micromat Drive 10).

3. Reboot your machine after the repairs are made.

But, you may be wondering, how do I start up from a disk other than my internal hard disk? To start up from a CD or DVD, hold down the C key after you restart your Macintosh.

**Tip:**

If you are in the market for disk repair utilities (and you should be), check out the aforementioned Norton SystemWorks and Micromat Drive 10. I’ve also heard great things about Aladdin Disk Warrior. All of these applications include a bootable CD. Consider the relatively small investment to give yourself peace of mind when something goes wrong with your Macintosh’s hard disk.
Startup Disk Preference

Mac OS X supports multiple startup disks. You can only boot into one at a time, of course, but you can have several at your disposal. You can boot from most external FireWire drives, CDs, DVDs, and other kinds of attached disks, as long as they have a Mac OS X system folder.

Select the system you want to use to start up your computer

![Startup Disk preferences](image)

You have selected Mac OS X, 10.3 on the volume "Mac OS X Install Disc 1".

Click the lock to prevent further changes.

Figure 9-20: I have four startup disks available: my Mac OS X 10.3.1 installation disk, Mac OS 9.2.2, the Mac OS X 10.3 install disk, and network startup.

You use the Startup Disk preference in System Preferences to select a different startup disk. This preference will show all of the available choices for startup disks on your Macintosh. Choose the disk you want to make your startup disk and click the Restart... button. Your Macintosh will restart using the startup disk you selected, and you can then make repairs on your internal hard disk. When you’re finished with repairs, set the startup disk back to the default and restart.

Note:

The Restart... button is there for convenience. Whichever startup disk you select will be the startup disk, even if you don’t click the Restart... button. Mac OS X immediately applies changes; it doesn’t really have the concept of Apply as in Microsoft Windows.
Summary

I hope you come away with the knowledge of how to protect your Macintosh and keep it running smoothly. It’s easy to ignore security and general maintenance, but if you give these topics the attention they deserve, you can rest easy knowing that your Macintosh is safe and sound.
“When do I ever use Terminal?” Brian asked. We were sitting at one of his two Macs in his home office. I was trying to activate the Debug menu in Safari for him, but Terminal, the application I needed to use, wasn’t on his Dock.

“Well,” I said, “if you figured out how to use it, you could really unleash the power of Mac OS X.” I executed the command and quit Terminal. I leaned back in the chair and thought about what had just happened. Did Brian find Terminal useless because he didn’t know how to use it, or did he find it useless because he didn’t know what it was capable of?

When I use a Microsoft Windows machine, I open a command line for all kinds of tasks, including copying files, moving files, pinging other machines on a network, and creating network connections. I could do these things in Microsoft Windows Explorer, but my background lies in Unix and MS-DOS, so I work better with command lines.

Brian switched from PC to Macintosh a couple of years ago. When he was a PC user, he very rarely used the command line. I think most Microsoft Windows users don’t even know there’s a command line available, which is just fine; the old MS-DOS-based Microsoft Windows operating systems (like Microsoft Windows 95 and Microsoft Windows 98) were designed to help users retreat from having to type in arcane commands to do what they wanted on their machines. Switchers who aren’t accustomed to a command line can find Terminal somewhat intimidating or, as in Brian’s case, useless. Switchers who have used the command line in Microsoft Windows will be excited
about the possibilities afforded by Terminal but possibly daunted by learning all the new Unix commands.

Fear not, friends; this chapter aims to help you understand more about the Unix piece of Mac OS X and how to use the Terminal application to your advantage, including those daunting Unix commands. But first, allow me to introduce you to Darwin.

---

**Note:**

If you switched from Linux, you may find the Unix coverage in this chapter to be familiar. Except for the BSD-specific commands, the commands in this chapter work the same way on Linux. Thus, they may be old hat to you.

---

**What Is Darwin?**

In a nutshell, Darwin is the Unix piece of Mac OS X or, more accurately, the BSD piece of Mac OS X. Terminal is the command line for Mac OS X. It opens a window into Darwin and makes available a wealth of powerful commands that can simplify your common tasks and give you absolute control over your machine and how it works. Terminal is not a fancy program; it’s just a *shell*, a way to type in commands that are understood by the Unix piece of Mac OS X.

When Apple bought NeXT in December 1996, the plan was to solve Apple’s Mac OS woes by doing something with the NeXTStep operating system. If you remember from Chapter 2, NeXTStep used the BSD operating system at its core, and BSD is a flavor of Unix. As a descendant of NeXTStep, Mac OS X is also based on the BSD operating system. While Apple engineers were developing their Mac OS X strategy, they decided to separate the Unix side of Mac OS X into its own operating system, which they called Darwin.

Darwin is pretty cool. It works on different processors, including the Intel Pentium 4, and you can run it standalone. I’ve read about several organizations that use Darwin on their
servers, and there's even a port of X Window System for Darwin. You can use Darwin as your sole OS with a GUI and everything.

The Unix crowd appreciates Darwin for its technical ability, but that appreciation also has a lot to do with the fact that Darwin is open source. Being open source gives Darwin the advantage of having a large team of developers working on the operating system and contributing their own ideas and code to make Darwin more powerful, more reliable, and more secure. Because it is open source, Darwin is able to incorporate other open-source products, such as Apache, MySQL, sendmail, and Samba. Darwin is similar to its open-source cousin Linux; the things that help make Linux great are the same things that help make Darwin great.

**Looking Under the Covers**

Darwin is comprised of five main components — the Mach microkernel, the BSD subsystem, networking via TCP/IP, the file system, and the I/O Kit. Each of these components provides a set of capabilities that form the core of Darwin.

The Mach microkernel is the same as the one found in NeXTStep. It manages operating system resources such as memory usage (tracking how much memory is used and available) and processor scheduling (making sure applications get their fair share of processor time). The Mach microkernel is based on Carnegie Mellon’s Mach 3.0.

---

**Note:**

A kernel is the essential part of an operating system, handling the important tasks like memory management. A microkernel is a kernel that emphasizes using small modules to provide the basic features of the operating system. So in other words, a microkernel is a type of kernel where the tasks of the operating system are implemented as modules.
BSD, short for Berkeley Software Distribution, was developed at the University of California-Berkeley to run on Digital Equipment Corporation machines. The BSD subsystem is a customized version of the 4.4 BSD-Lite2 kernel, which is wrapped around the Mach microkernel. Darwin’s BSD subsystem performs the task of abstracting the networking and file system, as well as providing security and threading support (threading allows your applications to perform multiple tasks at once).

TCP/IP stands for Transmission Control Protocol/Internet Protocol. Darwin’s networking is based on the industry-standard TCP/IP stack from BSD. The TCP/IP support in BSD is legendary. TCP/IP is a wide-area networking protocol that forms the basis for Internet communication. It is a standard that grew out of usage rather than vendor requirements. TCP/IP isn’t a product; it’s a standard protocol for transmitting information. As such, it works on all kinds of networking hardware, including Ethernet, which is built into every Macintosh sold.

An operating system’s file system is responsible for organizing directories and files. There are several different types of file systems on every kind of operating system. Microsoft Windows XP uses NTFS, while older versions of Microsoft Windows use FAT32. Darwin’s file system is based on the Unix file system (VFS). Darwin’s VFS is enhanced to support the addition of other file systems, and Darwin also supports the native Macintosh file system, HFS+.

Finally, Darwin includes the I/O Kit, which simplifies developing device drivers. Device drivers are the pieces of code that make things like your scanner and mouse work.

Having read all of that technical stuff, you may still be confused as to how Darwin fits into the Mac OS X picture. Look at it this way: Mac OS X is a whole bunch of different parts, including the application frameworks (Cocoa and Carbon), the display technologies (Quartz and Aqua), OpenGL (for displaying 3D), and QuickTime (for multimedia). Mac OS X is built on top of Darwin, which forms the foundation for the Mac OS X operating system.
Terminal is the application you use to access the command-line subsystem of Mac OS X. It’s not a fancy application, but it has some nice features that make command-line work more pleasant and a whole lot easier.

I thought you would benefit from seeing the actual output of the commands in a Terminal session, so I included screen shots of the commands so you would know what to expect. If an equivalent MS-DOS command exists, I note it. A few of the commands, such as mkdir and uptime, don’t have screen shots because there’s no output specific to those commands. Also, be aware that, while all of the screen shots were captured in Mac OS X 10.3 Panther, the commands are the same for Jaguar as well.

Before we jump into the commands, you should know a few things about Unix. First of all, the commands are typically very short. It can sometimes be difficult to figure out what a command does by just looking at it. There are two possible explanations for this. First, it’s a commonly agreed upon conception that Unix users (and programmers) are lazy and therefore don’t want to type in long commands. I think this is only partly true; the Unix command to clear the screen is clear, whereas in MS-DOS it’s cls (for clear screen). If Unix users were lazy, why would they type out the whole word “clear”?

The other, more plausible explanation for the terse Unix syntax requires one to remember that computers in the 1970s didn’t have tons and tons of memory as they do today. The entire operating system would sometimes have to fit in as little as 16 bytes. That’s a tiny amount of space, and simple, short commands take up less memory. They’re also easier to remember.
How the Command Line Works

In order for you to issue commands to the underlying Darwin system in Mac OS X, you need some kind of interface to that system. That interface comes in the form of a shell. The shell is simply a program that processes commands issued to the system. It performs two key functions — interpreting the commands and offering a programming language to combine the commands. Interpreting a command compares the entered command against a list of supported commands and executes the command if it's valid. The programming language in a shell exists to allow you to combine commands, giving you more control of your operating system. In MS-DOS, this was done via creating batch files. In Unix and Unix-like operating systems, this is called shell scripting.

In Microsoft MS-DOS, the shell is COMMAND.COM. This shell is still used by the command prompt in Microsoft Windows 2000 and Microsoft Windows XP. COMMAND.COM processes all the MS-DOS commands you type in the command prompt.

Mac OS X has two default shells, depending on what version you are using. In Mac OS X 10.2 Jaguar, the default shell is tcsh. In Mac OS X 10.3 Panther, the default shell is bash.

**tcsh**

Tcsh is an enhanced version of the Berkeley Unix C shell (csh). Tcsh offers features such as spelling correction, a history mechanism, job control, and programmable word completion. The tcsh shell scripting language has syntax similar to the C programming language.
bash

Bash is a shell based on the sh shell. Stephen Bourne created the traditional Unix shell sh. Bash is a pun on his name; it's an acronym for Bourne-Again Shell. Bash is a very popular shell because of its compatibility with sh and its incorporation of features from Korn shell (ksh) and C shell (csh).

Using Mac OS X Commands

Now that you have a basic understanding of Darwin and know about shell differences, you're ready to start working with Mac OS X commands. Fire up the Terminal application if it's not already running. If you're running Mac OS X 10.3 Panther, you will see something like Figure 10-1.

![Figure 10-1: A basic Panther Terminal session with no commands](image)

The first line lets you know when you last logged in to your Macintosh. The second line is a nice little welcome message, which you can change (and we do later). The third line is your command prompt, allowing you to start typing in commands. This line will be different in your Terminal window for two reasons: The hostname and login name are different. The word
“Tyger” that appears in my Terminal session is my machine’s *hostname*. Your hostname will be something different, typically whatever you named your computer when you turned it on for the first time. You can also change your machine’s hostname in System Preferences, via the Sharing preference, as shown in Figure 10-2.

![Sharing System Preference](image)

Figure 10-2: The Sharing system preference, which allows you to change your hostname

You can change your Macintosh’s hostname by typing a new value in the Computer Name field. Notice that mine says Tyger, just like Terminal showed in Figure 10-1.
If you are using Mac OS X 10.2 Jaguar, the Sharing preference has a place for your machine's Rendezvous name. Rendezvous is Apple's implementation of something called "Zero Configuration." It lets you hook up devices to your network and your Macintosh will automatically find them and make them available, without any configuration on your part. iTunes can share playlists via Rendezvous, for example. Your Rendezvous name does not have to match your computer name. You can keep them separate or make them the same. Make your own decision based on your naming convention. For most users, matching the names will make things easier. Mac OS X 10.3 Panther doesn't require a separate Rendezvous name. Your machine's name is used instead.

The second difference in the prompt is the name preceding the $. On my machine, that name is “rob” because that’s the name I use to log into my Macintosh. The tilde (~) in the prompt indicates that you are in your home directory, which is /Users/ followed by your logged-in name. My home directory is /Users/rob.

So, looking at the prompt, you should see your machine name, followed by your location (the current folder), then the name of the currently logged-in user, and then the prompt ($).

**Note:**

This chapter uses the tcsh shell in Panther, but all of the commands work the same way in bash.
Changing Your Shell

You can change your shell in Terminal by simply entering the path and name of the shell. For example, in Jaguar, you could enter /bin/bash and the bash shell would start. Likewise, in Panther, you could enter /bin/tcsh and run the tcsh shell. If you start one shell while you’re in another (for example, you run /bin/bash while you’re in /bin/tcsh), the new shell will run simultaneously with the old. Type exit to exit a shell and the Terminal application together.

Figure 10-3: I used /bin/tcsh to switch to tcsh from bash. Bash is still technically running; it’s just not my active shell.

You can also easily change your default shell in Terminal by telling Terminal to execute a command at startup. This eliminates running two shells at once. Normally, Terminal executes /usr/bin/login at startup, which starts the default shell. To change your default shell, start Terminal, click the Terminal application menu, and then click Preferences.... You will see the dialog in Figure 10-4.
When creating a new Terminal window:

- Execute the default login shell using `/usr/bin/login`  
- Execute this command (specify complete path):

  `/bin/bash`

Declare terminal type (STERM) as:  

- Open a saved `.term` file when Terminal starts:

![Terminal Preferences](image)

Figure 10-4: Changing your default shell

Click the radio button labeled Execute this command (specify complete path). In the text box, replace the text with whatever shell you want. If you want bash, type `/bin/bash`. If you want tcsh, type `/bin/tcsh`. Press the Return key and close the window. Restart Terminal, and your new default shell will be active.

### Working with Files and Directories

I use the command line the most when working with files and directories. Whether it's deleting files or editing configuration files, I pop into Terminal to get it done. There are several useful commands for working with files and directories in Mac OS X.

**Note:**

Unix commands, filenames, and directory names are case sensitive! That means that `P worse and `pwd` are not the same thing. This is different from MS-DOS, where you could type `DIR` and `dir` and get the same results. If you type these Unix commands into Terminal, make sure Caps Lock is off.
You know that the tilde represents your home directory, but you may wonder where your home directory is located. You can find out with `pwd`, which displays the current directory. The letters `pwd` stand for "print working directory." Go ahead and type it in. You should see something like Figure 10-5.

```
[Tiger:-] rob$ pwd
/Users/rob
```

Figure 10-5: The result of the `pwd` command

On my machine, the result is `/Users/rob`. This is the equivalent of `~/rob`. The MS-DOS equivalent of `pwd` is `cd`.

Now that you know where you are, you need to know what directories and files are available in the current directory. This is accomplished via the `ls` command, which means “list.” Type this command in Terminal. My results are in Figure 10-6.
You should see the contents of your home directory. Keep in mind that your home directory may contain some different items than mine.

The `ls` command accepts arguments, which allow you to fine-tune the results of `ls`. For example, you can type `ls -a` to display all files and directories (including hidden files) and `ls -1` to display details of files and directories. These details include security information, size, and date created. You can also combine the arguments into one command, `ls -al`, which will display a list of all files and directories with their details. You can see this in Figure 10-7.

The MS-DOS equivalent of `ls` is `dir`. 
man

You may wonder, “How do I find out all the arguments for ls?” Well, if I printed them here, it would take up the entire chapter, so I’ll show you a cool command called man (short for manual). First, type clear to clear out Terminal and give you a fresh screen. Then type man ls, and you should see the results in Figure 10-8.

![Figure 10-8: The result of the man ls command](image)

The man command gives you a description of the command, describing usage and each argument. This is called a man page. To scroll through the man page, press the Spacebar. When you finish reading the man page, press the q key to quit man.

MS-DOS does not have an equivalent to man.

mkdir

The mkdir command creates a new directory. Type mkdir switch at the command prompt to create the *switch* directory. This is the directory that we work with in the rest of this section.

The MS-DOS equivalent of mkdir is md.
**cd**

The `cd` command changes the directory based on the argument you provide. You can pass the name of a valid directory, an entire path, or two periods (..). All arguments passed to `cd` are preceded by a space. See Figure 10-9 for an example of how to use `cd`.

![Example of cd command](image)

Figure 10-9: A few examples of the `cd` command, shown with arguments. Notice that my location changed and is shown in the brackets after my host name.

Now, go back to your home directory by typing `cd ~`, and then type `cd switch` to change to your `switch` directory, which you should have created with `mkdir`. Once you execute that command, type `pwd` to make sure you’re where you want to be. You should be in the `switch` directory under your home directory. Mine is `/Users/rob/switch`.

If you type `cd` without any arguments, it will take you to your home directory (the equivalent of `cd ~`).

The MS-DOS equivalent of `cd` is `cd`.

**pico**

Now that you know how to navigate through directories and show their contents, it’s time to learn how to create and edit them. This is important when dealing with the various configuration files in Unix. You can always use TextEdit if you want, but this chapter is about the command line. Rather than open a big application, I think it’s much easier to fire up a small text editor from the command line if I’m already navigating the file system to find and work with configuration files (like those used by open-source applications).
There are several text editors available in the command line. My favorite is Pico. Pico is a simple, easy-to-use text editor for Unix. It’s been around for as long as I can remember. Back in the early 1990s, I used Pico to read my email. How’s that for old school?

To use Pico, simply pass a filename as an argument. If the file doesn’t exist, Pico will create it. Try it out; make sure you are in the switch directory under your home folder (mine is ~/rob/switch, for example), and then type pico switcherfile in Terminal. This will open Pico and create a new file called switcherfile. See Figure 10-10 for what happens next.

Figure 10-10: The result of the pico switcherfile command. Notice that the application name appears in the Terminal title bar.

When you get Pico opened with switcherfile loaded, type some text. I typed the words “switched to Macintosh.” Save the file by pressing Control-O. This writes the contents to switcherfile. Then press Control-X to exit Pico. You now have a file to manipulate with the rest of the commands in this section.
Note:
Be sure you use the Control key and not the Command key when pressing Control-O and Control-X. You don’t want to hit Command-X!

The MS-DOS equivalent of pico is edit.

more

The more command simply displays the contents of a file. Type more switcherfile at the command prompt to quickly display the contents of switcherfile. See Figure 10-11 for an example.

Figure 10-11: The result of the more switcherfile command. The command won’t work if switcherfile can’t be found, so make sure you’re in the correct directory either by typing pwd or by looking at your prompt.

One of the neat things about more is that you can use it with other commands, such as ls. Simply put a pipe symbol (|) and the more command at the end of your ls -a command, as in Figure 10-12. This will pause the output of the command.
Figure 10-12: The result of the Is -a | more command when executed at the root directory, which is located at /. When you execute more at the end of a command with a pipe, as we did with Is -a | more, press Enter to scroll the results line by line, and press the Spacebar to scroll the results page by page. Try it out.

The MS-DOS equivalent of more is more, and the MS-DOS equivalent of Is -a | more is dir /p.

**cp**

By this point, you should have a directory called switch under your home directory, and you should currently be in that directory in Terminal. Entering pwd will confirm this. Another way to confirm your directory location is by looking at your prompt; it should show ~/switch. Type ls to confirm that switcherfile exists in the current directory.

Now you can copy switcherfile to another location. This is accomplished with cp, which is short for "copy." The cp command simply copies a file from one location to another. The original file is left alone.

To use cp, simply pass it two arguments — first, the name of the file you want to copy and second, the location to where you want to copy it. You can also use cp to create a new copy of a file
by passing a different filename in the second argument. Check out Figure 10-13 for an example of how to use cp.

```
[Tyger:/] rob$ cd
[Tyger:-] rob$ cd switch
[Tyger:-/switch] rob$ ls switcherfile
[Tyger:-/switch] rob$ cp switcherfile /
[Tyger:-/switch] rob$ cp switcherfile switcherfile2
[Tyger:-/switch] rob$ ls switcherfile switcherfile2
[Tyger:-/switch] rob$
```

Figure 10-13: Using the cp command in a couple of different ways

At your prompt, type `cp switcherfile switcherfile2`. This will create a copy of `switcherfile` named `switcherfile2` in the current directory. Type `ls` to confirm.

The MS-DOS equivalent of `cp` is `copy`.

**mv**

The `mv` command moves a file from one location to another. It takes two arguments. The first argument is the file you want to move, and the second argument is the location where you want to move the file. You can also use `mv` to rename a file by passing the filename as the second argument. This is similar to `cp`, except `mv` moves your file to its new filename; your original file is renamed, so there's only one file, while `cp` leaves your original file alone. See Figure 10-14 for an example of the `mv` command.

```
[Tyger:/switch] rob$ cp switcherfile2 switcherfile3
[Tyger:/switch] rob$ ls switcherfile switcherfile2 switcherfile3
[Tyger:/switch] rob$ mv switcherfile3 switcherfile_newname
[Tyger:/switch] rob$ ls switcherfile switcherfile2 switcherfile_newname
[Tyger:/switch] rob$
```

Figure 10-14: Using the mv command to rename a file. First, I used `cp` to create a copy of `switcherfile2` called `switcherfile3`, then I used `mv` to rename `switcherfile3` to `switcherfile_newname`. 
We want to move the original switcherfile to the home directory. Do this by typing `mv switcherfile . ./`. This tells the command line that you want to move switcherfile to the parent directory, which happens to be the home directory. Confirm the move by typing `ls ~/.switch`. The only file in `~/switch` should be `switcherfile2`.

The MS-DOS equivalent of `mv` is `move` for moving files and `ren` for renaming them.

**chmod**

The `chmod` command changes permissions for access to a file. To use it, you have to pass one or more command-line switches, based on what you want to do to the file, and the filename itself. You can use it to set access permissions (such as who can access the file), as well as some file attributes like read-only and hidden. This command is illustrated in Figure 10-15.

![Figure 10-15](image)

Figure 10-15: By using the `chmod` command with the `-w` switch, I can set `switcherfile2` to read-only.

A complete discussion of `chmod` would take up too much space here, but I thought it deserved a mention for one main reason: Sometimes, in Mac OS X, permissions on a file get screwy, and it can be difficult to set them back to the way you want. Using `chmod`, you can set permissions from the command line.

There isn’t really an MS-DOS equivalent of `chmod`, but you can use `attrib` to set a file to read-only, hidden, system, and archive.
Before I tell you about \texttt{rm}, I must tell you that it is a dangerous command. I can’t stress that enough. If you’re inclined to stay away from things that can delete files from your computer, then go ahead and skip \texttt{rm} and \texttt{rmdir} entirely. You don’t have to be afraid of \texttt{rm}; in fact, it’s a very useful command. Just know what you are doing before you do it. You \textit{must} follow my instructions \textit{exactly}. Feel free to read the man page for \texttt{rm} by typing \texttt{man rm}, but make sure you fully understand what’s happening before you play around with \texttt{rm}.

Now, with that warning out of the way, let’s use \texttt{rm} to delete the extraneous \texttt{switcherfile2} file we created earlier. First, make sure you’re in \texttt{~/switch}. If you’re not, get there using \texttt{pwd} and \texttt{cd} to find your way. Once you’re in \texttt{~/switch}, type \texttt{ls} to confirm that \texttt{switcherfile2} is present. Type \texttt{rm switcherfile2} to delete the file. Make sure you look at Figure 10-16 to see what the results should be before you proceed.

After you run \texttt{rm switcherfile2}, run an \texttt{ls} command to verify that the file is deleted; the prompt doesn’t give feedback that the file has been deleted. If the file is still present, step back through the commands and compare your Terminal with my screen shot to make sure you’re doing the right thing.
Note:

Be very, very careful with the rm command. It doesn’t move files to the Trash; it permanently deletes them. It’s very easy to delete every file on your computer with a mistaken argument passed to rm. Know that it’s there if you really need it, but I suggest using Finder to delete files. Then you at least have a way to get them back if you change your mind.

The MS-DOS equivalent of rm is del.

rmdir

The last command we’re going to discuss is rmdir, which removes a whole directory. First, type pwd to confirm you are in ~/switch. Now type cd .. to move up to the parent directory. Enter ls to see that switch is listed in the contents of your current directory. You’re now ready to delete the switch directory.

Like rm, rmdir can be dangerous if you don’t know what you’re doing. Fortunately, it has some safeguards built in; for example, it won’t delete a directory that isn’t empty.

Delete the switch directory by typing rmdir switch at your command prompt. Like rm, the prompt doesn’t give you any feedback to let you know the directory has been deleted; you’ll need to run ls to confirm that the directory is gone. Check Figure 10-17 for the sequence of commands.

```
[Type:~/switch] rob$ pwd
/Users/rob/svtch

[Type:~/switch] rob$ ls
[Type:~/switch] rob$ cd ..

[Type:~] rob$ ls
Desktop  Library  Music  Public  Sites
Documents  Movies  Pictures  Shared  switch

[Type:~] rob$ rmdir switch

[Type:~] rob$ ls
```

Figure 10-17: Using rmdir. Notice that I confirmed my location before I ran the command.
The switch directory has shuffled off this mortal coil. Be sure to check out the man page for rmdir so you can understand its arguments.

The MS-DOS equivalent of rmdir is rmdir.

**Using Networking Commands**

The networking commands help immeasurably when you are trying to find information about computers on a network (including the Internet). The commands discussed here are by no means complete; they’re just a sample of what is available in Terminal.

**Tip:**

These commands, plus a few others, are available in a Mac OS X application called Network Utility. You can find it in /Applications/Utilities. The command-line versions are handy if you’re already in Terminal. I tend to use the command-line versions exclusively, but you may find Network Utility easier to use.

**nslookup**

Nslookup is a command-line application that allows you to look up information about Internet servers. You can use it to find the IP for a specific server given its domain name as an argument. Nslookup will check the domain name server (DNS) for an entry corresponding to the specified domain name and return information about that domain. Nslookup by default uses the DNS server specified by your ISP settings, or you can pass the DNS server as an argument.

Check out Figure 10-18 for an example of how I used nslookup to get information about my web server, standefer.com.
nslookup is deprecated and may be removed from future releases. Consider using the 'dig' or 'host' programs instead. Run nslookup with the '-s[l]([n]e)' option to prevent this message from appearing.

Server: 4.2.2.4
Address: 4.2.2.4:1163
Non-authoritative answer:
Name: standefer.com
Address: 66.78.111.17

[Tyger:~] ros$ nslookup standefer.com

Figure 10-18: The result of nslookup standefer.com

If you want more information about nslookup, consult its man page. It has a pretty exhaustive explanation of how to use arguments with the nslookup command.

The MS-DOS equivalent of nslookup is nslookup. It works exactly the same way.

Note:

As you can see in the screen shot, with the release of Panther, nslookup has been deprecated in favor of dig and host. These commands work the same way as nslookup; simply pass the name of the web server as an argument.

ping

Ping is an application that I can’t live without. Whenever I need to verify a machine is connected to my network, I ping it. The concept of pinging in the computer world is the same as in the submarine world. Submarines send out ping messages (a sound) and use sonar to determine if the sound has bounced off of something; they’re usually looking for another submarine. A message is sent out, and if it’s received, verification is provided.

In the computing world, ping works basically the same way, except that you know the address of the computer; you just need to know if it’s home. Your computer sends a ping message to a specified computer’s address, and if the receiving computer is on
the network, it responds with a series of messages indicating how long it took for your ping request to be answered.

To use ping, simply pass the address of the computer you want to ping as an argument to the ping application. You can pass either the IP address or the fully resolved domain name. Figure 10-19 shows the ping command in action.

```
[Tyger:-] rob$ ping standef.coa
PING standef.coa (66.70.18.17): 56 data bytes
64 bytes from 66.70.18.17: icmp_seq=0 ttl=54 time=78.988 ms
64 bytes from 66.70.18.17: icmp_seq=1 ttl=54 time=78.984 ms
64 bytes from 66.70.18.17: icmp_seq=2 ttl=54 time=78.129 ms
64 bytes from 66.70.18.17: icmp_seq=3 ttl=54 time=77.952 ms
64 bytes from 66.70.18.17: icmp_seq=4 ttl=54 time=77.673 ms
--- standef.coa ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 77.673/78.285/78.988 ms
```

Figure 10-19: The result of the ping command. After five “hops,” I pressed Control-C to stop the ping request.

When you are ready for ping to stop pinging, simply press Control-C. This will display the summary of the ping results. If you want to fine-tune your ping request, check out the man page for ping.

The MS-DOS equivalent of ping is ping.

**traceroute**

Traceroute is a cool application that prints out the path that network packets take to a specified network host (a *packet* is simply a piece of information). Keep in mind that when you request a web page with a web browser such as Safari, you're not getting a one-to-one relationship with the server. Your request is routed through several Internet servers on the way to its destination. If you're not able to connect to a server, traceroute is a great application for finding out where the problem lies in the path from your computer to the web server.
To use traceroute, simply pass the IP address or domain name of the computer whose route you want to trace. See Figure 10-20 for an example.

```
$ rob$ tracroute standefcr.com
tracroute to standefcr.com (66.76.18.17), 30 hops max, 40 byte packets
1  crntx1-ar7-4-63-064-001.crntx1.dsl-verizon.net (4.63.64.1) 23.218 as 36.741 23.164 as
2 4.24.52.49 (4.24.52.49) 22.887 as 21.524 as 21.607 as
3 p3-3.crntx1-cr8.bbnplanet.net (4.24.117.69) 21.632 as 21.67 as 23.7 as
4 p8-2.crntx1-br2.bbnplanet.net (4.24.8.197) 25.289 as 32.041 as 25.341 as
5 unknown.level3.net (64.159.4.69) 21.296 as 33.436 as 42.058 as
6 so-b1-4.bbn2.newyork1.level3.net (64.159.1.42) 68.942 as 77.732 as 60.92 as
6 as
7 gipe7-6.ipco101.newyork1.level3.net (64.159.17.35) 61.403 as 73.257 as 71.997 as
8 so-b1-6.hsod.newark1.level3.net (289.244.13.198) 61.372 as 61.348 as 79.4 as
81 as
9 corei.evr.dotpipe.net (64.156.8.38) 61.492 as 61.477 as 77.145 as
10 via12.evr.dotpipe.net (64.196.128.25) 61.453 as 61.6 as 81.748 as
AC
```

Figure 10-20: The result of tracroute standefcr.com indicates that several servers handle my request between my machine and the standefcr.com server.

Each line in the tracroute output is called a hop. A hop is a switch from one computer to another; in other words, it’s an entry for each server your packet touches before it reaches its destination. If you see asterisks instead of a server name, then your packet has stalled somewhere.

The MS-DOS equivalent of tracroute is tracert.

### Using the Convenience Commands

There are a few commands, like clear, that exist solely for convenience. Knowing these commands could make your Terminal sessions a little less frustrating.
clear

This command clears the screen and gives you a clean space to work from. I use this after I’ve typed a bunch of ls commands and I need to do something else. Some people never use clear. Keep in mind that if you use clear and you still need to know what the Terminal output for previous commands was, you can use the Terminal scroll bar to scroll up and see everything you did previously.

The MS-DOS equivalent of clear is cls.

history

I love history. I don’t know how I could ever get by without it. In MS-DOS, there’s an old command called DOSKEY that kept a running list of commands you issued; to get a previous command, you kept pressing the up arrow key until your command appeared. The history command in Darwin is much more useful and, frankly, much cooler. Typing history in Terminal will display a numbered list of every command you’ve issued in that Terminal session, along with the time it was issued.

Try it out. To execute a command from history, type the exclamation point (!) and the number of the command you want to run again, then press the Return key. The command will be executed.

The history command isn’t useful if you just use ls and cd. It’s great, however, for those times when you’re editing files with long paths or you’re compiling applications. Then it becomes invaluable.

I guess the closest MS-DOS command to history is the aforementioned DOSKEY, although it pales in comparison.
**uptime**

The `uptime` command displays the length of time that has elapsed since the last time you rebooted your computer. It also displays load averages, which can be useful if you have multiple users connected to your machine at one time. If you want to know how long your computer has been working since your last reboot, run `uptime` in Terminal.

---

**Note:**

There's a certain geek factor associated with `uptime`. Many Unix folks like it when their computers run for a long time without a reboot. The longer your machine is up, the better; it gives you "geek cred." I think the longest `uptime` I ever recorded on my machine was 17 days, and I had to reboot for Software Update.

There is no MS-DOS equivalent to `uptime`.

**who**

`who` displays a list of users currently logged into your computer. This is useful when you have multiple people using the same machine. I use it to check for unauthorized access to my machine.

Run the command `who` in Terminal to see a list of users currently logged in. At the very least, it should show two entries. The first entry is you, logged into the machine itself (noted as console). Notice that it shows the time you logged in as well. The second entry should also be you, logged into Terminal (it's noted as ttypl). Any other users listed should be investigated further if you didn't authorize access for them.
cal

Cal is a fun little program, although it doesn’t serve much of a purpose in terms of managing your machine. The cal command conveniently displays a calendar. That’s simple enough, but cal goes a step further. If you pass it a month as an argument, it shows a calendar for that month. If you pass a month and a year, it shows you the calendar for the specified month in the specified year. Using cal 7 1776, I found out that July 4, 1776, was a Thursday. Check it out for yourself. Type cal and the digit representing the month for which you want to see a calendar (i.e., 1 for January, 2 for February, and so on). If you want to see a specific year, put it in four-digit format following the month. See Figure 10-21 for an example.

Figure 10-21: According to cal 7 1969, the Apollo 11 mission to the moon landed on a Sunday.

If you want to see the current month’s calendar, simply run cal with no arguments.

There’s no MS-DOS equivalent of cal.
This chapter introduced you to the BSD underpinnings of Mac OS X, known as Darwin. Darwin is a complicated subject that could easily take up an entire book, so this chapter covered the easier parts and showed you several helpful Darwin commands that you can use with the Terminal application. A comparison to equivalent MS-DOS commands was provided for those who used the MS-DOS command line on the Microsoft Windows (or MS-DOS) platform.

Terminal is a very useful tool. Practice will make you more comfortable with it and let you use it to your full advantage in the future.
Mastery of the Mac OS X keyboard shortcuts can significantly enhance your Macintosh experience. Daniel is crazy about keyboard shortcuts. It’s crazy to watch him use a Macintosh, as his hands rarely leave the keyboard. Other people, like my wife, don’t use the keyboard shortcuts at all, preferring the familiar assuredness of a mouse movement. All I can recommend is you try out the shortcuts and stick with the ones you like. Anything that is accessible via a shortcut can be done with a mouse; the opposite, however, is not necessarily true.

**Startup**

These are keystrokes you execute when your Macintosh is starting up. Press the keystroke after the Macintosh chimes and the Apple logo appears.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Start up from a CD (the CD must have a Mac OS system folder)</td>
</tr>
<tr>
<td>n</td>
<td>Start up from a compatible network server</td>
</tr>
<tr>
<td>r</td>
<td>Force a screen reset (PowerBook only)</td>
</tr>
<tr>
<td>t</td>
<td>Startup in FireWire Target Disk mode. Use this when you have your Macintosh</td>
</tr>
</tbody>
</table>
connected to a PC or Macintosh via a FireWire cable. This effectively turns your Macintosh into a FireWire hard disk.

x
Shift
Command-V
Command-S
Option-Command-Shift-Delete

These are really handy keyboard shortcuts you can execute in Finder and most of your applications. Not all of the shortcuts work in all applications (for example, Command-E will not eject a disc when you're in Word:mac; it only works in Finder).

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-B</td>
<td>Minimize the Finder toolbar</td>
</tr>
<tr>
<td>Command-D</td>
<td>Duplicate a file, folder, or alias</td>
</tr>
<tr>
<td>Command-E</td>
<td>Eject a disc</td>
</tr>
<tr>
<td>Command-F</td>
<td>Find a file or folder</td>
</tr>
<tr>
<td>Command-H</td>
<td>Hide the active application</td>
</tr>
<tr>
<td>Option-Command-H</td>
<td>Hide other applications</td>
</tr>
<tr>
<td>Command-I</td>
<td>Show Info</td>
</tr>
<tr>
<td>Command-J</td>
<td>Open View Options</td>
</tr>
<tr>
<td>Command-K</td>
<td>Connect to server</td>
</tr>
<tr>
<td>Command-L</td>
<td>Make an alias</td>
</tr>
<tr>
<td>Command-M</td>
<td>Minimize window (also works in applications)</td>
</tr>
</tbody>
</table>
Option-Command-M  Minimize all windows (also works in applications)
Command-N  Open a new Finder window
Command-O  Open a file, folder, or application (also works in applications)
Command-R  Show original item. Use this when you want to find the target of an alias.
Command-W  Close a window (also works in applications)
Option-Command-W  Close all windows
Command-Right Arrow  Expand folder (list view only)
Option-Command-Right Arrow  Expand the folder and nested subfolders (list view only)
Command-Left Arrow  Collapse the folder (list view only)
Option-Command-Up Arrow  Open the parent folder and close the current window
Command-Up Arrow  Move up one folder
Command-Down Arrow  Move down one folder
Command-Shift-N  Create a new folder
Command-Delete  Move the selected item to the Trash
Command-Shift-Delete  Empty the Trash
Command-Option-D  Toggle Dock hiding
Command-Shift-A  Go to the Applications folder
Command-Shift-C  Go to the Computer folder
Command-Shift-G  Go to a specific folder
Command-Shift-H  Go to your home folder
Command-Shift-I  Go to your iDisk
Command-Shift-Q  Log out of Mac OS X
Control-Eject  Show the Restart/Sleep/Shutdown dialog
Control-Command-Eject  Quit all applications and restart
Option-Command-Eject  Put the Macintosh to sleep
Command-[  Back (also works in some applications, like Safari)
Command-]  Forward (also works in some applications, like Safari)
Appendix A

Command-?  Open Mac OS X Help
F9    Show all windows in Exposé
F10   Show application windows in Exposé
F11   Show desktop in Exposé
F12   Eject

Application Shortcuts

These keystrokes work in most applications. They provide quick access to common functions, like cutting, pasting, and printing.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-A</td>
<td>Select All</td>
</tr>
<tr>
<td>Command-C</td>
<td>Copy</td>
</tr>
<tr>
<td>Command-N</td>
<td>Open a new blank file</td>
</tr>
<tr>
<td>Command-P</td>
<td>Print</td>
</tr>
<tr>
<td>Command-Q</td>
<td>Quit an application</td>
</tr>
<tr>
<td>Command-S</td>
<td>Save</td>
</tr>
<tr>
<td>Shift-Command-S</td>
<td>Save As</td>
</tr>
<tr>
<td>Command-V</td>
<td>Paste</td>
</tr>
<tr>
<td>Command-X</td>
<td>Cut</td>
</tr>
<tr>
<td>Command-Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Command-Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Command-Tab</td>
<td>Switch applications</td>
</tr>
<tr>
<td>Option-Command-Esc</td>
<td>Open the Force Quit Applications window</td>
</tr>
<tr>
<td>Command-Shift-3</td>
<td>Capture the screen to a file</td>
</tr>
<tr>
<td>Command-Shift-4</td>
<td>Capture the selection to a file</td>
</tr>
</tbody>
</table>
Universal Access

If you use the Universal Access features of Mac OS X, these key-strokes are essential.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control-F1</td>
<td>Turn on full keyboard access</td>
</tr>
<tr>
<td>Control-F2</td>
<td>Highlight menu (full keyboard access must be on)</td>
</tr>
<tr>
<td>Control-F3</td>
<td>Highlight the Dock (full keyboard access must be on)</td>
</tr>
<tr>
<td>Control-F4</td>
<td>Highlight the active window (full keyboard access must be on)</td>
</tr>
<tr>
<td>Control-F5</td>
<td>Highlight the toolbar (full keyboard access must be on)</td>
</tr>
<tr>
<td>Control-F6</td>
<td>Highlight the Utility window (full keyboard access must be on)</td>
</tr>
<tr>
<td>Option-Command-*</td>
<td>Turn on Zoom</td>
</tr>
<tr>
<td>Option-Command-+</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Option-Command-</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Control-Option- Command-*</td>
<td>Switch to white on black scheme</td>
</tr>
</tbody>
</table>
0                  Hold the mouse button
.                  Release the mouse button (use after pressing 0)

Drag and Drop

These are keystrokes you can execute while dragging an object.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Copies the object</td>
</tr>
<tr>
<td>Option-Command</td>
<td>Creates an alias to the object</td>
</tr>
<tr>
<td>Command</td>
<td>Moves the object</td>
</tr>
</tbody>
</table>
Essential Macintosh Web Sites

As I was putting the finishing touches on this book, I went to Safari to check the accuracy of some technical information. I headed to one of my favorite Macintosh web sites, MacOSXHints.com. The process got me thinking: What are the most essential web sites for Macintosh users? I fired up iChat and started asking my Macintosh-using friends to see if we agreed on a short list of essential Macintosh-specific web sites. I compiled and categorized the results, took some screen shots, and added some of my own comments to create this appendix. Keep in mind that this is an opinion; this list is by no means an exhaustive one. Consider it a starting point for you.

News

Macintosh news is doled out in small portions, morsels of delight that are feasted upon by the Macintosh community. Okay, it’s not always that romantic, but Macintosh news is important to Macintosh users; sometimes, a Macintosh news story can be so huge that people will talk about it for months.
apple.slashdot.org

Slashdot is an extremely popular weblog. A *weblog* is a web site that offers information updated on a frequent basis, presented in a dated log format. Slashdot presents user-provided information, called *stories*, which usually link to other news sources. Each story has a comments section, which allows visitors to comment on the posted stories.

Slashdot has a special section for Apple that lists Apple-specific stories. The stories cover all kinds of Apple news and information, often with a technical slant.

![Figure B-1: apple.slashdot.org loaded in Safari 1.1](image)
MacNN.com

The Mac News Network, located at MacNN.com, is an essential source of Macintosh news and information. It’s updated very frequently with all of the latest news in the Macintosh world, as well as reviews of hardware and software. The site also offers a chat area and a forum for discussion.

Figure B-2: MacNN.com loaded in Safari 1.1
Games

Despite its reputation as a computer for anything but gaming, there exists a strong contingent of Mac users who play games on their machines. Game developers are doing a better job of releasing versions of their games for the Macintosh, and there are a number of great games that are Macintosh-specific, too.

InsideMacGames.com

There is no better site for Macintosh games coverage than InsideMacGames.com. With news, reviews, previews, hardware coverage, editorials, a forum, chat, release dates, and technical assistance, InsideMacGames.com is about as thorough as you can get when it comes to games on your Mac.

Figure B-3: InsideMacGames.com loaded in Safari 1.1
Technical

I'm a pretty technical person, so I like to know my Macintosh inside and out. Of course, I sometimes have problems, so I need a resource to help me out in that area.

MacFixIt.com

Although the Macintosh is a great computer, it's not infallible. Sometimes things just go wrong. Whenever I have some kind of problem with my Macintosh or Mac OS X, I head to MacFixIt.com. The site covers all kinds of technical information, such as software updates, hardware recalls, and general troubleshooting.
MacOSXHints.com

MacOSXHints.com is the go-to site for information on configuring and troubleshooting Mac OS X. Want to know how to set up an FTP server? How about playing a DivX file in QuickTime player? Need a script to quickly show hidden files? These questions are just a few whose answers can be found at MacOSXHints.com.

Figure B-5: MacOSXHints.com loaded in Safari 1.1
Shopping

I'm always on the lookout for a good deal, and when shopping for hardware or software for my Macintosh, I use a couple of sites that offer current prices for Macintosh stuff at popular retailers. Using these sites, I don't have to do all the hunting, so I can spend more time comparing prices and availability.

MacPrices.com

MacPrices.com tracks prices on Macintosh hardware. The information is grouped by system, making it very easy to drill down into the specific piece of hardware you're looking for. Choosing RAM for a Macintosh system is a breeze at MacPrices.com, although I do wish they partnered with more RAM vendors.

Figure B-6: MacPrices.com loaded in Safari 1.1
DealMac.com

When I'm looking for a good deal on something, I head to DealMac.com. The site lists current specials and deals available from different vendors. You may find a Palm m130 handheld for $140, or an open-box PowerBook G4 for $2,170. DealMac.com also has a coupon section, where you can go and find some really good bargains at online retailers.

Figure B-7: DealMac.com loaded in Safari 1.1
Humorous

Macintosh users are often regarded as a zealous lot, so occasionally it’s fun to laugh at ourselves. (I’m laughing on the inside.)

CrazyAppleRumors.com

CrazyAppleRumors.com is a really strange site that offers fake Apple-related news. Sometimes it’s a fake product announcement. Other times it’s a fake conversation with Steve Jobs. The site taps into the hullabaloo that surrounds Apple product announcements and the thick veil of secrecy that Apple wraps around everything they do. CrazyAppleRumors.com describes itself as “...dedicated to the fabrication of Apple rumors that defy verifiability, grammatical convention or any basis in reality.”

Figure B-8: CrazyAppleRumors loaded in Safari 1.1
Hardware and Software

Sometimes you need more than just what is given to you. For those times, there are some great web sites. I've chosen two: one for software and one for Macintosh portables.

VersionTracker.com

VersionTracker.com is an essential site for essential updates to essential software. It was recommended to me by Daniel, whom I've always regarded as a Macintosh demigod. Daniel lives in New York City now, which is home to (I hear) the coolest Apple Store. It's in SOHO.

Figure B-9: VersionTracker.com loaded in Safari 1.1
PowerBookCentral.com

Although its name implies it only covers PowerBooks, PowerBookCentral.com also offers support for iBook owners. It features the latest news, classifieds, buyer’s guides, price trackers, editorials, and reviews. It’s the essential web site for PowerBook owners.

Figure B-10: PowerBookCentral.com loaded in Safari 1.1

Summary

It is my hope that the 10 sites mentioned here help you expand your own Macintosh knowledge and experiences. It is my greater hope that this book has been useful, enjoyable, and worth your time.
Index

A
Access, 249-250
access, controlling, 297-304
accessibility, setting options for, 149-150
accounts, 297
  creating, 299-300
  creating for self, 304
  setting privileges for, 300-302
  switching, 303-301
Accounts preference pane, 299
  setting options in, 299-300
  using to activate FileVault, 308
  using to change password, 310
Action button (Finder), 94-95
Active Screen Corners pane, 139
Activity Monitor, 317-318
Address Book, 115-116, 190-191, 290
AirPort, 48
alias, 54, 91
  creating, 91
Alto, 17
antialiasing, 132
AOL Instant Messenger, 158-159
appearance, setting, 129-132
Appearance preference pane, 129-130
  setting options in, 129-132
Apple, 10-14
Apple I, 12-13
Apple II, 13-14
Apple II+, 14
Apple IIe, 15-17
Apple III, 14-15
Apple III+, 15
Apple key, 53
Apple Lisa, see Lisa and Lisa 2
Apple menu, 64-67
Apple Speakable Items, 144-145
AppleWorks vs. Office, 248
  application menu, 68
  application switcher, 117-118
  applications,
    adding, 105
  animating when opening, 128
  force quitting, 320-321
  hiding, 81-82
  installing, 103-104
  keyboard shortcuts for, 360
  launching, 105
  quitting, 105-106
  removing, 105
  switching on desktop, 117-121
arrow buttons (Finder), 91-92
Auction Manager, 156
automatic log out, 296, 298
B
background, 133
  automatically changing, 136-137
  copying from PC to Mac, 189-190
  setting, 133-137
background image, see background
Backup, 314-315
backup software, see background
BSD, 31-32, 330
  using with Mac OS X, 5
burn-in, 137
burning, 232
batch files, 332
Berkeley Software Distribution, see BSD
bookmarks,
  importing into Microsoft Internet
    Explorer for Macintosh, 186-187
  importing into Safari, 187-188
  preparing to copy from PC to Mac, 163-165
Bookmarks folder, 186-188
browsers, 153-157
burn-in, 137
burning, 232
C
cal command, 355
Calendar, 290-291
cameras, see digital cameras
cd command, 341
Index

CDs,
  accessing data from, 230
  burning, 231-236
  setting preferences for, 237
  using, 229-236
CDs & DVDs preference pane, 237
chmod command, 346
Classic, using to open Mac OS 9 applications, 116-117
clear command, 353
Close button, 58-59, 101
closed operating system, myth of, 45
colors, setting for Mac OS X, 130
column view, 93-94
Command key, 53
command line, 327-328
  using, 332, 337-352
compatibility, backward, 116-117
computers, types of, 10-11
contacts, preparing to copy from PC to Mac, 166-167
Contacts folder, 190-191
contextual menus, in Dock, 73-74
Control key, 54
cp command, 344-345
Customize Toolbar pane, 97-98

D
Darwin, 328-330
Data menu, Excel:mac, 279
date, setting, 147-149
Date & Time preference pane, 147-148
Delete key, 55
desktop, 60
Desktop & Screen Saver preference pane, 133-134
  using, 133-139
desktop background, see background
desktop publishing, development of, 24
Detto Move2Mac, using to copy files from PC to Mac, 168
devices,
  display, 238-239
  input, 194-195
  specialty, 195
dialog box, 98
digital cameras, 207
  using, 207-211
digital music player, 201-203
directories, working with in command line, 337-349
disk image, 227
  burning to CD, 233-234
  creating, 227-228
Disk Utility, 223
  using, 224-228
  using to burn CD, 233-234
  using to fix permissions errors, 322
  using to repair hard disk, 323
disks,
  copying, 227-228
  ejecting, 222-223
  erasing, 225-226
  hiding on desktop, 221
  mounting, 57
  repairing, 224-225
  unmounting, 57
  using, 221-228
  using to copy files from PC to Mac, 175-176
display devices, using, 238-239
Display PostScript (DPS), 32
Displays preference pane, 239
Dock, 58, 71
  adding items to, 74-75
  automatically hiding, 128-129
  contextual menus in, 73-74
  customizing, 74-76
  magnifying icons in, 127
  minimizing effects, 128
  positioning, 127
  removing items from, 76
  setting preferences for, 76
  sizing, 127
  using, 71-73
Dock preference pane, 126
  setting options in, 127-129
documents, 254
  creating, 255
  formatting, 259-260
  printing, 216-218
  saving as PDFs, 218
Documents folder, 186
drag-and drop keyboard shortcuts, 362
drive space, increasing, 318
DVD Player, watching movies with, 109-110
DVD region coding, 110
DVDs,
  accessing data from, 230
  burning, 236-237
  setting preferences for, 237
  using, 229-230, 236-237
  watching, 109-110
E
Edit menu,
  Excel:mac, 276
  Office:mac, 257
  PowerPoint:mac, 282
  Word:mac, 267
e-mail, copying from PC to Mac, 167
e-mail application, 157
Energy Saver preference pane, 140
  setting options in, 140-143
Enter key, 55
Entourage:mac, 244, 286-292
  Address Book, 290
  Calendar, 290-291
  Mail, 288-289
  Notes, 291-292
  Tasks, 292
  using as personal information manager, 287-292
  using to synchronize PDA, 244-246
  using with Microsoft Exchange, 286-287
Excel:mac, 273-279
Excel:mac menus, 276-279
  Data, 279
  Edit, 276
  File, 276
  Format, 278
  Insert, 277-278
  Tools, 278-279
  View, 277
expense of Macs, myth of, 43-44
Exposé, 118
  options in, 119-121
extended desktops, 238
external hard drives, using, 228-229
F
fast user switching, 303-304
Fat Mac, 22-23
favorites, see bookmarks
faxing with Mac, 219
file compression, 178-179
File menu,
  Excel:mac, 276
  Office:mac, 256-257
  PowerPoint:mac, 281-282
  Word:mac, 266
file security, 308-309
file transfer protocol, see FTP
files,
  backing up, 314-316
  compressing, 178-179
  copying, 90
  copying from PC to Mac, 161, 168-184
  deleting, 90
  downloading to Mac, 183-184
  encrypting, 308
  moving, 90
  organizing, 185
  preparing to copy from PC to Mac, 162-167
  renaming, 91
  system, 80
  uploading to Internet, 179-183
  user, 79-80
  working with in command line, 337-349
FileVault, 296, 308
  using to secure files, 308-309
Finder, 61-63, 86-87
  Action button, 94-95
  arrow buttons, 91-92
  folder contents, 89
  keyboard shortcuts for, 358-360
  search box, 95-96
  sidebar, 88
  view buttons, 92-94
  View options, 87
Finder toolbar, 91-95
  customizing, 97-98
firewall, 306-308
FireWire, 201, 318
folders, 79
  accessing, 89
Index

in Finder, 89
preparing to copy from PC to Mac, 162-163
selecting, 89
spring-loaded, 90
synchronizing, 316
Font menu, Word:mac, 270-271
font options, setting, 132
font smoothing options, 132
Force Quit, 320-321
Format menu,
Excel:mac, 278
PowerPoint:mac, 284-285
Word:mac, 270
formatting options, 259-260
Formatting Palette, 259-260
FrontPage, 250
FTP, 169
using to copy files from PC to Mac, 169-172
using to download files to Mac, 183-184
using to upload files, 179-180
function bar, 274-276

G
G4 Cube, 36
gaming platform, Macintosh as, 48-50
Get Info, 102-103
Grab, using to capture screen shots, 122-123
g graphical user interface, see GUI
Group permissions, 321-322
GUI, 17, 51
and Macintosh, 21

H
hackers, protecting Mac from, 306-308
handwriting recognition software, 196-197
hard disk, repairing, 323
Help menu, Office:mac, 259
hiding window or application, 81-82
history command, 353
home folder, 185
hop, 352
hostname, changing, 334
hot corners, 139
hypertext, 34

I
iCal, 114-115
iChat, 158-159
icon view, 92
icons,
changing, 150-151
copying from PC to Mac, 190
iDisk,
using to download files to Mac, 184
using to upload files, 181-182
iDVD, using to burn DVD, 237
iMac, 36
image, setting as background, 134-136
Image Capture, 210
using to manage photos, 210
iMovie, 211
incompatibility, myth of, 41-42
inefficient development process, myth of, 46
Ink, 196-197
notepad, 198-199
preference pane, 196
writing with, 197-198
input devices, support for, 194-195
Insert menu,
Excel:mac, 277-278
PowerPoint:mac, 283
Word:mac, 268-270
instant messaging, 158
Internet,
uploading files to, 179-183
using to copy files from PC to Mac, 176-184
Internet connection, establishing, 152-153
iPhoto, 208
using to manage photos, 208-210
iPod, 201-203
using to manage photos, 208-210
disconnecting, 206-207
Preferences pane, 204
using as PDA, 205-206
using iSync to synchronize with Mac, 205-206
using with iTunes, 203-205
iSync,
using to synchronize iPod and Mac, 205-206
using to synchronize PDA, 241-243
iTunes,
importing music with, 106-108
playing music with, 108-109
using to burn music CD, 234-236
using with iPod, 203-205

J
Jaguar, 37, 85
Jobs, Steve, 11-13, 20, 22, 29-30, 33, 35-36

K
Kerberos, 296
kernel, 329
Keyboard & Mouse preference pane, 199-200
keyboard shortcuts, 123, 357-362
keyboards,
  configuring, 199-200
differences between Mac and PC, 52-55
support for, 194-195
Keychain, 311-312
  using to manage passwords, 311-312

L
LaserWriter, 24
Linux, using with Mac OS X, 5
Lisa, 17-18
Lisa 2, 21
list view, 92-93
Is command, 338-339

M
.mac,
  using for iDisk access, 181
  using to back up files, 314
Mac II, 24-26
Mac OS, 21
licensing, 28
Mac OS X, 2, 36-37
  customizing appearance of, 129-132
development of, 29-37
  myth of closed OS, 45
myth of inefficient development process, 46
myth of OS not being secure, 47-48
  security features, 295-297
using with BSD, 5
using with Linux, 5
using with Unix, 5
Mac OS X commands, using in Terminal, 333-335
Mac OS X menus,
  Apple menu, 64-67
  application menu, 68
Mac OS X user interface,
differences from Microsoft Windows, 77-83
  similarities to Microsoft Windows, 58-76
Mac Plus, 23
Mac TV, 26
Mach kernel, 31
Mach microkernel, 329
Macintosh,
  and compatibility with PCs, 41-42
debut of, 22
development of, 17-22
myths about, 40-50
protecting from hackers, 306-308
protecting from viruses, 313
reasons for switching to, 1-2
software support for, 40
upgrading, 42
Macintosh GUI, 21
  legal battle over, 24
Macintosh-specific web sites, 363-373
macros, using in Office:mac, 262
Mail, 157, 288-289
mail linking, 288-289
mainframes, 10
man command, 340
man page, 340
memory, increasing, 317
menu bar, 64-70
menu extras, 69
  using, 69-70
menus,
  Excel:mac, 276-279
  Mac OS X, 64-68
  Office:mac, 256-259
  PowerPoint:mac, 281-285
  Word:mac, 266-273
mice, support for, 194
microcomputers, 11
Microsoft, and legal battle over Macintosh GUI, 24
Microsoft Access, see Access
Index

Microsoft Excel for the Mac, see Excel:mac
Microsoft Exchange, using with Entourage:mac, 286-287
Microsoft FrontPage, see FrontPage
Microsoft Internet Explorer 5.2, 155-157
Microsoft Internet Explorer for Macintosh, importing bookmarks into, 186-187
Microsoft Internet Explorer, exporting favorites from, 164
Microsoft Office, see Office
Microsoft Office for the Mac, see Office:mac
Microsoft Office XP, see Office XP
Microsoft PowerPoint for the Mac, see PowerPoint:mac
Microsoft Project, see Project
Microsoft Publisher, see Publisher
Microsoft Visio, see Visio
Microsoft Windows user interface, differences from Mac OS X, 77-83
similarities to Mac OS X, 58-76
Microsoft Word for the Mac, see Word:mac
minicomputers, 10-11
minimizing, configuring, 131
miscellaneous commands in Terminal, 352-355
mkdir command, 340
more command, 343-344
mouse, 55-57
buttons on, 55-56
configuring, 199-200
development of, 56
pointer, 82
Move2Mac, using to copy files from PC to Mac, 168
movie cameras, using, 211
movies, watching, 109-114
Movies folder, 189
Mozilla, exporting bookmarks from, 165
music,
importing with iTunes, 106-108
playing with iTunes, 108-109
music CDs, using iTunes to burn, 234-236
Music folder, 188-189
mv command, 345-346
myths about Macintosh, 40-50

N
Netscape 7, exporting bookmarks from, 165
network place, 181
Network preference pane, 152-153
network print server, 213
networking commands in Terminal, 349-352
Newton PDA, 26, 28
NeXT, 29-31, 33-35
acquisition by Apple, 35-36
NeXT Cube, 33
NeXTStep operating system, 31-33
niche market appeal of Macintosh, 44-45
No Limits account privileges, 300-301
Notes, 291-292
nslookup command, 349-350

O
Office, 247-248
and Mac, 247-249
vs. AppleWorks, 248
Office Assistant, 262
Office:mac,
differences from Office XP, 249-253
formatting with, 259-260
setting preferences in, 263
similarities to Office XP, 253-263
using macros in, 262
Office:mac document, creating, 255
Office:mac menus, 256-259
Edit, 257
File, 256-257
Help, 259
Tools, 258
Window, 259
Office:mac toolbars, 261
Office XP,
differences from Office:mac, 249-253
similarities to Office:mac, 253-263
online access, 152
Open dialog box, 99-100
OpenSSH, 296
OpenSSL, 296
OpenStep, 34
operating system security of Mac OS X, 47-48
operating systems, 18
Option key, 54
Other permissions, 322
Outlook Express contacts, preparing to copy from PC to Mac, 166-167
Owner permissions, 321

P
packet, 351
Page Setup dialog box, 217
Palm Desktop for Macintosh, using to synchronize PDA and Mac, 240-241
Panther, 2, 85
passwords,
  changing, 309-310
  managing with Keychain, 311-312
PCs, and compatibility with Macintosh, 41-42
PDA,
  connecting to Mac, 240
  synchronizing with Mac, 240-246
  using iPod as, 205-206
  using with Mac, 240-246
PDF, saving document as, 218
permissions, 308, 321
  types of, 321-322
  using Disk Utility to fix errors with, 322
personal computers, origins of, 11-12
personal digital assistant, see PDA
personal information manager, see PDA
  using Entourage:mac as, 287-292
pico command, 341-343
Pictures folder, 189
ping command, 350-351
Pixar, 30
playlist,
  creating, 235
  using in iTunes, 204-205
power button, 57
Power Mac, 27
PowerBook, 26
PowerPC consortium, 27
PowerPC processor, 27
PowerPoint:mac, 280-285
PowerPoint:mac menus, 281-285
  Edit, 282
  File, 281-282
  Format, 284-285
  Insert, 283
  Slide Show, 285
  Tools, 285
  View, 282-283
preference panes, 126
Preferences dialog box, 263
Print & Fax preference pane,
  setting fax options in, 219
  setting print options in, 215-216
Print dialog box, 217-218
printer,
  configuring, 215-216
  connecting, 212-213
  setting up, 213-215
printing with Mac, 212-218
privileges,
  setting for accounts, 300-302
  types of, 300-302
processes, monitoring, 317-318
Project, 251-252
Project Gallery, 254
proprietary platform, myth of, 43
Publisher, 250-251
pwd command, 338
Q
QuickTime Player, using, 111-113
R
RAM, upgrading, 317
Recent Items submenu, customizing, 131
region coding of DVDs, 110
remote login, 305-306
removable media, using, 228
Rendezvous, 335
Return key, 55
Rhapsody, 35-36
rm command, 347-348
rmdir command, 348-349
root account, 297
Rule of Probable Connectivity, 193
S
Safari, 153-155
  importing bookmarks into, 187-188
Samba, 172
Save dialog box, 100-102
scanner, 220
Index

scanning with Mac, 220
screen real estate clutter, hiding, 118-121
screen saver, 137
setting up, 137-138
setting up timer for, 138-139
screen shots, capturing, 122-123
scroll bars, 77-78
configuring, 130-131
scrolling, 131
search box (Finder), 95-96
Secure Shell, 305, see also OpenSSH
using for remote login, 305-306
Secure Sockets Layers, see OpenSSL
security,
configuring, 298
features, 295-297
file, 308-309
Security preference pane, 298
using to activate FileVault, 308
shared menus, 256
Sharing preference pane, 334
services list, 306
using to access FTP, 170
using to access Windows Sharing, 173
shell, 328, 332
changing, 336-337
scripting, 332
using, 332
shortcuts, see keyboard shortcuts
sidebar (Finder), 88
Simple Finder account privileges, 302-303
Sleep mode, 57
setting, 140-141
Slide Show menu, PowerPoint:mac, 285
software support for Macintosh, 40
software, updating, 319-320
Software Update preference pane, 319
setting options in, 319-320
Some Limits account privileges, 301-302
songs, importing with iTunes, 106-108
Sound preference pane, 146-147
sounds, setting, 146-147
Speech preference pane, 143
setting options in, 144-146
speech recognition, 144-145
spring-loaded folder, 90
startup, keyboard shortcuts for, 357-358
startup disk, selecting, 324
Startup Disk preference pane, 324
selecting startup disk in, 324
still cameras, using, 207-210
SuperDrive, 25
switching to Mac, reasons for, 1-2
synchronization,
of PDA and Mac, 240-246
with iPod, 206
system files, 80
System Preferences, 124-126
Accounts preference pane, 299-300
Appearance preference pane, 129-132
CDs & DVDs preference pane, 237
Date & Time preference pane, 147-148
Desktop & Screen Saver preference pane, 133-139
Displays preference pane, 239
Dock preference pane, 126
Energy Saver preference pane, 140-143
Ink preference pane, 196
Keyboard & Mouse preference pane, 199-200
Network preference pane, 152-153
Print & Fax preference pane, 215-216
Security preference pane, 298
Sharing preference pane, 170, 173, 334
Software Update preference pane, 319-320
Sound preference pane, 146-147
Speech preference pane, 143
Startup Disk preference pane, 324
Universal Access preference pane, 149-150

T
tabbed browsing, 154-155
Table menu, Word:mac, 272
tables, support for, 194
tarball, 104
tasks, 292
TCP/IP, 330
tcsh, 332
Terminal, 328, 331
changing shell in, 336-337
commands, 333-355
starting session in, 333-334
Index

using to change password, 310
time, setting, 147-149
toolbars, customizing, 97-98, 261
Tools menu,
   Excel:mac, 278-279
   Office:mac, 258
   PowerPoint:mac, 285
   Word:mac, 271-272
traceroute command, 351-352
trackballs, support for, 194
Transmission Control Protocol/Internet Protocol, see TCP/IP
Trash, 72
Twentieth Anniversary Macintosh, 36

U
Universal Access, 149
   keyboard shortcuts for, 361
   preference pane, 149-150
Unix, 30-31
   using with Mac OS X, 5
   vs. Windows, 18
upgradeability of Macintosh, 42
uptime command, 354
user accounts, see accounts
user files, 79-80
users, switching, 303-304

V
video mirroring, 238
view buttons (Finder), 92
View menu,
   Excel:mac, 277
   PowerPoint:mac, 282-283
   Word:mac, 267-268
View options in Finder, 87
Virtual Private Networking, see VPN
virus protection software, 313
viruses, protecting Mac from, 313
Visio, 252-253
Visual Basic for Applications macro engine, 262
voices, setting 145-146
volume menu extra, setting, 70
VPN, 296

W
wallpaper, see background
web browsers, 153-157
web sites, Macintosh-specific, 363-373
weblog, 364
WEP, 296
who command, 354
window controls, 58-59
Window menu, Office:mac, 259
windows,
   hiding, 81-82
   moving, 81
   sizing, 80
Windows Media Player, using, 113-114
Windows Sharing, 306
   using to copy files from PC to Mac, 172-175
Windows vs. Unix, 18
Wired Equivalent Privacy, see WEP
Word document window, 264-265
Word:mac, 264-273
Word:mac menus, 266-273
   Edit, 267
   File, 266
   Font, 270-271
   Format, 270
   Insert, 268-270
   Table, 272
   Tools, 271-272
   View, 267-268
   Work, 273
Work menu, Word:mac, 273
workbooks, 273-274
worksheets, 273-274
Workspace Manager, 32
Wozniak, Steve, 11-13

Z
Zip format, 17
Looking for more?

Check out these and other titles from Wordware's complete list

Game Developers Library

- ShaderX2: Introductions & Tutorials with DirectX 9
  1-55622-902-X • $44.95
  6x9 • 384 pp.
- ShaderX2: Shader Programming Tips & Tricks with DirectX 9
  1-55622-988-7 • $59.95
  6x9 • 728 pp.
- DirectX 9 Audio Exposed: Interactive Audio Development
  1-55622-288-2 • $59.95
  6x9 • 568 pp.
- Strategy Game Programming with DirectX 9.0
  1-55622-922-4 • $59.95
  6x9 • 560 pp.

Graphics Library

- LightWave 3D 7.5 Lighting
  1-55622-354-4 • $69.95
  6x9 • 496 pp.
- Essential LightWave 3D 7.5
  1-55622-226-2 • $44.95
  6x9 • 424 pp.
- LightWave 3D 8: Cartoon Character Creation
  1-55622-083-9 • $49.95
  6x9 • 550 pp.
- CGI Filmmaking: The Creation of Ghost Warrior
  1-55622-227-0 • $49.95
  9x7 • 344 pp.

Applications Library

- Mastering Business Analysis with Crystal Reports 9
  1-55622-293-9 • $44.95
  6x9 • 424 pp.
- Transact-SQL User-Defined Functions
  1-55622-079-0 • $49.95
  6x9 • 480 pp.
- Photoshop 7.0 for Screen Printers
  1-55622-031-6 • $59.95
  6x9 • 584 pp.
- Learn Google
  1-55622-038-3 • $24.95
  6x9 • 344 pp.
- The Macintosh Projects Book
  1-55622-228-9 • $59.95
  6x9 • 400 pp.

Visit us online at www.wordware.com for more information. Use the following coupon code for online specials: macsw0456
Designed for Windows users ready to make the switch to the Macintosh environment, this book discusses turning Windows skills into Macintosh skills, moving files to a Mac, Mac OS X equivalents to Windows applications, and other topics important to a new Mac user. *Macintosh Switcher's Guide* ultimately demystifies using, maintaining, and enjoying a Macintosh computer and all that goes with being a Macintosh user.

- Understand the differences and similarities between Mac OS X and Microsoft Windows.
- Learn how to configure preferences and customize toolbars in Mac OS X.
- Find out how to use the Office:mac applications.
- Discover the ways in which Mac OS X keeps your files secure.
- Unleash the power of Mac OS X with Terminal.

**About the author:**

Robert Standefer is a software architect specializing in enterprise applications for a large systems integration firm. Robert actively contributes to cross-platform development projects on Mac OS X and Windows. He lives in Dallas, Texas, with his wife and four cats.

**Covers**

Mac OS X Panther

**Level:** Introductory to intermediate

**Category:** Macintosh computers

ISBN 1-55622-045-6

$24.95 U.S. $34.95 Canada